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1 Welkom bij AerOn 

Bedankt voor het aanschaffen van de AerOn radio-automatiseringssoftware. AerOn is 
de meest complete radio-automatisering die op de markt beschikbaar is. De modulaire 
opbouw maakt de software schaalbaar in capaciteit, omvang en functionaliteit.  
 
AerOn is in te richten naar ieder type en formaat studio, met het vermogen om 
eenvoudig, snel en naar eigen inzicht uit te breiden wanneer dat gewenst is. Omdat de 
software zo compleet is, is het van groot belang om de software van binnen en van buiten 
te leren kennen.  
 
In deze handleiding vindt u alles wat u moet weten om u op weg te helpen met AerOn. 
Om het systeem tot in de details te leren kennen, raden wij u aan de handleiding dan 
ook minimaal één keer helemaal door te lezen.  
 
Deze handleiding is chronologisch opgebouwd. In de eerste hoofdstukken wordt een 
korte achtergrond geschetst bij de opbouw en de mogelijkheden van het AerOn studio-
systeem. Vervolgens worden de verschillende onderdelen van de software één voor één 
beschreven en tot slot worden de diverse uitbreidingsmogelijkheden van het systeem 
uitgediept.  
 
Voor informatie over de installatie van AerOn kunt u hoofdstuk 30 raadplegen 
‘Configuratie en installatie van AerOn’. 
 
Deze handleiding wordt regelmatig bijgewerkt als er nieuwe ontwikkelingen zijn en ook 
na feedback van onze gebruikers.  
 
Indien u meer gedetailleerdere toelichting wenst over de verschillende mogelijkheden 
van AerOn is er veel informatie te vinden in het portal 
https://support.broadcastpartners.nl/support/solutions, een ticket voor support kunt u 
aanmaken in https://support.broadcastpartners.nl. 

1.1 OnAir en Productiestation 

AerOn kan in diverse configuraties geleverd worden. Zo kan AerOn op één PC 
geïnstalleerd worden waarop het hele radioproces, van planning tot productie, gebeurt, 
maar ook op twee of meer PC’s, afhankelijk van de wensen van de klant. 
 
Indien uw configuratie uit meerdere PC’s bestaat, is het belangrijk om voor de 
verschillende PC’s een duidelijke naamgeving te hanteren. Het station dat de nonstop- 
en live-uitzendingen verzorgt, noemen we het OnAir station. De overige PC’s (waarop u 
databanken invult, de format- of commercialplanning uitvoert, voicetracks inspreekt of 
nieuwe audiotracks opneemt) noemen we productiestations.  
 
Of een PC functioneert als OnAir of productiestation wordt feitelijk bepaald door de 
licentie. Naarmate de configuratie groter wordt, kan een aparte PC geplaatst worden 
waarop alle databanken en audiobestanden staan. Die PC is de server. Productie en/of 
OnAir stations fungeren in een dergelijke configuratie als een client. 
 

https://support.broadcastpartners.nl/support/solutions
https://support.broadcastpartners.nl/
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Afhankelijk van de licentie kan AerOn ook fungeren als nonstop-server i.c.m. meedere 
studio’s, Studio player, Web player, Event systeem op locatie of Remote voicetrack. 
 

Als de 30-dagen trial is verlopen vervalt AerOn automatisch in de “Gratis Thuiswerk 
versie”. AerOn kunt u zonder licentie gebruiken, bijvoorbeeld thuis. De functionaliteit is 
dan beperkt tot de basis.  
- Muziek toevoegen aan de database, beluisteren in de PFL player en bewerken in 

Databank editor.  
- Items opzoeken in Databank browser. 
- Playlists openen en deze manueel wijzigen. 

1.2 Systeemeisen 

Voor gebruik van AerOn moet uw PC minimaal aan de volgende eisen voldoen: 
 

• Dual Core processor Intel i3 of AMD Ryzen 3. (Enkel AerOn) 

• Quad Core processor Intel i5 of AMD Ryzen 5 (AerOn + PostgreSQL database server) 

• Windows 11, 

• Windows 10; 

• 8 GB intern geheugen 

• 16 GB intern geheugen aanbevolen (AerOn + PostgreSQL database server) 

• 512 GB SSD voor OS en PostgreSQL database.   

• Een extra SSD/HDD voor opslag van audiobestanden. 

• Beeldschermresolutie van 1920 bij 1080 aanbevolen. 
 
Formatplanner en Commercialplanner zijn uitstekend in staat gebruik te maken van  
hogere prestaties van een snellere processor (Intel i7 / i9 / AMD Ryzen 7 / 9).  Daarnaast 
bieden server PC’s uitgerust met een Intel Xeon of AMD EPYC processor en registered 
ECC geheugen een hogere stabiliteit en zekerheid en behoeft de hardware minder 
frequent een reboot. Deze laatst genoemde systemen zijn uitermate geschikt voor server 
toepassingen. 
 
AerOn werkt tot dusver in Windows 10 en hoger. Op gebruik van Aeron met oudere 
besturingssystemen wordt door Broadcast Partners geen ondersteuning aangeboden. 
Het gebruik van versies ouder dan Windows 10 raden we dan ook ten stelligste af.  
 
Voor de opslag van audiobestanden is het aangewezen om geen gebruik te maken van 
een NAS omdat de meeste te traag zijn in gebruik voor onair playout. Een NAS kunnen 
we aanbevelen als backup medium. Voor een centrale server wordt vanaf vijf clients 
een Windows Server OS aanbevolen. 
 
Bij het gebruik van meerdere PC’s in één netwerk, is het belangrijk dat het netwerk met 
hoogwaardige componenten wordt opgebouwd. Zo werd er in het verleden al 
ondervonden, dat PC’s met een Gigabit-netverbinding en een 100-Megabit switch niet 
optimaal samenwerkten. Na het vervangen van de switch door een Gigabit switch 
werden bepaalde acties zo’n 30 keer sneller waar, afgaande op de specificaties, 
maximaal een factor 10 te verwachten was. 
 
Broadcast Partners selecteert voor haar automatiseringen uitsluitend merk-PC’s. Levert 
u zelf PC’s aan voor AerOn, neemt u dan vooraf contact op met uw leverancier om na te 
gaan of uw configuratie wel voldoet. In het verleden bleken computers van een 
bedenkelijke kwaliteit, aangeprezen door een lokale dealer, nog wel eens een bron van 
narigheid. 
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1.3 Opbouw van het systeem 

AerOn is een modulair opgebouwd automatiseringssysteem. Dat betekent, dat u 
uitsluitend die onderdelen (modules) hoeft aan te schaffen die u nodig heeft. Groeien na 
verloop van tijd de behoeften, dan kunt u stap voor stap het systeem opwaarderen.  
 
In deze alinea beschrijven we in het kort de mogelijkheden van de verschillende extra 
modules.  
 
Voor een gedetailleerdere beschrijving van de verschillende modules kunt u terecht op 
onze website: http://www.aeron.studio. Het op maat maken van oplossingen voor 
specifieke wensen behoort tot de mogelijkheden. Neem hiervoor gerust contact op met 
één van onze medewerkers.  info@broadcastpartners.nl 
 

 Studio Xtra Xpert 

Formatplanner ✓ Xtra Xpert 

Database browser ✓ Xtra Xtra 

Commercial planner ✓ Xtra Xtra 

Voicetracking ✓ Xtra Xtra 

Remote VT license  ✓ (2 x) ✓ (4 x) 

Jingle player ✓ Xtra Xtra 

Item browser ✓ ✓ ✓ 

Audio logger ✓ ✓ ✓ 

Time shifter ✓ ✓ ✓ 

InOutBox ✓ Xtra Xtra 

Studio switch ✓ ✓ ✓ 

SmartGPIO ✓ Xtra Xtra 

Production  ✓ ✓ 

Radix  Green Blue 

Editions   ✓ 

Extra playour   ✓ 

 
✓ = standaard 
 = niet beschikbaar 
 

1.4 Overzicht van beschikbare modules 

Hieronder vindt u in het kort een overzicht van de beschikbare modules. 
 

Formatplanner 
Met deze module kunt u bij Formatplanner semi-vaste items plannen. Semi-vast plannen 
maakt het mogelijk om nieuwsitems binnen een (instelbaar) tijdsvenster rond een 
bepaald tijdstip in te plaatsen. Op die manier zal de muziektrack voorafgaand aan het 
nieuws in zijn geheel afspelen en niet voortijdig uitfaden zoals bij vaste items het geval 
is. 
 

Formatplanner Xtra 
Met Formatplanner Xtra krijgt u planregels tot uw beschikking en er kunnen meerdere 
criteria per kolom geselecteert. Ook kunnen tracks instelbaar per uurformat onderling 
shuffelen. Zo plant u tracks binnen eenzelfde format op wisselende posities. 
 

Formatplanner Xpert 

mailto:info@broadcastpartners.nl


2025-05 Handleiding AerOn 

4 Broadcast Partners 

Met Formatplanner Xpert kan er veel gedetaillerder gepland worden. Zo kan er o.a. 
ingesteld worden dat bepaalde criteria uitgesloten worden bij het plannen.  Kan er een 
format gemaakt worden op basis van mood en texture. Daarnaast biedt deze module 
ook de mogelijkheid om per taal en per criteria een scheiding en max aantal per uur in 
te stellen. 
 

Database browser Xtra 
De uitbreidingsmodule Databank browser Xtra biedt ten opzicht van de standaard  
Databank browser diverse extra zoekfuncties, sorteermogelijkheden en vensterpresets. 
Zo kunt u onder andere zoeken op songtekst, texture, mood en worden er in plaats van 
enkel titel, artiest en audioID ook allerlei extra kolommen weergegeven, zoals de diverse 
criteriagroepen, laatst gespeeld, laatst gepland, speelduur, trackuurgetal, artiestuurgetal 
enzovoorts. Vervolgens kunt u op verschillende kolommen tegelijk sorteren om zo snel 
de gewenste gegevens te vinden. Ten slotte biedt Databank browser Xtra definieerbare 
vensterpresets die per ingelogde gebruiker en tevens ook per desktop-resolutie naar 
eigen voorkeur instelbaar zijn en er kan een gedetailleerde playlisthistorie van een artiest 
of track opgezocht worden in Databank editor. 
 

Commercialplanner Xtra 
Bij Commercialplanner Xtra kan een voorkeurspositie voor een reclamespot binnen een 
commercialblok ingegeven worden. Er kunnen o.a. per blok vier extra jingles toegevoegd 
worden die onafhankelijk van commercials gepland kunnen. Deze jingles houden ook 
rekening met de per track instelbare week- en jaardefenitie. Campagnes kunnen op 
even- of oneven dagen/week gepland worden en kunnen er verschillende extra 
spreidingsmogelijkheden over de periode en plaatsing per blok ingesteld worden. 
Campagnes kunnen als “Opvullen van lege blokken” gekenmerkt worden. Maximaal 
aantal commercials kan per blok in de weekmatrix ingesteld.  
 

Voice Tracking Xtra 
Met de module Voice Tracking Xtra kunt u voicetracks inlezen zoals in een live-situatie. 
De outro en intro van de tracks zijn tijdens het inspreken van de voicetrack hoorbaar en 
de voicetrackers kunnen tijdens het opnemen interactief bepalen wanneer de volgende 
track start. Daarnaast voegt deze module ook nog een extra spoor toe dat o.a. de 
mogelijkheid biedt om een jingle onder de voicetrack of intro van een track te slepen. 
 

Remote VT license 
Deze module is nodig om vanop afstand te kunnen voicetracken. Externe voicetrackers 
kunnen met behulp van hun eigen licentie vervolgens inloggen in het systeem en vanaf 
thuis (of waar ook ter wereld) de voicetrackfuncties van AerOn gebruiken. 
 

Jingle Players Xtra 
Met deze module kunt u Jingle Players uitbreiden tot maximaal 8 jingle carts. In totaal 
kunt u op die manier tot 56 jingles klaarzetten om te starten. U krijgt de beschikking over 
meerdere cue-modes en meerdere jingles kunnen in een groep achter elkaar worden 
gestart. Net als bij Live Players Xtra kunt u met deze module ook bij de jingles cuepunten 
instellen. 
 

Item browser & File browser 
Item browser biedt de mogelijkheid om een geheel eigen mapstructuur aan te leggen en 
te ordenen in een boomstructuur, zodat presentatoren/DJ’s hun items in hun eigen map 
bij elkaar kunnen plaatsen. U kunt de categorie mappen onderverdelen in algemene 
mappen, mappen per ingelogde gebruiker of per gebruikersgroep. Item browser is ook 
een ideaal hulpmiddel voor radiostations die met een redactie werken waar bijvoorbeeld 
nieuwsitems geproduceerd worden. Zie ook InOutBox.  
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Met deze module krijgt u er ook een File browser bij waarmee u door de audiomappen 
(Audio lokaal) kunt bladeren en waarmee u ook metadata, aanwezig in de ID3-tags, kunt 
updaten naar de database. Per gebruiker kan er ook een File browser-rootmap worden 
ingesteld c.q. toegewezen.  

Audio logger 
Met Audio logger kunnen 24/7 opnames van de uitzending gemaakt worden. De  
bewaartermijn, audiokwaliteit en bron zijn instelbaar. Indien gewenst kunt u de 
audiologgeropnames automatisch laten uploaden naar ftp. 
 

Time shifter 
Time shifter is een module waarmee een externe bron of stream in hoge kwaliteit wordt 
opgenomen om deze later weer opnieuw uit te zenden. Deze module wordt veelal 
gebruikt om live programma’s op te nemen om deze vervolgens later te kunnen herhalen. 
Indien gewenst kunt u de timeshifterropnames automatisch laten uploaden naar ftp. 
 

InOutBox Xtra 
InOutBox is een extern programma waarmee op handige manier bestanden kunnen 
worden verplaatst. Nieuwsitems kunnen automatisch worden gedownload en in de juiste 
map geplaatst worden. Bij nieuwsredacties kunnen nieuwsitems die klaar zijn voor 
uitzending, vanuit een centrale map op de redactie, automatisch verplaatst worden naar 
de opgegeven map in Item browser, waar ze direct zichtbaar komen voor de DJ. De Xtra 
variant biedt de mogelijkheid om meerdere configuraties aan te maken. 
 

Studio switch 
In combinatie met de geschikte hardware (RME geluidskaart) maakt deze module van 
uw PC een studio switch, waarbij op een standalone systeem in nonstop-mode het 
signaal geheel buiten de mengtafel om naar de zendlijn gerout wordt. Daarnaast kan 
met deze module een master/slave systeem met meerdere onair studio systemen 
worden gebouwd. 
 

SmartGPIO 
De SmartGPIO applicatie koppelt meerdere protocollen van hardware apparatuur met 
Aeron op basis van triggers. Hardware apparatuur kan een mengtafel of een controller 
zijn. Bvb een Pioneer DJ set of Elegato Stream Deck. De ondersteunde protocollen zijn: 
Ember+, Axia (LWRP), D&R Airlite, Tipro keyboards en Midi-in. Daarbij wordt ook de 
Shuttle Pro ondersteund. De SmartGPIO is een client server applicatie. Vanop meerdere 
computers kan de configuratie worden aangemaakt en gewijzigd. 
 
Voor meer informatie kunt u onze website raadplegen: 
https://www.broadcastpartners.nl/aeron/. 

1.5 Overzicht van sneltoetsen 

Op de voorlaatste pagina in deze handleiding vindt u een overzicht van de meest 
gebruikte sneltoetsen. 
 

1.6 Audio systeem 

AerOn ondersteunt professionele audiokaarten van vooraanstaande fabrikanten als 
RME, Telos (Livewire) en Dante. Alle gangbare audioformaten worden ondersteund, 
inclusief audio van videobestanden. Neem bij vragen contact op met Broadcast Partners. 

https://www.broadcastpartners.nl/aeron/
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Onderstaande tabel geeft een indicatie van hoeveel tracks u op een (PC of server) 
harddisk kwijt kunt in een aantal veel voorkomende opslagformaten. Er is uitgegaan van 
een gemiddelde duur van 3:30 per track. 
 

            Harddisk Ongecomprimeerd Gecomprimeerd 

 PCM Wave 128 kbps 256 kbps 384 kbps 
1 GB 29 320 160 107 

500 GB 14.493 159.783 79.892 53.261 
1 TB / 1000 GB 28.986 319.566 159.783 106.522 

1.7 Hardware ondersteuning 

AerOn kan verschillende soorten randapparatuur bedienen. Voor digitale mengtafels 
heeft u de keuze uit onder meer Axel Tech, Studer, Lawo, Axia, D&R, GatesAir en DHD. 
 
De Compact Interface Module is een low-cost GPIO oplossing voor het aansluiten van 
remote starts van de analoge mengtafel voor het bedienen van Live assist en Jingle 
players. Een uitgebreide beschrijving van de CIM staat achteraan in de handleiding. 

1.8 Extra mogelijkheden 

AerOn is een open systeem. Dit betekent dat u verschillende andere softwarepakketten 
kunt gebruiken in combinatie met AerOn. We bespreken hieronder een applicatie 
waarmee u AerOn op afstand kunt bedienen, alsook een tweetal oplossingen voor het 
veiligstellen van uw data. 

1.8.1 TeamViewer 

Er zijn diverse communicatiepakketten beschikbaar waarmee u allerlei zaken op afstand 
kunt regelen, zoals TeamViewer en Remote Desktop. Zo kunt u vanaf de PC die bij u 
thuis staat bijvoorbeeld Formatplanner bedienen of een audiotrack kopiëren. Om van 
deze TeamViewer permanent gebruik te kunnen maken dient het programma 
geïnstalleerd te worden op zowel de PC waarop AerOn staat als op de PC op afstand. 
De TeamViewer versie op de PC op afstand moet 
minimaal gelijk zijn en beide PC’s dienen uitgerust te zijn 
met een permanente internetverbinding (kabel of ADSL). 
 
De online supportafdeling van Broadcast Partners maakt 
gebruik van TeamViewer. In de afgelopen jaren is de 
populariteit van dit communicatiepakket sterk 
toegenomen, omdat het niet alleen betrouwbaar, maar 
ook eenvoudig in gebruik is gebleken.  
 
Een TeamViewer QuickSupport client wordt meegeleverd 
met AerOn en hoeft niet perse apart geïnstalleerd te 
worden. Bij online support door Broadcast Partners kunt u 
TeamViewer QuickSupport starten vanuit AerOn via de 
menu’s Help → TeamViewer.  
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Bij incidenteel gebruik van de TeamViewer software volstaat een gratis licentie. Maakt u 
echter geregeld gebruik van de software, dan dient u een licentie aan te schaffen. 

1.8.2 Backupvoorziening 

In het verleden is helaas meer dan eens gebleken, dat het ontbreken van een back-up 
bij het opnieuw opnemen van audio en invoeren van gegevens voor overuren heeft 
gezorgd. Aangezien ook de meeste AerOn-systemen werken met audiobestanden die 
opgeslagen zijn op de harddisk, is het maken van een back-up dan ook geen overbodige 
luxe.  
 
De grote hoeveelheden data (1 TB of meer) vragen om een degelijke back-
upvoorziening. Vandaag de dag is de meest voor de hand liggende oplossing het maken 
van een kopie naar een werkstation en naar een externe USB Harddisk. Een externe 
harddisk is ondertussen absoluut betaalbaar. 
 
Belangrijk om te weten is, dat systeembeheerders de reservekopie liefst maken terwijl 
de automatisering door loopt, maar dat de meeste backupsoftware de mogelijkheid om 
een reservekopie te maken van bestanden die in gebruik zijn, niet ondersteunt  
 
AerOn biedt echter zelf een voorziening om een kopie van deze databank te maken. 
Meer informatie over de back-upfunctie in AerOn vindt u in hoofdstuk 20: Databank 
Backup. 

1.8.3 RAID 1 

RAID staat voor Redundant Array of Inexpensive Disks en is een verzamelnaam voor de 
implementatie van harddisks in systemen om de beschikbaarheid of prestaties deze 
systemen op te voeren. RAID is er in verschillende ‘levels’ met elk hun eigen toepassing. 
De één is gericht op prestaties, de ander op beschikbaarheid. Dat laatste is van belang 
als het om AerOn gaat. 
 
RAID 1 maakt gebruik van ‘mirroring’ ofwel spiegel harddisks. Hierbij wordt een identiek 
aantal schijven in duplo gebruikt. In de praktijk betekent dit dat, wanneer er een crash 
optreedt van een harddisk, de data nog beschikbaar blijft op de spiegeldrive.  
 
De extra kosten van een dergelijk systeem bestaan uit het aanschaffen van een extra 
harddisk met dezelfde capaciteit en een zogenaamde RAID-controller. De beide 
harddisks worden op de RAID-controller aangesloten die ervoor zorgt dat de data op 
beide schijven synchroon blijft.  
 
De meeste AerOn-gebruikers kiezen tegenwoordig voor deze oplossing. De uitvoering 
is dan als volgt: Broadcast Partners installeert 2 zogenaamde ‘hot-swappable racks’ en 
3 identieke harddisks in bijpassende schuiven. Harddisk 1 blijft altijd in het systeem 
aanwezig. Harddisk 2 en 3 worden geregeld gewisseld. De ene is een exacte kopie, de 
andere vertegenwoordigt de situatie op het laatste moment dat deze in de PC aanwezig 
was.  
 
Op deze manier heeft u bij uitval van één harddisk altijd een exacte kopie. Bij uitval, 
brand of andere tegenslagen heeft u een backup van de data. Voorwaarde is natuurlijk 
dat u de backup elders bewaart en niet in de studio. 
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1.9 Aan de slag met AerOn  

Hieronder vindt u een globaal overzicht van de te nemen stappen om met AerOn aan de 
slag te gaan. 
 
Installatie  (Hoofdstuk configuratie en installatie AerOn) 
- PostgreSQL database server en de AerOn studio software. 
- Configureer de databaseverbinding bij de allereerste start van AerOn.  
 
Configureer de noodzakelijke instellingen  (Hoofdstuk instellingen) 
- Audiomappen instellen: Globaal → Audio lokaal.  

 
Sleep mappen vanuit Windows Verkenner naar Audio lokaal. 
Sub-mappen hoeven niet ingevuld, die worden door AerOn automatisch ingelezen. 
 

- Uw selectie-criteria invullen: Globaal → Criteria.  
- Afspeelkanalen instellen:  Lokaal → Audio → Output routering.  . 
 
Audiobestanden-metadata toevoegen aan databank  (Hoofdstuk databank import) 
- Sleep multi-select audiobestanden naar het bureaublad van AerOn.  

 
U kunt slepen vanuit een hoofdmap of submap of slepen vanuit het Windows 
verkenner zoek resultaat.  
 

Het Slepen audiobestanden-venster opent zich automatisch zodra AerOn de 
metadata van alle gesleepte audiobestanden aan de database heeft toegevoegd. 

 
Multiselect criteria invullen  (Hoofdstuk multi criteria editor)  

- Multi-select de in de vorige stap toegevoegde tracks. Klik rechts in het Slepen 
audiobestanden-venster en selecteer in het popup-menu Multi criteria editor. 

- Ken uw criteria toe aan de geselecteerde tracks. U kunt de Multi criteria editor ook 
gebruiken via selectie in Databank browser of Item brower. 

 
Formatplanner planning  (Hoofdstuk formatplanner) 
- Uurformat samenstellen. 
- Dagformat samenstellen. 
- Playlist plannen. 
 
Raadpleeg de diverse hoofdstukken voor gedetailleerde informatie. 

1.10 Playout output reference level 

Het Playout output reference level + de per track/voicetrack gain-offset is het output level 
waarop AerOn de audio afspeelt. 
 

Het Playout output reference level is instelbaar via Instellingen → Globaal → 
Algemeen → Extra → Playout output reference 
Deze globale instelling wordt toegepast bij iedere AerOn client die zich met dezelfde 
RadioID aanmeldt op de database. 
 
Het Playout output reference level is instelbaar op RMS -12 dB t/m -24 dB en Peak -9 
dB t/m Peak 0 dB.  
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De standaard instelling is RMS -18 dB. Dit is in AerOn het basis referentie level. Bij RMS 
-18 dB is de Peak referentie 0 dBFS. Ingesteld op RMS klinken de levels per track voor 
het menselijk gehoor beter op elkaar afgestemd. Bij een Playout output reference level 
ingesteld op Peak is de referentie altijd 0 dBFS. 
 
Voor een Orban Soundprocessor is Peak -9 dB de aanbevolen level instellling. 
 
Naast deze globale level instelling is er een per track-gain-correctie beschikbaar. De per 
track-gain-correctie is een offset t.o.v. het Playout output reference level. De track-gain 
kan per track vast ingesteld in Databank editor. Standaard instelling van de track-gain is 
0 dB (Geen versterking). 
 
 In Mix editor kan per track/voicetrack de gain-offset aangepast worden. In uw 
persoonlijke instellingen kunt u aanvinken of de gain-offset automatisch wordt toegepast 
bij voicetracks. Met deze gain-offset kunnen voicetracks afgespeeld tot Peak 0 dB.  
 
Het Playout output reference level + de track/voicetrack gain-offset bij elkaar opgeteld 
zal nooit harder worden afgespeeld dan Peak 0 dBFS. U kunt dus altijd onbezorgd de 
gain-offset maximaal instellen. De gain-offset kan ingesteld op -15 dB t/m +15 dB. 
 
Als u het Playout output reference level instelt op bijvoorbeeld RMS -22 dB, dan is er +4 
dB extra headroom om een per track/voicetrack gain-offset toe te passen. 
 
Bij voicetracks is het van belang dat de RMS Loudness voldoende hoog is. Ideaal is een 
RMS van -12 tot -14 dB. Dit is nodig om voicetracks zonder al te veel ducking luid genoeg 
over de outro en intro van een track heen te laten spelen. Daarom is het van belang dat 
er na de MIC altijd voiceprocessing wordt toegepast. Een alternatief is gebruik maken 
van een VST2 plugin. Die kan worden ingeladen middels de VST voicetrack plugin host. 
 
Enkele voorbeelden 
 
1) Stel een track/voicetrack heeft een RMS waarde van -18 dB en een van Peak 0 dB 

en een gain-offset van 0 dB. Bij een output reference van RMS -18 dB wordt de track 
0 dB zachter afgespeeld. De Peak wordt dan effectief afgespeeld op 0 dBFS. 

 
2) Stel een track/voicetrack heeft een RMS waarde van -14 dB en een van Peak 0 dB 

en een gain-offset van 0 dB. Bij een output reference van RMS -18 dB wordt de track 
-4 dB zachter afgespeeld. De Peak wordt dan effectief afgespeeld op -4 dBFS. 

 
3) Stel een track/voicetrack heeft een RMS waarde van -18 dB en een van Peak -2 dB 

en een gain-offset van 0 dB. Bij een output reference van RMS -22 dB wordt de track 
-4 dB zachter afgespeeld. De Peak wordt dan effectief afgespeeld op -6 dBFS. 

 
4) Stel een track/voicetrack heeft een RMS waarde van -18 dB en Peak -1 dB en een 

gain-offset van +7 dB. Bij een output reference van RMS -22 dB wordt de track -4 dB 
zachter afgespeeld. Met de gain-offset daarbij opgeteld wordt de track weer luider 
en wordt de Peak effectief afgespeeld op 0 dBFS. 



2025-05 Handleiding AerOn 

10 Broadcast Partners 

2 Audioformaten en mappen 

In dit hoofdstuk wordt uitgelegd welke audioformaten door AerOn ondersteund worden, 
waar u de audio mappen moet instellen en hoe AerOn de mappen doorzoekt. 
 
Een centrale rol in AerOn speelt de AudioID. Dit is de naam van het audiobestand, zoals 
ze ook op de harde schijf te vinden is, zonder map en zonder extensie (bijvoorbeeld 
‘XA2014’ of ‘Alicia Keys - No one’).  
 
AerOn scant tijdens het opstarten alle audiomappen inclusief submappen en zet het 
volledige pad inclusief de gehele bestandsnaam in cache. Hiervoor is gekozen om zo 
flexibel mogelijk te zijn. Hierdoor maakt het niet uit waar en in welke onderliggende 
submap een audiobestand staat. AerOn zal altijd het bestand vinden. 
 
Het audioformaat (flac, wav of mp3) is t.o.v. de AudioID van ondergeschikt belang, net 
als de locatie (schijf X: of Y:). 
 
De Bass audio engine in AerOn ondersteunt de meest gangbare audioformaten en is 
door het plugin-systeem in staat om nog extra audioformaten af te spelen als gebruikers 
daar behoefte aan hebben. 
 
Audioformaten 
We zien dat er verschuivingen plaatsvinden in het gebruik van audioformaten. Met het 
toenemen van de schijfcapaciteiten is opslag in PCM WAV of een lossless 
gecomprimeerd audioformaat steeds gangbaarder, FLAC (Free Lossless Audio Codec). 
 
AerOn ondersteunt standaard de volgende extensies.  

 
(Dit is te vinden via menu Bestand → Openen → Audio): 
 
De audioformaten staan hierbij gerangschikt op basis van prioriteit. De extensie .wav 
krijgt -met andere woorden- de hoogste prioriteit; daarna volgen .mp2, .mp3, enzovoorts. 
In de praktijk betekent dit, dat een bestand ‘XA2014.mp3’ eerder zal worden afgespeeld 
dan bijvoorbeeld ‘XA2014.ogg’, omdat het audioformaat .mp3 een hogere prioriteit heeft 
dan het audioformaat .ogg. 
 
Audio mappen en bestanden zoeken 
Nu uitgelegd is hoe AerOn met de audioformaten en extensies omgaat, kijken we naar 
de mappen waarin de bestanden staan. De mappen waarin AerOn de audiobestanden 

moet zoeken en kan vinden, die moeten ingevuld in Instellingen → Globaal → Audio 

lokaal en dat ziet er bijvoorbeeld als volgt uit, zoals weergegeven in onderstaande 
afbeelding: 
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Bij het inladen, cue-en of afspelen van ‘XA2012’ zoekt AerOn naar een bestand met de 
naam ‘XA2012.wav’ tot en met ‘extensie XA2012.mp4’ en doet dit als eerste in de  map 
‘D:\Audio\MP2\Mpeg1’. Als het bestand in deze map niet gevonden wordt, dan gaat de 
zoekactie verder in de submappen van ‘D:\Audio\MP2\Mpeg1’. Als ook daar het 
gewenste bestand niet gevonden wordt dan gaat de zoekactie op dezelfde wijze verder 
in ‘D:\Audio\MP2\Mpeg2’ en uiteindelijk tot in de zesde map ‘D:\Audio\MP2\Mpeg6’. 
 
Aangezien AerOn audiobestanden ook zoekt in submappen, kan bovenstaande  
configuratie net zo goed vereenvoudigd worden tot ‘D:\Audio\MP2’. Hiermee wordt 
hetzelfde bereikt, maar op een meer eenvoudige wijze. 

 
 
Bij de configuratie met enkel ‘D:\Audio\MP2’ is de volgorde van zoeken in de diverse 
submappen geheel afhankelijk van Windows. 
 

• Wat gebeurt er nu als ‘XA2012.mp2’ vervangen wordt door ‘XA2012.wav’? 
AerOn constateert dat het oude bestand niet meer bestaat en gaat op zoek, vindt 
dan het nieuwe bestand. Probleem opgelost. 
 

• Wat gebeurt er nu als ‘XA2012.mp3’ verplaatst wordt naar een andere map? 
AerOn constateert dat  het oude bestand niet meer bestaat en gaat op zoek, vindt 
dan het nieuwe bestand. Probleem opgelost. 
 

• Wat gebeurt er als ‘nieuws.mp3’ voortaan wordt opgeslagen als ‘nieuws.wav’ en 
de gebruiker vergeet het oude bestand te verwijderen? 
AerOn vindt nog steeds het oude bestand en zal dit afspelen.  
Met de kopieën zoekfunctie in Beheer is het vinden en verwijderen van kopieën  
heel eenvoudig. Probleem opgelost. 

 
Indeling audiomappen 
Waar het vroeger handig was om de audiobestanden te plaatsen in een beperkt aantal 
mappen, heeft u nu de mogelijkheid om de mappen in te delen naar een structuur die 
beter past bij het radiostation. Zo kunt u denken aan een aparte map voor elke 
presentator of DJ, programma of de muziektracks per jaar verdeeld in submappen.  
 
AerOn heeft geen statische link naar een bestand. U bent dus geheel vrij om submappen 
te hernoemen of bestanden te verplaatsen naar een andere sub- of hoofdmap.  
 

TIP!: Na een dergelijke verplaats-actie is het wel aan te bevelen om de tracks opnieuw 

te scannen via menu Databank → Aanwezig scannen. Alle audiobestanden worden 
dan opnieuw opgezocht waarmee AerOn de locatie van ieder bestand weer in cache 
heeft. Dit verhoogt ook de algehele snelheid van het systeem. Zie ook hoofdstuk 
scanrechten voor meer info. 
 
Vanuit Windows Verkenner of File browser kunt u audiobestanden slepen in AerOn om 
de bestanden op die manier aan de databank toe te voegen of ze in playlist of jingle 
players te plaatsen zonder ze aan de databank toe te voegen. Vanuit Windows kunt u 
bestanden slepen vanuit een map of vanuit een zoekresultaat. 
 

TIP! Om audiobestanden-metadata tijdens het slepen uit Windows verkenner of File 
browser  aan de databank te kunnen toevoegen moet de ‘Toevoegen databank-optie’ 
zijn aangevinkt. Om deze optie te mogen aanvinken moet u voldoende rechten hebben. 

Zie ‘Toevoegen databank’  
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(Onderin op de statusbalk)  
 
Kopieën 

In AerOn vinden we via de menu’s Tools → Beheer → Kopieën de oplossing voor het 
vinden van de kopieën met meteen de suggestie voor het verwijderen van de kopie. 
 
Met duizenden en vaak tienduizenden audiobestanden, talloze mappen, en 
verschillende bestandsextensies, kan het gebeuren dat er een kopie van een 
audiobestand wordt gemaakt met dezelfde extensie of een andere extensie in dezelfde 
map of andere map.  
 
Kortom: met kopieën van audiobestanden wordt het onduidelijk welke door AerOn 
afgespeeld zal worden en juist daarom kunt u kopieën beter voorkomen. 
 
Bijvoorbeeld: 

 
 
Bestanden in een submap hebben een lagere prioriteit: 

 
 
Het gebeurt ook wel eens dat er bij het werken met nieuws- en info-items kopieën 
ontstaan en dat er daardoor een verkeerde oude versie gespeeld wordt. De tool Beheer 
is ook dan de eerste plaats om op zoek te gaan naar mogelijke kopieën.  
 
In deze tool heeft u ook de mogelijkheid om de voorafluistering te gebruiken en te 
luisteren welke versie het betreft voordat één van de bestanden verwijderd wordt. Ook 
de datum en tijd van laatste wijziging kunnen hierbij een handig hulpmiddel zijn.  
 
Het verwijderen van veel kopieën zorgt ook voor performance winst omdat er dan niet 
onnodig meer bestanden aanwezig zijn en doorzocht hoeven. Ook voorkomt u hiermee 
dat bijvoorbeeld voicetrackers thuis een ander bestand inladen dan de versie die in de 
studio gespeeld wordt. Zie hoofdstuk Beheer voor meer info. 
Zoektijd audiobestanden 
 
Tijdens het zoeken naar audiobestanden, bijvoorbeeld tijdens het opstarten, vult AerOn 
een in-memory bestandscache met het volledige pad naar ieder audiobestand. 
Als een module een audiobestand nodig heeft, dan wordt als eerste de bestandscache 
aangeroepen om de locatie te weten.  
 
Staat de locatie van een audiobestand niet in de bestandscache dan start AerOn een 
zoekactie. Dit kan bijvoorbeeld het geval zijn wanneer er nieuwe audiobestanden in een 
map zijn gezet, of als audiobestanden verplaatst zijn die door die AerOn cliënt waarop jij 
werkt nog niet zijn gescand.   
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Via menu Databank → Aanwezig scannen kan een gebruiker op een lokaal systeem 
in de studio een zoekactie forceren zodat de locatie van alle op dat moment aanwezige 
audiobestanden in de audio-lokaal-mappen in de bestandscache wordt gezet. Daarna 
als alle audio mappen zijn gescand, werkt de AerOn cliënt de database bij en zet de 
“Aanwezig” flag bij alle records met een gevonden audiobestand.  In een aantal situaties 
wordt de in-memory bestandscache automatisch bijgewerkt c.q. aangevuld. 
 
Hoeveel tijd er nodig is om alle audiobestanden in alle audiomappen te 

zoeken wordt weergegeven in Instellingen → Globaal → Audio 

lokaal.  Hoe snel dit zoeken gaat is daar dus terug te zien.  
 
Tijdens de zoekactie naar audiobestanden controleert AerOn of het een 
audio bestand is en vult de in-memory bestandscache. De totale tijd die 
daarvoor nodig is wordt weergeven bij zoektijd. Een normale waarde is 10.000 
bestanden per seconde als de bestanden op een lokale SSD staan. Waarden die hoger 
liggen dan meerdere seconden per 10.000, kunnen duiden op een traag netwerk of een 
trage NAS. In dit geval wordt geadviseerd het netwerk te controleren. 
 
Door audiobestanden op een locatie te zetten die door Windows geindexeerd kan 
worden, kunt u performance issues voorkomen. Een Windows server OS presteert 
bijvoorbeeld beter dan een Windows 10 OS als het gaat om het delen van bestanden. 
En een SSD presteert bijvoorbeeld beter dan een ouderwetse HDD. 
 
Het zoeken van audiobestanden in submappen is een fractie trager dan enkel het zoeken 
in gespecificeerde hoofdmappen zonder submappen. Als er heel veel submappen zijn, 
bijvoorbeeld zoals met iTunes waarbij er soms maar 1 bestand per submap aanwezig is, 
zal het zoeken langer duren. Het zoeken naar bestanden is ook trager als dit over een 
netwerk moet gebeuren i.p.v. op een lokale SSD. 
 
In AerOn kunt u tot 99 hoofdmappen opgeven. AerOn doorzoekt de hoofdmappen van 
boven naar beneden, in de volgorde zoals ze zijn ingevuld in de instellingen. 
 
Hoe sneller bestanden gevonden kunnen worden, des te hoger dat de reactiviteit van 
het systeem zal zijn. Het is daarom niet aanbevolen om bestanden op een trager medium 
zoals een standaard NAS te plaatsen.  
 
We bevelen aan om een standaard NAS enkel aan als backup-medium te gebruiken.  
 
AerOn heeft drie oplossingen om het zoeken te versnellen. 
 
1) Als een bestand wordt gezocht zal AerOn de locatie in cache zetten en onthouden. 

 
2) Kort na de start van AerOn vindt er een grote zoekactie plaats waarbij alle 

audiobestanden ineens opgezocht worden. Dit verhoogt de snelheid van het 
systeem, omdat de locatie van alle aanwezige audiobestanden in één keer in cache 
wordt ingelezen.  

 
3) Via de functie Aanwezig scannen in het menu Databank worden alle audiomappen   

overlopen en wordt de bestandencache bijgewerkt. Zie ook hoofdstuk aanwezig 
scannen 

 

Tip! AerOn heeft een playlist controle functie waarmee u kunt controleren of alle 
audiobestanden aanwezig zijn. Die kunt u via het playlist-menu uitvoeren om er zeker 
van te zijn dat alle audio aanwezig is voordat de playlist onair gespeeld gaat worden. 
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Goflvorm bestanden 
Behalve de audiobestanden zult u in de mappen ook bpk-bestanden (.bpk) tegenkomen. 
Bpk-bestanden worden door AerOn gemaakt en bevatten naast de golfvorm (de 
grafische weergave van de track in bijvoorbeeld Databank editor) ook aanvullende 
informatie.  
 
Verwijdert u bpk-bestanden, dan maakt AerOn ze opnieuw aan zodra ze weer nodig zijn. 
AerOn maakt dan een nieuw bpk-bestand bij het openen in bijvoorbeeld de Databank 
editor of Mix-editor. Ook InOutBox maakt automatisch golfvormen aan bij bestanden die 
u telkens vernieuwt, zoals nieuws en verkeer.  Zie hoofdstuk InOutBox. 
 
Golfvormen scannen 

In Beheer is een functie aanwezig om alle golfvormen ineens te scannen en aan te 
maken waar nodig. Zie Beheer → Golfvorm. Dit verhoogt de browse snelheid omdat dan 
niet telkens een golfvorm berekend hoeft bij het inladen van nieuw toegevoegde tracks.  
 
Bij iedere nieuwe track die in de databank aanwezig is wordt tijdens een scan ook 
meteen de fade-in start ingesteld volgens het Startlevel. De volgende-tijd (start next) 

wordt ingesteld volgens het Endlevel. Zie Instellingen → Globaal → Algemeen → 
Databank editor. 
 
Remote audio mappen over VPN als lokale audio mappen gebruiken 
 
Een aantal gebruikers synchroniseert wel voicetracks naar de studio nadat ze thuis hun 
voicetracks hebben opgenomen, maar ze synchroniseren geen audiobestanden.  
 
In dat geval gebruikt men de remote audiomappen over VPN als lokale audio door deze 
bij audio lokaal in te stellen als lokale audiomappen.   
 
Dit werkt uiteraard trager dan bestanden inladen die op de lokale SSD-schijf staan, 
omdat audiobestanden dan altijd over Internet/VPN worden ingeladen. Het argument 
van deze gebruikers is dat er geen audiobestanden gesynchroniseerd hoeven. Met een 
snelle internet verbinding kan dit prima werken. 
 
Om met deze werkwijze het opstartproces van AerOn te versnellen, moeten de audio 
lokaal mappen en de audio remote mappen identiek en in exact dezelfde volgorde 
worden ingesteld.  
 
Als audio lokaal en audio remote indentiek zijn ingesteld zal AerOn tijdens het opstarten 
de in-memory bestandscache vullen met de opgeslagen filepath in het lokale database 
bestand AudioName.nx1 zodat een scan over VPN niet noodzakelijk is om de filepath 
van ieder audiobestand te weten.  
 
Dit principe remote audio als lokaal audio werkt i.c.m. met een Remote voicetrack licentie 
en i.c.m. een Productie licentie. 
 
Als AerOn eenmaal is opgestart wordt er ook automatisch een remote audio scan gestart 
zodat het AudioName.nx1 database bestand steeds wordt bijgewerkt met de actuele 
filepath van alle aanwezige remote audiobestanden. 
 
Dit bestand AudioName.nx1 wordt opgeslagen in een map “Remote” in de AerOn 
datamap. Bij de eerstvolgende start van AerOn zal die daardoor snel alle locaties van 
bestanden vinden en inladen en sneller opstarten dan met een remote audio scan over 
VPN. 
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Tip! Als u in het menu toegang de remotemappen opnieuw activeert dan wordt het 
zoeken naar alle remote bestanden in gang gezet. Zo kunt u thuis de in-memory 
bestandscache tussentijds vernieuwen als er in de studio nieuwe tracks zijn toegevoegd.  
Als de bestandscache is bijgewerkt zal AerOn de remote bestanden sneller lokaliseren. 
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3 Databank editor 

Databank Editor kunt u openen via het menu Databank → Editor,  het bijhorende icoon 
op de knoppenbalk. Of via de menu’s van o.a. Playlist en Databank browser. Of ALT+F11 

 
Databank editor kan beschouwd worden als de basis van de radio-automatisering. 
Kortgezegd noemen we deze ook wel Editor.  
 
In de Editor kunt u onder andere uw tracks benoemen, categoriseren op basis van 
selectiecriteria en songteksten toevoegen. Zo kunt u er ondermeer de titel van de track 
aanpassen, een artiest of auteur bewerker of de uitgever benoemen, maar ook 
selectiecriteria ingeven waarop uw formatplanning gebaseerd wordt. 
 
Databank editor ziet er anders uit afhankelijk van de situatie. Opent u Databank editor 
op het moment dat Databank browser actief is of als een playlist de focus heeft, dan gaat 
de Editor naar de track die op dat moment is geselecteerd als PFL-volgen actief is.  
 
Als u een bestand opent via menu Bestand → Open → Audio, dan ziet u onderstaand 
dialoogvenster. 
 

 
 
Als u in het Audio bestand openen-venster een audiobestand aanklikt, ziet u onderaan 
de bestandsindeling van het audiobestand, de titel en de uitvoerende artiest, mits dit 
audiobestand reeds in de databank aanwezig is.  

Met de button ‘Play’ kunt u het audiobestand direct beluisteren, zonder het eerst te 

hoeven openen in Databank editor. De optie ‘Play end’ laat de laatste seconden van 

een bestand horen en ‘Auto play’ speelt de bestanden automatisch af tijdens het 

bladeren zodat u niet steeds op ‘Play’ hoeft te drukken. 
 

Zodra u een bestand selecteert en ‘Openen’ aanklikt, verschijnt Databank editor in 
beeld. 
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De titelbalk van Databank Editor toont de modus, u ziet de tekst  [Browse] of [Edit] en 

de titel en artiest van het huidige audiobestand. In de modus [Browse] bladert u door de 
databank en worden er geen gegevens gewijzigd.  
 
Gebruikers met de benodigde toegangsrechten kunnen omschakelen naar de modus 

[Edit]. Dit is de modus waarin de track en criteria gegevens gewijzigd kunnen worden. 

Het omschakelen naar de [Edit] modus gebeurt automatisch zodra u begint te typen of 
als u bijvoorbeeld criteria selecteert.  
 

Tip! In de gebruikersrechten kan een beheerder instellen welke gegevens een gebruiker 
mag wijzigen. 
 
De balkjes met subtitels, zoals de teksten Algemeen, Buma en Publiceren, veranderen 

van kleur en worden dan ROOD gekleurd. Voordat u kunt verder bladeren naar de 
volgende track moet u eerst de wijzingen opslaan met de knop op de werkbalk of met de 

sneltoets CTRL+S.  
 
Rechts onderaan in Databank editor treft u de knoppen aan waarmee u door de databank 
heen kunt bladeren. Indien de meest linkse knop ‘Automatisch opslaan’ actief is, zoals 
weergegeven in de onderstaande afbeelding, worden gedane wijzigingen tijdens het 
bladeren automatisch opgeslagen. 

  
Databank editor bladert standaard gesorteerd op artiest van A tot Z door de databank. 

Onderin het Databank Editor-venster vindt u een knop genaamd PFL volgen waarmee 
u de bladervolgorde van Databank editor koppelt aan de PFL player op de werkbalk. 

 
Door PFL volgen aan te vinken koppelt u Databank editor met Databank browser, 
Playlist of Export. Zodra u in een venster een andere track selecteert waarvan het 
audiobestand aanwezig is, dan volgen andere vensters automatisch mee.  
 
Slepen uit Windows verkenner of File browser 
Een andere methode voor het openen en laden van audiobestanden is, door de 
bestanden vanuit Windows Verkenner of File browser in Databank editor te slepen.  
Vanuit Windows kunt u bestanden slepen vanuit een map of vanuit een zoekresultaat. 
 
Als u meerdere bestanden in één keer in AerOn sleept dan worden die automatisch 

geimporteerd en opent zich een venster Slepen audiobestanden.  Vanuit dit venster 

Slepen audiobestanden-venster kunt u de tracks één voor één openen in Databank 
editort. Fade-in start en het startpunt volgende track, de Volgende-tijd, worden 
automatisch gezet volgens de Databank editor-instellingen en ook de golfvorm wordt 
dan berekend en ingeladen.  
 

Tip! Via Beheer → Golfvorm kunt u golfvormen in batch scannen. 
 

Tip! Om audiobestanden tijdens het slepen uit Windows verkenner of File browser aan 
de databank te kunnen toevoegen moet de Toevoegen databank-optie op de statusbalk 
zijn aangevinkt. 

 
(Onderin op de statusbalk) 
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Slepen audiobestanden-venster 
 

Vanuit het Slepen audiobestanden-venster kunt u ook meteen de criteria invullen of 

herzien middels de Multi criteria editor. Sneltoets CTRL+M 
 

Via Beheer → Golfvormen kunt u van alle audiobestanden ineens alle golfvormen laten  
berekenen. Als een golfvorm-scan wordt uitgevoerd na het toevoegen van nieuwe tracks 
kan dat de reactiviteit van het systeem bevorderen doordat dan niet telkens een golfvorm 
moet worden berekent tijdens het bladeren en inladen van tracks. 
 
AerOn herkent en gebruikt de ID3 tags van o.a. .mp3 en .flac bestanden om aanwezige 
metadata in te laden tijdens het toevoegen aan de databank. Dit houdt in dat bij het 
importern de titel, artiest, jaartal, album, bpm, key, commentaar (track info) en afbeelding 
in nieuwe .mp3 en .flac bestanden automatisch door AerOn toegevoegd en ingevuld 
worden. 
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3.1 Track 

 
Tabblad Track 
 

Titel Titel van de track 

Artiest Uitvoerende artiest. Bij het intypen vult AerOn de tekst aan.  

Tip! Zie “Tools → Beheer → Artiest” om eventuele foutieve 
notaties van artiesten ineens op te ruimen. 
 

Auteur Auteur van deze track.  
 

Jaar Hier vult u het jaartal in van uitbrengen van een plaat. 

Bestandsnaam De bestandsnaam (zonder extensie) van het audiobestand of 
videobestand. 
 
U kunt hier het audiobestand of videobestand hernoemen door een 
andere naam in te typen. Of door een ander audiobestand of 
videobestand uit de audiomappen te selecteren. Via de werkbalk 
kunt u het vervolgens opslaan. 
 

Tip! De extensie is niet bepalend voor AerOn om het bestand te 
kunnen vinden. AerOn ondersteunt standaard de volgende 
formaten: .wav, .mp2, .mp3, .s48, .mpg, .mpeg, .snd, .flac, .fla, 
.oga, .ogg, .wma, .aac, .m4a, .m4b en .mp4.  
 
Door het toevoegen van extra BASS audio library .dll files kunnen 
extra extensies en formaten worden ondersteund.  
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Buma rapportage 
De Buma in Nederland en Sabam in Vlaanderen stellen voor de rapportage van 

gespeelde muziek bepaalde eisen, hiervoor moeten de velden onder het kopje Buma 
zorgvuldig ingevuld worden. De vooraf ingevulde Buma gegevens worden bij het onair 
afspelen per track in de Historie playoutlog gezet.  Via de Buma rapportage kunnen  de 
gegevens uit de Historie playoutlog worden gerapporteerd. Buma gegevens komen niet 
met terugwerkende kracht in de historie playoutlog. U dient de Buma gegevens 
voorafgaand aan onair play in te vullen. 
 

ID Bij muziekwerken de barcode zoals vermeld op de geluidsdrager. 
In het geval van commercials is dit het door Buma/Stemra/Sabam 
toegekende commercialnummer. 

Versie Welke versie is ten gehore gebracht? Invullen indien van een 
muziekwerk diverse versies zijn, bijvoorbeeld Remix, Unplugged, 
Live. 

Deel Met name van toepassing bij klassieke werken, bijvoorbeeld 
Adagio, Allegro, Ouverture. 

ISRC code De International Standard Recording Code die aan de opname is 
toegekend. De ISRC code dient te worden weergegeven als een 
code van 12 cijfers/letters zonder streepjes tussen de verschillende 
onderdelen. 

Bewerker Naam van de arrangeur of bewerker. Te herkennen op de label-
informatie door één van de volgende vermeldingen: 
Arranged by … / J. Jansen (arr.) / Trad-arr. J. Jansen 

Dirigent Naam van de dirigent zoals aangegeven op de geluidsdrager. 
Achternaam, voornaam. 

Orkest Naam van het orkest zoals aangegeven op de geluidsdrager. 
Voorloop lidwoorden (the, de, …) weglaten. 

Categorie Mogelijke waarden: 
Geen (geen Buma code, te gebruiken voor items die niet in één van 
de categorieën valt en zodoende niet opgenomen moet worden in 
een Buma rapportage) 

 

Tip! Zie “Tools → Beheer → Kopieën” om eventuele kopieen in 
andere audiomappen op te sporen. 
 

Videonaam 
(vMix) 

Dit veld wordt gebruikt voor de vMix Visual Radio-integratie. 
 
Als u in AerOn niet de video bestanden afspeelt dan kunt u 
in dit veld kunt de bestandsnaam van een videobestand invullen. 
 
Met dit veld kunt u een videobestand koppelen aan de audio track 
die in AerOn gebruikt wordt. AerOn gebruikt dit veld voor het 
doorsturen van de videonaam naar het vMix Visual Radio systeem. 
AerOn speelt het audiobestand af terwijl het vMix Visual Radio 
systeem dan de gekoppelde video afspeelt. 
 

Tip! Omdat AerOn dit veld niet gebruikt om zelf dit bestand af te 
spelen, kunt u de videonaam ook invullen door een videobestand 
te selecteren uit een map die niet tot de zoekmappen van AerOn 
behoort. 
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Muziek 
Tune (jingle / pingel / stationcall /bridge) 
Library (stockmuziek) 
Conference (literair werk) 
Kadens (improvisatie in klassiek werk, meestal door de solist) 
Reclame (commercial) 
 

Publiceren 
Playlists kunt u exporteren naar ondermeer HTML, XML en Tekst, bijvoorbeeld voor 
publicatie op internet en voor publicatie naar Radix RDS (Broadcast Partners RDS 
software) voor weergave op de autoradio.  
 

Bij ‘Publiceren’ geeft u bij ‘Wat’ op hoe dat moet gebeuren. 
 
U heeft de keuze uit:  
Niet 
Titel - Artiest 
Titel 
Artiest - Titel 
Artiest 
Aangepast 
 

Kiest u bij ‘Wat’ voor ‘Niet’, dan vindt er geen publicatie van dit item plaats.  
 
Naast de voorgedefinieerde vormen kunt u ook kiezen voor een aangepaste informatie, 
reklame of promo-tekst, de tekst kunt u naar eigen wens invullen in het invoerveld 

‘Aangepast’. 
 

Bij ‘Voorbeeld’ wordt weergegeven hoe en welke tekst er gepubliceerd gaat worden. 
 

Bij ‘Website’ kunt u een link naar een website invullen, bijvoorbeeld een link naar een 

store, webshop of youtube. Deze informatie kunt u publiceren met de tag <#Website>. 
 

Tip! Voor het publiceren van deze voorgedefineerde vormen en ook voor de aangepaste 
tekst moet de tag <#Publication> opgenomen worden in het HTML, XML of Tekst 
bronsjabloon. Zie het betreffende hoofdstuk voor meer info over exporteren van de 
playlist naar HTML, XML of Tekst. 
 
De tags voor titel <#Title> en artiest <#Artist> die halen de gegevens uit de invoervelden 
voor titel en artiest. 
 

Track informatie 
Onder het kopje ‘Track informatie’ heeft u ruimte om een afbeelding in te laden en 
willekeurige informatie van een track in te vullen. Dit veld kan bijvoorbeeld gebruikt 
worden bij live-uitzendingen om wetenswaardigheden van een track te benoemen. 
Wetenswaardigheden over de uitvoerende artiest of de drager (elpee, CD) kunt u op het 
tabblad ‘Artiest’ invullen. 
 

Artiesten invullen 
Voor de velden Artiest en Titel is het van belang dat ze consistent worden ingevuld. 
 

Tip! Formatplanner kan aan de hand van de Artiest planregels ervoor zorgen, dat tracks 

van dezelfde artiest niet (kort) na elkaar gedraaid worden. Bij de controle op Titel wordt 
voorkomen dat een cover (alternatieve versie) te kort na het origineel komt of 
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omgekeerd. Dus voor een juiste selectie en scheiding van artiesten is het voor 
Formatplanner van belang de artiest en titel consistent in te vullen. 
 
Enkele adviezen bij het invoeren van deze velden: 

• Laat lidwoorden weg, bijvoorbeeld ‘The Rolling Stones’ wordt ‘Rolling Stones’, ‘The 
Supremes’ wordt ‘Supremes’. 

• Hanteer steeds dezelfde wijze voor het invullen van voornaam en achternaam, dus 
niet ‘Phil Collins’, ‘P. Collins’ en ‘Collins, Phil’ door elkaar. Maar gebruik bijvoorbeeld 
enkel en altijd de notatie ‘Phil Collins’. 

• Gebruik alternatieve schrijfwijzen niet door elkaar, bijvoorbeeld ‘&’ en ‘and’ in ‘Hall 
and Oates’ en ‘Hall & Oates’. 

• Laat zo veel mogelijk punten weg, bijvoorbeeld ‘C.J. Lewis’ wordt ‘CJ Lewis’ en 
‘R.E.M.’ wordt ‘REM’. 

• Laat (o.a. Franse en Duitse ) accenten weg. 

• Voer deze velden bij voorkeur niet in hoofdletters in. Teksten in hoofdletters zijn voor 
de meeste gebruikers moeilijker en drukker om te lezen, bovendien nemen ze meer 
ruimte in op het scherm. Vergelijk bijvoorbeeld: 

Everybody gets a second chance 

EVERYBODY GETS A SECOND 
CHANCE 

 
 

Artiesten opruimen en controleren 
Bij het herzien en verbeteren van de artiestnamen kan het zijn dat de foutieve notaties 
niet meer zijn gekoppeld aan een track in de database. Dergerlijke artiesten kunt u het 

best verwijderen m.b.v. de module Beheer. Zo kunt u vermijden dat deze foutieve 
artiestnamen steeds opnieuw in de selectie komen en steeds kunnen worden ingevuld . 
 

Ook zijn er in Beheer een artiest controle en corrigeer functies aanwezig waarmee 
fouten in artiesten hersteld kunnen worden. 
 

3.2 Artiest 

In dit tablad kunt u informatie over een artiest invoeren. Bijv. een website, een foto, 
informatie en social media accounts. Het is ook mogelijk om artiesten uit te sluiten.  
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Tabblad Artiest 
 

Uurgetal Het uurgetal hier geeft aan na hoeveel uur een artiest opnieuw 
gepland mag worden. Een artiest met uurgetal 0 kan elk moment 
terug komen.  

Tip! Het uurgetal van de artiest kan tijdens het plannen zoals wij 
dat noemen gebroken worden door het trackuurgetal uit het tabblad 
Criteria1. Dit gebeurt als het trackuurgetal kleiner/lager is dan het 
artiestuurgetal, wat bijvoorbeeld bij ‘Hits’ vaak het geval is. Het 
artiestuurgetal is ook een breakable/unbreakable planregel vanaf 

Formatplanner Xtra. 

Website Hier vult u de URL van de website voor de artiest in. Met het kleine 
knopje ernaast wordt internet geopend met de ingevulde URL van 
de website. 

Twitter Hier heeft u de mogelijkheid de twitter gebruikersnaam van een 
artiest/band in te vullen. Deze kunt u als volgt invullen:  

https://twitter.com/Nsync  

Wanneer u op het Twitter icoontje klikt komt u op de Twitterpagina 
van de ingevulde gebruikersnaam terrecht.  

Instagram Hier heeft u de mogelijkheid de instragram gebruikersnaam van 
een artiest/band in te vullen. Deze kunt als volgt invullen:  

https://www.instagram.com/Nsync 

Wanneer u op het instragram icoontje klikt komt u op de instagram 
pagina van de ingevulde gebruikersnaam terrecht.  
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Uitsluiting 
toevoegen 

Om te voorkomen dat tracks van dezelfde artiest (kort) achter 
elkaar gedraaid worden, kijkt Formatplanner naar de naam van de 
artiest. Formatplanner sluit nummers van dezelfde artiest 
automatisch uit bij het plannen. Artiest uitsluiten is een plan rule.  

Met dit veld kunt u bijvoorbeeld bandleden met een solo carrière, 
duets en samenwerkende artiesten uitsluiten. Dit veld bevat alle 
artiesten die in de database aanwezig zijn en ondersteunt 
incrementeel zoeken. Als u de eerste letters van een artiestnaam 
typt wordt er automatisch gefilterd zodat de selectie wordt 
vereenvoudigd.  

Als u een artiest aanklikt wordt die toegevoegd aan uitgesloten. Bij 
het toevoegen van een uitsluiting worden artiesten ook automatisch 
omgekeerd uitgesloten. Bij het toevoegen van een nieuwe artiest, 
bijvoorbeeld tijdens het importeren van tracks, wordt die artiest 
automatisch uitgesloten bij andere artiesten als de nieuwe 
artiestnaam daar een match heeft. 

Uitsluiting 
weghalen 

Met dit veld kunt u een artiest uit de uitsluitlijst verwijderen. 
 
 

Sluit uit via tekst In dit veld kunt u een artiestnaam typen die u vervolgens kunt 
uitsluiten met een druk op de button Artiesten uitsluiten. Alle 
artiesten die deze tekst bevatten worden bij deze artiest 
toegevoegd aan uitgesloten. Artiesten worden tevens ook 
automatisch omgekeerd uitgesloten. 
 

Uitsluitgesloten In dit veld ziet u welke artiesten zijn uitgesloten.  
 
Dit veld werkt aan de hand van de gegevens uit de velden uitsluiten 
1 t/m 4 van andere artiesten. Als u bijvoorbeeld Paul McCartney 
uitsluit bij The Beatles, dan komt bij Paul McCartney automatisch 
The Beatles te staan.  Over en weer uitsluiten is niet nodig.  
 
Op deze wijze kunt u uitsluitingen 1 t/m 4 beter benutten en meer 
dan 4 uitsluitingen per artiest maken. 

 

Foto/plaatje In het veld linksonder heeft u de mogelijkheid een foto/plaatje van 
de artiest toe te voegen.  

Deze kunt u toevoegen door de foto of afbeelding in dit vak te 
slepen. Of door de rechtermuisknop te gebruiken in het vak en via 
het menu een afbeelding laden. Zo kunt u eenvoudig een 
afbeelding inladen.  

 

Artiestinformatie 
 
 

In het tekstveld langs het foto/plaatje heeft u de mogelijkheid om 
informatie over een artiest toe te voegen.  

 

Bijv. informatie over de geboortpleaats van de artiest, leeftijd, 
afkomst en hoelang deze al actief is. Deze kunt u toevoegen door 
te typen in dit vak, of door informatie te plakken in dit veld.  
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3.3 Criteria 1 

De velden op de tabbladen ‘Criteria 1’ vult u in als u gebruik maakt van  Formatplanner.  
 

 
Tabblad Criteria 1 
 

Texture (Formatplanner Xpert). De texture geeft aan hoe de track is 

geproduceerd. Deze kan variëren van ‘Schraal’ (Leonard Cohen) 

tot ‘Bombastisch’ (Two tribes – Frankie goes to Hollywood).  

Mood (Formatplanner Xpert). De mood geeft de stemming van de track 

aan en varieert van ‘Neerslachtig’ (Please don’t make me cry – 
UB40) tot ‘Euforisch’ (The final countdown – Europe).   

Intro Tempo van het intro van de track. Dit tempo wordt gebruikt in de 
tempo matrix. 

Tempo Tempo van de track in zijn geheel. Dit tempo wordt gebruikt in de 
Formatplanner uurformats. 

Uitro Tempo van het uitro van de track. Dit tempo wordt gebruikt in de 
tempo matrix. 
 

Tip! Het tempo van intro en uitro gebruikt Formatplanner om 
bijvoorbeeld te voorkomen dat na een track die ‘fast’ eindigt een 
‘slow’ track volgt. De toelaatbare outro/intro mix is instelbaar in de 
matrix in de Formatplanner-instellingen. 

Beschikbaar Normaliter zijn tracks beschikbaar voor Formatplanner en de 
gebruiker. Bij tracks en ook commercials, die niet door  
Formatplanner gepland mogen worden, kunt u ‘Planner’ uitvinken.  

Op die manier kunt u tracks uitsluiten die altijd niet passen bij het 
format van uw radiostation en dus niet automatisch gepland mogen 
worden. 

Als ‘Gebruiker’ is aangevinkt, dan is de track voor alle gebruikers 
beschikbaar in Databank browser.  De track kan dan in Databank 
browser opgezocht en o.a. in de playlist gesleept worden. 
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Taal Standaard zijn er in AerOn een aantal talen vooraf ingevuld, dit is 
uitbreidbaar tot 25 talen.  
 

Samenstelling (Formatplanner Xpert). De samenstelling van de artiest geeft u 
op om te voorkomen dat de planner bijvoorbeeld 3 tracks van een 
meidengroep achter elkaar zet.  De scheiding kunt u instellen in de 

scheidingsmatrix in Formatplanner Xpert 

Uurgetal 
 
(Trackuurgetal) 

Het trackuurgetal geeft aan na hoeveel uur een track opnieuw in 
aanmerking komt en weer gepland mag worden.  
 

Tip! Formatplanner controleert bij iedere track en planmoment of 
die track gisteren of eergisteren in hetzelfde uur al staat om te 
voorkomen dat die track ook vandaag in hetzelfde uur wordt 
geplaatst. Formatplanner plaatst tracks met een marge van 
minimaal 1 uur zodat die track daags na elkaar niet in hetzelfde uur 
komt.  
 
Het advies is om een veelvoud van 24 als uurgetal te vermijden. 
Voor een track met uurgetal 24 geldt namelijk dat u toestaat dat de 
track iedere dag op exact hetzelfde tijdstip mag terugkomen. 
 
Aanbevolen is ook om binnen eenzelfde categorie uurgetallen +1 
of -1 te differencieren zodat er een soort van verloop binnen een 
categorie ontstaat. Bij een beperkte hoeveelheid tracks van een 
bepaalde categorie heeft u meer kans dat dezelfde track direct na 
het vertrijken van het ingestelde uurgetal terugkomt. Een track met 
uurgetal 0 kan ieder moment en meerdere keren per uurformat 
opnieuw gepland worden.  
 
Als een track niet automatisch door Formatplanner gepland mag 
worden kunt u ‘Planner’ beter uitvinken. Een goed voorbeeld zijn 
commercials. 
 
Ook bij tracks die telkens niet worden gespeeld kunt u ‘Planner’ 
beter uitvinken. Zeker als dezelfde tracks telkens door de DJ uit de 
playlist worden verwijderd of overgeslagen. Niet gespeelde tracks 
komen namelijk meteen terug in aanmerking om gepland te worden 
en ze krijgen een steeds hogere prioriteit naarmate de tijd verstrijkt. 
 

Week definitie In een matrix van weekdagen en uren geeft u aan op welke uren 
van iedere weekdag een track gepland mag worden.  

Door linksboven vlak boven maandag te klikken selecteert u de 
hele weekmatrix in zijn geheel. Klik op de dag om alles voor die dag 
te selecteren. Met de spatiebalk kunt u geselecteerde uren aan of 
uit zetten.  

In de uren met donkergrijze blokjes mag een track gepland worden, 
en in de uren met lege vakjes mag het item niet gepland worden.  

Tip! Formatplanner Basis houdt enkel rekening met de ingestelde 

tijden op maandag voor de hele week. Vanaf Formatplanner Xtra 
kan de matrix per dag gevarieerd worden gepland. In combinatie 

met Formatplanner Xpert houdt ook Commercialplanner rekening 
met de weekdefinitie. 

Jaar definitie De jaardefinitie bepaalt de begin- en einddatum voor een track. 
 



Handleiding AerOn Databank editor 

 we make radio happen 27 

Deze stelt u in voor typische zomer- of winterplaten, kerst en 
carnaval. Kerstplaten kunt u heel precies een startdatum na 
Sinterklaas geven.  
 
Bij tracks die enkel in de maanden december en januari gepland 
mogen worden zet u de begindatum op 1 december en de 
einddatum op 31 januari. 

 
Texture en Mood 
Voor ‘Texture’, ‘Mood’ en ook de drie ‘Tempo’-velden geldt dat u het gehele aanbod 
muziek dat u speelt verdeelt over alle beschikbare mogelijkheden. U bent dan in staat 
om optimaal gebruik te maken van Formatplanner. Dat betekent concreet dat de 
droevigste tracks uit de collectie het criterium ‘neerslachtig’ krijgen en de allervrolijkste 
‘euforisch’.  
 
Sommige radiostations proberen een middenkoers te varen door bij tempo slechts te 
variëren van ‘slow’ naar ‘uptempo’ en Texture en Mood niet meteen in te vullen. Kiest u 
later een ‘slow’ track in een format, dan zullen daar veel tracks aan voldoen, namelijk 
(gemiddeld) 33% in plaats van 20% wanneer u alle 5 mogelijkheden had gebruikt.  
 
U kunt dus beter deze velden altijd invullen, ook al heeft u Formatplanner Basis. Het 
achteraf invullen of corrigeren van een verkeerd of onvolledig ingevoerde databank is 
een tijdrovende bezigheid. Bereid u daarom goed voor en benut van begin af aan alle 
invulopties. Als u later upgrade naar een hogere Formatplanner dan heeft u daar enkel 
profijt van.  

3.4 Criteria 2 

Vijf maal 25 te definiëren criteria staan voor elke track ter beschikking. De naamgeving 

van kolommen en criteria zijn vrij instelbaar. Standaard zijn de criteriakolommen ‘Soort’, 
‘Extra’ en ‘Doelgroep’ ingesteld. De criteriakolommen ‘Extra 4’ en ‘Extra 5’ kunnen 
naar eigen inzicht ingevuld en gebruikt worden.  
 

De twee laatstgenoemde criteriakolommen worden gebruikt vanaf Formatplanner Xtra. 
 
Het is belangrijk om deze kolommen en de benaming van de criteria goed in te vullen 
aan de hand van het bedachte format voor de doelgroep die uw radiostation voor ogen 
heeft. Voordat u feitelijk tracks aan de databank gaat toevoegen kunt u het beste eerst 

uw criteria invullen.. Zie Instellingen → Globaal → Criteria 
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Tabblad Criteria 2 
 
Bij elk van deze vijf criteriakolommen kunt u meer dan één optie aankruisen. Een track 
aangeven als ‘Hit’ en ‘Oldie’ is niet zinvol maar veel tracks zullen geschikt zijn voor meer 
dan één van de invulopties. De criteriumkolom doelgroep is, net als bij de overige 
criteriakolommen, uit te breiden tot 25 mogelijkheden. Ook de kolomnamen zijn 
instelbaar. 
 

Criteria van meerdere tracks tegelijkertijd wijzigen of verplaatsen 
Het wijzigen of verplaatsen van criteria van meerdere tracks tegelijkertijd kunt u uitvoeren 
in Multi criteria editor.  
 
Dit doet u door de gewenste tracks te selecteren in bijvoorbeeld Databank browser of 

Item browser en vervolgens in de submenus of via het menu Databank → Multi editor 
te kiezen of via de sneltoets CTRL+M. De criteria informatie van alle geselecteerde 
tracks wordt dan gecombineerd ingeladen in Multi criteria editor. Groene vinkjes 
bijvoorbeeld, gelden voor alle tracks. Meer informatie over  Multi criteria editor vindt u in 
hoofdstuk 4. 

3.5 Songtekst 

 

Op internet zijn veel songteksten beschikbaar. Met de knop ‘Zoeken’ wordt er 
automatisch op internet (Google) gezocht naar de songtekst van de geladen track. U 
kunt de gevonden tekst in het veld plakken. 
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Tabblad Songtekst 
 

3.6 Statistieken 

Op het tabblad ‘Statistieken’ vindt u onder andere de plan- en speelstatistieken van de 
track. 
 

 
Tabblad Statistieken 
 

Toegevoegd 
aan databank 

Datum en tijdstip waarop het item is toegevoegd aan de databank. 

 

Laatste 
wijziging 
bestand 

Bij ‘Laatste wijziging bestand’ is terug te zien wanneer het 
audiobestand het laatst is gewijzigd.  
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Dit is vooral handig voor items die worden gedownload, zoals 
bijvoorbeeld ANP (NL) of Belga (B) nieuwsbulletins. Bij het 
bladeren in Databank editor wordt automatisch gecontroleerd of er 
een nieuw audiobestand is afgeleverd. Daarmee is het voor u als 
gebruiker duidelijk wanneer het laatste audiobestand is afgeleverd. 

Zie ook het hoofdstuk InOutBox. 

Tip! Als alternatief kunt u %d in de titel opnemen. In het Live assist-
venster vervangt AerOn dit door de bestandsdatum en  -tijd. Zo 
heeft u een extra controle over de actualiteit van bijvoorbeeld het 
nieuws. 

Remote locatie Indicatie of het bestand lokaal of remote aanwezig is.  

Dit is met name van toepassing als u remote vanuit thuis of vanuit 
elders op de wereld werkt. 

Laatste 
speeldatum 

Datum en tijdstip waarop deze track het laatst onair is gespeeld. 

 

Komende 
speeldata 

Bij ‘Komende speeldata’ wordt informatie weergeven over 
tijdstippen waarop deze track in de toekomst gepland is en 
gespeeld gaat worden. M.a.w. in welke reeds geplande 
datumplaylists deze track staat. Deze informatie wordt gewist als u 
in beheer playlists verwijdert. 

 

Laatste 
plandata  

Onder het kopje ‘Laatste plandata’ vindt u informatie over de 
tijdstippen waarop deze track ooit is gepland door Formatplanner. 
De plandata in de toekomst kunnen voorafgaand aan een planning 
na bevestiging wel of niet gewist worden als u een playlist of 
meerdere playlists overnieuw plant.  

 

Historie track Hiermee kunt u in de historie bekijken waneer deze track onair 
gespeeld is geweest. 

Historie artiest Hiermee kunt u in de historie bekijken wanneer tracks van deze 
artiest onair gespeeld zijn geweest. 

3.7 Editor 

Op het laatste tabblad vindt u de geïntegreerde audio editor. Deze integratie staat u o.a. 
toe nieuwe items op te nemen en op hetzelfde moment de databankgegevens in te 
voeren.  
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Tabblad Editor 
 
De VU-meters en input selector kunt u openen met een klik op de groene pijl. Het bereik 
van de VU-meters kunt u instellen door er met de rechter muisknop op te klikken.  
 
U kunt het bereik stapsgewijs instellen van -24 naar -90 dB. De indicator rechts van de 

VU-meter-uitslag toont de peak-waarde. De CLIP-level-indicator licht op als de 
opname te hard is, d.w.z harder dan 0 dB, om vervorming te voorkomen moet u zachter 
dan 0 dB opnemen zodat deze indicatoren niet meer oplichten. Door te dubbelklikken 

zet u de level indicator terug naar -inf. 
 

Tip! Editor speelt af op de ‘Playout output reference’. AerOn past per track automatisch 
een gain-correctie toe zodat alle tracks op het ingestelde playout output referentie level 

worden afgespeeld. Zie Instellingen → Globaal → Algemeen → Extra → Playout 
output reference. 
 
      

Legenda inzoomen/uitzoomen 
 

 
Zoom alles. 

Toont hele item 

 
Zoom in. 

 
Zoom uit. 

 
Zoom begin. 

Een druk op deze knop laat u de eerste seconden van de track zien.  

 
Zoom einde. 

Een druk op deze knop laat u de laatste seconden van de track 
zien. 

 
‘Auto Cue’.  
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Zet de ‘Fade-in start’ op het -50 dB niveau aan het begin van de 

track.  Indien Shift ingedrukt: Zet ‘Volgende’ op het -20 dB niveau 
aan het einde van de track. Deze standaard niveaus zijn instelbaar 

in Instellingen → Globaal → Algemeen → Databank editor. 

 
‘Cursor lock’.  
Als deze functie actief is blijft de cursor (die de huidige positie 
weergeeft) in beeld tijdens het afspelen. 

 
De gele lijn in de editor is de fadecurve. De fadecurve wordt geheel van begin tot eind 
gerespecteerd bij het afspelen tijdens nonstop en bij het afspelen van een groep in Live 
assist. De fadecurve en de verschillende tijden zijn in het geel weergegeven. M.b.v. een 
zevental punten kunt u de gele lijn verslepen en zodoende de fadetijden aanpassen. De 

cursor verandert dan van vorm (  bij de punten en  bij de lijnstukken).  
 

Tip! Bij het afspelen van een doorstartgroep in Live-assist wordt de mix tussen iedere 
track en fadecurves gerespecteerd en het geheel wordt afgespeeld volgens de 
standaard mixtijden in de muziekdatabase of volgens met Mix editor aangepaste 
mixtijden. Bij het afspelen van één enkel item in Live-assist wordt de fadecurve bypassed 
en bepaalt de DJ altijd en geheel zelf het faden van de track met de fader op de 
mengtafel. 
 
Fadecurve 
 

 
 

 Fade-in start Dit is het punt waarop de track wordt gestart. Het startpunt kan na 
een stil intro liggen. Het wijzigen van dit punt verandert ook de 

fade-in duur. 

 Fade-in Deze lijn verplaatst de fade-in naar voren of achteren zonder de 

fade-in duur of de fade-out aan te passen. 

 Fade-in einde Dit is het punt waarop de fader geheel geopend is. Het wijzigen van 
dit punt verandert ook de fade-in duur.  

Voor tracks die niet mogen infaden moet dit punt geheel naar links 

worden geplaatst zodat deze samenvalt met de fade-in start. 
(Vertikale lijn) 

 Hele track U verplaatst deze lijn naar boven of naar beneden om de track 
tussen punt 3 en 5 harder of zachter te laten afspelen t.o.v. het 
Playout output reference level. U kunt hiermee bijvoorbeeld een 
bedje maken waarover u kunt presenteren. 

 Fade-out start Dit is het punt waarop de track begint met uitfaden. Het wijzigen 
van dit punt verandert ook de fade-out duur. Voor tracks met een 
staand einde verplaatst u dit punt naar rechts zodat deze samenvalt 

met het fade-out einde. Sneltoets F 

 Fade-out Deze lijn verplaatst de fade-out naar voren of achteren zonder de 

fade-out duur of fade-in aan te passen. 
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Fade-out   
einde 

Dit is het punt waarop de track stopt met afspelen. Dit punt kan voor 
het einde van de track liggen.  

 
 

 ‘Play’. Sneltoets P Met deze knop speelt u het item af vanaf de 

positie van de stippellijn, de cursor, in het grafische editor veld. U 
kunt deze positie ook heel precies invullen middels het muiswiel of 
toetsenbord. Als u dubbelklikt op de golfvorm zal de editor vanaf 
dat punt afspelen.  
 

 ‘Stop’. Sneltoets S Met deze knop stopt u het afspelen of 

opnemen.  

 ‘Record’. Sneltoets R Met deze knop kunt u audio van een 

geluidskaart opnemen. Voorafgaand aan een opname is het 
raadzaam eerst de instellingen na te kijken. Deze staan verderop 
beschreven.  

 
‘Einde afluisteren’. U krijgt de laatste seconden van de track te 
horen. De lengte hiervan kunt u naar eigen voorkeur opgeven in 

Instellingen → Gebruiker → Persoonlijk. Sneltoets 
CTRL+ALT+P 

 
Startpositie van het afspelen. 

 ‘Loop’. Sneltoets L  Hiermee is het mogelijk cuepunten, intro en 

uitro exact te bepalen.  

Negeer fade Door deze functie Negeer fade aan te vinken kunt u het einde van 
de track beluisteren zonder fade-out. 

 
 

 Deze gain is een offset t.o.v. het algemene playout output 
referentie level. 
 
Het afspeelvolume per track wordt door AerOn 
automatisch bepaald aan de hand van de algemene 
Playout output-reference level instelling. Per track wordt 
automatisch een gain-correctie toegepast zodat iedere 
track afspeelt op de Playout output-reference. Zie 

Instellingen → Globaal → Algemeen → Extra → 
Playout output reference 
 
Met de gele lijn die door de golfvorm loopt kunt u snel de 
gain offset aanpassen. U kunt een track bijvoorbeeld als 
ondergrond zachter laten afspelen.  
Als de gele lijn omhoog of omlaag wordt gesleept dan ziet 
u de golfvorm ook groter of kleiner worden. De golfvormen 
worden automatisch geschaald naar het Playout output 
reference-level + de toegepaste gain offset.  
 
Het effectief toegepaste Playout output level zal nooit 
harder zijn dan peak 0 dB. Een track zal nooit harder 
afspelen dan peak 0 dB. 
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 In dit veld kunt u de BPM informatie van de betreffende 
track invullen. De BPM informatie wordt bij het importeren 
automatisch ingelezen vanuit een ID3tag als die daarin 
staat ingevuld.   
 
Tip! De BPM informatie kunt u met File browser uit de ID3 
tag laden. 
 

 In dit veld kunt u de initial-Key (Harmonic Key) informatie 
van de betreffende track invullen. De initial-Key informatie 
wordt bij het importeren automatisch ingelezen vanuit een 
ID3tag als die daarin staat ingevuld.  
 
Tip! De Key informatie kunt u met File browser uit de ID3 
tag laden. 
 

 De Mix mode wordt gebruikt door de functie AutoMix in de 
playlist (via het menu) en het Formatplanner-uurformat.  
 
Met Mix mode kun je aangeven of een track/jingle geschikt 
is voor gebruik van AutoMix. Wanneer je ‘Default & 
Automix’ selecteert kan de track/jingle in alle gevallen 
gebruikt worden. D.w.z. dat een jingle zowel standaard of 
als jingle onder een intro gepland kan worden waar 
Automix is aangevinkt in het uurformat. 
 
Mix mode "Automix" betekent dat een jingle enkel gepland 
kan waar Automix in het uurformat is aangevinkt. 

  
Automix kan ook toegepast via het playlistmenu. 

 
Onderaan in het tabblad ‘Editor’ vindt u een reeks velden en knoppen om een speciefiek 
cue of fade punt te zetten. De play knoppen en invoervelden hebben bij elk onderdeel 
dezelfde functie. 
 

 
Afspelen vanaf de ingestelde positie, bij het passeren van 
een instelpunt licht deze knop op. 

 
Tijdens het afspelen klikt u op de bij het cue punt behorende 
knop om een cue punt in te stellen. In dit voorbeeld drukt u 
tijdens het afspelen van het item de knop ‘Volgende’ in. 
  

De editor kent sneltoetsen voor het instellen van Volgende 

(start next) sneltoets N, Fade-out start sneltoets F, Intro 

sneltoets I en Uitro sneltoets O. 

De cuepunten worden met deze sneltoetsen op de positie 
van de cursor ingevuld. 

 

Tip! Een uitzondering bij volgende is, dat de tijd die u hier 
instelt niet lager mag zijn dan 0:00:00.06 (60 milliseconden).  

Deze tijd mag niet lager zijn omwille van de juiste volgorde 
in de playlist te behouden. Aanbevolen wordt om deze 
minimaal in te stellen op 210 milliseconden wegens marges 
en schuiven in Mix editor. 
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Bij het verschuiven van tracks in Mix editor die vlak na zeer 
korte stilte-items staan, daarbij moet u opletten dat u de 
startpositie van de muziektrack niet onbedoeld voor het zeer 
korte stilte-item uitschuift.  
 
Neem hier als bijvoorbeeld een stilte-item dat later wordt 
vervangen door verkeersinformatie. Als het stilte-item onder 
een muziek track is of wordt geschoven zal vanzelfsprekend 
de verkeersinformatie de starttijd van het stilte-stilte-item 
krijgen en daardoor ongewenst onder de track schuiven.  
 
Ook bij “Update tijden van muziekdatabank” in de playlist 

Sneltoets CTRL+T. moet u dan rekening houden dat items 
nog in de gewenste volgorde staan na het toepassen. 
 
 

 
Met de rode markerknop kunt u de rode lijn Volgende 
onzichtbaar maken. 

De overige markerknoppen ook daarvan komt de kleur 
overeen met lijnkleur van de marker in het editor venster.  

 

 
Ieder invulveld kunt u eventueel heel nauwkeurig instellen 
m.b.v. het muiswiel en toetsenbord. Klik in het veld en 
verdraai het muiswiel. Of klik in het veld en typ de cijfers. 

Fade-in start Het punt waarop de fade-in begint. 
 

Fade-in duur De lengte van de fade-in. U kunt de fade-in korter of langer 
maken naar eigen voorkeur. Probeer uw instellingen uit door 
op de play-knop te klikken voordat u de wijzigingen opslaat. 
Een vertikale lijn betekent:  Niet infaden maar meteen voluit 
afspelen vanaf Fade-in start. 

Fade-out start Het punt waarop de fade-out begint. Sneltoets F 

Fade-out duur Dit is de lengte van de fade-out. Een vertikale lijn betekent: 
Niet uitfaden en meteen stoppen. 

Intro Dit is het tijdstip in het begin van de track waarop de intro 
van de track eindigt. Dit is normaal gezien het punt waarop 
de zang begint. Intro wordt weergegeven met een witte 

vertikale lijn. Sneltoets I 

Uitro Dit is het tijdstip aan het einde van de track waarop de outro 
van de track begint. Dit is normaal gezien het punt waarop 
de zang eindigt. Outro wordt weergegeven met een witte 

vertikale lijn. Sneltoets O 

Cue 1 t/m Cue 3 Met Cue 1, 2 en 3 kunt u in totaal drie punten in de track 
instellen voor het afspelen vanaf een bepaald punt in Live-
assist Xtra. Elk van deze drie cuepunten kunt u geheel 
willekeurig instellen. (lijnkleuren: lichtblauw, vaalblauw, 
groen) 
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Refrein De refrein optie kunt u activeren 
door het vinkje Refrein aan te 
zetten. De refrein optie kent 
dezelfde timing mogelijkheden 
als een normale track. Hiermee 
kun je een refrein in een plaat 
defineren. Het is mogelijk om 
fade-in start/eind, fade-out 
start/eind en een volgende 
positie toe te voegen. 

Dit refrein kunt u gebruiken in Jingle players. 

Volgende 
 
(Start next) 

Dit is het tijdstip waarop u vindt dat de volgende track in de 
playlist mag gaan spelen.  

Lijnkleur = rood. Sneltoets N   

 

Lengte Dit is de totale lengte van de track. (Bestandsduur) 

 
 

 
Naast de indicatoren voor bitrate, frequentie en compressie vindt 

u de knop om naar de Opname-instellingen te gaan. 
 

Opname 
instellingen 
 
Input  

Selecteer hier de input waarmee de audio wordt opgenomen. U 
kunt een input ook selecteren via een rechtsklik op de VU-
meters. 

 

Tip! Zie ook de opname instelllingen in Instellingen → Globaal 
→ Algemeen → Databank editor. 
 

Frequentie (kHz) De samplingfrequentie is 48 of 44.1 kHz. In de professionele 
radiowereld is een samplingfrequentie van 48 kHz de standaard. 
CD spelers en het populaire mp3 maken (meestal) gebruik van 
44.1 kHz.  

Bitrate (kbps) De bitrate is enkel van toepassing bij mp2 en mp3. 
In het algemeen geldt: hoe hoger de bitrate, hoe beter de 
kwaliteit. Opname in stereo is mogelijk met de volgende bitrates: 

64, 96, 128, 160, 192, 256, 320 en 384 kbit, bij mono zijn de 
bitrates 64 t/m 160 kbit toegestaan. 
 

Bestandsindeling 
(MP2…) 

De mogelijkheden zijn: 

PCM: Dit is ongecomprimeerde audio. De benodigde 
opslagcapaciteit is ruim 10 MB per minuut stereo-audio. 
FLAC: Dit is ongecomprimeerde audio. De opslagcapaciteit is 
ongeveer 2/3 van PCM. 

MP2: Dit formaat wordt steeds minder vaak toegepast.  
MP3: populaire keuze en betere geluidskwaliteit in vergelijking 
met mp2 en adpcm bij gelijkblijvende bitrate. 
Adpcm: Van mindere kwaliteit en verouderd; niet aanbevolen. 
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Kanalen 
(Stereo…) 

Stereo: de opname gebeurt in stereo. 

Left: de opname gebeurt in mono, via het linkerkanaal. 

Right: de opname gebeurt in mono, via het rechterkanaal. 

3.8 Speciale functies 

Audio opnemen van een geluidskaart-input 
Als u een opname start, dan maakt AerOn automatisch een nieuw bestand met het 
bestandsformaat volgens de opname-instellingen. De standaard gehanteerde 
bestandsnaam-indeling wordt gekenmerkt met “ingelogde gebruiker” en “datum tijdstip” 
waarop de opname is gestart.  Bijvoorbeeld “Johan 20191029 145714.mp3” 

 
Als u op tabblad track een bestandnaam invult voordat u de opname start dan is de 
gehanteerde bestandsnaam-indeling “bestandsnaam datum tijdstip”. 
Bijvoorbeeld “Middagprogramma 20191029 145714.mp3” 
 
Als er geen standaard opname-map is ingesteld dan wordt bij het starten van de opname 
eerst een venster geopend waarin u een audiodoelmap kunt selecteren.  

Om een vaste opname-map in te stellen zie Instellingen → Globaal → Algemeen → 
Databank editor. 
 
Nadat uw opname gereed is en ook opgeslagen is, dan kunt u de track desgewenst een 
andere bestandsnaam geven en nogmaals opslaan. Op het tabblad track kunt u een 
andere bestandsnaam typen of selecteren. 

 
Tip! Als u in Windows verkenner een nieuwe submap heeft toegevoegd dan kunt u de 

audiomappen en bestanden opnieuw in cache inlezen via menu Databank → 
Aanwezig scannen.  AerOn ververst dan de bestandscache en zal nieuwe submappen 
en bestanden daaraan toevoegen. Vanuit Windows verkenner kunt u bestanden slepen 
vanuit een map of vanuit een zoekresultaat. 

 
Opslaan als 
Zodra u de bestandsnaam op de “Track” tab wijzigt en vervolgens opslaat, verschijnt het 
onderstaande venster waarin u precies kunt aangeven wat er moet gebeuren.  
 

 
 
U kunt op deze wijze een audiobestand eenvoudig hernoemen of middels de bladerknop 

  of een nieuw audiobestand koppelen aan het database record.  
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Tevens is het mogelijk om een bestand in een andere map op te slaan. In dat geval kiest 

u middels de bladerknop  een andere map en drukt u op opslaan. AerOn toont dan 
onderstaande venster. 
 

 
 

Verwijderen 
Als u een AudioID uit de muziekdatabank wil verwijderen, dient u deze verwijdering te 
bevestigen met de knop ‘OK’ in het onderstaande venster. 
 

 
 
Indien u besluit om databankgegevens of het audiobestand niet meteen te verwijderen, 

kunt u dit later doen met de functie Beheer via het menu Tools → Beheer. 
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4 Multi criteria editor 

In de eerder beschreven Databank editor wijzigt u de gegevens van één enkele track. In 
een aantal gevallen kan het wenselijk zijn om de criteria van meerdere tracks tegelijk en 
identiek in te stellen. Of bij meerdere tracks eenzelfde afbeelding toe te kennen. 
 
U kunt het Multi criteria editor-venster openen na het selecteren van één of meer tracks 
in de volgende vensters: Playlist, Databank browser, Item browser en Slepen 
audiobestanden.  Het Slepen audiobestanden-venster opent zich automatisch als u 
meerdere audiobestanden vanuit Windows Verkenner of File browser in AerOn sleept. 
Vanuit Windows Verkenner kunt u bestanden slepen vanuit een map of vanuit een 
zoekresultaat. 
 

Multi criteria editor  kan geopend via menu Databank → Multi criteria editor of via het 

submenu in de diverse vensters of via de sneltoets CTRL+M. 
 

 
Tabblad Track 
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Tabblad Criteria 1 
 
Op de tabbladen Track, Criteria 1 en Criteria 2 vinkt u aan welke gegevens en welke 
criteria u wilt aanpassen. Het aantal geselecteerde tracks waarop de wijzigingen worden 
toegepast is linksonder in het Multi criteria editor-venster te zien.  
 
Wanneer u OK klikt worden de op alle tabbladen aangepaste gegevens bij alle 
geselecteerde tracks ineens opgeslagen in de databank. 
 
Gebruikers met het recht “Databank editor Wijzigen criteria” hebben toegang tot Multi 
criteria editor.  Zie hoofdstuk Gebruikers voor nadere informatie over toegangsrechten. 
 

Tip! Als u de audiobestanden op schijf heeft gecategoriseerd in submapjes, dan kunt u 
die op handige wijze multiselect voorzien van criteria. Ga met Windows verkenner of File 
browser in een submapje en sleep de audiobestanden in AerOn.  
Zodra het Slepen audiobestanden-venster is geopend, selecteer dan alle of een select 
aantal items en klik vervolgens rechts op de selectie om Multi criteria editor te openen. 
Vul de criteria in, druk OK om op te slaan en sluit Multi criteria editor. Herhaal waar nodig 
het slepen uit ieder submapje op schijf. Vanuit Windows Verkenner kunt u bestanden 
slepen vanuit een map of vanuit een zoekresultaat. 
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5 Databank browser 

Databank browser kunt u openen via het menu Databank → Browser, het bijhorende 
icoon op de knoppenbalk of de functietoets F11. 

 
Databank browser biedt een overzicht van alle tracks die op het systeem en in de 
databank beschikbaar zijn. Met Databank browser kunt u bladeren door de databank, 
eventueel aan de hand van verschillende criteria-filters die u selecteert. 
 
Standaard geeft Databank browser alle aanwezige c.q. beschikbare tracks weer. D.w.z. 
de tracks waarvan ook het audiobestand daadwerkelijk aanwezig is. 
 
De lettergrootte is instelbaar via menu Venster of via het muiswiel waarbij u tegelijkertijd 
de CTRL-toets ingedrukt houdt. Per kolom kan er gesorteerd worden en er kan 

stapsgewijs gezocht worden d.m.v. typen. Met CTRL+F kunt u de zoek-functie 
oproepen. 
 

 
 
In de overzichtsbalk bovenaan ziet u het aantal tracks dat beschikbaar is in het door u 
ingestelde filter.  
 

Reset Maakt het ingestelde filter ongedaan. 

Vernieuwen Met vernieuwen zorgt u ervoor dat u actuele gegevens in beeld 
krijgt. De metadata wordt opnieuw uit de databank in het geheugen 
gelezen. Deze optie gebruikt u als er wijzigingen in de 
muziekdatabank zijn aangebracht of als er nieuwe tracks 
geïmporteerd zijn. 
 

Tip!  Mocht een aantal tracks na vernieuwen plotseling 
‘Verdwenen’ zijn dan is het goed mogelijk dat er ergens een PC is 
die wel scan rechten heeft, maar geen toegang heeft tot alle 
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audiobestanden. In dat geval moet u via menu Databank → 
Aanwezig scannen uitvoeren en daarna Databank browser 
vernieuwen om alle tracks weer te zien.  Zie ook het hoofdstuk Scan 
rechten. 

 
De volgorde, of beter gezegd de sortering waarin de tracks getoond worden, kunt u 
veranderen en aanpassen door op de titel van de gewenste kolom te klikken. De titel van 
de kolom waarop is gesorteerd wordt met rode letters weergegeven.  
 

Tip! Bij dubbelklikken op een track wordt die track geopend in databank editor. 

5.1 Zoeken 

Databank browser is voorzien van diverse zoekfuncties. Als u bijvoorbeeld op artiest wilt 
zoeken sorteert u op de kolom ‘artiest’. Klik op de kolomheader. Vervolgens typt u de 
naam in die u zoekt en de Browser springt automatisch naar de beginletters van de 
gezochte artiest en markeert deze als die aanwezig is. Op dezelfde manier kunt u ook 
titels, AudioID en andere criteria per kolom stapsgewijs opzoeken in de databank. Met 
de ESC-toets kunt u de markering ongedaan maken. 
 

Met de sneltoets CTRL+F opent u een zoekvenster dat de ingetypte tekst in alle 
zichtbare kolommen zoekt. Na de laatste toetsaanslag start na 1 seconde de zoekactie. 

 
 
Een andere methode om snel te zoeken is door gebruik te maken van de rechter 
muisknop waarmee u het menu in beeld brengt. Via dat menu kunt u o.a. de diverse 
criteria filters maken. 
 
 
In Databank browser vindt u onder de rechter muisknop het onderstaand menu. 
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Overzicht van menu-functies 
 

Editor Het in Databank browser geselecteerde item wordt geopend in 

Databank editor.  Sneltoets ALT+F11 

De browsevolgorde in Databank editor kan gekoppeld aan de 
browsevolgorde van Databank browser. 

 

Multi criteria 
editor 

Wijzig de criteria van geselecteerde items m.b.v. Multi criteria 

editor.  Sneltoets CTRL+M 

Externe audio 
editor 

Opent het geselecteerde item in bijvoorbeeld Audacity of Audition. 

Snettoets CTRL+ALT+E 

Zie Instellingen → Lokaal → Algemeen → Externe audio editor 

Externe video 
player 

Opent het geselecteerde item in bijvoorbeeld VLC media player. 

Snettoets CTRL+ALT+M 

Zie Instellingen → Lokaal → Algemeen → Voice track vMix Visual 
Radio 

File browser Opent de File browser.  Sneltoets CTRL+B 

Historie Het geselecteerde item in Databank browser wordt geopend in de 
Historie. Hier krijgt u informatie over de plan- en speeldata van een 

nummer.  Sneltoets CTRL+ALT+H 

Vernieuwen De gegevens en metadata van de tracks worden opnieuw uit de 
databank in het geheugen gelezen. Deze optie gebruikt u als er 
wijzigingen in de muziekdatabank zijn aangebracht of als er nieuwe 
tracks geïmporteerd zijn. Idem aan de functie eerder vermeld. 

Sneltoets CTRL+N 
 

Beschikbaar .. De beschikbare tracks zijn degene waarvan de status in de 
database op aanwezig staat en een bijbehorend bestand op de 
harddisk hebben. De niet-beschikbare tracks zijn degene waarvan 



2025-05 Handleiding AerOn 

44 Broadcast Partners 

de status op niet aanwezig staat em het audiobestand niet 
aanwezig is.  Zie ook databank aanwezig scannen. 

Soort, Extra, 
Taal, 
Samenstelling 
… 

Hiermee filtert u de tracks zodat u enkel de items te zien krijgt die 
voldoen aan de criteria die u geselecteerd heeft. 

5.2 Exporteren 

AerOn biedt de mogelijkheid om metadata van tracks uit de database te exporteren naar 

een extern programma zoals Word of Excel, kies daarvoor menu Bestand → Document 
export en dan één van de beschikbare mogelijkheden Excel, HTML, Tekst, XML. Op 
deze manier kunt u bijvoorbeeld een playlist of de selectie in Databank browser 
exporteren naar bestand. 
 
Een andere mogelijkheid is om de inhoud van het Databank browser-venster via het 

Windows klembord te kopiëren (menu Bewerken → Kopiëren). Of via de sneltoetsen 

CTRL+C   CTRL+V  (Kopieren en plakken) 
 

5.3 Databank browser Xtra 

Databank browser Xtra is een aanvullende module voor Databank browser die nog meer 
opties heeft om het de gebruiker nog gemakkelijker te maken om ‘die ene gewenste 
track’ te vinden met uitgebreidere selectie- en zoekmogelijkheden.  
 

 
 
Extra kolommen 
De diverse kolommen kunt u zichtbaar zetten via het kolomheader-menu. Zo kunt u op 

het tabblad ‘Selectie’ ondermeer meerdere kolommen selecteren die u zo zichtbaar kunt 
maken met informatie waarin u vervolgens kunt zoeken, sorteren en filteren. 
 
Beschikbare kolommen 
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Bestand,   Titel,   Artiest,  Auteur,  Criteria Extra1,  Criteria Extra2,  Criteria Extra3,  
Criteria Extra4,   Criteria Extra5,   Taal,   Tempo,   Texture,   Mood,  Samenstelling,  
Laatst gepland,  Laatst gespeeld,  Uurgetal track,  Duur,  Laatst gewijzigd,  Jaar,  
Uurgetal artiest,   Album, BPM,  Key,   Gain,   Intro,   Mix mode,  Refrein en Import datum. 
 
Venster presets 
Daarnaast is er dan ook de mogelijkheid om per gebruiker venster presets te maken. 

Raadpleeg het hoofdstuk Venster voor meer informatie. 
 

 
 

Tabblad Selectie met beschikbare kolommen en criteria 

 
 

In het tabblad ‘Selectie’ wordt gekozen welke kolommen in beeld komen. Met het filteren 
van criteria kunt u een select aantal tracks zichtbaar maken in Databank browser Xtra. 
Zodra u hier een instelling en een criteriafilter heeft gemaakt en vervolgens op het 

tabblad ‘Track’ klikt, wordt de gekozen instelling geactiveerd. Tracks die voldoen aan de 
vinkjes worden getoond. 
 

Als u vervolgens terugkeert naar het tabblad ‘Selectie’, kunt u het filter aanpassen. U 
kunt in een kolom meerdere criteria aanvinken en zo een of-of selectie maken.  Boven 
elke criteriumkolom of groep vindt u een knop voor snelle de-selectie. Met een reset kunt 
u het gehele criteriafilter ongedaan maken. 

Velden Hier geeft u op welke velden uit de muziekdatabank u zichtbaar wilt 

maken in de kolommen op het tabblad ‘Track’. 

Beschikbaar De standaard is ‘Gebruiker’ en ‘Aanwezig’ aangevinkt en dat kan 
enkel gewijzigd worden door gebruikers die deze opties mogen 
aanvinken en wijzigen.  Of  u dit mag aanvinken is afhankelijk van 
uw gebruikersrechten. Zie daarom ook de gebruikersrechten. 
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 Deselecteer alles in de kolom. Als u geen enkel criteruim selecteert 
wordt er niet gefilterd op criteria. 
 

Reset Selectiefilter van criteria ongedaan maken.  
 

Vernieuwen Database opnieuw inladen. 
 
Om wijzigingen zichtbaar te maken die u in Databank editor heeft 
toegepast of om nieuw toegevoegde tracks zichtbaar te maken, moet 
de database opnieuw ingeladen middels Vernieuwen. 
 

Tip! Worden tracks niet zichtbaar, controleer dan Scan recht. De PC 
waarop u werkt moet bij Scan rechten de locatie Studio hebben. Zie 
Instellingen → Globaal → Scan rechten. 
 
Middels menu Databank → Aanwezig scannen en daarna Databank 
browser vernieuwen kunt u niet zichtbare tracks (opnieuw) zichtbaar 
maken.  Tracks waarvan het audiobestand aanwezig is krijgen dan 
opnieuw de status aanwezig als de Scan recht locatie Studio is. 

 
 

Onder de rechtermuis knop bevindt zich met Databank browser Xtra een soorgelijk menu 
waarmee u de eerder beschreven functies kunt aanroepen. 

Gebruiker: Aangevinkt geeft Databank browser Xtra enkel de tracks 

weer die voor gebruikers beschikbaar zijn.  Dit zijn de tracks waarbij 

in Databank editor “Gebruiker” is aangevinkt. Zet u hier een kruisje 

dan geeft Databank browser Xtra de tracks weer  waar in Databank 

editor “Gebruiker” NIET is aangevinkt en voor gebruikers NIET 

beschikbaar zijn. Gebruikers zonder het Beschikbaar-recht kunnen 

het Gebruiker vinkje niet wijzigen.  

 

Planner: Aangevinkt geeft Databank browser Xtra de tracks weer 

die voor Formatplanner beschikbaar zijn. Dit zijn de tracks waarbij in 

Databank editor “Planner” is aangevinkt. Deze tracks mag 

Formatplanner gebruiken om de playlists te plannen. Zet u hier een 

kruisje dan geeft Databank browser Xtra de tracks weer die  voor 

Formatplanner NIET beschikbaar zijn.  Gebruikers zonder het 

Beschikbaar-recht kunnen het Planner vinkje niet wijzigen. 

 

Aanwezig: Geeft de tracks weer waarvan het audiobestand 

daadwerkelijk aanwezig is.  Gebruikers zonder het Beschikbaar-

recht kunnen het Aanwezig vinkje niet wijzigen. 

 

Vinkt of kruist u een van de drie Beschikbaar-opties niet aan, dan 

doet die niet mee in het filter. Vinkt of kruist u geen enkele van de 

drie opties aan, dan worden alle in de databank aanwezige tracks 

getoond. Dit kan ook gebruikt worden in combinatie met de critera 

filters. 
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Op het tabblad ‘Zoek’ kunt u meer gedetailleerde zoekopdrachten uitvoeren. 
 

 
 

Titel met de 
tekst 

Hier kunt u zoeken in de titels. De titel hoeft niet te beginnen met 
de tekst. Titels die de zoektekst bevatten worden getoond. 

Typ tekst in en selecteer het tabblad track om het resultaat te tonen. 

 

Artiest met de 
tekst 

Hier kunt u zoeken in artiesten. Een artiest hoeft niet te beginnen 
met de tekst. Artiesten die de zoektekst bevatten worden getoond. 

Typ tekst in en selecteer het tabblad track om het resultaat te tonen. 

 

Songtekst met 
de tekst 

Hiermee kunt u zoeken in songteksten. 

Typ tekst in en selecteer het tabblad track om het resultaat te tonen. 

 

Weergave 
uurgetal 

Hiermee bepaalt u de weergave van uurgetallen. 

Exact: 
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Uurgetallen worden weergegeven in weken en dagen en uren. 

Afgerond: 
Uurgetallen worden afgerond weergegeven in weken of dagen of 
uren. 

Weergave 
tracks 

Dubbele titel en artiest: 
Met deze optie vindt een aparte filtering plaats waarbij alleen de 
tracks worden weergegeven waarvan de combinatie titel en artiest 
twee of meer keren in de databank aanwezig is. 

Uurgetal track kleiner dan uurgetal artiest: 
Met het uurgetal artiest regelt u hoe vaak een artiest en dus de 
tracks daarvan gepland kunnen worden. Bijvoorbeeld bij hits 
waarvan het uurgetal track vaak lager is dan het uurgetal artiest, 
krijgt u een artiest waarschijnlijk vaker in de playlist. Dit soort tracks 
maakt u met deze optie zichtbaar. 

 

Uurgetal … Hiermee geeft u aan dat het filter tracks weergeeft die een bepaald 
trackuurgetal hebben. 

Periode Met deze optie kunt u een filter instellen waarmee u tracks wilt zien 
die gepland of gespeeld zijn in een verder te specificeren tijdsvak. 

Texture De texture kunt u hier filteren door het groene balkje te verschuiven. 

Mood De mood kunt u hier filteren door het groene balkje te verschuiven. 

 

Tip!  De resultaten van deze zoekvelden, de tracks die voldoen, worden getoond op 
tabblad Track. 
 
Alle in Databank browser Xtra beschikbare filter-opties op het tabblad Selectie en het 
tabblad Zoek kunt u met elkaar combineren om het resultaat te verfijnen. 
 

 Navigatiebalk 
 
Onderaan is een navigatiebalk beschikbaar waarmee u door het resultaat kunt bladeren. 
 

 
 

 

 
Eerste item weergeven 

 
Vorige pagina 

 
Vorige item 

 
Aantal items in het zoekfilter 

 
Volgende item 

 
Volgende pagina 

 
Laatste item weergeven 

 
Zoekvenster 

 
Wisselen tussen de “Standaard weergave” en “Groeperen in 
boomstructuur” 

 

  In gegroepeerde weergave worden kolommen weergegeven in een boomstructuur.   
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Boomstructuur 
In de Boomstructuur-weergave wordt er standaard gesorteerd op de kolom artiest.  
 
Sleep kolomheaders op het groepeervlak om kolommen op te nemen in de 
boomgroepering. De boomstructuur wordt met kolomheaders van links naar rechts 
opgebouwd. Versleep de kolomheaders op het groepeervlak om de sortering van de 
boomstructuur in volgorde te wijzigen. In het onderstaande voorbeeld is de kolom Jaar 
erbij gesleept. 
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6 Item browser 

Item browser kunt u openen via het menu Databank → Item Browser, het bijhorende 
icoon op de knoppenbalk of de sneltoets CTRL+F11. 

 
Item browser biedt de mogelijkheid om de in de databank aanwezige tracks en items te 
ordenen in een boomstructuur. De boomstuctuur kunt u geheel naar eigen inzicht 
opbouwen.  
 

 
 
Aan de linkerzijde staat de boomstructuur met alle categorieën. Item browser kent 
algemene categorieën, gebruikerscategorieën en groepscategorieën.  
 
De gebruikersnaam-hoofdcategorie en de groepsnaam-hoofdcategorieën worden 
automatisch aangemaakt. In elk van deze categorieen kunt u een boomstructuur 
opbouwen. Algemene hoofdcategorieen kunt u zelf naar eigen wens toevoegen. 
 
De namen van algemene categorieën zijn witgekleurd en zijn toegankelijk voor alle 
gebruikers. Het kunnen toevoegen van een categorie is afhankelijk van het 
toegangsrecht. In de gebruikersrechten kan per gebruiker worden ingesteld of hij of zij 
algemene categorieën en/of groepscategorieën mag aanmaken en wijzigen. 
 
Gebruikersnaamcategorieën zijn geel gekleurd en zijn enkel toegankelijk voor de 
ingelogde gebruiker. Iedere gebruiker kan onder zijn eigen account een boomstructuur 
opbouwen in zijn eigen persoonlijke categorie.  
 
Groepsnaamcategorieën zijn groen gekleurd en zijn enkel toegankelijk voor gebruikers 
die lid zijn van de betreffende gebruikersgroep. Alle gebruikers die lid zijn van een groep 
hebben toegang tot de boomsstuctuur in deze catagorie. Afhankelijk van hun 
toegangsrecht mogen zij een boomstructuur aanmaken in een groepscategorie. 
 

Tip! Bij dubbelklikken op een track wordt die track geopend in Databank editor. 
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Via het menu onder de rechter muisknop kunt u categorieën toevoegen, wijzigen of 
verwijderen. 
 

 
 
Een categorie toevoegen 
Bij het toevoegen van een categorie geeft u een naam op en kiest u een passend icoon. 
Als er al categorieën zijn aangemaakt, wordt er standaard een sub-categorie in de 
focussed categorie aangemaakt.  
 
Bij ‘Inhoud’ kunt u ervoor kiezen om een nieuwe categorie te maken op basis van een 
criteria filter of een categorie waarin u items handmatig kunt toevoegen d.m.v. slepen 
(standaard selectie). Een nieuwe algemene hoofdcategorie maken als “rootmap” in Item 
browser is mogelijk door ‘Nieuwe hoofdcategorie-boom’ aan te vinken.  
 

 
 
Na het aanmaken van één of meerdere “Handmatige categorieën” kunt u items vanuit 
bijvoorbeeld Databank browser in de gewenste categorie in Item browser slepen. 
Naast handmatige categorieën kunnen ook filter categorieën worden aangemaakt. Per 
filter categorie kunt u een filter samenstellen met de beschikbare selectie-criteria.  
 
U kunt de gemaakte boomstructuur open- en dichtklappen met de pijltjes naast de 
categorieën of met de ‘+’ en ‘-‘ toetsen op het numerieke deel van het toetsenbord.  
Alle categorieën ineens openklappen doet u met CTRL + en alle categorieën 
dichtklappen doet u met CTRL -. 
 
Categorieën bewerken 
Klikt u met de rechter muisknop op een categorie-item dan verschijnt het volgende menu: 
 

 
 
De meeste menu items spreken voor zich. Een paar behoeven nadere uitleg. 

 
- Met de optie Verwijderen, verwijdert u het item enkel uit Item browser.   
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- Met de  optie “Verwijderen Item browser, Databank en Audio” verwijdert u het item 
niet alleen uit Item browser, maar ook uit de Muziek databank en u verwijdert meteen 
ook het audiobestand van harddisk. Bij gebruik van deze optie wordt nog extra om 
een bevestiging gevraagd zodat u niet per abuis kan verwijderen. Gebruikers met 
onvoldoende rechten kunnen en mogen deze optie niet aanroepen. 

 
De volgorde van de kolommen kunt u wijzigen door deze te verslepen. Welke kolommen  
u zichtbaar wilt hebben kunt u instellen in het kolomheader-menu. Door op de titelbalk 
van de kolommen met de rechter muisknop te klikken kunt u dit menu openen. De 
weergave van kolommen en andere venster-instellingen wordt automatisch per 
gebruiker opgeslagen en bewaard. 
 

 
 

Tip! De browsevolgorde van Databank editor kan gekoppeld met de browsevolgorde 
van Item browser. 

 
 

Redactie en productie 
Eén van de voordelen van het gebruik van Item browser is, dat items die toegevoegd 
worden aan een categorie ook direct zichtbaar zijn op een andere PC in het netwerk. Op 
die manier kan de nieuwsredactie items produceren en klaarzetten voor de DJ en 
technici in de studio. 
Voor het automatisch toevoegen aan categorieën, verversen of het automatisch 

importeren van items gebruikt u InOutBox. Categorieën waarin door InOutBox nieuwe 
of ververste items zijn geplaatst die kleuren rood zodat het de DJ meteen opvalt dat de 
inhoud is gewijzigd.  
 
Met InOutBox kan een systeem opgezet worden waarbij gebruikers (via ftp of dropbox) 
audiobestanden in een aangewezen map op disk plaatsen en die vervolgens door 

InOutBox worden verplaatst en aan een in InOutBox ingestelde Item browser-categorie 
worden toegevoegd. 
 

Het is ook mogelijk, met de beschikbare opties in InOutBox, om in te stellen dat items 
worden toegevoegd aan een specifieke gebruikers- of groepscategorie terwijl deze items 
niet zichtbaar worden in Databank browser en zo afgeschermd worden voor andere 
gebruikers. Het is ook mogelijk met InOutBox items automatisch in de playlist te 

plaatsen. Zie voor meer info het hoofdstuk InOutBox. 
 

6.1 File browser 

File browser kunt u openen via het menu Tools → File Browser of de sneltoets CTRL+B. 
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Met File browser kunt u door de audiomappen bladeren, weergeven of audiobestanden 
in de databank aanwezig zijn, metadata in ID3-tags van audiobestanden updaten naar 
de database, audioinfo weergeven en audio bestanden slepen naar diverse modules. 
 

 
 
Rootmappen instellen 
Per gebruiker kunnen er in de gebruikersrechten twee File browser-rootmappen worden 

ingesteld. Zie menu Toegang → Gebruikers. Is de eerste rootmap niet ingevuld 
(standaard instelling) dan kan de gebruiker door alle audiomappen heen bladeren. 
 
U kunt voor iedere gebruiker in de eerste rootmap bijvoorbeeld een map instellen met 
daarin audiobestanden en submappen voor algemeen gebruik. Daarnaast kunt u in de 
tweede rootmap bijvoorbeeld een map instellen met persoonlijke bestanden van de 
betreffende gebruiker. 
 
Zoekfunctie 
Met de zoekfunctie kunt u zoeken naar bestandsnamen in mappen waarvan File brower 
de bestanden heeft ingeladen.  Het zoekvenster kunt u openen middels het vergrootglas. 
Na intypen van tekst drukt u op de zoekknop of druk op enter om naar het volgende 
resultaat te gaan. 
 
Vernieuwen 
Met de vernieuwen functie zal File browser alle mappen doorzoeken en in iedere map 
de bestanden inladen. File browser zal daarna de inhoud van mappen niet vernieuwen 
totdat deze functie in het menu weer wordt aangezet. Dit versnelt het zoeken nadat alle 
bestanden zijn opgezocht. 
 
Bestanden toevoegen aan de databank 
Indien ‘Toevoegen databank’ op de statusbalk is aangevinkt worden bestanden aan de 
databank toegevoegd bij het slepen naar bijvoorbeeld de Playlist of Databank editor. 
Toevoegen aan de databank is afhankelijk van gebruikersrechten. Indien u het vinkje 
‘Toevoegen databank’ niet kunt aanzetten, dan heeft u daartoe geen rechten gekregen. 
 

Tip! Bij dubbelklikken op een bestand wordt de track in Databank editor geopend als de 
track in de databank aanwezig is. 
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Klik u rechts op een item in de File browser-tree dan verschijnt het tree-menu: 
 

 
 
Met de opties in het tree-menu kunnen o.a. audiobestanden worden geopend in 
Databank editor, of in een Externe audio editor, bijvoorbeeld Audacity, en ook in 
Windows verkenner. Of u dit mag uitvoeren is afhankelijk van uw gebruikersrechten.  
 
Via het File browser-tree-menu kunt u ook het tags-menu openen. 
 

 

 
 
De tag-items in dit menu worden automatisch geactiveerd zodra de corresponderende 
tagkolom via het kolomheader-menu is geactiveerd en in beeld staat.  
 
De metadata van ID3-tags in audiobestanden kunt u m.b.v. dit tag-menu updaten naar 
de databank, mits u rechten heeft om alles in Databank editor te mogen bewerken. 
 
Databank updaten met vernieuwde info in ID3 tags 
Zet eerst de tag kolommen in beeld. Selecteer dan audiobestanden in File browser, klik 
rechts op de selectie en open het tag-menu. Selecteer in het tag-menu de tags waarvan 
u de metadata in de databank wil updaten en klik vervolgens op “Update geselecteerde 
tags naar databank”.   
 
U krijgt eerst een melding van hoeveel bestanden en welke soort tag-metadata in de 
database overschreven zal worden.  Als u dit met Ja bevestigt dan wordt het feitelijk 
toegepast. 
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Dit kan handig zijn als u de tag meta data in uw audiobestanden heeft bijgewerkt met 
een ID3-tag editor zoals Mp3tag. https://www.mp3tag.de/en/index.html.  
 
Klik rechts op de kolomheader om het onderliggend menu te openen. In het 
kolomheader-menu kunnen de diverse kolommen geactiveerd en zichtbaar gemaakt. 
 
Bij het afmelden van een gebruiker wordt zijn persoonlijke kolom-indeling automatisch 
opgeslagen en bewaard tot een volgende aanmelding. 
 

 
 

Map Locatie van bestand. 
  

Track in databank Is het bestand als track aanwezig in de databank. 
 

DB artiest Artiest in de databank. 

DB titel Titel in de databank. 

DB intro Intro in de databank. 

DB speelduur Speelduur in de databank. 

DB jaar Jaar in de databank. 

DB BPM BPM in de databank. 

DB initial key Key in de databank. 
  
  

Tag artiest Artiest uit tag bestand.   

Tag Titel Titel uit tag bestand. 

Tag album Album uit tag bestand. 

https://www.mp3tag.de/en/index.html
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Tag auteur Auteur uit tag bestand. 

Tag jaar Jaar uit tag bestand. 

Tag BPM BPM uit tag bestand. 

Tag key Initial key uit tag bestand 

Tag Isrc Isrc uit tag bestand 

Tag comment Commentaar uit tag bestand.  Deze info kan opgeslagen in 
Track info. 

  

Alle tags en audio info Alle tag en audio info kolommen in beeld brengen. 
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7 Playlist 

Een Playlist kunt u openen via het menu Bestand → Open → Playlist of het icoon op de 

werkbalk. Of via de sneltoets SHIFT+CTRL+P. 

 
Een playlist is het draaiboek van uw radiostation voor het afspelen van tracks, reclames, 
jingels, promo’s, nieuws, info, raamprogramma’s et cetera. In de meeste gevallen 
gebruikt u Formatplanner voor het aanmaken van een playlist en Commercialplanner 
voor de commercials die er aan toegevoegd worden. Beide programma-onderdelen 
worden in aparte hoofdstukken beschreven. In dit hoofdstuk beschrijven we de playlist 
en leggen we uit hoe u die zelf kunt aanpassen. 
 
Onderstaand ziet u een voorbeeld van een playlist. In de titelbalk bovenaan ziet u voor 
welke dag deze playlist is. De kleur waarmee de titel en artiest in de playlist worden 
afgebeeld, wordt bepaald door de categorie waar het nummer toe behoort. De kleur van 

de categorieën kunt u aanpassen in Instellingen → Globaal → Criteria. 
 
De lettergrootte is instelbaar via menu Venster of via het muiswiel waarbij u tegelijkertijd 
de CTRL-toets ingedrukt houdt. Per kolom kan er gesorteerd worden door op de 
kolomheader te klikken . Er kan in de gesorteerde kolom stapsgewijs gezocht worden 

d.m.v. typen. Met de sneltoets CTRL+F kunt de zoek-functie oproepen. 

 
Een audiobestand gesleept uit Windows verkenner of File browser dat niet in de 
databank aanwezig is wordt cursief weergegeven. De weergegeven kleur kunt u instellen 

via Instellingen → Globaal → Algemeen → Track uit Verkenner. 
 

  
Playlist in detail weergave 



2025-05 Handleiding AerOn 

58 Broadcast Partners 

 
Playlist in tegelweergave 
 

De kolom ‘Start’ geeft aan op welk tijdstip het item gaat spelen. Deze starttijd kan 
variëren als u het nonstop-programma onderbreekt voor live-uitzendingen. Staan er bij 
de starttijd streepjes, dan geeft dit aan dat de track niet gespeeld zal worden vanwege 
een uitvulblok of een vast of semi-vast item dat in het volgende blok gestart gaat worden.  
 

Tip! De ruimte links van de kolom start is gereserveerd voor het zetten van ‘doorstart-
pijlen’. Klik met de muis om een doorstartpijl te zetten. Klik op een doorstartpijl om de 
doorstart ongedaan te maken. 
 
Net als in Databank browser kunt u een playlist sorteren, bijvoorbeeld sorteren op de 

kolom ‘Duur’, ‘Titel’ of ‘Artiest’. De sortering kunt u bijvoorbeeld gebruiken om te 
controleren hoe vaak een bepaalde artiest in een playlist voorkomt. Om te sorteren klik 

op een kolom-header. Sorteren op kolom ‘Duur’ geeft u bijvoorbeeld een snelle controle 
wat de langste track van de dag is. Via het kolom-headermenu kunt u de overige 
kolommen in beeld zetten. De kolommen kunt u ook van positie verslepen. Zo kunt u 
een playlist geheel naar persoonlijke wens indelen. De positie van kolommen en etc. 
wordt per gebruiker automatisch opgeslagen en bewaard tot een volgende aanmelding.  
 

Tip! Als de playlist niet is gesorteerd op ‘Start’ dan kunt u geen wijzigingen aanbrengen. 

De sortering op ‘Start’ kunt u herstellen door op de kolom-header ‘Start’ te drukken. Of 
druk op functietoets F9 die het actieve onair spelende playlistitem in beeld brengt.  
 
Commercialblokken staan altijd als groep in de playlist en staan standaard dichtgeklapt. 
Een commercialblok kunt u open- en dichtklappen door op het pijltje in de linker kolom 
te klikken. Alle commercialblokken ineens openklappen dat kan met de toetscombinatie 

CTRL + en en alle commercialblokken ineens dichtklappen kan met CTRL -. 
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Blokken 
Een playlist is doorgaans opgedeeld in blokken d.m.v. vaste- of semi-vaste items. De 
meeste radiostations hanteren blokken van een uur of een half uur. Meerdere gebruikers 
kunnen daardoor tegelijkertijd dezelfde playlist bewerken en bijvoorbeeld ieder in hun 
eigen uurblok voicetracks opnemen. Handigheid daarbij is om de playlist tijdens het 
bewerken in blokweergave te zetten. De playlist die onair is volgt dan niet het onair 
spelende item en ook het verversen van de playlist verloopt dan sneller. 
 
In de Bloknavigator kunt u wisselen tussen blokweergave en dagweergave. De optie 

Alle blokken weergeven aangevinkt dat is dagweergave. Alle blokken van begin tot 
eind van de dag worden dan ingeladen. De playlist in blokweergave zetten is eenvoudig. 
Klik op een uurblok in de bloknavigator om de playlist in blokweergave te zetten en dat 
uurblok in beeld te brengen. Bij het inslepen van tracks wordt een playlist in 
blokweergave sneller geupdate dan een playlist in dagweergave.  
 
Met de blokweergave voorkomt u ook dat de playlist bij iedere plaatwissel het actieve 
item volgt. De playlist van vandaag volgt in dagweergave de trackwissels van de actieve 
onair spelende items. In de instellingen kunt u hiervoor een time out instellen, zie 

Instellingen → Globaal → Algemeen → Extra → Playlist automatisch volgen na.  
 
Blokken die in gebruik zijn krijgen visueel een gereserveerd indicatie. Als een gebruiker 
een blok probeert te bewerken dat elders door een andere gebruiker wordt bewerkt 
verschijnt er een melding in beeld met daarin vermeld welke gebruiker dat blok in gebruik 
heeft. U kunt dan die gebruiker vragen om dat blok vrij te geven. Blokken vrijgeven kan 

via het playlist menu of met de sneltoets CTRL+K. Bij het afsluiten van een playlist 
worden blokken automatisch vrijgegeven. 
 

Playlist item mode 
AerOn kent voor playlistitems een viertal modes, de beschikbare modes zijn ‘Glijdend’, 
‘Uitvullend’, ‘Vast’ en ‘Semi-vast’: 
 

Glijdend: 
In de meeste gevallen komen de items (muziek, commercials et cetera) gewoon vloeiend 
achter elkaar. Op het moment dat een track is afgelopen, start de volgende en zo verder. 
Deze items hebben het kenmerk ‘Glijdend’ en worden in de playlist-kolommen ‘Start’ en 
‘Duur’ met witte cijfers weergegeven. Items glijdend zetten kan via het playlist menu of 

Sneltoets CTRL+L. 
 

Uitvullend: 
De tweede mode is ‘uitvullend’. Items met mode uitvullend zijn altijd tegen een item met 
vaste of semi-vaste begintijd geplakt. Veel radiostations maken gebruik van per uur een 
uitgevuld reclameblok dat voor het nieuws speelt. Doordat een uitvulblok tegen een vast 
item zit geplakt heeft een uitvulblok ook een vaste begin tijd. De starttijd van een 
uitvulblok is de starttijd van het (semi-)vaste item minus de lengte van het uitvulblok. Een 
uitvulblok in zijn geheel uitgezonden en niet afgebroken. In de playlist ziet u de starttijd 
en duur van deze items in gele letters. Items uitvullend zetten kan via het playlist menu 

of Sneltoets CTRL+U. 
 

Vast: 
Een aantal items benodigen een vaste begintijd. Het meest bekende voorbeeld is het 
nieuws. Vaste items zorgen ervoor dat de playlist wordt opgedeeld in blokken. Een vast 
item is altijd het eerste item van een playlistblok. De starttijd van een vast item wordt met 

rode cijfers weergegeven. De optie Vast geeft u aan in het Formatplanner-dagformat als 
u een playlistblok met een vaste begintijd wil plannen. U kunt de mode manueel wijzigen 
in het playlist-wijzigen-venster. Het playlist-wijzigen-venster kunt u openen met een 
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dubbelklik op de track in de playlist of via het playlist menu (Kies de optie Wijzigen). 
AerOn garandeert dat vaste items exact op het opgegeven tijdstip starten, dat betekent 
dat het voorgaand glijdende item wordt afgebroken en uitgefade. 

In Instellingen → Automatisering → Algemeen kunt u aangeven hoe glijdende items, 
die moeten wijken voor een vast item, netjes worden uitgefaded. 
 

Tip! Als u een vast item uit de playlist wil verwijderen, wijzig dan de mode naar glijdend. 
Als u de mode van vast naar glijdend wijzigt worden de twee blokken samengevoegd tot 
één blok. Een vast item kunt u ook glijdend maken door het naar beneden te verslepen, 
het item wat glijdend was wordt dan vast, de items worden dan in feite verwisseld. 
 

Semi-vast 
Een semi-vast item is dynamisch vast. De starttijd van een semi-vast item wordt met 
groene cijfers weergegeven. Een semi-vast item is altijd het eerste item van een 
playlistblok. Semi-vaste items zorgen ervoor dat de playlist wordt opgedeeld in blokken. 

De optie Semi-vast geeft u aan in het Formatplanner-dagformat als u een playlistblok 
met een semi-vaste begintijd wil plannen. U kunt de mode manueel wijzigen in het 
playlist-wijzigen-venster. 

In Instellingen → Globaal → Algemeen → Extra kunt u de Marge Semi-vast instellen 
waarmee wordt bepaald hoeveel tijd een semi-vast item maximaal terug in de tijd mag 
en kan schuiven. 

 
De werkelijke starttijd van semi-vast wordt telkens opnieuw bepaald bij de start van een 
track. Vooral in Live-assist is dat merkbaar waar u zelf de start van een track bepaalt. 
Als het nieuws op semi-vast staat, zal de laatst spelende track voor het semi-vaste 
nieuws niet afgebroken worden, maar helemaal tot het einde uitspelen. Dit kunt u ook 
zien aan de resterende speeltijd in de groene klok. Staat er ook een uitvulblok 
geprogrammeerd, dan houdt AerOn daar rekening mee en zal de spelende track niet 
afbreken voor het uitvulblok. Een uitvulblok zweeft automatisch mee met semi-vast. 
  

Tip! Als u een semi-vast item uit de playlist wil verwijderen, wijzig dan de mode naar 
glijdend. Als u de mode van semi-vast naar glijdend wijzigt worden de twee blokken 
samengevoegd tot één blok. Een semi-vast item kunt u ook glijdend maken door het 
naar beneden te verslepen, het item wat glijdend was wordt dan semi-vast, de items 
worden dan in feite van positie verwisseld. 
 

Eigenschappen van een playlistitem wijzigen 
Als u dubbelklikt op een track of item in de playlist verschijnt het Playlist-wijzigen-venster. 
Hierin kunt u een andere track opzoeken en die selecteren. U kunt bijvoorbeeld ook de 
mode wijzigen. Dit Playlist-wijzigen-venster verschijnt ook als u via de werkbalk op 
Toevoegen klikt waarmee items kunnen worden ingevoegd, bijvoorbeeld een externe 

audio bron. Sneltoets CTRL+I  
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De kenmerken van een playlistitem of track zijn verdeeld over enkele panelen: 
 

Item: 
Track uit 
databank 

Dit is het meest voorkomende item-type. Voorbeelden zijn  
muziektracks, jingles en commercials. Als u dit type kiest, 
selecteert u een track in de Playlistitem-browser. 

Extern 
audio-apparaat 

Hier kunt u één van de externe audioapparaten selecteren die u 
heeft ingesteld voor doorgifte van een raamprogramma. Dit kunnen 
bronnen zijn die zijn aangesloten op een geluidskaart, een internet-
audio-stream of via een ondersteunde Asio board of een mengtafel 
audio-source (bvb D&R Axum). U moet hier ook de lengte instellen. 
De lengte kan ingesteld in UU:MM:SS en tiende van seconde. 
 

Tip! Als u meerdere uren hetzelfde raamprogramma of dezelfde internet-mp3-stream 
wil doorgeven dan is het beter om meerdere keren hetzelfde extern audio-apparaat of 
externe-audio-bron na elkaar te plaatsen met telkens een lengte van bijvoorbeeld 1 uur 
of een half uur. AerOn zorgt er namelijk voor dat overgangen tussen dezelfde externe 
audio-apparaten naadloos in elkaar overlopen. Met meerdere externe items na elkaar 
kunt u een dip op de internetverbinding ook beter en makkelijker opvangen. Als de 
verbinding verbreekt en het verbinden niet lukt kan AerOn het volgende item starten. 
 

Mode: 
Hier kunt u instellen of een item ‘glijdend’, ‘uitvullend’, ‘vast’ of ‘semi-vast’ moet zijn.  
 
Bij een glijdend item kunt u niet de begintijd opgeven, deze is namelijk afhankelijk van 
de volgende-tijd (startnext) van het vorige item. Glijdende items kunt u met Mix editor 
verschuiven. 
 

Tip! De mode kan enkel worden gewijzigd als de playlist in dagweergave staat.  
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Dagweergave = Alle blokken weergeven aangevinkt. 
 

Bron: 
De items die door Formatplanner of door u in de playlist zijn gezet, hebben allemaal als 
afkomst ‘AerOn’. Commercialplanner markeert toegevoegde items met afkomst 
Commercialplanner. Als tussentijds de planning van de commercials wijzigt en 
aanpassing van de playlist noodzakelijk is, kan met behulp van ‘bron’ gedetecteerd 
worden welke items eerst uit de playlist verwijderd moeten worden voordat de nieuwe 
commercials er voor in de plaats komen. Als u zelf een commercial in de playlist sleept 
kunt u manueel de bron wijzigen zodat die track als commercial wordt gemarkeerd. 

 
Kolommen activeren en de playlist weergave aanpassen 
Als u met de rechter muisknop op de kolomheader klikt van o.a. Artiest of Titel, ziet u het 
onderstaande menu verschijnen. Hiermee kunt u diverse kolommen zichtbaar maken. 
De kolommen kunt u ook van positie verslepen. De persoonlijke indeling van kolommen 
wordt per gebruiker automatisch opgeslagen en bewaard. 
 

Kolomheader-menu bij detail-informatie: 
 

 
 

Kolomheader-menu bij tegels: 
 

 
 
 

Tegel / Detail 
weergave 
 

Weergave van de playlist met tegels of detail-informatie. 

Intro Hiermee kunt u de kolom ‘Intro’ zichtbaar maken, dit kan handig 
zijn als u voicetracks gaat opnemen. (Detail) 

Bron De ‘Bron’ geeft aan waar de track vandaan komt. Standaard is dit 
AerOn, maar commercials hebben meestal de markering dat ze 
afkomstig zijn van Commercialplanner. (Detail) 

Actie Hierin ziet u of er een actie aan de track is gekoppeld. (Detail) 

Plananalyse (Plan Checker). Deze optie is beschikbaar bij gebruikers die de 
module Plan Checker hebben aangeschaft.  
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Zodra u deze optie aanklikt worden er 4 extra kolommen (‘Aantal’, 
‘Alternatief’, ‘Uurformat’, ‘Index’) voor de plananalyse zichtbaar.  
(Beschikbaar bij Detail-weergave) 

Gebruiker Hierin kunt u zien welke gebruiker het betreffende blok in gebruik 
heeft. (Detail) 

BPM, Key 
Jaar, Album 
 

Zet de kolommen BPM, Key, Jaar en Album zichtbaar. 

(Beschikbaar bij Detail-weergave) 

Datum en blok 
navigator 
 

Deze optie maakt de linkerkolom met de kalender en het 
blokkenoverzicht zichtbaar.   

Door te klikken op een datum wordt de playlist van die dag 
ingeladen.  Door te klikken op de tijden navigeert u naar het 
corresponderende playlistblok. 

Met de optie Alle blokken weergeven selecteren zet u de playlist in 
dagweergave en wordt de gehele playlist ingeladen.  Met de optie 
Alle blokken weergeven uitzetten zet u de playlist in blokweergave 
en wordt enkel het blok ingeladen dat correspondeert met de tijd en 
ook het daaropvolgende blok. Dit laatste maakt dat de playlist iets 
sneller reageert bij het inslepen. 

Volgorde tracks Deze optie bepaalt de visuele sortering van een playlist.  Deze 
weergave-optie wordt automatisch per gebuiker onthouden en 
opgeslagen. De standaard sortering is Begin. 
 

Begin De playlist wordt gesorteerd op basis van de starttijd. Met deze 
sorteer-optie worden de tracks weergegeven in volgorde van 
oplopende starttijd. 

  

Midden De playlist wordt gesorteerd op basis van het midden van iedere 
track.  
 
Deze weergave is aanbevolen wanneer u in Mix editor veelal jingles 
volledig onder een intro schuift waarbij de jingle een hogere starttijd 
heeft dan de track waar de jingle is ondergeschoven. Met deze 
sorteer-optie wordt de jingle, ondanks de hogere starttijd, 
weergegeven boven de track.  
 

Tip! De sorteer-optie Midden is voornamelijk van toepassing bij de 
module Voicetracking Xtra. Tijdens het werken in Mix-editor kunt u, 
voor telkens de beste weergave, per situatie wisselen tussen deze 
beide sorteer-opties. 
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Het playlist-menu 
 

 
 
Als u op een willekeurige track rechtsklikt zal het playlist-menu verschijnen. Een aantal 
keuzes in het menu spreken voor zich, een aantal behoeft nadere uitleg: 
 

Plakken mixtijden 
databank 

Met deze functie worden de standaard mix-tijden en fade-curve 
uit de databank overgenomen.  

Sneltoets CTRL+E 

Deze functie is met name van toepassing bij het kopieren van 
items die onair gespeeld zijn geweest. (Het kopiëren uit een 
playlist in het verleden)  Tracks die tijdens een live uitzending zijn 
gespeeld kunnen in- of uit elkaar zijn geschoven doordat ze 
vervroegd of uitgesteld zijn gestart geweest. Ook kunnen tracks 
zijn overgeslagen waardoor de duur van een track kan zijn 

aangepast. In dat geval is plakken met CTRL+E het advies. 

Het plakken met mix-tijden uit de databank CTRL+E voorkomt 

dat er in de nog af te spelen playlist ongewenst items over elkaar 
schuiven of juist uit elkaar komen te liggen doordat u, of een 
andere DJ, het eerder zo heeft afgespeeld in Live assist.  

Bij standaard plakken CTRL+V worden altijd de mix-tijden uit 

de bron-playlist overgenomen. Mixtijden die in de bron-playlist 
met Mix Editor zijn aangepast blijven bij standaard plakken 

CTRL+V  behouden. 
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In het geval dat u items kopieert uit een playlist die reeds onair 
gedraaid heeft, worden de mix-tijden van die reeds gespeelde 

tracks bij standaard plakken CTRL+V exact zo overgenomen 

en worden de starttijden, de mix-tijden en de fade-curve exact zo 
geplakt zoals het eerder is afgespeeld geweest.  

Controleer na het gebruik van CTRL+V  altijd de overgangen in 

Mix-editor. En indien u het nodig acht, reset dan de mix-tijden en 

fade-curve met de functie  “Update tijden van 

muziekdatabank”. Sneltoets CTRL+T. 

Uurformat  (Plan checker). Met deze optie kunt u direct naar de item-regel-
index in het uurformat springen waarmee de focussed track is 

gepland. Sneltoets CTRL+ALT+U 

Deze menu-optie is beschikbaar met de Plan checker licentie-
optie.   

Tip! Om de optie Uurformaat zichtbaar te maken moet eerst de 
Plananalyse ingeschakeld worden. Klik hiervoor rechts op de 
titelbalk van de Playlist en vink in het menu de optie Plananalyse 
aan. 

Alternatieven 
 

(Plan checker). Net als Uurformat is ook deze optie  
beschikbaar met de Plan Checker licentie-optie. 

Met het uitvoeren van de optie ‘Alternatieven’ krijgt u in Databank 
browser de alternatieve tracks te zien voor de in de playlist 
geselecteerde track op basis van de criteria in de uurformat-regel 
waarmee de track is gepland geweest. Sneltoets 

CTRL+ALT+T 

Tip! Als u in Databank browser de kolommen Laatst gepland en 
Laatst gespeeld in beeld brengt dan kunt u een betere selectie uit 
de alternatieven maken. 

 

Editor Het geselecteerde item wordt geopend in Databank Editor.  

De browsevolgorde in Databank editor wordt automatisch 
gekoppeld aan de browsevolgorde van de playlist als PFL volgen 

actief is. Sneltoets ALT+F11 

 

Mix editor Opent track in Mix-editor.  Sneltoets F5 

Externe audio 
editor 

Opent het bestand in de ingestelde audio editor. Sneltoets 

CTRL+ALT+E 

Externe video 
player 

Opent het bestand in de ingestelde video player. Sneltoets 

CTRL+ALT+M 

File browser Opent File browser. Sneltoets CTRL+B 

Auto mix Deze functie past Automix toe op de in de playlist geselecteerde 
tracks op basis van de algemene Automix instellingen.  

Instellingen → Globaal → Algemeen → Automix. Sneltoets 

Ctrl+O 
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Jingles/Sweepers en etc. kunnen Automix gepland worden met 
het Formatplanner-uurformat als ze in Databank editor als 
Automix gekenmerkt zijn. 
 

Tip! Jingles die geheel onder de fadecurve (intro of outro) van 
een track staan, krijgen een aangepaste weergave van de 
starttijd. De starttijd wordt dan schuingedrukt weergegeven met * 
ernaast. 

 
Weergave van jingle onder intro of outro 
 
Tip! Groepeer Automix jingles met de muziek track zodat ze 
automatisch doorstarten in Live assist. 
 
 

Update tijden … Door het wijzigen van mix-overgangen met Mix editor worden de 
tijden en/of fadecurve voor die tracks enkel op die ene plaats in 
een playlist aangepast. Deze gewijzigde mixtijden slaat AerOn 
enkel op in de playlist. Deze wijzigingen kunt u ongedaan maken 
en terug naar default zetten met de functie “Update tijden van de 
muziekdatabank”.  

Update tijden Van 
de muziek 
databank 

Met deze functie herstelt u de mixtijden van in de playlist 
geselecteerde tracks naar de standaard waarden zoals die met 
Databank editor zijn ingevuld in de muziekdatabank. Sneltoets 

CTRL+T 

Tip! U moet in de playlist minimaal twee tracks selecteren om de 
mixtijden te kunnen herstellen naar de standaard mix-tijden. De 
met Mix Editor gedane wijzigingen worden dan ongedaan 
gemaakt.  

Update Levels Als de mix-tijden die u invoert in Databank editor nog niet 
helemaal op orde zijn, kunt u de mix-tijden in de playlist met deze 
functie Levels nog naar wens aanpassen.  
 
Met deze functie zoekt AerOn in de audiobestanden van de 
geselecteerde tracks naar het -20 dB punt en gebruikt dit 
eenmalig op deze plaats in de playlist om de mixtijd met de 
volgende track te bepalen. 
 

Update 
Bestandsduur 

Deze functie controleert de werkelijke lengte van het 
audiobestand en past zonodig de muziekdatabank aan. 
 
Normaliter komt de lengte van een audiobestand overeen met de 
waarden in de muziekdatabank. Dit is niet meer het geval als u 
een item opnieuw opneemt buiten AerOn (met bijvoorbeeld 
Adobe Audition) of als het een nieuwsitem is waarvan 
automatische opname of verversing plaatsvindt.  
 



Handleiding AerOn Playlist 

 we make radio happen 67 

Update tijden 
Naar de muziek 
databank 

Hiermee voert u de met Mix editor gedane wijzigingen door naar 
de muziekdatabank.  

U dient er rekening mee te houden dat een mix die tussen twee 
specifieke tracks erg goed klinkt, maar met andere tracks wel 
eens minder fraai zou kunnen zijn. Wees daarom voorzichtig met 
het gebruik van deze functie. 

Synchronisatie … Deze optie is enkel beschikbaar indien de remote audio mappen 
actief zijn. Voor meer informatie over de remote audio mappen: 
raadpleeg hoofdstuk 39 AerOn Thuis.   
Zie ook Scan rechten. Instellingen → Globaal → Scan rechten. 
 

Synchronisatie 
Voice tracks 

Hiermee laadt u de voicetracks uit het geselecteerde deel van de 
playlist in de synchronisatie-module en vandaaruit synchroniseert 
u ze vanaf u thuis naar de studio. 
 
Ook hier geldt, raadpleeg hoofdstuk 39 AerOn Thuis. 
 

Synchronisatie 
Audiobestanden 

Hiermee laadt u de audiobestanden uit het geselecteerde deel 
van de playlist in de synchronisatie-module en vandaaruit 
synchroniseert u ze vanaf de studio naar u thuis of andersom. 
 

U kunt de synchronisatie module ook openen via menu Tools → 
Synchronisatie audiobestanden en tracks erin slepen.  
 

Tip! De beheerder van het systeem kan in AerOn per gebruiker 
instellen of die mag synchroniseren en in welke richtingen die dat 
mag.  
 

Controleer 
Playlist… 
 

Bij het aanroepen van deze functie voert AerOn een controle van 
de gehele playlist uit. Er wordt ondermeer gecontroleerd of het 
audiobestand van de tracks die in de playlist staan, ook 

daadwerkelijk aanwezig is. Sneltoets CTRL+ALT+C 

Tip! Het is aanbevolen om gereed gemaakte playlists daags voor 
uitzending te controleren. Zo weet u zeker dat dan alle audio 
aanwezig is. 

Time shifter, 
toevoegen 

Hiermee voegt u aan de Time shifter een taak toe voor 
programma-opname op basis van de tijdspanne van in de playlist 
geselecteerde tracks. 

7.1 Speciale functies 

HTML, XML, Tekst export 
Via de menu’s Bestand → OnAir export kunt u een playlist exporteren naar 
exportsjablonen volgens een zelf te definiëren indeling. In deze handleiding is een 
hoofdstuk gewijd aan het exporteren naar HTML, XML, Tekst (zie hoofdstuk 24). 
 

Afdrukken en afdrukvoorbeeld 
Met de optie ‘afdrukken’ kunt u een playlist of een deel (selectie) daarvan afdrukken op 

papier of pdf. Als u Bestand → Afdrukvoorbeeld kiest, krijgt u een venster met 
afdrukvoorbeeld: 
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Via ‘Setup’ kunt u eventueel een andere printer kiezen dan degene die als standaard-
printer staat ingesteld. 
 

Kopiëren via het klembord 
Nog een mogelijkheid om een playlist naar buiten te brengen is met het Windows 
klembord. Als u meerdere items in de playlist selecteert, wordt de selectie gekopieerd, 

anders wordt de gehele playlist gecopiëerd. Kies Bewerken en Kopiëren (CTRL+C) om 
de playlistitems naar het Windows klembord te kopiëren. In applicaties als Word of Excel 
kunt u de items vervolgens plakken (CTRL+V). 

 
Items afspelen 
Playlist-items kunnen in PFL worden afgespeeld met sneltoets CRTL+P, met de 
SPATIEBALK en met diverse randapparatuur. 

 
Items slepen en verslepen 
Playlist-items kunnen worden verplaatst door ze te verslepen. Sleept u binnen één en 
dezelfde playlist dan worden ze verplaatst. Bij het slepen of kopieren naar een andere 
playlist worden de items glijdend daaraan toegevoegd met de mixtijden en fadecurves 
uit de bronplaylist.  Als u een track in een playlist sleept zal AerOn controleren of die 
track al in die playlist staat afhankelijk van uw persoonlijke instellingen. 
 
Items uit het verleden van de ‘onair playlist’ worden bij het verslepen gekopieerd en 
geplaatst met de fadecurves en mixtijden uit het verleden. De kopie-items krijgen exact 
dezelfde mixtijden en fadecurve zoals het eerder is afgespeeld geweest.  

Indien gewenst, herstel dan de fadecurves en mixtijden met “Update tijden van 

muziekdatabank” in het playlistmenu. Sneltoets CTRL+T.  

Of kopieer en plak de items met CRTL+E. (Plakken met tijden uit de muziek databank) 

 
In een ‘onair playlist’ kan er enkel worden gesleept naar een tijdstip in de toekomst.  
 
Vanuit een divers aantal vensters in AerOn kunnen items worden toegevoegd aan een 
playlist. Zo kunt u eenvoudig in Item browser of Databank browser items opzoeken en 
slepen naar de playlists.  
 
Ook vanuit Windows Verkenner of vanuit File browser kunnen audiobestanden naar een 
playlist gesleept, waarin ze dan als track worden toegevoegd. Vanuit Windows kunt u 
bestanden slepen vanuit een map of vanuit een zoekresultaat. Items gesleept uit 
Windows verkenner of File browser die niet in de database aanwezig zijn, worden in de 
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playlist cursief weergegeven. De weergave-kleur kunt u desgewenst instellen via 

Instellingen → Algemeen → Kleuren → Track uit Verkenner. 
 

Tip! Als een uit Windows Verkenner of File browser gesleept audiobestand nog niet in 
de muziekdatabank aanwezig is, dan wordt het audiobestand, afhankelijk van de 

Toevoegen databank-optie aan de muziekdatabank toegevoegd. U moet voldoende 
rechten hebben op deze optie te mogen aanvinken. 

 
(Zie onderin op de statusbalk)   
 
Het gesleepte audiobestand dient te staan in één van de audio-hoofdmappen of in een 

submap daarvan te staan. Zie Instellingen → Globaal → Audio lokaal. 
  
Sleept u vanuit een onbekende map, een map die niet in AerOn bekend is als audiomap, 
dan wordt automatisch Databank import geopend. Om te mogen importeren moet u 
voldoende rechten hebben. 
 

Foutdetectie in de actieve playlist 
Als er in de actieve playlist een afspeelfout optreedt doordat een afspeelkanaal mogelijk 
niet beschikbaar is of als audiobestanden niet aanwezig of corrupt zijn, dan worden die 
tracks automatisch doorgesteept.  Raadpleeg in dat geval de Historie-playout log. 
 

Fadecurve herstellen bij droppen, verplaatsen en verwijderen. 
Standaard worden fadecurves en mixen in de playlist bij het inslepen, verplaatsen of 
verwijderen, hersteld met de tijden uit de databank. Fadecurves en mixen gemuteerd in 
Mix editor worden dan ongedaan gemaakt. Ook als u sleept bij voicetracks. 
 
Wilt u dat dit niet gebeurt, dan kunt u deze optie uitzetten in uw persoonlijke instellingen 

via Instellingen → Gebruiker → Persoonlijk. 
 
Als u een voicetrack verwijdert dan wordt de mix altijd hersteld zodat duckings ongedaan 
gemaakt worden. 
 

Playlist bewerken en blokken reserveren 
Een playlist kan bewerkt worden vanaf diverse werkstations en remote waarbij iedere 
gebruiker een eigen blok bewerkt. Zodra u een blok bewerkt wordt dat automatisch voor 
u gereserveerd. Een andere gebruiker kan dat blok niet bewerken totdat u dat vrijgeeft 
of de playlist afsluit. 
 
Onderstaande symbolen geven de status van de blokken aan. 
 

 

 
Het playlistblok is door u gereserveerd. 
 

 

 
Het playlistblok is door een andere gebruiker gereserveerd. 
 

 

 
Het playlistblok mag niet door u bewerkt worden. 
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Vraag de systeembeheerder om toestemming. Hij kan u toegang 

verlenen via Toegang → Gebruikers → Gebruiker → Wijzigen 
playlist. 
 

 
Wanneer een playlistblok in gebruik is door een andere gebruiker krijgt u een melding 
als u dat blok probeert te bewerken. U kan de gebruiker vragen om zijn blokken vrij te 

geven. Menu Playlist → Blokken vrijgeven. Sneltoets CTRL+K 

 
 

Playlist full screen mode op apart beeldscherm 
Via een optie in instellingen → Lokaal → Algemeen kan de playlist full screen worden 
weergegeven op een apart tweede of derde beeldscherm. Een dergelijk scherm kunt u 
dan eventueel 90 graden draaien zodat een playlist in Tegel-weergave meer items 
zichtbaar kan hebben en zo nog meer overzicht geeft. 
 

Playlist export/import .pll bestand 
Playlists kunnen in de database worden opgeslagen als datum- en/of naamplaylist. De 
in de database aanwezige playlists kunnen als bestand op schijf worden opgeslagen en 
elders, thuis of in de studio, geopend. Voordat u een playlistbestand in een andere 
database opent, moeten de tracks, die deel uitmaken van deze playlist, zijn geimporteerd 
in die database. Exporteer daarom ook de tracks met Databank export. Vanuit een 
playlist kunt u de tracks in Databank export slepen. 
 

 
 
Playlist “Opslaan als” 

Via menu Bestand → Opslaan als kunt u een exacte kopie van een playlist opslaan 
als een datumplaylist, naamplaylist of exporteren en opslaan als een .pll bestand. 
 

Tip! Als u een playlist uit het verleden opslaat als een datumplaylist in de toekomst dan 
moet u de overgangen en mixtijden controleren. Waar nodig kunt u de mixtijden 

corrigeren met de functie “Update tijden van muziek databank” in het playlistmenu.  

Sneltoets CTRL+T. 
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Txt2Pll 
Gebruikers die Txt2Pll nog willen gebruiken om m.b.v. een tekstbestand tracks toe te 
voegen aan een door Formatplanner geplande playlist kunnen dat downloaden via 
onderstaande link. 
http://update.aeronstudio.nl/files/archive/txt2pll.exe 
 
In de AerOn NexusDB handleiding is er een hoofdstuk gewijd aan Txt2Pll. 
Die handleiding kunt u downloaden via onderstaande link. 
http://update.aeronstudio.nl/doc/aeron_studio_handleiding_nexusdb.pdf 
 
Txt2Pll is EOL sinds 2017 en wordt niet meer onderhouden. 
 
Blokweergave en dagweergave 
Een playlist kan in blokweergave worden gezet door een blok aan te klikken in het 
blokoverzicht. U kunt daarmee meteen naar het blok gaan dat u wenst te bewerken. 
 

 
 
Als de playlist in blokweergave staat verloopt het verversen en bewerken van de playlist 
sneller. Daarnaast ontvangt een playlist in blokweergave geen berichten als andere 
gebruikers op een ander werkstation ook de playlist aan het bewerken zijn waardoor u 
sneller kunt werken. 
 

7.2 Playlist import .pll bestand 

 
Playlists kunnen in de database worden opgeslagen als een datum- of naamplaylist. De 
in de database aanwezige playlists kunnen als .pll bestand op schijf worden opgeslagen 
en elders, bvb thuis of in de studio, geopend worden en op deze wijze geimporteerd 
worden. 
 
Voordat u een playlistbestand in een andere AerOn database opent, moeten de tracks, 
die deel uitmaken van deze playlist, zijn geimporteerd in die database. Exporteer daarom 
indien nodig ook de tracks metadata met Databank export. Vanuit een playlist kunt u de 
tracks eenvoudig in Databank export slepen. 
 

http://update.aeronstudio.nl/files/archive/txt2pll.exe
http://update.aeronstudio.nl/doc/aeron_studio_handleiding_nexusdb.pdf
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7.3 Playlist import .txt bestand 

 
AerOn biedt ondersteuning voor het importeren van playlists middels een tekst bestand.   
 
Formaat  
 

Field Required Format StartPosition CharLength 

Date  yy/mm/dd 1 8 

Time  hh:mm 9 5 

Mode  FI, SF, FL 15 2 

AudioName  string 18 1 -- 255 

                  1                  2                  3                  4                  5                  6       

123456789012345678901234567890123456789012345678901234567890123456789 
 
Mode 
 
FI = Vast 
SF = Semi-vast 
FL = Glijdend 
 
Voorbeeld text 
 
22/12/0601:00 SF NEWS FLASH 
22/12/0601:01 FL CommercialBlock1Placeholder 
22/12/0601:02 FL Madonna - Crazy For You 
22/12/0601:03 FL XB56432 
 
Workflow 
 
1) Selecteer menu Bestand > Open > Playlist > Bestand 
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2) Selecteer een text bestand en druk op openen.   
3) De playlists worden geimporteerd als naamplaylist. Bvb Import 20221227. 
4) Sla de naamplaylists op als een datumplaylist. 
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8 Formatplanner 

Formatplanner kunt u openen via het menu Tools → Formatplanner. Of sneltoets 
SHIFT+CTRL+F 

 
In dit hoofdstuk gaan we eerst in op de achtergronden bij formatplanning, waarna we 
een overzicht geven van de mogelijkheden van de verschillende plannermodules. 
Aansluitend geven we aan hoe u de uur- en dagformats samenstelt en welke rol 
(un)breakable rules en de plananalyse daarbij spelen. Als laatste onderdeel in dit 
hoofdstuk wordt het daadwerkelijke plannen van een playlist behandeld. 

8.1 Achtergronden bij formatplanning 

Onder een format verstaan we de totale programmering, inclusief promo’s, jingles, 
reclamespots en presentaties. Het succes van een radiostation wordt in grote mate 
bepaald wordt door dit programmaformat. Dit is het ‘gezicht’ van de radiozender. Alleen 
factoren als zendbereik en sound zijn qua belang van gelijke orde. 
 
De eerste taak bij het bepalen van een format bestaat uit het aanleggen van grenzen. 
Die grenzen zijn absoluut; hiermee bedoelen we: hoe ver gaan we in het uitzenden van 
extremen. Als er met meerdere personen aan een format gewerkt wordt, is dit zeker een 
vergadering waard, aangezien deze zaken het ‘gezicht’ van de radiozender bepalen. De 
volgende elementen moet zeker eerst besproken worden: 
 

• Wie zijn onze luisteraars? Welke leeftijdsgroep (nog niet op tijdstippen verdelen). 
Bepaal dat op de gemiddelde mens; die ene 70-jarige die House te gek vindt, telt 
(helaas voor deze persoon) niet mee. 

• Welke tracks draaien we absoluut nooit? House, Hardrock, tot: welke ‘smartlap’  wel 
of niet. 

• Welke krachttermen mogen nog wel en welke niet? 

• Hoe lang mag een info-agenda zijn? Maximaal 3 minuten of bijvoorbeeld 15 
minuten? 

• Breken we een interview in meerdere stukken en hoe lang mogen de stukken dan 
zijn? 

 
Nadat de grenzen zijn vastgelegd, kan de week in stukken worden opgedeeld. We gaan 
er hier van uit dat er nog geen programma’s zijn, zodat we in dit stadium nog niet 
gehinderd worden door zaken als presentatoren die van tijdstip moeten veranderen of 
overgangen tussen verschillende onderdelen van de programmering. Ook verdelen we, 
om het overzichtelijk te houden, nog niet verder dan in stukken van een uur. 
 
We beginnen op maandag om middernacht en stellen ons de vraag wie op dit moment 
onze luisteraars (kunnen) zijn. Argumenten als ‘de werkende man/vrouw in 
ploegendienst’ gaan hier een rol spelen. Ook de uitgezapte TV-kijker telt nog even mee. 
Als voorbeeld nemen we een commercieel ingestelde omroep met een klein zendbereik 
die streeft naar zoveel mogelijk luisteraars. We kunnen op dit tijdstip stellen dat het 
grootste gedeelte van de jeugd en studenten niet luistert. De doelgroep 15 - 20 jaar is 
dus maar zeer beperkt aanwezig. Ook de doelgroep 65 en ouder, niet meer betrokken 
in het arbeidsproces, is maar beperkt aanwezig. We houden dus de groep 21 tot 65 over 
als belangrijkste groep. In welke verhouding we de aandacht over die groep verdelen is 
nu de vraag. Als we de groep verder opsplitsen, kan het navolgende ongeveer de 
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verhouding zijn. In de tabel houden we rekening met het feit dat oudere generaties (in 
dit voorbeeld) minder commerciële radio luisteren. 
 

Maandag 0:00 uur - 6:00 uur 
15-20 jaar  1 % van het mogelijke luister publiek  
21-30 jaar  40 % van het mogelijke luister publiek 
31-40 jaar  35 % van het mogelijke luister publiek 
41-55 jaar  20 % van het mogelijke luister publiek 
55-65 jaar 5 % van het mogelijke luister publiek 

 
Als we ervan uitgaan dat we een zo groot mogelijk publiek willen bereiken, lijkt een format 
verdeeld als hierboven de oplossing. Als we echter 5 % van de muziek richten op 55-65 
jaar, zal menig 25 jarige de knop omdraaien. Als we anderzijds de Top 50, geschikt voor 
21-30 jaar, 40 % van het format laten uitmaken, zal de 60 jarige vermoedelijk afhaken. 
Er zijn twee oplossingen: de eerste (en gemakkelijkste) oplossing is, dat men één van 
de doelgroepen laten vallen.  
 
Als tweede mogelijkheid kan men muziek uitzoeken die door een zo breed mogelijke 
doelgroep wordt gewaardeerd. Daarmee worden voornamelijk de bekende ‘golden 
oldies’ bedoeld, die ook de jongere doelgroep nog aanspreken. Zij zijn doorgaans 
aanmerkelijk kritischer dan de oudere doelgroepen. Muziek van de Supremes, de 
Beatles, kortom de ’Tour of Duty-oldie’ is geschikt;  maar met Vera Lynn heeft de 
gemiddelde 25-jarige daarentegen absoluut geen affiniteit. Tegenwoordig wordt er ook 
veel muziek gemaakt die breed gebruikt kan worden, zoals Hello van Adele. 
 
We kunnen stellen dat onze doelgroep tijdens de nacht niet wezenlijk verandert. Pas 
rond 6:00 uur wisselt ons luisterpubliek. Als we weer voor het volgende uur de potentiële 
groep luisteraars analyseren, komen we op het onderstaande overzicht. De 
publiekssamenstelling zou er als volgt uit kunnen zien. Vergeet echter niet uw eigen 
ervaring te gebruiken om een succes te maken van uw format. 
 

Maandag 6:00 uur - 7:00 uur 
15-20 jaar 15 % van het mogelijke luister publiek 
21-30 jaar 30 % van het mogelijke luister publiek 
31-40 jaar 28 % van het mogelijke luister publiek 
41-55 jaar  17 % van het mogelijke luister publiek 
55-65 jaar 10 % van het mogelijke luister publiek 

 

Maandag 7:00 uur - 8:00 uur 
15-20 jaar 25 % van het mogelijke luister publiek 
21-30 jaar 25 % van het mogelijke luister publiek 
31-40 jaar 25 % van het mogelijke luister publiek 
41-55 jaar  15 % van het mogelijke luister publiek 
55-65 jaar 10 % van het mogelijke luister publiek 

 

Maandag 8:00 uur - 9:00 uur 
15-20 jaar 20 % van het mogelijke luister publiek 
21-30 jaar 25 % van het mogelijke luister publiek 
31-40 jaar 25 % van het mogelijke luister publiek 
41-55 jaar  15 % van het mogelijke luister publiek 
55-65 jaar 15 % van het mogelijke luister publiek 

 
In bovenstaande uren is het van zeer groot belang om de extremen te beperken. De 
irritatiedrempel ligt aanzienlijk lager dan om 4:00 ’s nachts. Als er tijdens de nachturen 
drie maal per uur een onbekende oldie gespeeld wordt, die wel binnen de gewenste 



2025-05 Handleiding AerOn 

76 Broadcast Partners 

doelgroep valt, stemt de luisteraar doorgaans niet direct op een ander station af. In de 
ochtenduren lopen we hiermee een groter risico. De concurrentie is nu ook groter! 
 
De conclusies die we tot nu toe kunnen trekken voor ons muziekbestand is, dat er een 
onderscheid moet zijn tussen bekende, minder bekende en onbekende tracks, die we 
wel op de radio willen draaien. De extremen moeten uit het bestand of zodanig 
gecodeerd worden dat ze kunnen worden herkend als niet-speelbaar. Die muziek moet 
in doelgroepen worden ingedeeld, waarbij een gedeelte van de tracks als geschikt voor 
meerdere doelgroepen kan worden aangemerkt. 
 
Het tempo van een track is uiteraard ook van belang. Eén slow-track stoort niet veel 
mensen. Een te nadrukkelijk slow-format wordt echter wel snel saai gevonden tijdens 
het werk. Veel adverteerders richten zich op de werkende groep (ja, ook de 
huisman/vrouw werkt) en de daaraan gekoppelde uptempo muziek. Het tempo-criterium 
heeft nog een tweede functie. Een te extreme tempo-wisseling is ongewenst. Met name 
van uptempo naar een (zeer) slow intro geeft een stilvallend effect. Men raakt in de mood 
door een aantal vlotte tracks en vervolgens verandert de stemming. Dergelijke zenders 
schakelt men snel uit. In de latere ochtend, van 9:00 tot 11:00 uur, speelt dit een kleinere 
rol. Men luistert over het algemeen minder intensief op deze uren. 

8.2 Aan de slag met Formatplanner 

Voordat u met Formatplanner aan de slag kunt moeten de criteria, waarmee u uw 
radiostation en identiteit gaat profileren, zijn ingevuld bij de criteria-instellingen in AerOn. 
Vanzelfsprekend moeten ook muziektracks, jingles, station calls, etc… aanwezig zijn 
waaraan u de diverse criteria heeft toegekend.  
 
In de diverse hoofdstukken in deze handleiding wordt uitgelegd hoe u met behulp van 
multiselect-slepen uit Windows verkenner of File browser of met de database import 
module uw database kunt vullen en in combinate met Multi criteria editor de diverse 
criteria kunt toekennen aan de tracks. 
 
Als u na deze eerste fase uw database op orde heeft dan kunt u een start maken met 
het maken en invullen van uurformats aan de hand van de weekprogrammering die u 
samen met uw team heeft bedacht en uitgewerkt.  
 
Een uurformat is simpelweg een lijstje met criteriaregels dat niet tijdsgebonden is. U zult 
diverse uurformats maken die u vervolgens in dagformats plaatst. In een dagformat daar 
bepaalt u met iedere regel op welk tijdstip welk uurformat gepland zal worden. De 
dagformats worden op hun beurt door Formatplanner gebruikt om de playlists te plannen. 
 
Als u een eerste planning heeft gemaakt dan kunt u daarna gaandeweg de formats 
verder gaan verfijnen.  
 
Bjvoorbeeld de diverse planregels, de shuflle functie in de uurformats en ook de criteria-
scheiding-matrix kunt u daarbij als tools gebruiken. Afhankelijk van welke formatplanner 
u heeft aangeschaft.  
 
De diverse mogelijkheden worden verderop in dit hoofdstuk gedetailleerd uitgelegd. 
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8.3 Formatplanner modules 

In dit hoofdstuk worden alle mogelijkheden van Formatplanner beschreven. 
Formatplanner is beschikbaar in 4 verschillende niveaus. Hoe hoger het niveau, hoe 
meer mogelijkheden u hebt. Controleer vooraf over welke modules van Formatplanner 
u beschikt zodat u weet of u gebruik kunt maken van de beschreven mogelijkheden.  
 

Planregel / Functie Basis 
 

Xtra Xpert 

Criteria kolommen 
(exclusief Taal en Tempo) 

3 x 25 5 x 25 5 x 25 

Criteria selectie 1 vinkje onbeperkt 
aanvinken 

onbeperkt 
- aanvinken 
- alternatieven 
- uitsluiten 

Uurgetal (trackuurgetal) ✓ ✓ ✓ 

Herhaling titel en artiest ✓ ✓ ✓ 

Tempo-overgang ✓ ✓ ✓ 

Dagdeel ✓   

Weekdeel  ✓ ✓ 

Jaardeel ✓ ✓ ✓ 

Artiest uitsluiten ✓ ✓ ✓ 

Semi vaste items ✓ ✓ ✓ 

Instelbare planregels  ✓ ✓ 

Texture en mood   ✓ 

Criteria scheiding   ✓ 

Taal scheiding   ✓ 

Groepsamenstelling 
scheiding 

  ✓ 

Automix ✓ ✓ ✓ 

Shuffle  ✓ ✓ 

Grafieken van criteria   ✓ 

Dalet export   ✓ 

 
De basis voor formatplanning wordt gelegd in de uurformats. Hier geeft u per item de 
selectiecriteria op waaraan de te kiezen track moet voldoen. Het uurformat wordt later in 
dit hoofdstuk beschreven. 
 
De bovengenoemde planregels staan een verfijning van de selectie toe. Het instellen 
hiervan doet u in Databank editor en in de Formatplanner-Instellingen. In de volgende 
hoofdstukken worden de onderlinge verschillen tussen de bovenstaande modules kort 
beschreven. 
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8.4 Formatplanner basis 

Criteria kolommen 
Er zijn 3 kolommen beschikbaar voor het selecteren van de gewenste criteria. De eerste 

3 kolommen in Instellingen → Globaal → Criteria.  Daarnaast zijn de kolommen ‘Taal’ 
en ‘Tempo’ beschikbaar. 
 

Criteria selectie 
In elke kolom kan maximaal één criterium aangevinkt worden. 
 

Uurgetal (trackuurgetal) 
Het trackuurgetal gebruikt u om een onderscheid te maken tussen tracks die u vaker en 
minder vaak wilt horen. Het trackuurgetal geeft aan na hoeveel uur een track terug kan 
keren in een playlist die met Formatplanner wordt gepland. Tracks die frequenter 
gepland mogen worden geeft u een lager trackuurgetal, tracks die minder frequent 
mogen draaien geeft u een hoger trackuurgetal. Afhankelijk van de hoeveelheid tracks 
met dezelfde criteria kan het uiteraard met een groter aantal tracks wel langer duren 
voordat u de track effectief terugziet in een playlist. 
 
Algemene tips 
Als u weinig tracks beschikbaar heeft en u ze (te) hoge uurgetallen geeft, ontstaat er een 
conflict. Na verloop van tijd heeft Formatplanner geen tracks meer om te plannen. 
Stel: U heeft 2.250 tracks met een gemiddelde lengte van 4 minuten. De totale tijdsduur 
bedraagt 2.250 * 4 = 9.000 minuten = 9.000 / 60 = 150 uur. Het gemiddelde uurgetal 
moet dus lager dan 150 zijn. Minus nog een kleine marge omdat track wegens andere 
opgelegde beperkingen, zoals de weekdeel planregel en de overige planregels, soms 
niet geplaatst mogen. 
 
Formatplanner controleert bij iedere track en planmoment of die track gisteren of 
eergisteren in hetzelfde uur al staat om te voorkomen dat die track ook vandaag in 
hetzelfde uur wordt geplaatst. Formatplanner plaatst tracks met een marge van minimaal 
1 uur zodat die track daags na elkaar niet in hetzelfde uur komt.  
 
Het advies is om een veelvoud van 24 als uurgetal te vermijden. Voor een track met 
uurgetal 24 geldt namelijk dat u feitelijk toestaat dat de track iedere dag op exact 
hetzelfde tijdstip kan terugkomen. 
 
Aanbevolen is ook om binnen eenzelfde categorie uurgetallen +1 of -1 te differencieren 
zodat er een verloop binnen een categorie ontstaat. Bij een beperkte hoeveelheid tracks 
van een bepaalde categorie heeft u meer kans dat dezelfde track direct na het vertrijken 
van het ingestelde uurgetal terugkomt. Een track met uurgetal 0 kan ieder moment en 
meerdere keren per uurformat opnieuw gepland worden.  
 
Als een track niet automatisch door Formatplanner gepland mag worden kunt u in 
Databank editor ‘Planner’ beter uitvinken. Een goed voorbeeld zijn commercials.  
 
Ook bij tracks die telkens niet worden gespeeld kunt u ‘Planner’ beter uitvinken. Zeker 
als dezelfde tracks telkens door de DJ uit de playlist worden verwijderd of overgeslagen. 
Niet gespeelde tracks komen namelijk meteen terug in aanmerking om gepland te 
worden en krijgen een steeds hogere prioriteit naarmate de tijd verstrijkt. 
 
Andersom als u een track in de playlist sleept en afspeelt, kan die minimaal pas na het 
verstrijken van het uurgetal opnieuw door Formatplanner geselecteerd worden. 
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Herhaling titel en artiest 
Over het algemeen wilt u niet dat twee tracks van een artiest kort na elkaar in een playlist 
gepland worden. In de Formatplanner-instellingen geeft u aan na hoeveel tijd deze een 
track met dezelfde titel opnieuw mag plannen. Het kan voor u onduidelijk zijn of hier een 
conflict ontstaat bij tracks met een laag trackuurgetal, bijvoorbeeld hits en tips. Het is 
immers zo dat hit/tip tracks veelal een lager uurgetal hebben dan de herhalingstijd voor 
titel en artiest. Formatplanner houdt hier echter rekening mee en zal, in het geval het 
trackuurgetal lager is dan de herhalingstijd, voor titel en artiest het trackuurgetal als 
maatstaf nemen. 
 

Tip! De herhaling van een artiest bepaalt u door in Databank editor in het tabblad ‘Artiest’ 
het artiest-uurgetal per artiest in te stellen. 
 

Tempo-overgang 
In de uurformats kunt u aangeven wat het algemene tempo moet zijn van de te kiezen 
track. Dit garandeert echter geen vloeiende overgangen tussen de tracks. Het intro- en 
outrotempo kunnen verschillend zijn van het algemene tempo van de track als geheel. 
 
Daarom is er in de Formatplanner-instellingen de outro-intro-tempo-matrix beschikbaar. 
In de outro-intro-tempo-matrix vinkt u aan welke overgangen van outrotempo naar 
introtempo toegestaan zijn.  
 
De gemiddelde luisteraar ervaart een overgang van fast naar zeer slow (of zeer slow 
naar fast) als stilte op de radio. U vinkt dus beter af dat overgangen van fast naar zeer 
slow en zeer slow naar fast niet mogen voorkomen. 
 

Dagdeel 
Niet elke track is geschikt om elk uur van de dag te spelen op de radio. Bepaalde tracks 
zijn bijvoorbeeld ongeschikt om tijdens de middag of ’s avonds laat op de radio te 
draaien. In Databank editor kunt u voor elk uur van de dag aangeven of de track al dan 
niet door Formatplanner ingepland mag worden.  
 
Bij de standaardversie van Formatplanner kunt u  één instelling gebruiken voor de gehele 
week: de uren die u instelt bij de maandag gelden voor alle dagen van de week. Als u 
per weekdag de uren anders wilt instellen, dient u Formatplanner Xtra aan te schaffen. 
 

Jaardeel 
Niet elke track is geschikt om het hele jaar door te spelen op de radio. Typische zomer-
, winter-, kerst- en carnavalsplaten mogen alleen gepland worden in een door u 
aangegeven periode. Met ‘jaardeel’ kunt u deze periode exact instellen van dag tot dag 
van begindatum tot einddatum. 
 

Artiest uitsluiten 
Soms is het gewenst om bepaalde artiesten uit te sluiten om kort na elkaar gepland te 
worden, dit bijvoorbeeld als één of meer artiesten uit een groep zich na verloop van tijd 
aan solocarrières wagen, of een duo vormt of samenwerkt met andere artiesten.  
 
Het is immers ongewenst dat een track van een artiest vlak na een track van de band 
speelt waar hij deel van uitmaakt. In Databank editor kunt u daarom in het tabblad 
‘Artiest’ een aantal artiesten uitsluiten voor het plannen van een track. 
 

Tip! U hoeft artiesten niet over en weer uit te sluiten. Bijvoorbeeld, als u bij John Lennon 
de Beatles uitsluit, wordt bij de Beatles automatisch John Lennon uitgesloten. Op deze 
wijze kunnen per artiest meer dan vier uitsluitingen worden gerealiseerd. 
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Automatisch plannen 
Automatisch om 23u45 een playlist plannen indien er niet is gepland voor de volgende 
dag. 
 

Semi vaste items 
In Formatplanner is het mogelijk semi-vaste items te plannen. Tevens kunt u deze 
gebruiken in de playlist. Raadpleeg hoofdstuk 7 Playlist voor meer informatie over semi-
vaste items. 
 

Automix 
Met deze optie is het mogelijk om jingles onder een intro te plannen. 

8.5 Formatplanner Xtra 

Deze module voegt aan Formatplanner Semi vast toe: 
 

Criteria kolommen 
Er zijn 5 kolommen beschikbaar voor het selecteren van de gewenste criteria. Daarnaast 
zijn de kolommen ‘Taal’ en ‘Tempo’ beschikbaar. 
 

Criteria selectie 
In elke kolom kunnen meerdere criteria aangevinkt worden. 
 

Shuffle 
Uurformat-items gekenmerkt met Shuffle 1 - 4 kunnen per Shuffle groep random 
onderling van positie verwisselen zodat ieder uur een ander ‘geluid’ ontstaat binnen de 
gestelde criteria. 
 

Weekdeel 
Eerder heeft u gelezen over het gebruik van het dagdeel (zie hoofdstuk 8.3). Na verloop 
van tijd blijkt de indeling in dagdelen voor bepaalde tracks niet voldoende te zijn, zeker 
niet als uw doelgroep luisteraars varieert in de loop van de week. Met het weekdeel wordt 
het mogelijk om per weekdag aan te geven dat tracks enkel op geselecteerde uren 
gepland mogen worden. Zo kunt u nu ook ingeven dat tracks op bepaalde dagen 
helemaal niet gespeeld mogen worden. 
 

Instelbare planregels 
Als u Formatplanner Xtra aanschaft, vindt u in de Formatplanner-instellingen een aantal 
planregels terug. De hier beschreven planregels (uurgetal, herhaling titel, enzovoorts) 
zijn niet voor alle omroepen van even groot belang. U kunt zelf aangeven of 
Formatplanner er rekening mee moet houden en in welke mate. Er zijn drie categorieën: 
 

Unbreakable 
rule 

De planregel moet altijd gerespecteerd worden. 

Breakable rule De planregel moet gerespecteerd worden, indien mogelijk. 

Unused rule De planregel wordt niet gebruikt door Formatplanner. 

 
Planregels invullen 
In de Formatplanner-instellingen geeft u het belang van elke planregel aan. U kunt hier 
bepalen welke planregels ‘breakable’ of ‘unbreakable’ zijn. De belangrijkste maakt u 
‘unbreakable’. Elke gekozen track zal dan zondermeer voldoen aan de ingestelde 
‘unbreakable rules’. U kunt ook beslissen om bepaalde planregels niet te gebruiken; deze 
plaatst u in de kolom ‘unused rules’. Dit kunt u bijvoorbeeld gebruiken voor mood of 
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texture als de criteria voor mood en texture nog niet helemaal in de databank zijn 
ingevoerd.  
 
De planregels kunnen ook nuttig zijn als Formatplanner bij het plannen bijvoorbeeld vijf 
opeenvolgende items niet heeft kunnen vinden doordat u onmogelijke eisen stelt (zoals 
een japanse carnavalsplaat met doelgroep 56-99 en zeer slow tempo). Normaal gezien 
wordt de planning dan gestopt.  
 
Met behulp van de planregels kunt u dit probleem echter voorkomen: u kunt nu van het 
uurgetal een ‘breakable rule’ maken. Als  Formatplanner bij het plannen dan geen 
geschikte tracks meer vindt voor de ingegeven criteria, vervalt de planregel uurgetal en 
wordt opnieuw een geschikte track gezocht die aan het uurformat voldoet.  
 
Bij ‘breakable rules’ is de volgorde van de regels van belang. De belangrijkste regel zet 
u bovenaan in de kolom, de minst belangrijke onderaan. Zodra er geen tracks meer 
beschikbaar zijn voor Formatplanner, laat deze de eerst de bovenste breakable rule 
vallen en gaat vervolgens opnieuw kiezen. Vindt Formatplanner opnieuw geen track dan 
laat deze de volgende breakable rule vallen en gaat vervolgens opnieuw kiezen. 

8.6 Formatplanner Xpert 

Deze module voegt aan Formatplanner Xtra toe: 
 

Criteria kolommen 
Er zijn 5 kolommen beschikbaar voor het selecteren van de gewenste criteria.  
 
In de kolommen kunt u naast de aangevinkte criteria andere criteria als alternatief 
aangeven én u kunt ook aangeven dat u bepaalde criteria juist niet wil selecteren. 
Hieronder wordt dat meer gedetailleerd omschreven. 
 

Criteria selectie 
Bij het selecteren van de juiste tracks heeft u hier meer mogelijkheden: per criterium kunt 
u beter aangeven waar de track wel of juist niet aan moet voldoen: 
 

• U kunt meerdere criteria selecteren (u vinkt ‘tip’ en ‘hit’ aan om aan te geven dat de 
track aan minimaal één van beide criteria moet voldoen). 

• U kunt bepaalde criteria uitsluiten (u vinkt ‘rock’ aan en kruist ‘love song’ af om aan te 
geven dat de track een rockplaat moet zijn, maar geen love song); 

• U kunt alternatieven opgeven (u vinkt ‘golden oldie’ aan en maakt ‘oldie’ een 
alternatief om aan te geven dat u bij voorkeur een ‘golden oldie’ wilt, maar als die er 
niet is een ‘oldie’ toestaat). 
 

Met deze mogelijkheden bent u voldoende in staat om het format aan uw wensen en 
eisen aan te passen. Bij de selectie van taal kunt u bijvoorbeeld ‘Engels’ afkruisen om 
aan te geven dat elke taal behalve Engels is toegestaan. 
De alternatieven worden pas gebruikt als er met de ‘normale’ selectie door de planner 
geen keuze gemaakt kan worden. 
 

Texture en mood 
Texture geeft aan hoe de track is geproduceerd, terwijl ‘Mood’ de stemming aangeeft. 
Deze twee criteria zijn wat moeilijker te bepalen dan bijvoorbeeld de taal of het tempo 
maar maken een subtiele verfijning van het format mogelijk. Met behulp van texture en 
mood kan Formatplanner ervoor zorgen dat overgeproduceerde tracks bijvoorbeeld niet 
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achter elkaar spelen of dat de melancholie niet toeslaat door een reeks neerslachtige 
tracks te plannen. 
 

Criteria scheiding 
Bij de criteria die u niet actief gebruikt kunt u met de opties voor scheiding nog een 
verfijning in de playlists realiseren. Per criterium geeft u op hoeveel van deze tracks 
achter elkaar gepland mogen worden en hoeveel tracks zonder dit criterium er dan 
tussen moeten. Eventueel kunt u ook een maximum aantal opgeven dat in dit uurformat 
gepland mag worden. De Criteria scheiding is ook van toepassing op Shuffle items. Meer 
gedetailleerde informatie over ‘criteria scheiding’ vindt u in hoofdstuk 8.8. 
 

Taal scheiding 
Bij een aantal radiostations is het niet gewenst dat bijvoorbeeld Nederlandstalige tracks 
kort na elkaar spelen. In de Formatplanner-instellingen kunt u per taal opgegeven 
hoeveel van deze tracks met een bepaalde taal er direct opvolgend achter elkaar mogen. 
 
De scheiding tussen de tracks: na hoeveel tracks een track van een bepaalde taal 
opnieuw mag én een maximum aantal tracks met een bepaalde taal per uurformat.  
 
De Taal scheiding is ook van toepassing op Shuffle items. Met behulp van de scheiding-
matrix worden ook Shuffle items gescheiden. 
 

Groepsamenstelling scheiding 
Net als bij een scheiding tussen tracks in een bepaalde taal, is het vaak niet gewenst 
bijvoorbeeld duetten of solo zangeressen kort na elkaar spelen. In de Formatplanner-
instellingen kunt u per groepsamenstelling opgeven hoeveel van deze tracks er direct 
opvolgend achter elkaar mogen, de scheiding tussen de tracks: na hoeveel tracks een 
track met een bepaalde groepsamenstelling opnieuw mag én een maximum aantal 
tracks met een bepaalde groepsamenstelling per uurformat.  
 
De Groepsamenstelling scheiding is ook van toepassing op Shuffle items. Met behulp 
van de scheiding-matrix worden ook de Shuffle items gescheiden. 
 

Grafieken van criteria 
De hoeveelheid beschikbare tracks worden volgens de diverse toegewezen criteria 
weergegeven in een grafisch overzicht. 
 
Naarmate de formats complexer worden en u meer gebruik maakt van criteria als 
‘texture’ en ‘mood’ kan het handig zijn om een grafisch overzicht te hebben van de 
hoeveelheid beschikbare tracks volgens de diverse criteria. 
 

8.7 Formatplanning overzicht 

Start Formatplanner (via Tools → Formatplanner). 
Aan de linkerzijde van het venster is een navigatiebalk zichtbaar waarmee u kunt 
navigeren tussen de verschillende onderdelen. 
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We beschrijven ze hier in het kort: 
 
Uurformat: voor elk uur of willekeurig dagdeel maakt u een 
uurformat waarin aangegeven is welke soort muziek en jingles 
dan gepland moeten worden. 
 
Dagformat: voor elke dag (van de week) maakt u een 
dagformat waarin van uur tot uur (of andere willekeurige 
tijdstippen) de te gebruiken uurformats benoemd staan. 
 
Info: hier vindt u grafieken van de beschikbare tracks volgens 
een aantal criteria (Formatplanner Xpert). 
 
Planning: na het invoeren van de uur- en dagformats kunt u 
hier de playlists voor de komende dagen laten genereren. 
 
Instellingen: naast de uur- en dagformats zijn er enkele 
instellingen waarmee u het gedrag van de planner beïnvloedt. 

 

8.8 Instellingen 

De Formatplanner-instellingen heeft u bij het dagelijks gebruik van Formatplanner 
nauwelijks nodig, daarom staan ze onderin het venster. Bij de start zult u hier wel als 
eerste aan de slag moeten om e.e.a. juist in te stellen.  
 
De instellingen zijn verdeeld in verschillende niveaus. Bij Formatplanner basis kunt u 
gebruik maken van de algemene instellingen. Bij Formatplanner Xtra en Xpert zijn tevens 
de aanvullende instellingen en overige tabbladen te gebruiken. 
 

 
 

Herhaling titel Met deze instelling bepaalt u na hoeveel tijd een track met dezelfde 
titel gekozen mag worden (uren, minuten). Over het algemeen 
wordt dit ingesteld op enkele uren.  
 
Er zijn echter nummers die wel vaker gespeeld mogen worden, 
zoals ‘hits’. ‘Hits’ hebben in de databank over het algemeen dan 
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ook een lager trackuurgetal dan de herhaling titel. Met 
bovengenoemde instelling kan dit tot een conflict leiden. De 
Formatplanner lost dit op door enkel het trackuurgetal te 
respecteren bij de keuze van tracks als die een lager trackuurgetal 
hebben dan deze instelling. 
 

Automatisch 
plannen om 
23:45 

Sommige radiostations stellen het plannen van de playlist uit tot het 
laatste moment, bijvoorbeeld omdat er ’s avonds nog nieuwe tracks 
in het systeem zijn ingevoerd. 
 
Sporadisch kan het voorkomen dat men dan ook vergeet een 
planning aan te maken. Met deze nood-functie zal Formatplanner 
zelf een playlist proberen aan te maken voor de volgende dag als 
er om 23:45 nog geen playlist is. 
Formatplanner gebruikt voor de planning automatisch een 
dagformat waarin de naam van de weekdag voor komt. Zo kunt u 
bepalen dat voor iedere weekdag automatisch het juiste dagformat 
wordt genomen. Is er geen dagformat met een weekdagnaam, dan 
neemt Formatplanner het eerste uurformat in alfabetische 
vorgorde. 
 
U kunt deze functie slechts op één PC binnen het netwerk 
aanzetten.  
 

Sluit 
Formatplanner 
na automatisch 
plannen 
 

Het Formatplanner venster wordt gesloten het automatisch 
plannen is gelukt. 

Uurgetal 
plandatum reset 

Met deze instelling bepaalt u de drempel van het trackuurgetal bij 
het terugzetten van plandatums. Als u een playlist opnieuw plant 
terwijl er in de toekomst nog meerdere playlists aanwezig zijn, kunt 
u met deze optie ervoor zorgen dat enkel de plandatums worden 
teruggezet bij tracks met maximaal het uurgetal wat u hier instelt. 
Bij tracks met een hoger uurgetal en die verderop in playlists 
gepland zijn, blijft dan de plandatum behouden. 
 

Scheiding 
gisteren 
 

Standaard instelling is 1 uur.  Als een track gisteren om 12 uur is 
gepland zal die vandaag niet tussen 11 uur en 13 uur gepland 
worden. 
 

Toegestane 
tempo- 
overgangen 

Bij het plannen van de tracks houdt Formatplanner rekening met 
de overgang tussen uitrotempo van de ene track en introtempo van 
de andere track om al te bruuske overgangen te vermijden. Kruis 
hier de toegestane overgangen aan. In de afbeelding hierboven 
staat bijvoorbeeld een instelling waarmee u voorkomt dat u van 
‘slow’ naar ‘fast’ gaat en omgekeerd. Voor het invullen volgt u de 
richting van rij naar kolom. 

 
Formatplanner Xtra 
Planregels Met de muis sleept u de verschillende planregels naar één van de 

drie rules vlakken.  
 
De mogelijkheden voor het instellen van de plan regels hangen af 
van het niveau van Formatplanner. Meer informatie over de 
verschillende regels vindt u vanaf hoofdstuk 8.2. 
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Formatplanner Xpert 
Alternatieven 
toestaan 

Deze optie werkt bij Formatplanner Xpert. Bij een tekort aan tracks 
die aan de opgegeven criteria voldoen, maakt Formatplanner 
gebruik van de alternatieven die u in het uurformat heeft opgegeven 
om alsnog een track te kiezen. 

Dalet export Met deze optie kunt u de planningen direct naar een 
bestandsformaat exporteren dat door Dalet wordt herkend. 

 

 
 

Tip! Voor alle vijf de kolommen met criteria en de kolommen taal en samenstelling kunt 
u per kolom deze matrix apart invullen. Doorgaans zult dit instellen en gebruiken bij de 
criteria-items, de taal-items en de samenstelling-items die u niet expliciet invult in uw 
uurformats zodat u deze scheiding-matrix per uurformat daarmee kunt combineren. 
 

Max achter 
elkaar 

U geeft aan hoeveel tracks van het betreffende criterium opvolgend 
achter elkaar gepland mogen worden. Mag er van u een onbeperkt 
aantal tracks van een categorie opvolgend achter elkaar gepland 
worden, dan laat u deze waarde op 0 staan. Als deze waarde op 0 
staat spelen de volgende kolommen (scheiding en max per uur) 
geen rol. 
 

Scheiding Nadat u een track met dit criterium heeft gepland, mag dit criterium 
gedurende een aantal tracks niet terugkeren. Als u hier bijvoorbeeld 
3 invult, dan moeten er eerst 3 tracks met een andere criterium 
volgen voordat een track dit criterium weer geplaatst mag. De 
minimumwaarde voor dit veld is 1. 

Max per uur Hiermee beperkt u het totaal aantal tracks van dit criterium per 
uurformat. De waarde 0 geeft een onbeperkt aantal van dit type 
tracks per uur aan. 

8.9 Uurformat 

In de inleiding van dit hoofdstuk zijn de verschillende modules van Formatplanner 
beschreven. Hier beschrijven we de uurformats waarin u per regel (item) de criteria kunt 



2025-05 Handleiding AerOn 

86 Broadcast Partners 

invullen. Afhankelijk van Basis, Xtra of Xpert worden opties wel of niet toegepast tijdens 
het plannen. Een uurformat is feitelijk een vooraf samengestelde lijst met criteria-regels 
die niet tijdsgebonden is en in een dagformat kan worden geladen. 
 
De muzieksamensteller van een radiostation stelt vast hoe de muziekkeuze gedurende 
de dag is. Hiervoor stelt hij/zij een format op. De muziekkeuze kan van uur tot uur (of per 
half uur) verschillend zijn, maar ook tijdens langere periodes gedurende de dag hetzelfde 
blijven, bijvoorbeeld tijdens de nacht. De dag wordt dus in een aantal stukken opgeknipt.  
 
Voor elk stuk (meestal een uur) maken we een uurformat waarbij we voor de eerste track 
de criteria vastleggen, daarna voor de tweede track, de derde en zo verder. Een 
uurformat is feitelijk een lijst met achtereenvolgende items. De item defenitie in het 
uurformat bepaalt welke soort tracks er binnen de aangegeven criteria door 
Formatplanner wordt gekozen. Zodoende bepaalt u met de uurformats inhoudelijk het 
gehele format. 
 

 
 
In het linkerdeel van het venster bladert u door het uurformat. Afhankelijk van gemaakte 
keuzes volgt de weergave in het rechterdeel mee. 
 
Met de knoppen linksonder het uurformat kunt u items aan het uurformat toevoegen of 
ze er uit verwijderen.  
 
Met de knoppen rechtsonder bladert u door de uurformats en kunt u uurformats 
toevoegen of verwijderen. 
 
Uurformat kopiëren 
Als u een uurformat eenmaal heeft opgeslagen, dan kunt u dat uurformat kopiëren d.m.v. 

Opslaan als via menu Bestand. U geeft het kopie een andere naam en slaat het 
uurformat op. Daarna kunt u het nieuwe uurformat bewerken. 
 

Uurformat regel definitie 
 
In de kolom ‘Type’ heeft u de volgende keuzemogelijkheden: 

Criteria Selecteer een track aan de hand van criteria. 
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Track Geef een vaste track op. Sleep de gewenste track naar ‘vast item’. U 
kunt hiernaar toe slepen vanuit bijvoorbeeld Databank browser. 

U kunt hier ook een duur instellen.  Zo kunt u er bijvoorbeeld voor 
zorgen dat het nieuws altijd met dezelfde lengte wordt gepland. 

Extern Geef een bron met extern audio op, met een gewenste tijdsduur. 

Comm 1 .. 6 Commercialblok 1 t/m 6 uit Commercialplanner. 

 

Type Criteria 
Voor elke track (maar ook jingle of info-item) hebben we een aantal criteria beschikbaar 
waarmee we uit een bepaalde categorie selecteren. In Instellingen → Globaal → Criteria 
kunt u de 5 kolommen met criteria naar eigen inzicht indelen.  
 

Soort Songtypen zoals ‘tip’, ‘hit’, ‘current’, enzovoort. 

Extra Songcategorie zoals ‘pop’, ‘dance’, ‘rock’, enzovoort. 

Doelgroep 5 leeftijdscategorieën. 

Extra 4 Naar eigen inzicht te gebruiken. 

Extra 5 Naar eigen inzicht te gebruiken. 

 
Deze vijf criteria kolommen gebruikt u samen met taal en tempo om per uurformat-regel 
een track te selecteren die voldoet aan de door u gezette criteria-combinatie. 
 
De aankruisvelden hebben drie mogelijkheden: 
 

 De groene vinkjes geven aan waar de te selecteren track aan moet 
voldoen. Formatplanner kiest dan uit de muziekdatabank alleen die 
tracks waar de overeenkomstige criteria aangevinkt zijn. U kunt 
vanaf Formatplanner Xtra ook meerdere vinkjes in één kolom 
plaatsen. Meerdere vinkjes  in één kolom geven een OF-selectie 
aan, vinkjes in verschillende kolommen geven een EN-selectie aan. 

Als u vinkjes plaatst in meerdere kolommen dan moet aan de 
combinatie worden voldaan. Zijn er tijdens het plannen op moment 
van toepassen van de uurformat-regel geen tracks beschikbaar, die 
aan alle vinkjes voldoen, dan wordt de regel overgeslagen. 

Het formatplannerrapport toont alle overgeslagen regels zodra een 
planning is voltooid. Vandaaruit kunt u doorklikken naar de 
betreffende uurformat-regel. (Plan Checker optie) 

 (Formatplanner Xpert). Soms weet u op voorhand dat het aantal 
bruikbare tracks beperkt is en geeft u met een geel bolletje bij 
bepaalde criteria aan dat deze als alternatief geselecteerd mag als 
er niet voldaan kan worden aan de criteria-combinatie. De vinkjes 
in de kolom worden dan als het ware verruild met het alternatief. 

 (Formatplanner Xpert). Als laatste kunt u met een rood kruis 
aangeven dat tracks met dit criterium worden uitgesloten. 

 

Selectiekolommen 
In de eerste 5 kolommen heeft u te maken met criteria in de muziekdatabank waarvan u 
er meerdere kunt aanvinken. Het plaatsen van vinkjes en kruisjes is dan ook zinvol. Bij 
songtype zou u kunnen aangeven dat een ‘pop’-track gewenst is, maar geen ‘love song’.  
 
In de laatste 2 kolommen, taal en tempo, heeft u te maken met criteria in de 
muziekdatabank waarvan u er per track maar één kunt instellen. Een track is Engelstalig 
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of Nederlandstalig et cetera, maar nooit beide. Per uurformat kunt u er wel meerdere per 
kolom aanvinken. In plaats van ‘Taal’ en ‘Tempo’ aan te vinken kunt u ook besluiten om 
de criteria-taal-samenstelling-matrix in te vullen zodat format planner deze kan 
gebruiken voor taal en tempo. Of ook om bijvoorbeeld jaartal-criteria te scheiden. 
 

Bijvoorbeeld: U vinkt in de kolom ‘Songtype’ de opties ‘Current’ en ‘Recurrent’ aan. In 

de kolom ‘Tempo’ zet u een rood kruis bij ‘Medium’. Dit betekent dat de track die 
Formatplanner nu moet kiezen een ‘Current’ of ‘Recurrent’ track moet zijn en in elk geval 
geen medium tempo. Met kolommen waar niets is ingevuld wordt geen rekening 
gehouden. 

 

Type Track 
In plaats van selectiecriteria opgeven voor een track kunt u ook een vast item kiezen. Dit 
is bijvoorbeeld handig voor het programmeren van het nieuws of de verkeersinformatie 

aan het begin van het uur. Daarvoor sleept u het gewenste item naar het kader bij ‘Vast 
item’. Vult u bij ‘Duur’ niets in, dan neemt Formatplanner bij het maken van de playlist 
de werkelijke lengte van het item in de database.  
 
In het geval van nieuws kunt u hier beter de minimumduur van het nieuws invullen 
bijvoorbeeld 1m30s, zodat Formatplanner hier rekening mee kan houden in zijn planning. 
U zorgt er op die manier voor dat er aan het einde van het uur geen stilte zal zijn doordat 
het nieuwsbestand korter wordt.  
Formatplanner Xpert houdt geheel rekening met de weekmatrix zoals die in Databank 
editor is ingevoerd. Met hetzelfde uurformat op diverse uren in een dagformat kunt u er 
zo voor zorgen dat er bijvoorbeeld ’s nachts geen nieuws is maar overdag wel. 
Formatplanner Basis en Xtra nemen de maandag-instelling over voor alle overige dagen 
van de week. 
 

Type Extern audio 
Bij ‘Extern audio’ kunt u een externe bron (Raamprogramma) opgeven. Bij Duur vult u in 
hoe lang de externe bron moet spelen. 

 
Type Blok 1 .. 6 Commercialplanner 
Blok 1 t/m 6 zijn de commercialblokken 1 t/m 6 die in Commercialplanner beschikbaar 
zijn. Door deze keuzes in het uurformat op te nemen kunt u precies aangeven op welke 
plaats de commercials moeten komen. Bijvoorbeeld: direct na het nieuws op het hele 
uur, of pas na de jingle die daarna komt.  
 
Neemt u geen van deze mogelijkheden op in het uurformat, dan plaatst Formatplanner 
de commercialblokken volgens de in Commercialplanner ingestelde tijden in de playlist. 
U heeft dan beperkte controle over de plaatsing van een commercialblok in de playlist. 
Dat kan dan bijvoorbeeld tussen een jingle en een track zijn wat u misschien niet wenst. 
(Dit is de situatie voor bestaande gebruikers van AerOn die een upgrade hebben 
uitgevoerd en nog geen uurformats aangepast hebben). Gaat u de commercialblokken 
in het uurformat opnemen, dan moet u wel alle blokken in het uurformat opnemen.  
 
Laat de tijdinstelling van de blokken in Commercialplanner zo veel mogelijk aansluiten 
met de beoogde tijd in de playlist om zo het nadien exporteren van aangepaste 
commercialblokken mogelijk te maken. De Commercialplanner exporteert commercials 
naar de playlists op basis van tijd met een marge van 10 minuten t.o.v. de per 
commercialblok ingestelde bloktijd in de Commercialplanner-blokdefenitie. (Door het 
bewerken van de playlist kan e.e.a. namelijk opschuiven.)  Vindt Commercialplanner in 
de playlist een blok binnen de marge, dan wordt het gewijzigde commercialblok opnieuw 
tussen dezelfde tracks geplaatst. 
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Voor enkele van de overige kolommen heeft u het menu onder de rechter muisknop 
nodig. 
 

 
 

Doorstarten 
(Groep) 
 

Twee of meer items door Formatplanner gegroepeerd in de playlist 
laten zetten. Hiermee wordt in de playlist een doorstart gezet en 
een groep gevormd. 

Shuffle 1-4 (Formatplanner Xtra). Met de shuffle-optie kunt u hetzelfde 
uurformat gedurende de dag telkens anders laten klinken en toch 
binnen het format plannen. 

Er zijn vier shufflegroepen beschikbaar. Uurformatitems die als 
‘shuffle’ gemarkeerd zijn kunnen per shufflegroep onderling van 
positie wisselen en kunnen zo ieder uur in een andere willekeurige 
volgorde worden gepland. De shuffle selectie hoeft niet 
aaneengesloten te zijn. Jingles en overige vormgeving zult u 
doorgaans nooit shuffelen of samen shuffelen in een eigen 
shufflegroep, bijvoorbeeld shuffle 3.  

Tip! In combinatie met de scheiding-matrix voor criteria, taal en 
samenstelling (per categorie/ per track/ per uur) die beschikbaar is 
vanaf Formatplanner Xpert hanteert de Shuffle-functie ook de 
scheiding van criteria bij criteria waarbij de scheiding-matrix is 
ingesteld.  

Uitvullen De laatste items in het uurformat laat u hiermee uitvullen naar het 
einde van het uur. Dit is vaak nodig voor het laatste commercialblok 
‘comm 6’. 

Herstart format Bij een te kort uurformat springt de Formatplanner standaard terug 
naar het eerste item van het uurformat om een uur alsnog vol te 
plannen. Maar als op de eerste regel het nieuws staat, dan wordt 

dat nogmaals gepland. Met de optie Herstart format kunt u dit 
voorkomen en geeft u een andere plaats in het uurformat op waar 
naar toe gesprongen moet worden om alsnog het uur vol te 
plannen.  

Tip! U plaatst Herstart format beter op een item na nieuws, 
commercials of uuropener. Zo voorkomt u dat, aan het einde van 
hetzelfde uur, het nieuws en uuropener nogmaals worden 
ingepland. 

AutoMix (Formatplanner Playlist Semi-Vast) Wanneer je automix bij 
een item aanvinkt, kan een track, meestal een jingle, door 
Formatplanner automatisch onder outro/intro worden gemixt op 

basis van de algemene Automix instellingen. Instellingen → 
Globaal → Algemeen → Automix. 

Automix tracks ( meestal jingles ) worden gemixt volgens de 
Globale Automix instelling, die vervolgens wordt toegepast als de 
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outro en intro track, die onderdeel uitmaken van de gehele mix, in 
de database feitelijk ook een outro en/of intro hebben. 

Tip! Om items als Automix te kunnen plannen moet de Mix mode 
zijn ingesteld bij tracks die voldoen aan de selectie-criteria in de 

uurformatregel. De Mix-mode moet zijn ingesteld op Mix mode 
Automix of Mix mode Default en Automix.  Zie Mix mode in 
Databank editor op het tabblad Editor.  

Aantal Als u onderaan de knop ‘Aantal’ of als u de kolomheader aanklikt, 
gaat AerOn het aantal berekenen en ziet u daarna hoeveel tracks 
er in de databank aanwezig en beschikbaar zijn met de door u 
ingestelde criteria-combinatie. Met beschikbaar wordt bedoeld dat 
‘Planner’ in Databank editor is aangevinkt. Met een aantal 
kleurvarianten rood wordt zichtbaar gemaakt dat er weinig of zelfs 
heel weinig tracks aanwezig zijn die voldoen aan de criteria-
combinatie. Er wordt hierbij geen rekening gehouden met weekdeel 
of jaardeel. 
 
Weinig tracks hoeft overigens geen probleem te zijn bij tracks met 
een laag trackuurgetal. De kleuring is meer een leidraad om de 
aandacht daarop te vestigen. 

 
Herstart format 
De optie Herstart format wordt toegepast als een uurformat te kort blijkt. Een uurformat 
met vijf items of met slechts één item is toegestaan. In de praktijk bestaan uurformats 
vaak uit 20 tot 25 items.  Formatplanner zal standaard verder gaan met het eerste item 
uit het uurformat als dat te kort blijkt. U heeft bijvoorbeeld een uurformat met daarin 5 
items. Dit format gebruikt u om één uur muziek te plannen. Nadat het vijfde item uit het 
format is gebruikt, heeft  Formatplanner nog maar 20 minuten gepland. Dit is dus niet 
genoeg om een uur te vullen. Formatplanner kiest dan de zesde track van het uur 
volgens de criteria van het eerste item van het format en gaat zo verder totdat het uur is 
volgepland.  
 
Bij welk item Formatplanner opnieuw begint bij een te kort uurformat kunt u beïnvloeden 

met de optie ‘Herstart format’ zoals op de vorige pagina beschreven staat. Hiermee 
kunt u voorkomen dat het nieuws of een uuropener in hetzelfde uur nogmaals 
geselecteerd worden. 
 
Het uurformat kunt u langer maken dan het aantal tracks dat u in een uur verwacht. Dit 
heeft geen consequenties. Zijn er in het format maar 18 tracks nodig om een uur te 
vullen, dan stopt Formatplanner daar. Het 19e en 20e item worden dus niet benut (er 
wordt geen overbodige track gepland).  
 

Tip! Tracks die wel zijn gepland, maar die niet worden gespeeld komen met verhoogde 
prio meteen weer in aanmerking bij de eerstvolgende planning. Bijvoorbeeld doordat ze 
uit de playlist worden verwijderd of in de extra tijd terecht komen, Zodra een track wel 
wordt gespeeld dan wordt bij de eerstvolgende planning het uurgetal toegepast. 
 
Extra tijd 
 
Per uurformat kunt u extra tijd instellen en zo extra tracks laten plannen.  

 
Tijdens live-uren overdag, waarbij tracks soms ingekort worden, heeft u meer muziek 
nodig dan ’s nachts of overdag als AerOn nonstop draait. Deze optie kunt u ook 
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gebruiken voor het inplannen van extra tracks (als nood format) vlak na een externe 
internetstream. Mocht de stream uitvallen, dan gaat AerOn verder met deze extra tracks 
in de playlist. 
 
Texture en Mood 

Vanaf Formatplanner Xpert kunt u gebruik maken van de criteria ‘Texture’ en ‘Mood’. 
Met deze optie kunt u binnen een uurformat tracks plannen met een bepaalde energie 
en stemming. Waar het hier om gaat, is het neerzetten van een bepaalde sfeer tijdens 
het uur waarvoor u dit format gebruikt. Met de schuifbalken bovenin het venster geeft u 
aan in welk bereik de gemiddelde texture en mood van 3 achtereenvolgende tracks 
steeds dienen te liggen. 

 
Afdrukken en opslaan als bestand 

Een overzicht van een uurformat kunt u op de printer afdrukken door Bestand → 

Afdrukken. Via Bestand → Afdrukvoorbeeld kunt u het laten weergeven en opslaan 
als bijvoorbeeld pdf. Een voorbeeld afdruk van een uurformat ziet er als volgt uit: 
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8.10 Dagformat 

 
 
In een dagformat geeft u feitelijk aan hoe een dagplanning er in totaliteit uit gaat zien. 
De uurformats bepalen de muziekkeuze van Formatplanner gedurende het verloop van 
de dag. In het dagformat bepaalt u de volgorde en start van ieder uurformat. 
 
U kunt volstaan met één dagformat als de programmering elke dag gelijk is, maar 
doorgaans zult u voor elke dag van de week een dagformat aanmaken. Het zal duidelijk 
zijn dat een goede naamgeving het gebruik van de dagformats vereenvoudigt naarmate 
u er meer aanmaakt. 
 

Tijd Dit is het tijdstip waarop het gekozen uurformat actief wordt in de 
playlist. Dit kan iedere willekeurige tijd zijn, maar meestal beginnen 
uurformats op het heel of op het half. Ieder tijdstip opgegeven in het 
dagformat bepaalt de starttijd van het eerste item gekozen uit het 
uurformat en bepaalt tevens waar het voorgaande uurformat stopt. 
Iedere tijd die u in het dagformat instelt bepaalt dus waar het 
voorgaande uurformat ophoudt en een nieuw uurformat begint. Met 
het laatste uurformat in een dagformat plant Formatplanner altijd 
tot 24:00 uur (einde van de dag). 

Mode Met deze optie geeft u aan of het eerste item van een uurformat 
gepland gaat worden met een vaste, semi-vaste of glijdende 
begintijd. Uurformats met de mode vast of semi-vast delen de 
playlist op in blokken. Iedere gebruiker kan een eigen blok 
bewerken zodat meerdere gebruikers tegelijkertijd een playlist 
kunnen bewerken. Het allereerste item in een playlist heeft altijd 

een vaste of semi-vaste begintijd. Meer informatie over ‘vast’, 
‘semi-vast’ en ‘glijdend’ vindt u in hoofdstuk Playlist. 

Uurformat U geeft hier op welk uurformat door Formatplanner gebruikt moet 
worden voor de muziekkeuze. 

Bewerken 
Met de knoppen linksonder in het dagformat kunt u items aan het dagformat toevoegen 
of ze er uit verwijderen. Met de knoppen rechtsonder bladert u door de dagformats en 
kunt u dagformats toevoegen of verwijderen. 
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Dagformat snel vullen 
Wanneer u achtereenvolgens 24 lege regels (of meer) toevoegt aan een dagfomat kunt 
u meerdere regels selecteren en vervolgens d.m.v. een rechtsklik die regels ineens 
invullen. 
 
Dagformat kopiëren 

Als u een dagformat heeft gemaakt, dan kunt u dat dagformat kopiëren d.m.v. Opslaan 
als via menu Bestand. U geeft het kopie een andere naam en slaat het dagformat op. 
Daarna kunt u het nieuwe dagformat bewerken. 
 
Afdrukken en opslaan als bestand 

Een overzicht van een dagformat kunt u op de printer afdrukken door Bestand → 

Afdrukken of via Bestand → Afdrukvoorbeeld weergeven en opslaan als bijvoorbeeld 
pdf. 
 

8.11 Info (Formatplanner Xpert) 

Met Formatplanner Xpert kunt u in het tabblad ‘Info’ meer informatie krijgen over de 
criteria van de ingevoerde tracks in de databank. Het berekenen van de verschillende 
grafieken kan enige seconden duren, afhankelijk van de grootte van de database. U ziet 
enkel een overzicht van de actieve tracks omdat dit de tracks zijn die door de planner in 
een playlist gepland kunnen worden. 
 

 
 

Naast het overzicht met de kolom ‘Aantal’ in het uurformat is het infovenster een goed 
hulpmiddel om te kijken of u met de ingestelde criteria en uurformats wel in staat bent 
om een goede playlist te laten maken. 
 

De grafieken kunt u ook afdrukken via het menu Bestand → Afdrukken. 
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8.12 Planning 

Als u het tabblad Planning opent, ziet u aan de linkerzijde een kalender die de komende 
zes maanden toont. Hier selecteert u een begin- en einddatum waarna deze in de lijst 
aan de rechterzijde geplaatst worden. U kunt meerdere dagen tegelijk selecteren door 
met de muis over de kalender te slepen.  
 
Formatplanner kijkt in de beschikbare dagformats of er een dagformat is waar de naam 
van de weekdag in voorkomt. Als dat het geval is, wordt dat dagformat meteen 
voorgesteld in de planlijst, zoals te zien is in het schermvoorbeeld. Eventueel kunt u in 
de planlijst een ander dagformat kiezen. 
 

 
 

Zodra u op Start drukt, begint Formatplanner automatisch met een analyse van de 
databank. Daarna worden achtereenvolgens de opgegeven data gepland. In de 
statusbalk ziet u de voortgang. 
 
Tijdens het planproces wordt van elke track in de muziekdatabank bijgehouden wat de 
laatste datum en tijd zijn waarop het item is gepland. Deze plandata moeten teruggezet 
worden naar het verleden om het mogelijk te maken dat u voor de gewenste dag een 
playlist aanmaakt. Wilt u dat niet, dan kan Formatplanner geen playlists genereren. 
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Een playlist die niet aan uw verwachtingen voldoet of waarin een verandering is gebeurd, 
kunt u opnieuw laten plannen. In dat geval geeft Formatplanner een melding dat de 
playlist al bestaat. Als u doorgaat verschijnt de melding dat er reeds is gepland voor dat 
tijdstip en vraagt Formatplanner of de plandata aangepast moeten worden. Zodra u de 
plandata heeft teruggezet (om een dag overnieuw te plannen), moet u eigenlijk de 
aansluitende dagen ook opnieuw plannen om er zeker van te zijn dat uurgetallen, 
herhaling titel en herhaling artiest gerespecteerd blijven. 
 

Na afloop van het planproces kunt u een datum selecteren in het kader ‘Planning’. Door 
op het playlist-icoon in de taakbalk te klikken, wordt de playlist van de geselecteerde dag 
geopend. 
 
Tracks die gepland zijn, maar uiteindelijk in de uitzending niet gespeeld worden, die 
komen direct terug in aanmerking om opnieuw gepland te kunnen worden. 
 

8.13 Plan checker 

Playlist analyse 

De Plan checker is o.a. geïntegreerd in de playlist.  Deze kunt u openen door met de 
rechter muisknop te klikken op de titelbalk van de playlist met Artiest/Titel etc.. en 

vervolgens kiest u in het Header-menu de Plananalyse-optie. In het Playlist-menu 
komen er dan een tweetal menu-opties bij en worden er daarnaast een aantal extra 
kolommen zichtbaar. 
 
Het samenstellen van uurformats, invullen van criteria in de muziekdatabank en bepalen 
van (un)breakable rules is een proces dat veel tijd en aandacht vraagt. Nadat een playlist 
is gepland, vraagt u zich soms af hoe Formatplanner tot die specifieke trackkeuze is 
gekomen. Waren er te weinig tracks met het criterium ‘recurrent’ of zijn er geen uptempo 
Franstalige (o.i.d.) tracks? 
 
Extra opties in het playlist-menu 
 

 
 

Uurformat Hiermee kunt u het uurformat openen waarmee de track is gepland. 

Alternatieven Als u deze menu-optie aanklikt wordt in Databank browser een filter 
gezet met de selectie-criteria waarmee de playlist-track is gepland 
zodat u snel een andere track kunt selecteren binnen dezelfde 
selectie-criteria. 

 
Extra playlist kolommen 

 
 



2025-05 Handleiding AerOn 

96 Broadcast Partners 

Aantal Het aantal tracks dat voldoet aan de criteria-combinatie in de 
uurformat-regel.  

Bij nadere inspectie van de aantallen in de playlist en uurformats 
zal het over het algemeen zo zijn, dat de aantallen in de playlist 
lager zijn dan het aantal weergegeven in een uurformat. Dit komt 
doordat er op het moment van plannen rekening wordt gehouden 
met week- en jaarindeling en bijvoorbeeld ook herhaling van titel en 
artiest enzovoort. Deze aantallen worden tijdens de planprocedure 
in de extra analysekolommen in de playlist gezet. 

Bij het berekenen van het aantal tracks in een uurformat wordt 
enkel rekening gehouden met de criteria-combinatie omdat een 
uurformat per definitie niet tijd gebonden is. 

 

Alter Het aantal tracks dat voldoet aan de criteria-combinatie in het 
uurformat, met gebruikmaking van alternatieven. 

Uurformat Naam van het uurformat waarmee dit item is gepland. 

Index Volgnummer van het item in het uurformat. 

 
Als u met de rechter muisknop op een item in de playlist klikt, kunt u via de menu-optie 

‘Uurformat’ direct naar het juiste item in het uurformat springen om de criteria eventueel 
aan te passen als u niet tevreden bent over de songkeuze. 
 
Als u een track in een playlist sleept zal AerOn controleren of diezelfde track al in die 
playlist staat. 
 

Formatplanner analyse 

Een andere plananalyse-tool is beschikbaar via menu Tools → Formatplanner 

analyse. Sneltoets CTRL+ALT+F Hierin ziet u op welke dagen en uren een track 

gepland is. Standaard gaat het overzicht terug tot twee weken geleden, maar het filter 
kan eenvoudig uitgezet met het vinkje linksonder of aangepast worden met de knop 
Customize. Door te dubbelklikken op een cijfer wordt de playlist van die dag geopend 
voor nadere inspectie. Deze tool volgt automatisch mee met de geselecteerde track in 
bijvoorbeeld playlist of Databank browser. 
 

 
 

Formatplanner rapport 
Na het voltooien van een planning geeft Formatplanner in een rapport weer bij welke 
uurformat items er geen track gekozen kon worden. Vanuit dit venster kunt u direct 
doorkliken naar de betreffende uurformat-regel. Als u Automatisch volgen aanvinkt, dan 
navigeert Formatplanner automatisch mee naar de betreffende uurformat-regel als u 
door het Formatplanner-rapport navigeert. 
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9 Commercialplanner 

Commercialplanner kunt u openen via het menu Tools → Commercialplanner. Of 
sneltoets CTRL+SHIFT+C 

 
Aan de linkerzijde van het venster is een navigatiebalk zichtbaar waarmee u kunt 
navigeren tussen de verschillende onderdelen. 
 

 

We beschrijven ze hier in het kort. Verder in dit hoofdstuk 
worden de onderdelen in meer detail besproken. 
 
Klant: zodra u een opdracht ontvangt voor een 
reclamecampagne vult u hier de gegevens van de klant in. 
 
Campagne: hier voert u de gegevens van de betreffende 
campagne in (deze neemt u niet op bij de klant omdat een klant 
meerdere campagnes kan hebben). 
 
Planning: na het invoeren van één of meer 
reclamecampagnes kunt u hier de campagne automatisch 
laten plannen. 
 
Dagoverzicht: geplande radiocampagnes kunt u terugzien in 
het dagoverzicht. 
 
Instellingen: er zijn diverse instellingen waarmee u ondermeer 
ingeeft wanneer er een commercialblok in de programmering 
van het radiostation is opgenomen. 
 
Het onderdeel ‘Instellingen’ ziet u onderaan in de navigatiebalk. 
Als u Commercialplanner voor het eerst gebruikt zult u hier 
moeten starten. Hier geeft u namelijk op wat wel en niet mag. 

9.1 Instellingen 

 
De Commercialplanner-instellingen zijn onderverdeeld in verschillende subcategorieën 
die hieronder één voor één beschreven zijn. 
 

9.1.1 Algemeen 
 
In de groep ‘Algemeen’ vindt u een aantal globale instellingen. 
 
Maximum aantal 
items per uur 

Hier stelt u in hoeveel commercials er in totaal per uur gepland 
mogen worden. Het maximaal aantal commercials per uur is 
standaard 90. Jingles en reminders worden niet meegeteld. 
 
Bijvoorbeeld: als er 3 commercialblokken in een uur geplaatst 
worden, zal het totaal aantal commercials dat in deze 3 blokken 
uitgezonden wordt, bij elkaar opgeteld niet meer bedragen dan het 
ingestelde maximum aantal items per uur.  
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In Commercialplanner Xtra stijgt het maximaal instelbaar aantal 
items per uur automatisch mee als Max. aantal commercials per 
blok hoger wordt ingesteld. 
 
 

Maximum aantal 
commercials  
per blok 

(Commercialplanner Basis). Hier stelt u algemeen in hoeveel 
items in elk blok gepland mogen worden. Maximaal instelbaar 
aantal items per blok is 15.  
 

Tip! In Commercialplanner Xtra kan het maximaal aantal items per 
blok per blok ingesteld in de Standaard weekindeling om piek en 
dal uren te kunnen creëren. Zie verderop voor meer info hierover. 

 
 

Commercialplanner Xtra 
 

 
 

Maximum 
aantal 
commercials 
per blok 

(Commercialplanner Xtra). Hier stelt u algemeen in hoeveel items 
in elk blok gepland mogen worden. Maximaal instelbaar aantal 
items per blok is 75.  
 

 
Stem conflict 
toestaan 

(Commercialplanner Xtra). De planner plaatst standaard niet 
meer dan één commercial, die door dezelfde persoon is 
ingesproken, in een blok. Als deze optie aangevinkt is, kunnen twee 
commercials ingesproken door dezelfde persoon in hetzelfde blok 
geplaatst.  De autoplanner zal nooit meer dan 2 commercials met 
dezelfde inspreekstem in een blok plannen. 
 

Branche conflict 
toestaan 

(Commercialplanner Xtra). De planner plaatst standaard niet 
meer dan één commercial van een bepaalde branche in een blok. 
Als deze optie aangevinkt is, kunnen door de planner maximaal 
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twee commercials van dezelfde branche in één blok geplaatst 
worden.  
 

Dalet export (Commercialplanner Xtra). Met deze optie kunt u de planning 
direct naar een bestandsformaat exporteren dat door Dalet wordt 
herkend. Meer details hierover vindt u op de volgende pagina’s. 

RCS Traffic 
export 

(Commercialplanner Xtra). Met deze optie kunt u planning 
direct naar een bestandsformaat exporteren dat door de RCS 
Traffic software wordt herkend. Meer details hierover vindt u op de 
volgende pagina’s. 

Traffic 2000 
export 

(Commercialplanner Xtra). Met deze optie wordt de planning 
geëxporteerd in een formaat dat compatibel is met de uitvoer van 
Traffic 2000. Meer details hierover vindt u op de volgende pagina’s. 
 

E Power export (Commercialplanner Xtra). Met deze optie wordt de planning 
geëxporteerd in een formaat dat compatibel is met de uitvoer van 
‘E Power’. Enkel de inhoud van ‘E Power’ import blokken, 
herkenbaar aan een paarse kleur, wordt geexporteerd. 

 

Export naar 
bestand: 
Exporteer 
commercials 
inclusief jingles 
 

(Commercialplanner Xtra). Als deze optie aan staat worden 
commercials en jingles geexporteerd. Anders worden enkel 
de commercials geexporteerd. 

Export naar 
playlist: gebruik 
weekdag-
playlist als 
datum-playlist 
niet bestaat 

(Commercialplanner Xtra). Bij editiesystemen wordt op de 
slave-stations gewerkt met extern audio waarbij het programma 
van het hoofdstation via externe audiobron overgenomen wordt. De 
playlists zien er in het algemeen voor elke dag hetzelfde uit en 
moeten enkel voorzien worden van de nieuwe commercials.  
 
Met deze optie volstaat het aanmaken van 7 basis-naamplaylists 
(genaamd maandag t/m zondag).  
 
Tijdens het exporteren zal Commercialplanner deze templates 
gebruiken om commercials in datumplaylists op te slaan. 
 

Split Extern 
Audio 

(Commercialplanner Xtra). Extern audio in de playlist wordt 
standaard opgesplitst tijdens het exporteren van commercials. 
Deze optie kunt u eventueel uitvinken.  
 

Aantal items per 
blok limiet 

(Commercialplanner Xtra). De ‘Aantal items per blok limiet’ is 
standaard 15. Deze is instelbaar in stappen van 15, 30, 45, 60, 75.   
Deze optie bepaalt de limiet van het maximale aantal commercials 
per blok.  Bij de blokinstellingen kan in de standaard weekindeling 
het Max items per blok worden ingesteld tot aan deze limiet. 
 
Deze optie is met name voor ‘E Power’ import om meer items dan 
de standaard 15 per blok te kunnen importeren. Het maximaal 
instelbaar aantal items per uur en Max items instelbaar per blok 
verhoogt automatisch mee met deze optie.  
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Export offset 
bloktijd in playlst 

(Commercialplanner Xtra). Standaard is de export bloktijd 
offset 9 minuten. Met deze optie kunt u de export offset instellen 
tussen 1 en 20 minuten. 
 
Commecialplanner exporteert blokken altijd op basis van de bloktijd 
die per blok is ingesteld in de Standaard weekindeling.  
 
Omdat bij het bewerken van de playlist de commercialblokken in 
tijd kunnen verschuiven wordt deze offset toegepast om tijdens het 
exporteren de commercialblokken, die reeds in de playlists 
aanwezig zijn, te matchen.  
 
De commercial planner kijkt t.o.v. de ingestelde bloktijd of er 9 
minuten terug of 9 minuten verderop reeds een commercialblok in 
de playlist staat. Dit wordt toegepast bij glijdende 
commercialblokken. Vindt Commercialplanner in de playlist een 
commercialblok binnen de offset, dan vervangt Commecialplanner 
dat blok met het gewijzigde commercialblok en plaatst dat blok 
tussen exact dezelfde tracks.   
 
Vindt Commercialplanner binnen de offset tijdspanne geen 
commercialblok in de playlist, dan wordt een commercialblok altijd 
op basis van de ingestelde bloktijd in de playlist geplaatst. 
 

Tip! Het is aanbevolen om ervoor te zorgen dat 
commercialblokken zijn gevuld met minimaal 1 item als playlists 
worden gepland.  Op deze wijze is er altijd een commercialblok in 
de playlist aanwezig wat dan juist gematcht kan worden tijdens een 
commercialplanner export. 

 
Alle blokken 
aanzetten bij 
toevoegen van 
een nieuwe 
campagne 

Met deze optie wordt bepaald of bij het toevoegen van een nieuwe 
campagne alle blokken 1 t/m 6 voor de gehele week worden 
aangezet. 

 
Bij een E Power 
import de tracks 
opruimen die 
niet meer in 
campagnes 
staan. 

 
Met deze optie wordt bepaald of bij de start van een ‘E Power’ 
commercial import, de ‘E Power’ tracks worden opgeruimd die niet 
meer in campagnes staan. 
 
De ‘E Power’ tracks met een naamgeving als ‘COMMERCIAL - 
1908630’ en niet meer in de commercialplanner staan, worden dan 
voorafgaand aan de nieuwe import verwijderd uit de muziek 
database. Daarna kunt u indien gewenst, met Beheer de bestanden 
van uw harddisk verwijderen. 
 

Logging Als u deze optie actieveert wordt het plan proces naar bestand 
gelogd. Dit kan helpen om problemen op te sporen. 

 

Tip! Het wijzigen van deze instellingen heeft pas invloed als u de volgende keer één of 
meer campagnes plant. Dat wil zeggen: Als het maximum aantal commercials per blok 
was ingesteld op 15 en u verandert dit naar 12, dan kan het nog zijn dat er 
commercialblokken in het dagoverzicht aanwezig zijn met 13, 14 of 15 commercials. 
Deze restrictie wordt pas in acht genomen als u opnieuw campagnes gaat plannen. Pas 
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als alle beschikbare campagnes opnieuw gepland zijn, zullen de hier opnieuw ingestelde 
blokregels voor alle campagnes gerespecteerd zijn in het dagoverzicht. 
 
Blokinstellingen 
Met de blok-instellingen kunt u zeer creatief te werk gaan. 
Bijvoorbeeld, U wilt de commercialblokken het liefst zo gelijkmatig mogelijk opvullen. 
Hiervoor verlaagt u het maximum aantal campgnespots (items) per blok. Naarmate er 
meer campagnes bij komen verhoogt u het aantal per blok om deze volledig te plannen. 
U verhoogt dan bij een select aantal blokken het aantal items per blok. Na deze 
verhoging zal het aantal commercials per blok en per uur naar verwachting redelijk 
constant blijven. De instelling maximum aantal items per uur moet minimaal gelijk zijn 
aan 6x het totaal aantal items per blok om zes blokken per uur volledig vol te maken. 
 
Ander voorbeeld: In een drukke periode lukt het u niet meer om een aantal campagnes 
te plannen wegens brancheconflicten. U plant eerst de campagnes die absoluut niet in 
hetzelfde blok mogen komen. Daarna staat u in de instellingen branche conflicten toe en 
plant u de overige campagnes. Vervolgens zet u de branch conflict optie weer uit. 
 
 

Dalet export 
 
De Dalet export plaatst de exportbestanden in de map die u in de instellingen 

aangegeven hebt bij ‘Dalet export’. Het formaat waarin geëxporteerd wordt, is een ascii-
formaat waarbij elke commercial of jingle op één regel staat. De bestandsnaam van het 
tekstbestand heeft de volgende vorm: DDMMJJ.asc (bijvoorbeeld 140204.asc). De 
indeling van iedere regel in het tekstbestand ziet er als volgt uit: 
 

Positie Betekenis 
1 .. 8 Tijdstip: UU:MM:SS 
9 Spatie 
10 .. 39 Titel van de commercial (uit de databank) 
40 .. 69 Artiest van de commercial (uit de databank) 
70 Spatie 
71 .. 78 Bestandsnaam van de commercial zonder extensie 
79 Spatie 
80 + 81 Lengte van het item in seconden (afgerond) 

 

 
 
 

RCS Traffic export 
 
De RCS Traffic export plaatst de exportbestanden in de map die u in de instellingen 

aangegeven hebt bij ‘RCS Traffic export’. Het formaat waarin geëxporteerd wordt, is 
een ascii-formaat waarbij elke commercial of jingle op één regel staat. De bestandsnaam 
van het tekstbestand heeft de vorm: MMDDJJS2.log (bijvoorbeeld 021404S2.log). De 
indeling van iedere regel in het tekstbestand ziet er als volgt uit: 
 

Positie Betekenis 
1 C = commercial indicator 
2 .. 8 Tijdstip: UUMM:SS 
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9 .. 12 Bestandsnaam van de commercial zonder extensie 
13 .. 36 Artiest en titel van de commercial (uit de databank) 
37 .. 39 0000 = niet gebruikt 
40 .. 43 Lengte van het item in seconden (afgerond) 
44 + 45 CM = commercial 
46 .. 67 Spatie = niet gebruikt 

 

 
 
Traffic 2000 export 
 
De Traffic 2000 export plaatst de exportbestanden in de map die u in de instellingen 

aangegeven hebt bij ‘Traffic 2000 export’. Het formaat waarin geëxporteerd wordt, is 
een ascii-formaat waarbij elke commercial of jingle op één regel staat. De bestandsnaam 
van het tekstbestand heeft de vorm: DDMM.asc (bijvoorbeeld 1402.asc). De indeling van 
iedere regel in het tekstbestand ziet er als volgt uit: 
 

Positie Betekenis 
1 .. 25 Titel van de commercial (uit de databank) 
27 ..58 Artiest van de commercial 
60 .. 108 Bestandsnaam van de commercial zonder extensie 
120 + 121 Jaar 
123 + 124 Maand 
126 + 127 Dag 
129 .. 136 Tijdstip: UU:MM:SS 

 
 

 
 
E Power export 
 
De E Power export plaatst de exportbestanden in de map die u in de Commercialplanner-
instellingen hebt aangegeven bij ‘E Power export’. Het formaat waarin geëxporteerd 
wordt is een ascii-formaat waarbij iedere commercial of jingle op één regel staat. De 
bestandsnaam van het tekstbestand heeft de vorm: JJMMDD.asc (bijvoorbeeld 
250214.asc). 
 
AerOn - E Power format 
 

Field Required Format StartPosition CharLength 

Date v yy/mm/dd 1 8 

Time v hh:mm:ss 10 8 

CommBlockNumber v 1 -- 6 19 1 

Title - string 21 1 -- 30 (truncated) 

Artist - string 52 1 -- 30 (truncated) 

TrackLengthSeconds - digit 83 3 

AudioName v string 87 1 -- 255 

 
                  1                  2                  3                  4                  5                  6                  7                  8          
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1234567890123456789012345678901234567890123456789012345678901234567890123456789012345678901234 
 

Voorbeeld: 
 
18/02/09 18:01:00 1 POSTBANK - HYPOTHEEKADVISEUR   COMMERCIAL                     032 COM149782 

9.1.2 Branche / Stem 
 
Aan elke klant in de databank kunt u een tweetal branches toekennen. Hier vindt u een 
overzicht van alle bekende branches. Per slot van rekening is het meestal ongewenst 
om concurrenten in een bepaalde branche in hetzelfde reclameblok te programmeren. 
Daarnaast kunt u hier ook de stemmen invoeren die u per campagne kunt gebruiken. 
 

 
 
Bij elke campagne kunt u maximaal twee inspreekstemmen opgeven. 
 

9.1.3 Jingle 
 
Een commercialblok kan beginnen met een startjingle, tussen de verschillende 
commercials komt eventueel een tussenjingle en aan het einde komt de eindjingle. De 
jingles die u daarvoor wilt gebruiken, voert u hier in. 
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De start- , tussen- en eindjingles worden enkel gepland als er ook commercials in het 
blok zitten.  
 

Commercialplanner Xtra 
Als u de module Commercialplanner Xtra heeft aangeschaft, kunt u gebruik maken van 
de voorjingles en najingles. Deze kunt u bijvoorbeeld gebruiken om vormgeving te 
plannen. Deze jingles omsluiten het commercialblok als dat aanwezig is. Voor- en 
najingles worden altijd gepland, ook als er geen commercialblok is. Voor- en najingles 
worden altijd aan de playlist toegevoegd, ook als er verder geen commercials in 
hetzelfde commercialblok zijn gepland. 
 
Jingles voegt u toe door ze vanaf bijvoorbeeld Databank browser naar het Jingle-venster 

te slepen. In de kolom ‘Jingletype’ geeft u aan wat voor soort jingle het betreft. U kunt 
meerdere jingles selecteren en met het menu onder de rechter muisknop ineens het type 
instellen voor de gehele selectie. 
 

 
 

9.1.4 Blok 
 
Commercialplanner biedt de mogelijkheid om per uur maximaal 6 commercialblokken te 
definiëren. Hoe u deze benut kunt u voor elk uur van de dag apart aangeven en dit ook 
nog eens voor elke dag van de week apart. Hiermee komt u op een totaal van 6 x 24 x 
7 = 1008 blokken. 
 



2025-05 Handleiding AerOn 

106 Broadcast Partners 

De Standaard weekindeling is een matrix waarbij u per dag en uur een blokindeling kunt 
bepalen. Per dag door op de titel van de dag te klikken. Per uur door op de uuraanduiding 

aan de bovenzijde te klikken. Het selecteren van meerdere dagen of uren met de ‘Shift’-
toets is eveneens mogelijk.  
 
Daarnaast kunt u blokken selecteren d.m.v. slepen. Klik een blok aan, houd de linker 
muistoets vast, sleep de muis naar het gewenste blok, laat de muis los.  
 

Om de gehele week te selecteren klik linksboven op het lege vak boven ma om alle 
blokken in de matrix te selecteren. 
 

Tip!  Wijzigingen in de Standaard blokindeling matrix worden toegepast op de selectie. 
Welke blokken er zijn geselecteerd wordt weergegeven in een tekstregel onder de 
Standaard weekindeling matrix.  
 
Met de kleuren geeft de matrix aan of het blok gebruikt mag worden. 

Rood Blok met vaste begintijd. 

Groen Glijdend blok. 

Blauw Uitvullend blok. 
 

Paars Import blok. (t.b.v. het E Power formaat) 

 
 

Tip!. Als u een blok instelt op Vast dan moet er in het Formatplanner-dagformat op exact 
hetzelfde tijdstip de mode op Vast worden gezet. In het Dagformat geselecteerde 
uurformat moet het in allereerste uurformat item een marker worden gezet met het 
corresponderende commercialblok. Vaste blokken in de Standaard weekindeling moeten 
altijd synchroon lopen met vaste blokken in de Formatplanner-dagformats. 
 
Nadat u een selectie in de weekindeling heeft gemaakt, ziet u een exacte specificatie 
van de instellingen in het blok weergegeven in het onderste gedeelte van het venster. 
 
De kolommen hebben de volgende betekenis: 

Status De mogelijkheden zijn: 
Uit:  dit blok wordt niet benut. De overige kolommen kunt u 

dan niet invullen; 
Aan:  dit blok kunt u gebruiken voor commercials, voor- en 

najingles; 
Voor + Na:  dit blok kunt u enkel gebruiken voor voor- en najingles. 

Import:        Hiermee wordt aangegeven dat E-Power campanges 
in deze blokken worden geplaatst. De indeling van 
importblokken in de Standaard weekindeling moet 
overeenstemmen met de inhoud van uw E-Power 
tekstbestanden. 

 

  

Mode De mogelijkheden zijn: 
Vast:  dit blok heeft een vaste begintijd; 
Glijden:  dit blok is glijdend; 
Uitvullen:  dit blok is uitvullend. 



Handleiding AerOn Commercialplanner 

 we make radio happen 107 

Tijd Minuten in het uur waarop dit blok gepland wordt. Bijvoorbeeld: 12 
geeft aan, dat dit blok om 12 minuten na het hele uur in de playlist 
wordt geplaatst.  
 
Begint het uurformat (in Formatplanner) met het nieuws, dan zet u 
de tijd van het eerste blok op 1. De commercials komen dan vlak 
na het nieuws in de playlist. Het laatste blok kunt u uitvullend maken 
door de mode op ‘uitvullend’ te zetten en de tijd op 60.  De tijden 
van de blokken 1 t/m 6 moeten oplopend zijn ingesteld. 
 

Min duur (Commercialplanner Xtra). Minimum lengte van het blok in 
seconden. Let op het toevoegen van voldoende jingles om een blok 
mee op te vullen als de minimale lengte niet bereikt kan worden 
met campagnes.  
 

Max duur (Commercialplanner Xtra). Maximum lengte van het blok in 
seconden.  

Max items (Commercialplanner Xtra). Dit is het maximum aantal 
commercials dat in dit blok voor mag komen.  Maximaal instelbaar 
tot 75 campagnes per blok.  

Om campagnes zo goed mogelijk te verdelen over alle blokken 
houdt u hier beter een zo laag mogelijke waarde aan om een 
gelijkmatig aantal per blok verdeeld over alle blokken te bekomen.  

Sync (Commercialplanner Xtra). Bij editiesystemen gebruikt u deze 
optie om aan te geven dat de blokken qua lengte moeten 
synchroniseren. De planner zal de kortste blokken aanvullen en 
synchroniseren tot de lengte van het langste blok zodat alle edities 
even lange commercialblokken hebben.  

Voorjingle 1 en 
2 

(Commercialplanner Xtra). Deze jingles komen aan het begin 
van het blok. De voorjingles worden ook in de playlist geplaatst als 
er verder geen commercials in het blok zijn opgenomen. U kunt hier 
direct een vaste jingle kiezen uit de lijst, maar u heeft ook deze 
mogelijkheden: 
 
<Geen>: er wordt geen voorjingle gepland. 
<Random>: er wordt een willekeurige voorjingle uit de lijst gepland. 
<Opvullen>: de beschikbare jingles kunnen gebruikt worden voor 
het opvullen van een blok tot een bepaalde lengte, bijvoorbeeld bij 
edites. 
 

De keuze Opvullen is enkel beschikbaar bij voor- en najingles. 

Startjingle Deze jingle komt voor de eerste commercial (en na de voorjingles 
als die er zijn). De startjingle wordt enkel gepland als er 
commercials in het blok aanwezig zijn. 

Tussenjingle Deze jingle wordt steeds tussen commercials geplaatst als er twee 
of meer commercials in het blok zitten. 

Eindjingle Deze jingle komt na de laatste commercial. De eindjingle wordt 
enkel gepland als er commercials in het blok zitten. 

Najingle 1 en 2 (Commercialplanner Xtra). De najingles zijn de laatste items 
van een blok en komen altijd na de eindjingle. Najingles worden 
ook in de playlist opgenomen als er verder geen commercials in het 
blok zitten. 
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Een schematische voorstelling van de volgorde van commercials en jingles is als volgt: 

voor- 
jingle 1 

voor- 
jingle 2 

start- 
jingle 

comm. tussen-
jingle 

comm. tussen-
jingle 

 

 

 comm. tussen- 
jingle 

comm. eind- 
jingle 

na- 
jingle 1 

na- 
jingle 2 

 

 
 
Bij het selecteren van meerdere uren in de weekindeling is het mogelijk dat in de 

blokindeling één of meerdere items ‘leeg’ zijn. Hiermee wordt aangegeven dat voor een 
deel van de geselecteerde uren de instelling afwijkend is, blokken zijn dan verschillend. 
 
U bent vrij de starttijden van de verschillende blokken te kiezen, ze moeten echter altijd 
oplopend zijn. Heeft u een blok om ‘kwart voor’, neem dan blok 5. Radiostations die enkel 
commercials uitgevuld aan het eind van het uur spelen, nemen blok 6. Hierdoor heeft u 
later altijd nog de mogelijkheid om eenvoudig een extra blok aan te zetten zonder de 
instellingen ingrijpend aan te moeten passen. 
 

Tip! Wilt u een reclameblok op het halve uur uitzenden, zet dan de tijd op 29, 29 minuten 
na het hele uur. Het blok kan dan iets eerder dan het halve uur starten, maar het zal ook 
niet veel later dan het halve uur komen. Eventueel kunt u een halve uur reclameblok ook 
een vaste begintijd geven. 
 
Als u in de Standaard weekindeling commercialblokken uitzet nadat er al eerder is 
gepland, moet u vermoedelijk een groot deel van de campagnes opnieuw plannen omdat 
in de uitgezette blokken nog campagnes gepland zullen staan. Heeft u enkel andere 
jingles gekozen, dan moet u enkel jingles opnieuw plannen. Hierover kunt u later in dit 
hoofdstuk lezen. 
 
De consequenties van wijzigingen in deze instellingen zijn als volgt: 

Mode Blokken uitzetten: in principe moeten alle commercials opnieuw 
gepland worden. Het is  mogelijk dat als u blokken uitzet er blokken 
uit staan waar in het dagoverzicht nog commercials in staan. 
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Blokken aanzetten: u hoeft geen actie te ondernemen. De volgende 
keer dat u commercials plant zijn er meer blokken beschikbaar. 

Tijd In het dagoverzicht moet u opnieuw exporteren, zodat de blokken 
op de nieuwe tijden in de playlists gezet worden. 

Min & Max Indien beide waarden gelijk zijn aan elkaar moeten de commercials 
opnieuw gepland worden. Indien beide waarden niet gelijk zijn 
moeten de commercials alleen opnieuw gepland worden als de 
marge verkleind is (minimum omhoog, maximum omlaag). 
 

Max items Als u het maximaal items per blok verhoogt hoeven enkel nieuwe 
campagnes opnieuw gepland worden. Als u het maximaal items per 
blok verlaagt moeten de campagnes opnieuw gepland worden, 
indien er te veel commercials in een blok staan. 

Jingles De jingles moeten opnieuw gepland worden. 

9.2 Klant 

 

9.2.1 Algemeen 
 

 
 
In het voorgaande venster vult u de gegevens van de klant in. De meeste velden spreken 
voor zich en behoeven geen nadere toelichting. 
 

ID 
Elke klant krijgt een eigen klantcode. Bij het toevoegen van een nieuwe klant vult de 
planner hier zelf het volgende bruikbare nummer in (1 hoger dan het hoogste bestaande 
nummer). U kunt eventueel zelf een ander nummer invoeren. Nadat u de klant 
opgeslagen hebt, is het niet meer mogelijk om het ID te wijzigen. De reden hiervoor is, 
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dat de campagnes die u gaat invoeren altijd verwijzen naar (het ID van) de klant. Gebruikt 
u naast Commercialplanner ook boekhoudkundige software voor de facturatie, dan is het 
handig om het klantnummer binnen die software gelijk te laten lopen met het ID. Het 
klantnummer in de administratie komt dan overeen met het ID in de planner. 
 

Branche 1/Branche 2 
De branche(s) waarin deze adverteerder actief is, voert u in om te voorkomen dat 
concurrenten (of campagnes van dezelfde adverteerder) in hetzelfde blok gepland 
kunnen worden. 
 
Met de zoekfunctie is het mogelijk om elke gewenste tekst te zoeken in de gegevens van 

alle ingevoerde klanten. Sneltoets CTRL+F. 

9.2.2 Browser 
 
Het browservenster geeft een beknopt overzicht van alle ingevoerde klanten. 
 

 
 
De sorteervolgorde kunt u aanpassen door op de titelbalk van een kolom te klikken. Door 
te dubbelklikken op een klantregel, springt u direct naar de detailgegevens van deze 
klant. 
 
In iedere kolom is een filter beschikbaar waarmee u gegevens kunt filteren. 
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Een overzicht van aanwezige klant-gegevens kunt u afdrukken of exporteren naar 

bijvoorbeeld pdf, excel of email. (via het menu Bestand → Afdrukken of Bestand → 

Afdrukvoorbeeld). 
 

 
 

9.2.3 Import (Commercialplanner Xtra) 
 
Ketenradio’s die geheel of gedeeltelijk dezelfde campagnes uitzenden, kunnen klant- en 
campagnegegevens van elkaar importeren. Hier kunt u klantgegevens importeren uit 
een andere database importeren. Later in dit hoofdstuk wordt het importeren van 
campagnegegevens uitgelegd. Daar vindt u een uitgebreidere beschrijving waarin staat 
aangegeven hoe u het beste te werk kunt gaan. 
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9.3 Campagne 

 
 

9.3.1 Algemeen 
 
In de afbeelding hierboven ziet u een voorbeeld van een campagne. De verschillende 
onderdelen van het tabblad ‘Algemeen’ worden in dit hoofdstuk kort beschreven. 

 

ID 
Elke campagne krijgt een eigen code. Bij het toevoegen van een nieuwe campagne vult 
de planner hier zelf het volgende bruikbare nummer in (1 hoger dan het hoogste 
bestaande nummer). U kunt eventueel zelf een ander nummer invoeren. Nadat u de 
campagne opgeslagen hebt is het niet meer mogelijk om het ID te wijzigen. De reden 
hiervoor is dat bij het automatisch en handmatig plannen steeds het ID van de campagne 
wordt opgeslagen in de dagoverzichten. Gebruikt u naast Commercialplanner andere 
software voor het boeken van campagnes, dan is het handig om het campagnenummer 
binnen die software gelijk te laten lopen met het ID. Het ordernummer in de administratie 
komt dan overeen met het ID in de planner. 
 

Naam 
Hier geeft u de algemene naam van de campagne op. 
 

 
Klant 
Hier geeft u de naam van de klant op. U kunt de gegevens van de klant altijd snel 
nakijken via de knop ‘…’ naast het invulvak. 
 

Reclame bureau 
Hier geeft u (indien van toepassing) de naam van het reclamebureau op. Net als bij ‘klant’ 
kunt u ook hier de gegevens van het reclamebureau gemakkelijk nakijken met de knop 
‘…’. 
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Stemmen 
Hier vult u de namen in van maximaal twee personen die de commercial ingesproken 
hebben. 
 

Voorkeurpositie  (Commercialplanner Xtra).   
Met voorkeurpositie geeft u aan waar de spot bij voorkeur in het blok moet voorkomen. 
Er zit hier echter een zekere willekeurigheid in. 
 

Geen De commercial kan overal in het blok voorkomen. De kans om als 
eerste of laatste geplaatst te worden is kleiner. 

Eerste De commercial wordt altijd als eerste in een blok geplaatst. Een 
blok kan slechts één commercial bevatten waarvan de 

voorkeurpositie ‘eerste’ is. 

Begin De commercial wordt aan het begin van het blok geplaatst. De 
commercial komt voor commercials met de voorkeurpositie 

‘midden’. 

Midden De commercial wordt in het midden van het blok geplaatst. Deze 
komt na commercials met de voorkeurpositie ‘begin’ en voor 
commercials met de voorkeurpositie ‘einde’. 

Einde De commercial wordt aan het einde van het blok geplaatst. De 

commercial komt na commercials met de voorkeurpositie ‘midden’. 

Laatste De commercial wordt altijd als laatste in een blok geplaatst. Een 
blok kan slechts één commercial bevatten waarvan de 

voorkeurpositie ‘laatste’ is. 
 

Het wordt aangeraden om de standaard positie ‘Geen’ te handhaven voor de meeste 
campagnes, tenzij de klant om een specifieke plaatsing vraagt. Het is ook weinig zinvol 

om het merendeel van de campagnes één van de voorkeurposities ‘Begin’, ‘Midden’ of 

‘Einde’ mee te geven. Het beste effect bereikt u wanneer deze voorkeurposities min of 
meer gelijk verdeeld zijn over de aanwezige campagnes. Bij campagnes waar u 

reminders gebruikt, moet u nooit voorkeurpositie ‘Laatste’ invullen, u kunt dan het beste 

‘Begin’ of ‘Midden’ invullen. De planner zal ook actief proberen een campagne met 
reminder eerder in een blok te plaatsen. 
 

Plaatsing 
Hiermee geeft u aan hoe de gewenste commercials geplaatst worden gedurende de 
termijn dat campagne loopt. 
 

Willekeurig De spots worden min of meer willekeurig verdeeld over de hele periode 
zoals in het voorbeeld hieronder.  

 

Merk op: op 1 januari 2016 is deze campagne tussen 9:00 en 10:00 
drie keer te horen. De eerste twee dagen is de campagne 7 keer op de 
radio, op 4 januari 12 keer. 

 

Verdeeld 
over periode 

De autoplanner kijkt naar alle blokken waarin de campagne mag 
voorkomen en verspreidt de commercials zorgvuldig over deze 
blokken.  
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Bijvoorbeeld: als er 1000 mogelijke blokken zijn en er moeten 330 
commercials gepland worden, dan wordt in elk derde blok deze 
campagne gepland. 
Door branche-, stemconflicten en dergelijke kan het voorkomen dat er 
blokken overgeslagen worden. 

 

Merk op: de spots worden verdeeld over de toegestane blokken. Het 
aantal toegestane blokken is per dag verschillend. 

 

Verdeeld per 
dag 

Commercialplanner Xtra 
Het aantal commercials dat u heeft opgegeven wordt gedeeld door het 
aantal beschikbare dagen. Dit aantal wordt elke dag gepland. 
 
Bijvoorbeeld: als u 120 spots wenst in 10 dagen, plant de 
Commercialplanner elke dag 12 spots. 
Bijvoorbeeld: als u 100 spots wenst in 12 dagen, plant de 
Commercialplanner 8 of 9 spots per dag. 
De autoplanner verdeelt de spots over de beschikbare blokken in de 
dag. 

 

Merk op: Elke dag wordt de spot even vaak uitgezonden, verder 
worden ze netjes verdeeld over de dag. 

 

Opvullen 
lege blokken 

Commercialplanner Xtra 
De planner zoekt uit welke blokken de minste commercials bevatten 
en plaatst de campagne daar als eerste. Deze methode hanteert u voor 
budget- of promotiecampagnes (bijvoorbeeld promotie van de nieuwe 
zomerprogrammering, Wereld Natuur Fonds, Amnesty International) 
waarmee u de lege blokken opvult om zo een meer evenredige 
verdeling van de blokken te verkrijgen. 
Merk op: Voeg ook niet teveel opvulcampagnes toe. Adverteerders 
weten dan dat uw portefeuille niet goed gevuld is en zullen een hogere 
korting bedingen. 

Handmatig De  campagne komt nooit zichtbaar in het planningsoverzicht. De 
campagne plant u zelf door deze in het dagoverzicht in de gewenste 

blokken te slepen.  Wanneer u ‘Auto save’ activeert worden 
wijzigingen automatisch opgeslagen als u door het dagoverzicht 
bladert. 
 

Start en Einde 
Hier geeft u de start- en einddatum van de campagne aan. De maximum looptijd van 
een campagne bedraagt 5 jaar. Het is tevens mogelijk om het eerste en laatste uur 
waarop de campagne gepland mag worden aan te geven. Bij een campagne die 
maximaal 7 dagen beslaat, kunt u in de weekkalender exact aangeven op welke uren de 
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commercials gepland mogen worden. Zodra de campagne langer is, zult u het start- 
en/of einduur moeten aanpassen als de campagne niet van middernacht tot middernacht 
moet lopen. U gebruikt dit bijvoorbeeld voor een braderie die in het weekend plaatsvindt 
en op zondag omstreeks 17:00 eindigt. Op de laatste dag geeft u dan aan dat er geen 
commercials meer gepland mogen worden na bijvoorbeeld 15:00 uur. Zodra er 
commercials gepland zijn is het niet meer mogelijk om de startdatum van de campagne 
aan te passen. 
 

Commercials 
Het eerste getal geeft aan hoeveel commercials u tijdens deze campagne wilt plannen. 
Het tweede getal geeft het (afgeronde) aantal commercials per dag aan. Beide getallen 
kunt u invullen. Het andere getal wordt automatisch aan de hand van het aantal 
beschikbare dagen aangepast. Bij het wijzigen van de begin- of einddatum of 
periodekalender van de campagne wordt opnieuw het aantal commercials per dag 
uitgerekend. 
 
Let op: U boekt een campagne over een bepaalde periode en geeft 10 commercials per 
dag op. Daarna sluit u een aantal dagen in de periodekalender uit. Aan de hand van het 
totaal aantal opgegeven commercials en het beschikbare aantal dagen wordt opnieuw 
het gemiddelde aantal per dag uitgerekend. Het is goed mogelijk dat er 10 blijft staan. 
Het totaal aantal commercials is echter niet gewijzigd, wat tot gevolg heeft, dat er bij het 
plannen gemiddeld iets meer dan 10 commercials per dag zullen worden uitgezonden. 
Wilt u toch een vast aantal van 10 commercials per dag, vul dan dit aantal opnieuw in 
zodat het totaal herberekend wordt. 
 

Gepland 
Het aantal commercials dat tot en met vandaag en tot het einde van de campagne is 
gepland. De software zal het eerste getal steeds opnieuw uitrekenen aan de hand van 
het dagoverzicht, dit kan enige tijd kosten als u de planner een week niet hebt gebruikt. 
 

Lengte spots 
Indicatoren voor de totale lengte van de spots. De indicatoren lopen automatisch mee 
indien het totaal aantal spots, of het aantal spots per dag wordt verhoogd of verlaagd.  
 

Beschikbaar 
Aan de hand van de periodekalender en de weekindeling wordt uitgerekend hoeveel 
blokken en dagen er beschikbaar zijn voor deze campagne. Het spreekt voor zich dat 
het aantal beschikbare blokken minstens zo groot moet zijn als het gewenste aantal 
commercials. 
 

 
Plan campagne 
Na het doorvoeren van de meeste wijzigingen in de campagne, zult u deze campagne 
opnieuw moeten plannen om die wijzigingen door te voeren. Deze optie start 
desgewenst automatisch. Deze optie maakt het mogelijk om alle campagnes aan te 
passen en deze daarna tegelijk te plannen. Commercialplanner ziet welke campagnes 
opnieuw gepland moeten worden. Na het plannen gaat deze optie vanzelf weer uit. 
 

Weekindeling 
In de instellingen heeft u in de Standaard weekindeling opgegeven op welke dagen en 
uren er globaal commercials mogen voorkomen. Hier geeft u op in welke van deze 
blokken de campagne geplaatst mag worden. Voor elke weekdag en elk uur is dit apart 
aan te geven. Het selecteren van blokken doet u met de cijfers 1 t/m 6, met het menu 
onder de rechter muisknop of met het respectievelijke cijfer op het toetsenbord. 
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Blok 1 .. Blok 6 Activeer of deactiveer het betreffende blok op de dagen en uren die 
volgens de Standaard weekindeling toegestaan zijn. 

Alle 1008 
blokken aan 

Activeer alle 1.008 blokken, ook degene die niet actief zijn in de 
Standaard weekindeling. Maakt u later blokken actief in de 
Standaard weekindeling, dan worden deze eveneens actief in de 
campagne. 

Alle 1008 
blokken uit 

Deactiveer alle 1.008 blokken, ook degene die niet actief zijn in de 
Standaard weekindeling. Maakt u later blokken actief in de 
Standaard weekindeling, dan worden deze niet actief in de 
campagne. 

 

Periodekalender (Commercialplanner Xtra) 
De periode waarover de campagne loopt is zichtbaar. Met de knop ‘Termijn’ is het 
mogelijk om snel alle (on)even, dagen, weken of maanden te selecteren. Het is ook 
mogelijk om een bepaalde weekdag te selecteren voor uitzending door op de dagnaam 
te klikken en met de spatiebalk die dag aan of uit te zetten. Het selecteren van weken 
gaat op analoge wijze door op het weeknummer te klikken en de week met de spatiebalk 
aan of uit te zetten. Op die manier is het mogelijk om per dag aan te geven of campagne 
wel of niet gepland mag worden. 
 
Bij het bladeren door de databank wordt steeds het aantal commercials dat tot de huidige 
dag is gepland bepaald door de dagoverzichten na te gaan. Als u Commercialplanner 
een week of langer niet heeft gebruikt, kan dit enkele seconden duren. Bij frequent 
gebruik is er geen vertraging merkbaar. 
 

Nadat u een campagne heeft gepland kunt u een overzicht afdrukken via Bestand → 

Afdrukken.  Via Bestand → Afdrukvoorbeeld kunt u een overzicht weergeven en 
opslaan als bijvoorbeeld pdf. Daarop kunt u zien op welke dagen en uren de spots van 
deze campagne te horen zullen zijn. 
 

Via menu Bestand → Opslaan als kunt u een campagne kopiëren en opslaan 
onder een andere naam. Alle gegevens worden meegenomen naar de nieuwe 
campagne. U hoeft bij wijze van spreken enkel een start- en einddatum op te 
geven om de campagne te kunnen plannen. 
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9.3.2 Spots 
 
Op het tweede tabblad van de campagne geeft u de hoofdspots op en reminders die in 
hetzelfde commercialblok komen als de hoofdspot. De tracks sleept u vanuit Databank 

browser onder hoofdspot of reminder. Met de toets Del kunt u ze weer verwijderen. 
 
 



2025-05 Handleiding AerOn 

118 Broadcast Partners 

 
 
U kunt maximaal 10 hoofdspots en reminders aan een campagne toevoegen. Deze 
moeten vanaf de bovenste regel ingevuld worden. De planner zal de spots van boven 
naar beneden laten rouleren in de planning. Spots die na een lege regel zijn ingevuld 
worden door de autoplanner niet herkend.  
 

Tip! Als de tekst in het rood aangegeven is, heeft u de betreffende track uit de databank 
verwijderd; dat is geen probleem voor campagnes die verlopen zijn. Bij actieve 
campagnes moet u deze fout corrigeren. 
 
Heeft u één hoofdspot en vier verschillende reminders? U vult dan 4 keer dezelfde 
hoofdspot in en in de tweede kolom de verschillende reminders. 

De keurslager Tournedos op maandag 

De keurslager Woensdag gehaktdag 

De keurslager Zaterdag vleeskroketten 

De keurslager Biefstuk op zondag 

 
Heeft u drie spots waarvan er één vaker moet worden uitgezonden? U vult de spot die 
vaker moet voorkomen twee of meer keren in de lijst in. 

De nieuwe Corolla  

Toyota Prius  

De nieuwe Corolla  

Toyota Rav4  

 
In het onderste deel van het venster is het planningsrapport zichtbaar. In het 
planningsrapport vindt u gegevens over de laatste campagneplanning. Als er bij het 
plannen conflicten zijn opgetreden ziet u dat hier. Als het aantal conflicten en 
beschikbare blokken bij elkaar opgeteld een groter getal is dan het aantal beschikbare 
blokken op het tabblad Algemeen, dan blijkt daaruit dat er blokken zijn met meerdere 
conflicten. 
 
Campagne uit de planning halen 
Mocht u een campagne uit het dagoverzicht willen verwijderen dan gaat u als volgt te 
werk. 
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Zet in de campagne het aantal commercials ‘per dag’ op 0, m.a.w, zet het aantal te 
plannen spots op 0. De einddatum van de campagne moet u ongewijzigd laten. Plan de 
campagne opnieuw. 
 
Bij het plannen van een campagne worden eerst reeds geplande commercials uit het 

dagoverzicht verwijderd. Daarna ziet de planner aan ‘0 per dag’ dat er bij die campagne 
geen commercials meer gepland moeten worden en plaatst deze campagne niet terug 
in het dagoverzicht.   
 
Als de campagne eenmaal uit het dagoverzicht is verwijderd, kunt u besluiten de 
campagne definifief te verwijderen uit het campagne overzicht. De gehele planhistorie 
van de campagne wordt uit het dagoverzicht verwijderd. U kunt dan geen campagne 
overzicht meer afdrukken.  
 

9.3.3 Browser 
 
Het derde onderdeel van de campagnes is een browser, zoals die er ook is voor de 
klanten. Deze kent een aantal mogelijkheden tot filtering van de gegevens vergelijkbaar 
met de werkwijze in Excel. 
 

  
 
U kunt een kort overzicht van de aanwezige reclamecampagnes op de printer afdrukken 

via het menu Bestand → Afdrukken of weergeven via Bestand → Afdrukvoorbeeld 
en bijvoorbeeld opslaan als pdf. 
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9.3.4 Import (Commercialplanner Xtra) 
 
Deze functie is enkel beschikbaar voor gebruikers met de module Commercialplanner 
Xtra. Voor het overnemen van de gegevens van klanten en campagnes uit een andere 
AerOn database zijn er importfuncties in Commercialplanner aanwezig.  
 

Tip! Voordat u hiermee aan de slag gaat is het van belang dat u met het volgende 
rekening houdt. Namelijk dat klant ID’s in beide databases exact overeenstemmen. 
 
In de pagina’s hiervoor is reeds beschreven dat het ID die u aan een klant toekent het 
best overeenkomt met het klantnummer dat u gebruikt in de administratie. Campagnes 
geeft u bij voorkeur het ordernummer als ID. Heeft u nog geen administratie opgezet dan 
adviseren wij u om elke klant (ongeacht op welk station deze adverteert) een unieke ID 
te geven. Bij het importeren van campagnes wordt de verwijzing naar het klantnummer 
meegenomen. Als u geen unieke ID’s gebruikt, verwijzen de campagnes na het 
importeren naar de verkeerde klant. Aan de hand van een voorbeeld geven wij aan wat 
er dan gebeurt: 
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Station 1 Station 2 
ID Klant ID Klant 

2 Slager 4 Bakker 

4 VW garage 5 VW garage 

    
ID Campagne ID Campagne 

20 Biefstuk - Slager 21 Gebak - Bakker 

21 Touran - VW garage   

 
De ‘Touran’ campagne draait alleen op het eerste station, maar gaat nu ook op het 
tweede station lopen. Op station 1 is deze campagne verbonden met klantnummer 4, 
namelijk ‘VW garage’. Op station 2 importeert u de campagne ‘Touran’. Na import 
verwijst deze op station 2 naar klant ‘Bakker’, omdat deze klant ID 4 heeft. campagne ID 
21 is al in gebruik op station 2, dus krijgt ‘Touran’ het eerst volgende vrije nummer. 
 
Op station 1 gaat ‘Bakker’ adverteren. ID 4 is hier al in gebruik. De gegevens van deze 
klant kunt u op station 1 importeren van station 2, maar omdat ID 4 al in gebruik is zal 
de bakker op het eerste station een andere ID krijgen. 
 
De situatie hierboven is heel verwarrend, zeker naarmate u meer klanten en 
reclamecampagnes hebt. Een goede opzet zou als volgt kunnen zijn: 
 

Station 1 Station 2 
ID Klant ID Klant 

2 Slager 4 Bakker 

5 VW garage 5 VW garage 

    
ID Campagne ID Campagne 

20 Biefstuk - Slager 22 Gebak - Bakker 

21 Touran - VW garage   

 
Na het importeren van klanten of campagnes zijn de ID’s en verwijzingen op beide 
stations altijd identiek. 
 
 
 
 

9.4 Planning 
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9.4.1 Campagnes plannen 
 
In het venster zijn alle aanwezige campagnes zichtbaar die nog niet verlopen zijn. De 
volgorde in de lijst wordt bepaald door de einddatum. De campagne die het eerste 
verloopt, wordt standaard als eerste gepland. Met de knoppen linksonder is het wel 
mogelijk de volgorde aan te passen. Opvulcampagnes staan onderin en zijn met een 
blauwe kleur gemarkeerd. Deze kunt u onderling ook van volgorde wisselen maar nooit 
voor de reguliere campagnes laten plannen. In de kolom aantal is zichtbaar hoeveel 
commercials nog gepland moeten worden. Als dit aantal niet 0 is zal er een vinkje in de 

kolom Schedule staan. Een rood blokje geeft aan dat de campagne niet gepland kan 
worden omdat er geen spot opgegeven is. 
 
De volgorde in de kolom kan van belang zijn. De campagne die bovenaan staat wordt 
als eerste gepland, de onderste als laatste. Wel is het zo dat de planner eerst altijd alle 
IP-campagnes zal plannen, daarna de reguliere en als laatste de opvulcampagnes. Het 
heeft de voorkeur om campagnes met restricties (beperkt aantal blokken, branche of 
stemconflict) als eerste te laten plannen. Opvulcampagnes kunt u het beste ook steeds 
laten plannen. Nadat de reguliere campagnes gepland zijn, is het goed mogelijk dat 
bepaalde blokken niet meer door de opvulcampagnes gevuld hoeven worden. 
 
Zodra u op ‘Start’ klikt zal het automatisch plannen beginnen. Dit gebeurt in 3 fasen: 
 

Voorbereiden Van alle te plannen campagnes worden de in de toekomst 
geplande spots uit het dagoverzicht verwijderd. 

Plannen Deze planfase bestaat eigenlijk uit twee afzonderlijke fasen. Eerst 
worden de reguliere campagnes gepland in de volgorde zoals u die 
heeft aangegeven in de lijst (de bovenste als eerste, de onderste 
als laatste). Daarna worden de opvulcampagnes gepland. 
Bij het plannen van de afzonderlijke campagnes kan het zijn dat 
eerst geteld moet worden hoeveel spots er al gepland zijn tot 



Handleiding AerOn Commercialplanner 

 we make radio happen 123 

vandaag. Dat is echter alleen van toepassing als u een campagne 
herplant die op dat moment al loopt. 

Afwerken In deze laatste fase worden alle blokken gecontroleerd en zet de 
planner de campagnes in de juiste volgorde. 

 
Nadat het plannen is voltooid, exporteert Commercialplanner, afhankelijk van een 
instelling, de commercialblokken automatisch naar de geplande playlists. 
 
Commecialplanner exporteert blokken altijd op basis van de bloktijd die per blok is 
ingesteld in de Standaard weekindeling. Omdat bij het bewerken van de playlist de 
commercialblokken in tijd kunnen verschuiven wordt er een (instelbare) export offset 
toegepast om tijdens het exporteren de commercialblokken die reeds in de playlists 
aanwezig zijn te matchen. De commercial planner kijkt  t.o.v. de bloktijd of er 9 minuten 
terug of 9 minuten verderop reeds een commercialblok in de playlist staat. Dit wordt 
toegepast bij glijdende commercialblokken. Vindt Commercialplanner in de playlist een 
commercialblok binnen de offset tijdspanne, dan vervangt Commecialplanner dat blok 
met het gewijzigde commercialblok en plaatst dat tussen exact dezelfde tracks in. Vindt 
Commercialplanner geen commercialblok in de playlist binnen de offset tijdspanne, dan 
wordt een commercialblok altijd op basis van de ingestelde bloktijd in de playlist 
geplaatst. 
 
Tijdens het plannen van de reclamecampagnes bepaalt Commercialplanner ook welke 
jingles er in de blokken komen en plaatst die in ieder blok waar jingles zijn aangegeven. 
Dat blokken gepland worden inclusief jingles is o.a. nodig omdat Formatplanner eerst 
kijkt wat de lengte van alle commercialblokken tesamen in een uur is en dan de 
resterende tijd vult. Tijdens het plannen van commercials blijven de blokken waarin enkel  
voor- of najingles zitten ongemoeid. Hiervoor kunt u apart de jingles plannen. 
 
Na afloop van het plannen ziet u in het planoverzicht direct welke campagnes geheel 
gepland zijn en de campagnes die u moet controleren. Campagnes waarbij het te 
plannen aantal “0” wordt weergegeven die zijn volledig gepland. U kunt snel naar de 
details van een campagne toe springen door in het planoverzicht op de campagne te 
dubbelklikken. 
 
Voor het plannen van blokken met een vaste lengte (een bepaalde minimum- en 
maximumlengte mag ook) is een aangepaste strategie noodzakelijk. Om de gewenste 
lengte te verkrijgen, zullen er bij bepaalde blokken extra items toegevoegd moeten 
worden. De gebruiker moet daarvoor de volgende zaken in de gaten houden: 
 

1. Zet de maximum bloklengte van een blok zo laag mogelijk. Opvullen van bijna 
lege blokken naar één minuut is minder erg dan opvullen naar twee minuten. 
Gaandeweg kan de maximum bloklengte opgevoerd worden als er meer 
campagnes lopen. 

2. Hoe meer opvulcampagnes er aanwezig zijn, hoe makkelijker het is om de 
blokken naar de gewenste lengte op te vullen. 

3. Met de voor- en najingles vult de planner de gaten die niet meer met een 
campagne te dichten zijn. Er moeten voldoende jingles met een verschillende 
lengte voorhanden zijn. 

 
Zoals eerder vermeld houdt de planner bij het plannen van een campagne rekening met 
onder andere de branche en inspreekstem van de overige campagnes in het blok. 
Bij het plannen van een blok met een ingestelde maximumlengte kijkt de software tevens 
naar de totale lengte van de bestaande items. Het blok komt pas in aanmerking voor 
gebruik als de resterende lengte groter is dan de lengte van het langste item (bij 
campagnes met verschillende spots moeten deze niet allemaal dezelfde lengte hebben). 
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De opvulcampagnes worden normaliter als eerste geplaatst in de blokken die helemaal 
of bijna leeg zijn. Bij het plannen met een bepaalde minimumlengte krijgen die blokken 
voorrang. De planner probeert de blokken met restricties vol te krijgen met de 
opvulcampagnes. Door het zo veel mogelijk opvullen van blokken met campagnes 
voorkomt u dat een blok begint of eindigt met een relatief lange jingle. 
 
Na het plannen van de campagnes vindt controle van de blokken plaats. De planner 
berekent de resterende lengte van het blok die opgevuld moet worden om binnen de 
gestelde grenzen van minimum- en maximumlengte te blijven. Deze lengte wordt 
opgevuld met een voorjingle of najingle of beide. 
 
Voor het opvullen van gaten tot bijvoorbeeld één minuut kan de gebruiker 60 jingles 
opnemen die steeds een seconde langer zijn dan de vorige. Door slim gebruik te maken 
van de combinatie voor- en najingle kan de gebruiker ook voorjingles opnemen met de 
lengtes 1, 2, … 9 seconden en najingles met de lengtes 10, 20, … 60 seconden. 
 
AerOn en Commercialplanner rekenen in milliseconden. Daardoor is het haast 
onmogelijk om tot de milliseconde goed uit te komen met het plaatsen van de jingles, 
tenzij de lengte van alle items exact een veelvoud van 1000 milliseconden is. Bij het 
bepalen van de voor- en najingles kiest Commercialplanner automatisch de jingle of 
combinatie van voor- en najingles uit waarmee de kleinste afwijking wordt bereikt. Neemt 
u, zoals hierboven beschreven de jingles op, dan is die afwijking maximaal een halve 
seconde, namelijk of een halve seconde te kort of een halve seconde te lang. Wilt u toch 
kortere items gebruiken, houdt dan rekening met een minimale lengte van 200 
milliseconden. 
 

9.4.2 Jingles plannen 
 
Veel radiostations gebruiken de voor- en najingles als uuropener of –afsluiter. In de 
blokken waar ook commercials in voorkomen, zal de planner deze direct mee plannen. 
Voor de overige blokken zonder commercials kunt u gebruik maken van deze functie 
Jingles plannen. 
 
Deze functie is gescheiden gehouden om te voorkomen dat bij het plannen van een korte 
campagne (wat vaak in enkele seconden gebeurd is), van alle geplande blokken de 
jingles gecontroleerd moeten worden. 
 

U kiest Jingles plannen als er wijzigingen in de instellingen met betrekking tot de jingles 
zijn aangebracht. De planner doorloopt dan alle blokken in de toekomst, verwijdert oude 
jingles en voegt de nieuwe toe. De campagnes die reeds in de blokken zijn gepland, 
blijven ongewijzigd. Dit is belangrijk omdat u misschien al een complete planlijst aan uw 
adverteerder heeft overhandigd. 
 
Radiostations die tijdens bijvoorbeeld de kerstperiode andere voor- en najingles willen 
uitzenden gaan als volgt te werk: voor de kerst vult u in de Standaard weekindeling de 

kerstjingles in. U kiest Jingles plannen. Als u na de kerstperiode de oude jingles weer 

wilt gebruiken, zet u deze weer in de Standaard weekindeling en kiest opnieuw Jingles 
plannen. 
 
Er zijn twee fasen: 

Voorbereiden Van alle blokken die in de toekomst in het dagoverzicht staan 
berekent de planner de lengte (commercials, zonder jingles) 
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Afwerken De jingles worden aan de blokken toegevoegd zoals deze in de 
Standaard weekindeling ingesteld staan. Jingles worden 
toegevoegd tot op de laatste dag in de toekomst waar commercials 
gepland zijn. 
 

9.4.3 Spots plannen 
 
Sommige klanten boeken een campagne voor een lange periode maar willen de spot(s) 
gedurende de periode veranderen. Dat is op zich geen probleem, de campagne is 
eenvoudig opnieuw te plannen. Bestaat echter de wens om de spots in dezelfde blokken 
te laten, dan komt deze optie van pas. Wijzig de spot(s) van de campagne en kies de 

optie ‘Spots plannen’. 
Het is niet mogelijk deze optie te kiezen als er tevens meer of minder spots gepland 

moeten worden. Ook heeft het veranderen van de optie ‘Plaatsing’ in de campagne 

geen effect, de nieuwe spots worden middels ‘Spots plannen’ in exact dezelfde blokken 
gezet. 
 

9.4.4 Automatisch exporteren 
 
Formatplanner zal tijdens het plannen van een playlist automatisch de commercials en 
commercial-jingles voor die dag aan de playlist toevoegen. 
 
Met de optie automatisch exporteren aangevinkt zorgt u er voor dat de reeds aanwezige 
playlists na het plannen van campagnes of jingles van de nieuwe gegevens uit het 
dagoverzicht worden voorzien. Het exporteren vindt dan automatisch plaats nadat het 
plannen van campagnes of jingles is voltooid. 
 
Automatisch exporteren is onderverdeeld in twee opties die u kunt aanvinken. Namelijk 
Automatisch exporteren naar playlist en Automatisch exporteren naar bestand. Als u 
laatst genoemde optie aanvinkt dan wordt er geexporteerd naar tekstbestanden in het 
‘E Power’, Dalet, RCS of Traffic formaat indien deze formaten ook zijn geactiveerd in de 
instellingen. 
 

Tip! Als playlists geheel of gedeeltelijk ingebruik zijn dan kan er na het voltooien van de 
planning geen export plaats vinden. U krijgt dan een melding dat playlists ingebruik zijn. 
Geef daarom voorafgaand aan het plannen en exporteen indien nodig de blokken in de 
playlists vrij. Na het plannen van commerfcials en jingles kunt u altijd nog exporteren 
vanuit het dagoverzicht als het automatisch exporteren niet voltooid kon worden. 
 
Exporteren weekdag naamplaylists 
Het exporteren vindt enkel plaats voor die dagen, waarvoor reeds een playlist aanwezig 
is. Mocht er geen playlist aanwezig zijn, dan controleert de planner of er een naam-

playlist aanwezig is met de naam van de weekdag en gebruikt dan deze indien ‘Gebruik 
weekdag-playlist als datum-playlist niet bestaat’ in de Commercialplanner-
instellingen is aangevinkt. De playlist met commercials wordt altijd met de normale naam 
opgeslagen als datum-playlist. (bijvoorbeeld: Een naam-playlist “Donderdag” wordt 
voorzien van commercials en opgeslagen als datumplaylist Donderdag 24 september 
2015). U kunt deze methode bijvoorbeeld gebruiken bij editiesystemen waar de edities 
meestal enkel externe audio en de eigen lokale commercials uitzenden. De playlists op 
de edities worden dan geautomatiseerd opgeslagen als datumplaylists en voorzien van 
de actuele commercialplanning. 
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Tip! Met genoemde optie ‘Gebruik weekdag playlist’ is het bij langlopende campagnes 
mogelijk dat u ineens playlists hebt tot aan het einde van het jaar of zelfs later. 
Desgewenst kunt u deze playlists in Beheer verwijderen. 
 
Exporteren naar playlists 
Commecialplanner exporteert blokken altijd op basis van de bloktijd die per blok is 
ingesteld in de Standaard weekindeling. Omdat bij het bewerken van de playlist de 
commercialblokken in tijd kunnen verschuiven wordt er een (instelbare) export offset 
toegepast om tijdens het exporteren de commercialblokken die reeds in de playlists 
aanwezig zijn te matchen. De commercial planner kijkt  t.o.v. de bloktijd of er 9 minuten 
terug of 9 minuten verderop reeds een commercialblok in de playlist staat. Dit wordt 
toegepast bij glijdende commercialblokken. Vindt Commercialplanner in de playlist een 
commercialblok binnen de offset tijdspanne, dan vervangt Commecialplanner dat blok 
met het gewijzigde commercialblok en plaatst dat tussen exact dezelfde tracks in. Vindt 
Commercialplanner geen commercialblok in de playlist binnen de offset tijdspanne, dan 
wordt een commercialblok altijd op basis van de ingestelde bloktijd in de playlist 
geplaatst. 
 

Tip! Om Commercialplanner-export de gelegenheid te geven om gewijzigde 
commercialblokken altijd tussen de tracks te plaatsen zoals aangegeven in de 
Formatplanner uurformats kunt u bijvoorbeeld in ieder commercialblok een voor- of 
najingle of een promo campagne plannen. Zo kunt u bewerkstelligen dat in ieder 
commercialblok minimaal 1 item aanwezig is overal in de playlist een commercialblok 
aanwezig is wanneer er playlists gepland worden. Als er overal een commercialblok 
aanwezig is, dan is de Commercialplanner in staat om alle in de playlists aanwezige 
commercialblokken te matchen en op exact dezelfde positie een gewijzigd 
commercialblok te plaatsen. 

9.5 Dagoverzicht 

In het tabblad dagoverzicht krijgt de gebruiker een overzicht van welke commercials er 
gepland zijn. Bovenaan klikt u eerst in de tijdsbalk om het gewenste uur weer te geven. 
De blauwe balken geven aan in welke mate de desbetreffende uren met commercials 
gevuld zijn. 
 
De blokken die in het overzicht uit staan, zijn lichtgrijs gekleurd. Zo kunt u ook controleren 
of er nog commercials in blokken gepland staan die, mogelijk na de laatste planning, in 
de Standaard weekindeling uitgezet zijn. 
 
U kunt commercials ook manueel toevoegen aan het dagoverzicht door ze vanuit de lijst 
met beschikbare campagnes naar het gewenste blok te slepen. Is het toevoegen van 
een campagne niet mogelijk wegens een conflict, dan wordt dit onderin het venster 
zichtbaar. In de lijst zijn enkel campagnes zichtbaar waarvan de einddatum niet is 
verstreken op de datum van het overzicht. 
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Sneltoetsen 
 
Ctrl+PgUp Vorige dag 

Ctrl+PgDn Volgende dag 

PgUp Vorig uur 

PgDn Volgend uur 

 
Bij een aantal campagnes is achter de naam een getal tussen haakjes zichtbaar. Het 
getal geeft aan welke spot in dit blok is geplaatst. Bijvoorbeeld (2) geeft aan dat de 
tweede spot die u bij de campagnegegevens heeft ingevoerd in dit blok zal spelen. 
 
Het wordt aanbevolen om campagnes niet te verwijderen uit de campagnedatabank als 
ze nog in het dagoverzicht staan. In het dagoverzicht kan dan namelijk de naam van de 
campagne niet meer teruggevonden worden. Van verwijderde campagnes wordt in het 
dagoverzicht het ID getoond. Bijvoorbeeld [34] geeft aan dat campagne 34 uit de 
databank verwijderd is, maar nog wel in het dagoverzicht aanwezig is. 
 
Als een blok in het rood zichtbaar is, wordt hiermee aangegeven dat één of meerdere 
bestanden niet meer in de databank (en op de harddisk) aanwezig zijn. Dit kan tot 
problemen leiden bij het exporteren naar de playlist. Corrigeer de spots van de 
betreffende campagne. 
 
Met de knop ‘’Export is het mogelijk om de commercials van de gewenste dag te 
exporteren naar de bestaande playlists. Hiervoor mogen in de playlists geen blokken in 
gebruik zijn, bijvoorbeeld op een ander werkstation. Exporteren van commercials uit het 
verleden is niet mogelijk.  
 

Export 
Bij een druk op de knop ‘Export’ wordt “Deze dag” van het dagoverzicht geëxporteerd 
naar de playlist die correspondeert met de 
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dagoverzicht datum. En ook naar bestand als in de instellingen Dalet, RCS, Traffic 2000 
of E Power export actief is. 
 
Tevens is het mogelijk om alle dagen vanaf de huidige dag te exporteren naar de 
aanwezige playlists en ook naar tekstbestanden. Hiervoor drukt u op het pijltje naast de 

knop ‘Export’ en kiest u in het menu een van de opties ‘Vanaf deze dag … ’. 
 

  
 

Import  (Commercialplanner Xtra) 
Na een druk op de knop ‘Import’ kunt u een tekstbestand selecteren om een 
commercialplanning te importeren. Bij deze importfunctie wordt gebruik gemaakt van 
templates volgens het formaat ‘E Power’. 
 
AerOn - E Power format 
 

Field Required Format StartPosition CharLength 

Date v yy/mm/dd 1 8 

Time v hh:mm:ss 10 8 

CommBlockNumber v 1 -- 6 19 1 

Title - string 21 1 -- 30 (truncated) 

Artist - string 52 1 -- 30 (truncated) 

TrackLengthSeconds - digit 83 3 

AudioName v string 87 1 -- 255 

 
Maak een tekstbestand met meerdere regels, waarbij elke regel elk veld op de exacte 
startpositie heeft. 
 
1-Datum 10-Tijd19-CommBlockNr 21-Titel 52-Artiest 83-Tracklengte 87-Audionaam 
(zonder bestandsextensie) 
 
                  1                  2                  3                  4                  5                  6                  7                  8          
1234567890123456789012345678901234567890123456789012345678901234567890123456789012345678901234 
 

Voorbeeld: 
 
18/02/09 18:01:00 1 POSTBANK - HYPOTHEEKADVISEUR   COMMERCIAL                     032 COM149782 

 
De bloknummers in het tekstbestand moeten overeenstemmen met de algehele 
blokconfiguratie. Ieder corresponderend reclameblok dient in de Standaard weekindeling 
op status Import te worden gezet. De corresponderende blokken in de Standaard 
weekindeling moeten dus gemarkeerd zijn als importblok.  Blokken die als importblok 
zijn gekenmerkt kunt u onderscheiden aan de paarse kleur. 
 

Tip! Voorafgaand aan een import moeten de audiobestanden, behorend bij de 
commercials zijn geimporteerd in de AerOn database. 
 
Nadat een template is geimporteerd verschijnen de commercials in het dagoverzicht. 



Handleiding AerOn Commercialplanner 

 we make radio happen 129 

Daarna kunt u er eventueel uw eigen jingles omheen plannen en/of uw eigen campagnes 
tussendoor in de blokken plannen. 
 
 
Afdrukvoorbeeld 
 
Het is soms handig om een overzicht op papier bij de hand te hebben. U kunt dit overzicht 

uitprinten via het menu Bestand → Afdrukken of via Bestand → Afdrukvoorbeeld. 
Een afdruk hiervan ziet er als volgt uit: 
 

 
 
In het venster Afdrukvoorbeeld kunt u behalve het overzicht afdrukken, het bijvoorbeeld 
ook opslaan als PDF (voor Adobe Acrobat), HTML bestand of versturen per e-mail. 
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9.6 Edities 

Een editie systeem wordt opgebouwd met één master editie, en één of meerdere 
slave edities. Het idee achter edities is dat de slave edities het programma van 
de master editie uitzenden gecombineerd met ontkoppeling van 
commercialblokken. Iedere editie speelt lokaal commercials uit.  
Op de slave edities wordt rondom de commercialblokken extern audio 
geprogrammeerd in de uren waarin het programma van de master editie wordt 
uitgezonden. Dat kan 24 uur per dag, maar het is ook mogelijk om in bepaalde 
uren nonstop muziek uit de lokale database van de editie uit te zenden en in de 
overige uren het programma van het hoofdsysteem over te nemen.  
 
Als  op de master editie een commercialblok wordt gestart, gaat er d.m.v. een actie 
trigger een bericht naar alle slave edities zodat het externe audio wordt afgebroken en 
het lokale commercialblok wordt gestart. 
 
Om de berichten te verzenden wordt gebruik gemaakt van het Messaging protocol van 
de database server. Naast het ontkoppelen van commercials is het ook mogelijk nieuws, 
jingles en overige vormgeving te ontkoppelen. 
 
Voor AerOn Edities zijn per editie de volgende modules nodig:  
- AerOn Xpert of AerOn Web 
- Editie functies 
- Commercialplanner Xtra 

 

9.6.1 Configuratie master editie 
 

Output routering 
De audiofeed van de master editie die naar de slave edities gaat, moet een feed zijn 
zonder commercials.  Daarom configureren we op de master editie de playout van 
commercials op een aparte uitgang van de geluidskaart. Deze commercial-uitgang loopt 
buitenom het program signaal van de mengtafel en wordt verderop gekoppeld in de 
zendlijn van de master editie. Het program signaal van de mengtafel routeren we naar 
de edities. 
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Uitgaande Acties 
Het verzenden van berichten naar de slave edities vindt plaats middels een actie trigger 
die gekoppeld is aan een audiobestand.  Om een editie puls te kunnen genereren slepen 

we in Acties een track. Via menu Tools → Acties → Uitgaande Acties → 
Audiobestanden.  Dit mag bijvoorbeeld een 0.5 seconde stilte item zijn.  De actie 

‘Extern audio afbreken’ moet u hierbij instellen.  
 
In Commercialplanner stellen we dit item in als ‘Voorjingle 1’ zodat dit item altijd als 
eerste item in ieder syndicate ontkoppeld commercialblok wordt geplaatst. De 
gekoppelde actie wordt uitgevoerd zodra een audiobestand wordt gestart in de 
Live/nonstop player of in de Jingle player.  De master editie zendt in dit geval naar alle 
slave edities het bericht ‘Extern Audio Afbreken’. Het commercialblok op de edities wordt 
gestart en gaat spelen. 

 
 

Nieuws en jingles ontkoppelen 
Nieuws, Jingles en overige vormgeving die syndicate moet worden ontkoppeld sleept u 
in Acties. Op alle edities importeert u tracks met dezelfde AudioID met per editie andere 
audioinhoud kenmerkend voor het thema. De audio moet op alle edities dezelfde 
speelduur hebben. 
 

U sleept op de master editie de tracks vanuit Databank browser in Audiobestanden via 

menu Tools → Acties → Uitgaande acties → Audiobestanden. De actie ‘Regionaal 
afspelen’ moet u vervolgens bij deze tracks instellen.   

 
Diezelfde AudioID’s moeten op de edities zijn ingesteld bij Inkomende acties → 
Regionaal. Op de edities sleept u dezelfde AudioID’s naar Regionaal. Zodra een 
dergelijk regionaal item op de master editie wordt gestart, speelt de slave editie dit 
AudioID in de Regionale jingle speler. 
 
Regionaal items worden op de master editie net als commercials afgespeeld over de 
commercial playout uitgang. 

9.6.2 Configuratie slave editie 
 
De slave editie moet weten wie er berichten naar de edities verstuurt. Wie de master is. 

Via menu Tools → Acties → Inkomende acties → Messaging selecteren we de 
master editie database. 
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Acties Regionaal 
Via menu Tools → Acties → Inkomende Acties → Regionaal sleept u jingles, station 
calls en overige vormgeving die lokaal op de slave editie moet worden afgespeeld. Deze 
items hebben op alle edites dezelfde AudioID (bestandsnaam), maar hebben 
vanzelfsprekend op iedere editie andere audio inhoud kenmerkend voor het thema. De 
speelduur van deze items moet op alle edities, inclusief master editie, exact even lang 
zijn. Zodra op de slave editie een bericht wordt ontvangen met een AudioID dat in de lijst 
‘Regionaal’ staat, wordt dat item automatisch afgespeeld in de Regionale jingle speler.  
De audio wordt op de slave editie automatisch gerouteerd naar de nonstop-output. 
 

 
Overzicht regionaal items 
 

 
Regionale jingle speler 
 

Verlengen extern audio 
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Als er van de master editie nog geen bericht is ontvangen terwijl op de slave editie de 
starttijd van het eerstvolgende commercialblok reeds is bereikt, moet het Extern audio 
kunnen worden verlengd. Zodra een verlenging is getriggert, gaat een gele klok de 
resterende verlengtijd aftellen. Een binnenkomend bericht wordt tijdens de verlenging 
opgevangen zodat het commercialblok alsnog syndicate wordt gestart. In het 

onderstaand voorbeeld is de verlenging maximaal 20 minuten. Zie Instellingen → 
Automatisering → Algemeen → Extern audio. 

 
 
Zodra op de slave editie een bericht ‘Extern Audio Afbreken’ binnenkomt wordt het 
commercialblok gestart. Commercialblokken staan altijd in een playlist en worden 
afgespeeld in de nonstop-player. 
 

 
 
 
 

9.6.3 Centraal commercials plannen (Commercialplanner Xtra) 

 
Op de master editie of werkstation plannen we commercials voor alle edites 
ineens. De master editie moet weten voor welke edities er commercials gepland 
moeten worden. In de Commercialplanner-instellingen moet bij Netwerk de 
database van iedere slave editie worden ingesteld.  
 
Sluit Commercialplanner af na het instellen en opslaan van de database-
verbinding en open daarna opnieuw Commercialplanner om de editie databases 
in te laden. Hierna kunt u de campagnes en commercials van alle edities centraal 
beheren en plannen. 
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Vanwege de grote hoeveelheid gegevens die gepaard gaat met 
commercialplanning is het aanbevolen om alle editie PC’s onder één dak in het 
lokale netwerk te koppelen. 
 
 
 
Opvullen commercialblokken 
Op alle edities wordt op hetzelfde moment een commercialblok gestart. De 
commercialblokken moeten op alle edites evenlang afspelen om synchroon te 
blijven. Daarom moeten op alle edities commercialblokken parallel exact even 
lang zijn. Om commercial blokken op alle edities even lang te kunnen maken zijn 
er voldoende opvul-items nodig. Dat kunnen bijvoorbeeld jingles, promos, station 
calls of heel korte stilte items zijn. Tijdens het plannen kijkt Commercialplanner 
welk blok van alle edities het langst is. De commercialblokken op de overige 
edities worden met opvul-items opgevuld tot die lengte.   
 
In de Standaard blokindeling kunnen per editie alle voor- en najingles per blok 
worden gebruikt om op te vullen. Als per blok 1 jingle wordt gebruikt om op te 
vullen zijn er doorgaans meer opvul-items nodig dan wanneer er per blok twee 
jingles worden gebruikt. Bij gebruik van twee jingles per blok volstaan in de 
meeste gevallen 20 items. Tien opvul-tems oplopend van 1 tot 10 seconden en 
tien opvul-items van 10, 20, 30, …, 100 seconden.  Om bijvoorbeeld 14 seconden 
op te vullen kan Commercialplanner de items van 4 en 10 seconden combineren.  
 
Om de zeer kleine verschillen te kunnen opvangen kunt u nog opvul-items 
toevoegen met een lengte varierend van 300 milliseconden tot bijvoorbeeld 1 
seconde. In onderstaand voorbeeld zijn dit stilte items die we instellen als 
allereerste item (‘Voorjingle 1’) en/of als allerlaatste item (‘Najingle 2’). 
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Bij Jingle krijgt u een overzicht van beschikbare voor- en najingles 
 
 

Blok instellingen 
In de Standaard weekindeling moet per blok op iedere editie ‘Sync’ worden aangevinkt 
in de ontkoppelde commercialblokken. Middels ‘Sync’ wordt aangegeven dat het een 

editie blok betreft. De maximum lengte van ontkoppelde commercialblokken moet op 
iedere editie exact gelijk zijn ingesteld.  De posities van voor- en najingles, die u wil 

gebruiken om commercialblokken op te vullen, moeten per blok op <Opvullen> worden 

ingesteld. Tijdens het plannen worden op die posities gemarkeerd met <Opvullen> 
opvulitems ingevoegd. Per blok zijn er vier posities beschikbaar. 
 

Op de master editie kan en mag de mode op Uitvullen zijn ingesteld. Op de slave edities 

zetten we de mode van alle ontkoppelde commercialblokken altijd op Glijden. Op de 
slave edities moet het verschil in tijd tussen commercialblokken onderling groter zijn dan 

de maximum bloklengte, dit om te voorkomen dat commercialblokken in de playlist 
tegen elkaar aan gaan plakken. Tussen de commercialblokken in moet immers altijd 
extern audio aanwezig zijn. De bloklengte wordt ingesteld in seconden. Als blok 6 is 

ingesteld op Tijd 58 en blok 1 ingesteld op Tijd 2, is dat een tijdsverschil van 4 minuten. 
D.w.z., de maximale bloklengte van blok 6 moet dan lager zijn dan 240 (4 minuten). 
Bloktijden van blokken in eenzelfde uur zetten we 11 minuten uit elkaar i.v.m. de 10 
minuten marge t.o.v. de actuele starttijd in de playlist. 
Blok 1 Tijd 2, Blok 2 Tijd 13, Blok 3 Tijd 24, Blok 4 Tijd 36, Blok 5 Tijd 47, Blok 6 Tijd 58. 
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Blokindeling master editie  (Blok 6 mode is Uitvullen) 
 

 
Blokindeling slave editie  (Alle blokken mode Glijden) 
 

 
 
 
 
 
Campagnes toevoegen 
Nadat de commercialblokken en jingles per editie zijn ingesteld kunt u beginnen met het 
toevoegen van campagnes. Een nieuwe campagne moet altijd worden toegevoegd op 
de master editie. Bij het opslaan wordt die namelijk toegevoegd op alle edities. Alvorens 
op te slaan is het daarom handig om zoveel mogelijk gemeenschappelijke gegevens in 
te vullen. Na het opslaan kunnen per editie in iedere campagne andere instellingen 
worden gezet. 
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De campagnes van alle edities worden gepland vanuit één overzicht. 
 
Nadat de commercialplanning is voltooid kan in het dagoverzicht de planning van iedere 
editie worden gecontroleerd. De einddatums van campagnes mogen per editie 
verschillend zijn. Om de lopende campagnes van slave edities zichtbaar te krijgen in het 
planoverzicht op de master editie moet de einddatum van die campagnes op de master 
editie minimaal gelijk zijn aan de einddatum van campagnes op de slave edities. 
 
In het dagoverzicht kunt u de planning controleren. 
 

 
Dagoverzicht 
 
Is de commercialplanning eenmaal in orde, dan kunt u playlists plannen. Om de playlists 
te kunnen plannen moet er in Formatplanner een dagformat aanwezig zijn met ieder uur 
de extern audiobron van de master-editie. We zorgen ervoor dat tussen 
commercialblokken in ieder uur een externe bron met vaste begintijd aanwezig is. Dit om 
te zorgen dat de blokken op alle edities synchroon blijven lopen.  
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9.6.4 Multiple playout 

 
Het is mogelijk om meerdere AerOn edities op één PC te draaien. Dit biedt de 
mogelijkheid om kosten op hardware te besparen. De audiokaart in de PC moet 
van het merk RME zijn omdat AerOn voor het schakelen en audio routering 
gebruikt maakt van de RME matrix mixer. Er zijn diverse RME audiokaarten 
beschikbaar. De RME audiokaart die wordt geïnstalleerd moet voldoende 
uitgangen hebben voor het aantal edities dat u wil draaien. 
 
Output routering 
Iedere editie moet afspelen op een eigen afspeelkanaal van de audiokaart. Per 
editie wordt een ander afspeelkanaal ingesteld. Iedere editie wordt op deze wijze 
in de RME matrix mixer gerouteerd naar een andere uitgang dan waar de overige 
edities op afspelen. Bijvoorbeeld edities 1 t/m 4 worden respectievelijk 
gerouteerd naar uitgangen 1 t/m 4. 

 
 
 
RME Extern & matrix 
Bij RME Extern & matrix stellen we de externe bron in. Per editie wordt ingesteld 
op welke ingang de audio van de master editie binnenkomt en naar welke uitgang 
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dat audio geschakeld moet worden. Hier configureert u dezelfde uitgang als die 
is toegewezen in Output routering. Dat is de nonstop uitgang waarop deze editie 
commercials afspeelt. 
 

 
 

 
 
RME TotalMix met 1x audio van de master editie en 4x slave editie output. 
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10 Nieuws 

In dit hoofdstuk laten we zien hoe u te werk moet gaan voor het opzetten van een 
nieuwsvoorziening. 
 
De nieuwsdienst stelt elk uur een nieuw item beschikbaar dat met een additioneel 
programma (ftp-programma) automatisch opgehaald wordt. Dit gebeurt idealiter kort 
voor het hele uur, zodat het nieuws zo actueel mogelijk blijft. Sommige nieuwsdiensten 
stellen hiervoor zelf een downloadtool ter beschikking die u vervolgens moet installeren 
en configureren. Raadpleeg hiervoor de handleiding van de leverancier. 
 
Nadat u het downloadprogramma heeft geïnstalleerd, moet AerOn studio ingesteld 
worden om de nieuwsitems automatisch te kunnen importeren. De map waarin het 

nieuws wordt gedownload moet in InOutBox als IN-box ingesteld worden. 
 

In Instellingen → Globaal → Audio lokaal geeft u op waar AerOn studio de 

audiobestanden kan vinden. Het nieuwsitem moet door InOutBox in één van de hier 

vermelde mappen of in een submap geplaatst worden. In InOutBox is dat de 

‘OutBoxmap’. InOutBox maakt bij ieder inkomend bestand een nieuw golfvormbestand 

dat gegevens bevat over het audiobestand zoals o.a. playout gain en duur. InOutBox 
kan ook gegevens in de database updaten of automatisch importeren. Voor nadere 

informatie raadpleegt u het hoofdstuk InOutBox. 
 
Het nieuwsitem moet na de eerste download worden toegevoegd aan de databank. 
Importeer het in de databank en dan in Databank editor, vult u titel en artiest in. In het 
tabblad ‘Criteria 2’ geeft u aan dat het om een nieuwsitem gaat, zodat u het makkelijk 
kunt opzoeken en zichtbaar maken in Databank browser. 
 

Tip! Als extra kunt u %d in de titel invoegen. In Live assist vervangt AerOn studio %d 
door de bestandsdatum en  -tijd. Zo heeft u een betere controle over de actualiteit. 
 
Op het tabblad ‘Editor’ zorgt u voor een correcte instelling van de mixtijden. AerOn studio 
houdt rekening met de relatieve verhouding tussen ‘volgende tijd’ (Start next) en ‘lengte’. 
Het nieuwsitem zal elk uur steeds een andere lengte hebben. De nieuwe lengte wordt 
automatisch in de playlist bijgewerkt. Het verschil tussen ‘volgende tijd’ en ‘lengte’, 
bijvoorbeeld 2 seconden,  blijft in de geplande playlist gehandhaafd. Past u in Databank 
editor ‘volgende tijd’ aan nadat er playlists zijn gepland, dan moet u opnieuw de playlists 
plannen om dat nieuwe verschil tussen volgende en lengte over te nemen. 
 
Om het nieuws te kunnen plannen is het nodig om in Formatplanner de uurformats aan 
te passen. Voeg een nieuwe regel in en stel deze in als Type ‘Track’.  U kunt vervolgens 
het nieuwsitem vanuit Databank browser of Item browser in het uurformat slepen. Vul 
ook een ‘Duur’ in. Neem de duur van het korste nieuws als maatstaaf, bijvoorbeeld 
00:01:30 anderhalve minuut. Als u ‘Duur’ op 00:00:00 laat staan, dan wordt het nieuws 
gepland met de actuele speelduur in de database op het moment van plannen. 
 

 
 
Na het plannen van playlists met de aangepaste formats kunt u de automatisering starten 
en zal elk uur automatisch het nieuws op de radio uitgezonden worden. 
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Mocht u op zeker moment constateren dat het nieuws niet elk uur automatisch wordt 
vernieuwd, dan moet u op zoek gaan naar de oorzaak. Een hulpmiddel hierbij is  
Databank editor waarin u op het tabblad ‘Statistieken’ kunt zien op welke datum en tijd 

het item voor het laatst is bijgewerkt. Ook de downloadlog in InOutBox kunt u 
raadplegen. 
 

 
 

Nieuwstune of bedje 
Sommige omroepen willen de nieuwsvoorziening wat persoonlijker laten klinken door het 
toevoegen van een tune die met het nieuws meeloopt. 
 
Hiervoor neemt u een item op met een lengte van bijvoorbeeld anderhalve minuut 
(vooropgesteld dat het nieuws ook minimaal zo lang duurt). Dit item begint meestal met 
een aankondiging van het nieuws, gevolgd door de tune. In de databank zet u de 

‘volgende tijd’ net na de aankondiging.  
 
Met de uurformats in Formatplanner zorgt u er voor dat dit item altijd precies voor het 
externe nieuws wordt gepland. U kunt ook de nieuwstune als vast uurformat item 
toevoegen. Dat doet u op dezelfde wijze als eerder voor het nieuws is beschreven.  
 
Wat gebeurt er in de uitzending? De aankondiging van het nieuws (nieuwstune) begint 
te spelen. Na enkele seconden wordt het nieuws gestart. De tune blijft ondertussen 
doorlopen en geeft zo het nieuws een persoonlijk tintje. 
 
Een andere mogelijkheid is tunes in het nieuwsbestand te mixen. Een tool zoals RTV 
AudioDownload Tool biedt uitgebreide mogelijkheden om tunes in het nieuws bestand 
te integreren. 
 

http://rtvsoftware.nl/
http://rtvsoftware.nl/


2025-05 Handleiding AerOn 

142 Broadcast Partners 

11 Automatisering 

Als er voor vandaag een playlist is gepland of als een naamplaylist als datumplaylist 
vandaag is opgeslagen kan pas de automatisering gestart worden. 
 
Er zijn twee manieren om de automatisering direct te activeren: 

• Via het menu: Automatisering  → Start; 
• Automatisch bij het starten van AerOn studio. Daarvoor moet in Instellingen → 

Automatisering → Algemeen de optie Automatisering starten bij opstarten 
AerOn aan staan. 

 
In beide gevallen laadt de automatisering de playlist van de huidige dag, zoekt daarin 
het item dat voor het moment van activeren is geprogrammeerd en gaat dat item spelen. 
Voor het laden van de juiste playlist zijn er twee mogelijkheden: 

• Er is een playlist voor de datum van vandaag; 

• Er is een naamplaylist met de naam van de weekdag (als er geen playlist voor 
de betreffende datum is). Als het vandaag maandag is, dan wordt de naamplaylist 
“Maandag” opgeslagen als datumplaylist vandaag. 

 
Er is nog een andere manier om de automatisering te starten: 

• Via het menu: Automatisering  → Start in Live assist; 
In dit geval zet de AerOn studio het item gereed in Live assist waarna u daarna deze 
interactief kunt starten. 
 
Formatplanner maakt bij iedere planning die u draait playlists met een datum. 
Formatplanner biedt als noodgreep de mogelijkheid om vanaf 23:45 automatisch een 
playlist te plannen. Naast deze optie zijn naamplaylists met namen van de dagen van de 
week handig als backup, mocht de automatische planning niet lukken of mocht u een 
keer vergeten te plannen, dan speelt in elk geval deze backupplaylist. Dergelijke 
naamplaylists worden geladen om 23:55 indien er voor de volgende dag geen playlist is. 
Is het morgen woensdag dan wordt naamplaylist woensdag geladen. 
 
De klok met blauwe cijfers geeft de huidige tijd aan, de automatisering vergroot dit 
venster en toont daarnaast extra klokken. De klok met groene cijfers geeft de resterende 
tijd van het huidige item of de resterende tijd van een commercialblok weer. Als er in de 
playlist items met vaste of semi-vaste begintijd zijn, ziet u links een rode klok met de tijd 
tot het eerstvolgende uitgevulde, semi-vaste of vaste item.  
 
Met de Semi-vast-optie is het mogelijk om de marge-tijd en berekende tijd van het 

eerstvolgende uitvulblok of semi-vast links onderin de klok weer te geven. Instellingen 

→ Automatisering → Algemeen → Toon labels Semi-Vast margetijd  Meer info 
hierover is te vinden in het hoofdstuk instellingen. 
 

  
 
Bij een AerOn Event licentie wordt rechts de resterende sessietijd weergegeven. 
 
De automatisering houdt van alle items die spelen de starttijd en duur bij. Dat is handig 
als u later één en ander wilt controleren. Zo wordt er, als u gebruikers invoert in AerOn 
studio, ook bijgehouden wanneer een gebruiker zich aan- of afmeldt op het systeem. 

Deze informatie is te vinden in de historie playout log (Bestand → Openen → Historie). 
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In het menu ‘Automatisering’ in de menubalk zijn ook nog een aantal andere opties te 
vinden: 
 

Extern audio toevoegen 
Met deze opie voegt u na het spelende item een externe audiobron in. In Instellingen 
→ Automatisering → Algemeen → Geforceerd item kunt u aangeven welke bron dat 
moet zijn. 
 

Stop extern audio 
Met deze optie kan een externe audiobron vroegtijdig afgebroken worden. 
 

Live assist 
De optie ‘Live assist’ wordt in het volgende hoofdstuk beschreven. 
 

Status 
De status van de automatisering toont welk item op dat moment in de playlist aan het 

afspelen is. U kunt hiervoor ook de functietoets F9 gebruiken. De actieve playlist toont 
het spelende item met een paarse balk. De kleur is naar eigen voorkeur instelbaar in  

Instellingen → Globaal → Algemeen → Kleuren → Actieve item. 
 

Monitor 
De monitor geeft op duidelijke wijze het huidige onair item en de komende vier items 
weer. 
 

  
 
Klik op de puntjes in het scherm midden-boven om de laatste twee tracks zichtbaar te 
maken. 
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12 Live assist 

Live assist kunt u openen via menu Automatisering → Live assist of de functietoets F12. 

 
Als u Live assist opent terwijl de automatisering in nonstop-mode speelt, ziet u bovenaan 
in de player m.b.v. de kleurstelling welke cart player actief is. Doet u verder niets dan 
ziet u dat bij een wisseling van een track in de automatisering de informatie in het venster 
automatisch wordt vernieuwd. De automatisering draait nonstop en loopt gewoon verder. 
 
Zolang u geen gebruik maakt van de Live assist-functie, draait de automatisering 
nonstop de tracks en verzorgt die de mixen onderling, de tracks worden in nonstop 
afgespeeld op één cart player. Als de presentator of DJ interactief tracks wil draaien en 
tussendoor presenteren, kan hij of zij gebruik maken van de Live assist-functie. (Functie-

toets F7). In interactieve Live assist-mode worden de tracks om en om op Cart player A 
en B afgespeeld.  
 
In de AerOn studio klokken geeft de middelste klok (groen) de resterende speeltijd van 
een track of de totale speeltijd van een commercialblok weer. In nonstop geeft de groene 
klok de resterende tijd weer totaan de ‘Volgende-tijd’. Dit is de ‘Volgende-tijd’ (Start next) 
die u per track in de Databank editor kunt instellen waarop de eerstvolgende track in de 
playlist automatisch gestart mag. Bij een track die wordt gestart in Live assist geeft de 
groene klok de resterende tijd weer tot aan einde-track. Live assist speelt interactief een 
track tot aan einde audiobestand, de DJ die bepaalt geheel zelf wanneer de track stopt 
en wanneer de volgende track start. Uitzondering hierop zijn tracks die tot een 
doorstartgroep behoren. Gegroepeerde tracks, behalve de laatste track uit een 
doorstartgroep, die worden automatisch gespeeld tot aan de “Volgende-tijd”, of zoals 
afgemixt met Mix editor. 
 
Voor gebruik van de Live assist-module heeft u het volgende nodig 

• Live assist-ondersteuning in de software; 

• CIM module voor remotestarts via een mengtafel. Of de licentie-optie Digitale 
mengtafel;  Optioneel SmartGPIO. SmartGPIO biedt bredere ondersteuning. 

• Bedieningsknoppen en faders op de mengtafel voor remotestart en eventueel 
voor het (de)activeren van Live assist. 

 

  
 
Bediening van de Live assist-functie is op verschillende manieren mogelijk: 
1. met de mengtafel (faders en knoppen). 
2. met de muis de play-, cue-, pause, of stopknop en etc.. aanklikken. 

3. met de toetsen F1 t/m F4.  zie Instellingen → Automatisering → Algemeen → 
Opties 

4. Met diverse randapparatuur zoals diverse mengtafels, MIDI en Elegato Stream Deck 
via SmartGPIO. 



Handleiding AerOn Live assist 

 we make radio happen 145 

 
U bent niet gebonden aan bediening via enkel de mengtafel, randapparatuur, 
toetsenbord of de muis. Het is mogelijk om deze te combineren. U kunt bijvoorbeeld met 
een muisklik een track cuën en die vervolgens middels de fader of knop op de mengtafel 
of via randapparatuur starten. 
 

 Zodra de automatisering is gestart kan de Live mode 

worden geactiveerd. Druk op de Live assist-knop (CD) in de werkbalk of druk F7. De 
bedieningsknoppen worden dan zichtbaar en geactiveerd. Vanaf dit moment zal de 
automatisering geen volgende tracks meer starten, tenzij u Live assist activeert middenin 
een doorstartgroep of commercialblok. In  Live assist-mode moet het interactief starten 
van tracks door de DJ gedaan worden. De automatisering zorgt er voor dat de volgende 
track of doorstartgroep steeds beschikbaar komt in de vrije cart player. Met een druk op 

F7 opent u het Live assist-venster meteen in de interactieve Live mode indien het 
venster nog niet was geopend. 
 

Tip! U kunt ook de automatisering starten in interactieve Live assist mode. Er zijn 
situaties waarin dit handig kan zijn, bijvoorbeeld als u vanuit een andere locatie de 
uitzending overneemt. 
 

  
 
Live assist en Automatisering spelen de tracks af op de ‘Playout output reference’. Per 
track wordt door AerOn automatisch een gain-correctie toegepast zodat alle tracks op 

het ingestelde playout output referentie level worden afgespeeld. Zie Instellingen → 
Globaal → Algemeen → Extra → Playout output reference. 
 

1. Bediening met de mengtafel 
De GPO start/stop puls van de mengtafel is verbonden met de CIM module.  Een 
start/stop puls kan ook ontvangen worden via Livewire, Ember plus of andere digitale 
protocollen. Zodra u de fader open zet, of op de mengtafel een knop indrukt, start de 
track in de betreffende cart player, evenzo stopt de track als de fader dicht gaat. De 
licentie-optie Digitale mengtafel biedt mogelijkheden tot verdere integratie met diverse 
mengtafels. Op de mengtafel zijn twee faders gereserveerd, één fader voor iedere cart 
player. 
 

2. Bediening met de muis 
Voor bediening met de muis heeft u meer mogelijkheden in Live assist. Van links naar 
rechts heeft u de volgende knoppen tot uw beschikking. 
 

Afspelen vanaf begin  Plaatst de cursor op de beginpositie. Fade-in start 

Afspelen na intro    Plaatst de cursor op positie einde intro 

Cue 1 Plaatst de cursor op positie cuepunt 1  

Cue 2 Plaatst de cursor op positie cuepunt 2  

Cue 3 Plaatst de cursor op positie cuepunt 3  

Afspelen vanaf outro Plaatst de cursor op positie begin outro 

Cue Zet het cue-punt op de cursor-positie 
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Eject Verwijdert de track uit de cart 

Play/Pause Start het afspelen of zet de track in pause 

Fade Fade-in en start track of fade-out en laadt 
volgende track 

Crossfade Fade-out de spelende track en start en fade-in de 
volgende track. 

 

Diverse cuepunten 
Met de knoppen 1, 2, en 3 heeft u drie vaste cuepunten tot uw beschikking. Deze 
cuepunten kunt u per track instellen in Databank editor bij Cue 1, 2 en 3 in het tabblad 
‘Editor’. Deze CUE-punten (gele lijn) worden net als INTRO en OUTRO (witte lijn) 
weergegeven in de golfvorm. Klik op knop 1, 2 of 3 om de track op die positie te cue-en. 
 

De cursor op elke positie cue-en   
De cursor kunt u op iedere willekeurige positie in de golfvorm cue-en. Sleep de cursor 
naar de gewenste positie in de golfvorm. Zodra u de cursor loslaat gaat de track in loop 
afspelen. Terwijl de track in loop afspeelt, druk dan op ‘CUE’ om op de cursor-positie  
cue-en. Druk op ‘PLAY’ om het afspelen te starten. Om opnieuw te cue-en druk dan op 
‘PAUSE’ en druk vervolgens opnieuw op ‘CUE’ om vanaf die cursor-positie te cue-en. 
Het afspelen kunt u ook meteen starten door te dubbelklikken in de golfvorm.  
Deze cue-funtie kunt u bijvoorbeeld ook gebruiken na het starten van de automatisering 
in Live assist mode. U kunt met deze cue-functie dan de eerste track scherp zetten op 
de gewenste cursor-positie in de golfvorm en deze afvuren zodra de track moet gaan 
spelen. 
 

Track openen in databank editor 
Dubbelklikken op een afbeelding opent de betreffende track in Databank editor. 
 

VU-meters en klokken 
 
Weergave klokken 
De weergave van de klokken kunt u aanpassen door erop te dubbelklikken of via de 
opties in het klok-menu.  De grootte van de digits schaalt automatisch mee met de 
venster-grootte. De lettergrootte is instelbaar via menu Venster. 
 

Total  is oplopend de speeltijd.   

Remain is aflopend tot einde bestand.  

Next is aflopend tot de volgendestart-tijd in de playlist.   

Intro is aflopend tot einde intro. 
 
Klok menu: 
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Weergave VU-meters en afbeelding 
De gevoeligheid van de VU-meters en de VU-schaal kunt u in stellen door er met de 
rechter muisknop op te klikken. U kunt de gevoeligheid instellen van -24 tot -90 dB. 
De afbeelding kan uitgezet zodat deze niet uit de database wordt geladen. De 
instellingen in de menus zijn persoonlijke instellingen. 
 
VU meter menu: 

  
 

Laad de 
actieve 
track in beide 
carts als beide 
carts in pauze 
staan 
 

Bij inschakelen van deze optie wordt het actieve item in 
beide carts geladen als er in beide carts niets speelt. Het gemak 
voor de DJ / presentator is dan dat het niet uitmaakt welke 
van beide faders hij of zij openschuift.  
Omdat de actieve track dan in beide carts gereed staat 
wordt altijd die gestart als een van beide faders open gaat. 

Kort gespeelde 
track niet in 
ReCue, meteen 
de volgende 
track inladen 

Met deze optie wordt een track bij het stoppen of het in pause 
zetten, ongeacht de speelduur, meteen uit de cart verdwijderd en 
wordt de volgende track uit de playlist inladen. 
 
Standaard staat deze optie uit en wordt een track die vanaf het 
laatste play command korter dan 1 minuut onair heeft gespeeld 
opnieuw in de Live cart gecued.  

  

Cross Fade 
mode 

Als u deze optie activeert wordt de crossfade functie aangezet. 
Crossfade-functie: Fade-out de spelende track en fade-in de 
volgende track. Klik op de crossfade button. 
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Autostart Vast 
of Semi-Vast en 
Live assist blijft 
actief 
 

Met deze optie wordt een Vaste of Semi-vaste track in Live assist 
automatisch gestart zodra de starttijd is bereikt, behalve als een 
studio automatisch wordt vrijgegeven. De voorgaande track wordt 
automatisch uitgefade als die glijdend is en Live assist blijft 
geactiveerd. Deze instelling overruled het automatisch 
uitschakelen van Live assist. 

 

Spreektijd weergave 
Als er niets speelt en de beide cart players in pauze staan, dan wordt in de AerOn studio 
klokken oplopend de spreektijd van uw presentatie weergegeven totdat u het volgende 
item afspeelt. 
 

 
 

Uitvulblok en Vast of Semi-vast 
Veelal is er in de playlist ieder uur een uitvullend reclameblok. Zodra de starttijd van een 
uitvulblok wordt bereikt speelt de automatisering automatisch het gehele uitvulblok. 
Afhankelijk van de automatiserings-instellingen blijft de Live assist-functie wel of niet 

actief. Zie  Instellingen → Automatisering → Algemeen → Opties  
 
Indien Live assist niet (automatisch) wordt uitgeschakeld dan bepaalt u zelf wanneer een 
item met semi-vaste of vaste begintijd moet starten. In Live assist-mode start standaard 
het vaste of semi-vaste item zodra u op play drukt of het start via de fader of knop op de 
mengtafel. Via een instelling kan een vaste of semi-vaste track automatisch starten. 
 
In uw persoonlijke instellingen zijn een aantal opties beschikbaar die u kunt gebruiken. 

Instellingen → Gebruiker → Persoonlijk → Live assist 
- Laad volgende track in beide carts als er niets speelt. 
- Bij stoppen van kort gespeelde track meteen de volgende inladen. 
- Autostart Vast of Semi-Vast en Live assist blijft actief. 
- Toon labels Semi-Vast margetijd. 
 

Zie het hoofdstuk Instellingen voor nadere uitleg. 

12.1 Doorstarten/groeperen 

In de playlist kunt u meerdere items groeperen (sneltoets CTRL+G) en zodoende 

automatisch laten doorstarten (sneltoets CTRL+D). Het groeperen gebeurt 

automatisch bij items die door Commercialplanner in de playlist zijn gezet. Andere items, 
bijvoorbeeld achtereenvolgens jingle, plaat kunt u manueel groeperen of anders gezegd 
doorstarten. Doorstartitems herkent u aan de pijlen voor de titels, de pijlen die de items 
als het ware bij elkaar houden. Een item met een pijl ervoor start automatisch door naar 
de volgende. 
 
Een doorstart maken kan heel eenvoudig door in de playlist één keer te klikken op de 
positie van de kolom waarin doorstartpijlen worden weergeven. Tijdens Live assist zal 
AerOn studio een doorstartblok als één geheel afspelen.  
 
Schakelt u tijdens zo’n gegroepeerd doorstartblok de Live assist-functie uit, terwijl Cart-
B speelt, dan start het volgende item op Cart-B of op Cart-A afhankelijk van de 
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instellingen ‘Uitvulblok altijd spelen in Cart A’ en ‘Nonstop altijd spelen in Cart-A’.   
Zie Instellingen → Automatisering → Algemeen → Opties 
 
Een gegroepeerd doorstartblok dat is gestart kan niet meer onderbroken worden zodra 
het tweede item is gestart indien dat blok drie of meer items bevat. De 
bedieningsknoppen van die Cart worden dan gedeactiveerd. In de andere Cart blijven 
de bedieningsknoppen geactiveerd, zodat u het eerstvolgende item na de groep kunt 
voorafluisteren en tijdig kunt instarten.  Een gegroepeerd doorstartblok (meestal 
reclame) wordt zoals eerder vermeld als één geheel afgespeeld.  Zodra het laatste item 
van een doorstartblok wordt gestart worden de bedieningsknoppen in de cart opnieuw 
geactiveerd.  
 
Bij het afspelen van een doorstartgroep in Live-assist wordt de mix tussen iedere track 
gerespecteerd en afgespeeld volgens de standaard mixtijden of volgens aangepaste 
mixtijden gemaakt in Mix editor. Bij het afspelen van één enkel item in Live-assist bepaalt 
de DJ altijd geheel zelf het faden met de fader op de mengtafel. 
 
Het voordeel van groeperen (doorstarten) is dat u de Live assist-functie actief kunt 
aanlaten tijdens reclameblokken of tijdens een zelf samengestelde groep en dat u 
daardoor geen extra werk heeft om een aantal tracks achter elkaar in zijn geheel 
automatisch opvolgend te laten afspelen. U heeft dan even uw handen vrij om even iets 
tussendoor te doen. Een alternatief is het systeem in nonstop-mode zetten. 
 
Track stoppen 
Zodra een actieve onair spelende track één minuut of langer heeft gespeeld, dan kan 
deze niet meer opnieuw ge-cued. Stopt u deze track dan wordt die uit de cart player 
verwijderd. De automatisering veronderstelt dan dat deze in uitzending is geweest. De 
andere cart player wordt dan de actieve. U hoeft dus niet de onair spelende track 
helemaal tot het einde te laten spelen om die automatisch uit een cart player te kunnen 
laten verdwijnen. 
 
Track inladen 
Als beide carts gepauzeerd zijn, dan wordt afhankelijk van een persoonlijke instelling de 

volgende track in beide carts geladen. Zie Instellingen → Gebruiker → Persoonlijk → 
Live assist  →  ‘Laad volgende track in beide carts als er niets speelt’ 
Als deze optie aan staat, dan maakt het niet uit welke fader u open zet. De eerstvolgende 
track wordt dan altijd gestart omdat die track dan in beide cart players is geladen. Zo 
kunt u voorkomen dat een andere track wordt gestart als u per ongeluk de verkeerde 
fader openzet. 
 

Tip! Met de eject-knop kunt u het item uit de cart verwijderen. Deze optie is handig als 

u besluit het geladen item niet te spelen. Sneltoets CTRL+Delete 

Als u deze optie gebruikt wordt automatisch de eerstvolgende track uit de playlist 
ingeladen. 
 
Track overgeslagen? 
Bij tracks die worden overgeslagen wordt de fadecurve in de playlist geheel uitgezet, dit 
wordt gedaan om te voorkomen dat bij voorafluistering in de mixeditor de overgeslagen 
track doorheen de volgende mix te horen is. Mocht het gebeuren dat u per ongeluk een 
track overslaat, en u wilt die alsnog afspelen, dan kunt u die track het beste naar beneden 
slepen in de run down van de playlist of plakken met CTRL+E. Bij het plakken met 
CTRL+E worden tracks altijd met de mixijden en de fadecurve uit de muziekdatabank in 
een playlist geplaatst. Bij het verslepen is dit afhankelijk van uw persoonlijke instellingen. 
Met kopiëren en standaard plakken CTRL+V worden track tracks altijd met de mixtijden 
en de fadecurve uit de bronplaylist in de doelplaylist. Tracks worden dan geplakt zoals 
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het eerder is afgespeeld of zoals het is bewerkt met Mix editor. Dit laatste geldt ook bij 
het kopiëren uit het verleden en plakken in de toekomst van de actieve playlist.  
 

Zie Instellingen → Gebruiker → Persoonlijk → Playlist → Fadecurve herstellen bij 
droppen, verplaatsen en verwijderen. Als deze optie uit staat, worden fadecurves en 
mixtijden bij het verslepen behouden zoals eerder afgespeeld of afgemixt met mix-editor. 
Bij het verwijderen van voicetracks wordt de fadecurve altijd hersteld zodat duckings 
ongedaan worden gemaakt. 
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13 Jingle players 

Jingle players kunt u openen via het menu Tools → Jingles, de functietoets F8 of het 
bijhorende icoon op de werkbalk. 

 
Jingle players kunt u los gebruiken of in combinatie met Live assist of Mix editor (zoals 
bij het opnemen van voicetracks). De lettergrootte is instelbaar via menu Venster. 
 

 
 
Het is mogelijk om voor iedere presentator / DJ en voor ieder programma een 
gepersonaliseerd jinglepakket met maximaal 14 tracks te maken. Jingles kunt u 
opzoeken in Databank browser of Item browser en vandaaruit in Jingle players slepen. 
U kunt ook jingles van en naar de playlist slepen en jingles verslepen tussen de carts. 
 
Jinglepakketten kunnen opgeslagen per gebruiker, per gebruikersgroep of algemeen. 
Algemene jinglepakketten zijn voor iedereen bereikbaar. 
 
De basisversie van Jingle players bevat twee jingle players, zodat u ineens uw 14 meest 
favoriete jingles beschikbaar hebt. Met Jingle players is het ook mogelijk meerdere 
jingles tegelijkertijd te laten spelen. Door een jingle aan te klikken wordt deze actief gezet 
in de cart. 
 
Op welk kanaal de jingles spelen, hangt af van de audiorouting die u heeft ingesteld in 

Instellingen → Lokaal → Audio → Output routering. Door het gebruik van 
multikanaal-audiokaarten is het mogelijk om elke player op een eigen fader op de 
mengtafel te zetten. 
 
Jingle players speelt af op de ‘Playout output reference’. AerOn studio past per track 
automatisch een gain-correctie toe zodat alle tracks op het ingestelde playout output 

referentie level worden afgespeeld. Zie Instellingen → Globaal → Algemeen → Extra 
→ Playout output reference. 
 
De tracks die in Jingle players zijn geladen worden standaard automatisch gecued zodat 
ze meteen instarten. Audiobestanden van tracks die gecued zijn, kunnen niet 
overschreven worden (bijvoorbeeld verkeersinformatie die telkens wordt vernieuwd). 
Houdt daar rekening mee. 
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In de VU-meters bevindt zich een menu met instelbare gevoeligheid en een optie om de 
VU-schaal weer te geven. Klik rechts op de VU-meters om dit menu op te roepen. 
 

 
 
Bij elke jingle bevindt zich onder de rechter muisknop ook een menu met de volgende 
opties: 
 

 
 

Na afspelen 
opnieuw cue-en 

Dit is de standaardinstelling. 

Na afspelen 
volgende cue-
en 

Na het afspelen van een jingle wordt de volgende jingle in de player 
gecued. 

Selecteer 
zonder afspelen 

Als de cart is ingesteld op ‘Direct starten bij muis selectie’ kunt u 
hiermee toch een andere jingle selecteren als u die met de 
mengtafel wilt starten. 
 

Verwijder jingle Verwijdert de geselecteerde jingle uit de cart. 

Begin / Fade in  
Intro 

De standaard afspeelpositie is het ‘fade in’-punt. Desgewenst kiest 
u hier een ander startpunt, bijvoorbeeld het refrein. Deze tijden 
kunnen worden ingevuld of aangepast in Databank editor. 

 
Jinglepakketten kiezen, maken of verwijderen kan via het menu dat bereikbaar is met de 
knop rechtsboven in iedere cart. 
 

 
 

Faderstart 
gebruiken 

Met een CIM-module en een analoge- of digitale mengtafel kunt u 
jingles gemakkelijk starten en stoppen. Door deze optie uit te 
schakelen, verhindert u het starten van een jingle als een fader op 
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de mengtafel wordt opengezet. Dit kan handig zijn als u jingles 
enkel start met een keypad op de mengtafel of een Tipro keyboard.  

Of ‘Faderstart gebruiken’ actief is kunt u herkennen aan de kleur 

van de knop F linksboven. Is deze groen dan is faderstart actief. 
 

Toon 
resterende tijd 
tijdens intro 

Met deze optie zal de introtijd getoond worden zolang de einde-
introtijd tijdens het afspelen nog niet is bereikt. 

Direct starten 
toetsenbord 

Deze optie geldt o.a. voor gebruikers die een Tipro-keyboard 
hebben of een mengtafel met een keypad (zie hoofdstuk 13.2 voor 
meer informatie hierover). Het Tipro-keyboard kunt u gebruiken om 
een jingle direct te starten. Als deze optie uitstaat, zet u een jingle 
klaar in de cart. Om te starten druk dan nogmaals om de geladen 
jingle te starten.  

Bij integratie met Digitale mengtafel wordt dit bij een aantal 
mengtafels aangegeven met de kleuring van knoppen. Zo ziet u 
meteen of een jingle klaar wordt gezet of direct gestart zal worden. 

Direct starten bij 
muis selectie 

Bij het gebruik van een touchscreen start u hiermee de jingle 
meteen als u die aanraakt op het scherm. 

Artiest 
weergeven 

Geeft naast de titel van de jingle ook de artiest weer. 

Golfvorm 
weergeven 

Afhankelijk van de beschikbare hoogte op het scherm kunt u er voor 
kiezen om de golfvorm wel of niet weer te geven. 

 
Alle bovengenoemde instellingen worden per gebruiker opgeslagen en bewaard. 
 
Vanuit Windows Verkenner of File browser kunnen audiobestanden worden gesleept 
naar Jingle players, waarin ze dan als track worden toegevoegd. Vanuit Windows kunt 
u bestanden slepen vanuit een map of vanuit een zoekresultaat. Audiobestanden 
gesleept uit Windows verkenner of File browser die niet in de database aanwezig zijn, 

worden in Jingle players cursief weergegeven. De kleur kunt u desgewenst instellen via 

Instellingen → Algemeen → Kleuren → Track uit Verkenner. 
 

Tip! Als een vanuit Windows Verkenner of File browser gesleept audiobestand nog niet 
in de muziekdatabank aanwezig is, dan wordt het audiobestand afhankelijk van de 

Toevoegen databank-optie aan de muziekdatabank toegevoegd. U moet voldoende 
rechten hebben om deze optie te mogen aanvinken. 

(Zie onderin op de statusbalk)   
 
Het gesleepte audiobestand dient wel in één van de audio-hoofdmappen of in een 

submap daarvan te staan. Zie Instellingen → Globaal → Audio lokaal.  
Versleept u vanuit een andere map, een map die niet bekend is als audiomap, dan wordt 
Databank import geopend. U moet voldoende rechten hebben om audiobestanden te 
mogen importeren. 
 
Jingle players kan full screen weergegeven op een apart beeldscherm. 

Instellingen → Lokaal → Algemeen → Jingles full screen 
 
Het kleurenpallet bij een Tipro keyboard kan naar wens uitgeschakeld. 

Instellingen → Gebruiker → Persoonlijk → Tipro achtergrondkleuren 
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13.1 Jingle players Xtra 

Met de aanvullend aan te schaffen module Jingle players Xtra breidt u het aantal players 
uit naar maximaal 8 en krijgt u daarnaast extra mogelijkheden. Klik met de rechter 
muisknop bovenaan in het zwarte vlak in Jingle players om het aantal carts te 
veranderen naar uw persoonlijke voorkeur. Het aantal players wordt per gebruiker 
bewaard. 
 

 
 
Als de optie ‘Aantal carts’ niet zichtbaar is, dan is in de gebruikersinstellingen een vaste 
waarde ingesteld. 
 

 
 

Onder de rechter muisknop bij elke jingle bevindt zich een uitgebreider menu met de 
volgende opties: 
 

Groeperen Twee of meer jingles groeperen (doorstarten) om deze als één 
geheel af te spelen. 
 

Na afspelen 
opnieuw cue-en 

Dit is de standaardinstelling. 

Na afspelen 
volgende cue-en 

Na het afspelen van de jingle wordt de volgende jingle in de 
player gecued. 
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Na afspelen 
volgende starten 

Na het afspelen van de jingle wordt direct de volgende jingle in 
de player afgespeeld. 

Herhalen Na het starten van de jingle wordt deze steeds herhaald totdat 
de gebruiker zelf de jingle stopt. 

Selecteer zonder 
afspelen 

Als de cart is ingesteld op ‘Direct starten bij selecteren’ kunt 
u hiermee toch een andere jingle selecteren als u die met de 
mengtafel wilt starten. 

Verwijder jingle Verwijdert de geselecteerde jingle uit de cart. 

Begin / Fade in 
Intro / Cue 1 
Cue 2 / Cue 3 

De standaard afspeelpositie is het ‘fade in’-punt. Desgewenst 
kiest u hier een ander startpunt, bijvoorbeeld Cue 1. Deze tijden 
kunnen worden ingevuld of aangepast in Databank editor. 

Refrein Wanneer bij de track een refrein is ingesteld in Databank editor 
dan kan het refrein in Jingle players afgespeeld worden door 
deze optie te gebruiken.  

Handmatig starten Dit is de standaardinstelling. De jingle wordt door de gebruiker 
gestart. 

Automatisch 
uitvullend 

Met deze optie kunt u een jingle als uurafsluiter exact laten 
aansluiten op een uitvulblok of (semi-)vast.  De jingle wordt 
automatisch gestart zodat de “volgende tijd” van deze jingle, die 
in Databank editor is ingesteld, op hetzelfde moment 
terechtkomt als de begintijd van een uitvulbok of (semi-)vast. 
Zolang het start tijdstip nog niet is bereikt telt de teller in het 
rood af naar de tijd waarop de jingle automatisch start. 
 

Handmatig 
uitvullend 

Gelijk aan automatisch uitvullend, met het verschil dat men het 
startijdstip van de jingle zelf kan bepalen. 
 

Bovenstaande instellingen worden per pakket bewaard. 
 
Automatisch en handmatig uitvullend starten is bedoeld om jingles af te spelen, zodat 
het einde daarvan perfect uitkomt met het uitvulblok of het (semi)vast item van de 
automatisering. Voor het afkondigen van een programma over een jingle is dit handig. 
De gebruiker hoeft daarbij dan niet steeds uit te rekenen hoeveel tijd deze nog heeft om 
netjes uit te komen. Het voordeel om dit te doen via Jingle players is, dat de jingle op 
een andere schuif van de mengtafel afspeelt zodat de Live Carts dan vrij blijven voor 
waarvoor ze zijn bedoeld: het afspelen van muziek uit de playlist. 
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13.2 Jingle keypad 

Tipro-keyboards zijn beschikbaar in 
verschillende formaten afhankelijk van 
het gewenste aantal afspeelbare 
jingles. Het keypad op de afbeelding 
hiernaast bijvoorbeeld, heeft 28 
mogelijke jingles, direct beschikbaar 
onder een eigen knop. Bij jingle player 
Xtra is optioneel een keypad 
beschikbaar met 64 knoppen (56x play 
en 8x stop) om zo alle 8x7 jingles te 
kunnen starten en stoppen. Voor het 
gebruik van dit keypad is installatie van 
de driver vereist. Sluit eerst het Tipro 
keyboard aan op een USB-aansluiting van de PC. Installeer daarna de driver. Het 
installatiebestand kunt u downloaden met onderstaande link. 
http://update.aeronstudio.nl/files/tipro_driver_opos_cco.exe 
 

Installatie procedure 
1) Sluit AerOn studio af. 
2) Sluit het Tipro keyboard aan op USB. 
3) Installeer de Tipro driver. 
 

Update procedure 
1) Sluit AerOn studio af. 
2) Koppel het Tipro keyboard los van USB. 
3) Open: Configuratiescherm → Programma’s → Programma’s en onderdelen 
4) Verwijder OPOS Service. 
5) Verwijder OPOS Common Control Objects. 
6) Sluit het Tipro keyboard aan op USB. 
7) Installeer de Tipro driver. 
 
Het Tipro keyboard werkt in alle Windows versies. In Windows 10 build 1809 werkt het 
vanaf driver 1.0.8.27 i.c.m. AerOn studio 1.12.2.25 (of hoger). 
 

http://update.aeronstudio.nl/files/tipro_driver_opos_cco.exe
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14 Mix editor 

Mix Editor kunt u openen via het menu Tools → Mix Editor, de functietoets F5, het 
bijhorende icoon op de knoppenbalk of via het playlistmenu. 

 
Met Mix editor kunt u de overgang tussen tracks aanpassen, voicetracks opnemen, fades 
instellen, gain aanpassen. 
 

 
 
Het bovenstaande venster toont Mix editor Xtra met de drie beschikbare audiosporen 
met de mix tussen tracks. Mix editor basis heeft twee audio sporen. De golfvorm van de 
track in het bovenste spoor staat vast en kan niet versleept worden. De golfvormen van 
de tracks in de onderste twee sporen kunnen met de rechter muisknop worden versleept. 
 
In het menu onder de rechter muisknop bevinden zich de volgende opties: 

 

Menu opties 
De menu-instel-opties worden automatisch per gebruiker 
opgeslagen en bewaard. 

Play 
Start deze track 
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Stop 
Stop het afspelen. 

Gain 

Met deze gain-offset optie kunt u per track en per voicetrack 
een extra afspeelcorrectie instellen. 

Deze gain-offset is een afspeelcorrectie t.o.v. het Playout 

output reference. Zie Instellingen → Globaal → 
Algemeen → Extra → Playout output reference. 

De gain offset wordt effectief toegepast tot een playout 
output level van max. peak 0 dB. Het totale afspeel level zal 
per track en per voicetrack nooit harder worden dan peak 
0dB. 

 

Gain lijn weergeven 

Toon de gain lijn.   

Met deze optie kunt u de gain lijn tijdelijk uitzetten. 

 

Externe video player 
Open de track in een externe video speler.  Sneltoets 

CTRL+ALT+M 

Databank editor Open de track in Databank editor.   Deze optie is niet 
beschikbaar in het voicetrack spoor. 

Verwijder track Verwijder de track uit de playlist. 

Duck Duck het gedeelte van de tracks in spoor 1 en 3 waaronder 
de voicetrack is gepositioneerd. Deze optie is enkel 
beschikbaar in het voicetrack spoor. 

Zie  Instellingen → Gebruiker → Persoonlijk → Voice 
track om uw eigen voorkeuren in te stellen. 

vMix voicetrack video Als u deze optie activeert zal Mix editor in vMix een video 
opname starten en bij het stoppen deze inladen als 
voicetrack. 

Zie  Instellingen → Lokaal → Algemeen → Voice track 
vMix Visual Radio 

Automatisch opslaan Automatisch opslaan bij bladeren. 

Wijzigingen worden automatisch opgeslagen als u naar de 
volgende mix bladert. 

Voice Track spoor Toon het voice track spoor en de opname-VU-meters. 

4e Spoor Toon het vierde spoor. (Voicetracking Xtra) 

Zoom Alles Toon tijdens het bladeren alle golfvormen altijd volledig. 

Automatisch instarten Als het afspelen in spoor 1 is gestart en daarna de opname 
is gestart, dan wordt tijdens het opnemen van een 
voicetrack automatisch de track in spoor 3 gestart als de 
tijdlijn cursor over het begin van die track loopt. Dit geldt ook 
voor de track in spoor 4. (Voicetracking Xtra) 

 

Knoppen per spoor 

 
Speel deze track. 
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Zoom in op de mix-overgang. 

 
Mute deze track. 

 
Open de VST2 plugin om de diverse parameters in te 
stellen. (VST2 voice track plugin host) 

 

Om uw VST2 plugin dll in te vullen zie. 

Zie Instellingen → Algemeen → Voicetrack → VST  

  

Golfvorm lijnen  

Witte lijn (vertikaal) 
 

Intro- of uitrotijd. 

Een introtijd wordt weergegeven met een witte lijn links. 

Een uitrotijd wordt weergegeven met een witte lijn rechts. 

 

Rode lijn (vertikaal) Volgende tijd in de database. 

De rode lijn verschuift nooit bij het muteren van een mix. De 
rode lijn representeerd altijd de per track ingestelde volgende-
tijd waarop in nonstop de volgende track start.  

Gele lijn (horizontaal) Gain. Deze gain is een offset t.o.v. het playout output 
reference level. Hiermee kunt u een track bijvoorbeeld 
zachter afspelen als ondergrond. 
 
In uw persoonlijke instellingen kunt u aangeven of de gain-
correctie automatisch wordt toegepast bij voicetracks. 

Instellingen → Gebruiker → Persoonlijk → Voice track. 
 

Blauwe lijn Fadecurve. De blokjes kunt u verslepen om de fading/ducking 
te wijzigen. Na het wijzigen van de fadecurve verandert de 
kleur van deze lijn van blauw naar rood. Na het opslaan of 
ongedaan maken wordt de kleur weer blauw. 

 
De vorm van de muiscursor geeft aan wat u kunt aanpassen van een geselecteerde 
Fadecurve: 
 

 

Verplaats de geselecteerde lijn horizontaal naar voren of naar 
achteren. Hierbij vindt een verplaatsing in tijd plaats. 

 

Verplaats de geselecteerde lijn verticaal. Hier vindt een wijziging 
van het ducking level plaats. 

 

De geselecteerde punt kunt u zowel horizontaal als verticaal 
verplaatsen. 

 
 

Algemene knoppen 
Onderin het venster vindt u nog een aantal knoppen met de volgende functies: 
 

 ‘Record’. Sneltoets R 

Voor de opname van een voicetrack is het raadzaam de 
opname-instellingen te controleren. Deze instellingen vindt u 
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in Instellingen → Globaal → Algemeen → ‘Databank 
editor en Voice track. 
 
Zie ook 

Instellingen → Gebruiker → Persoonlijk → Voice track. 
 

 ‘Play’. Sneltoets P  

Speelt de volledige mix.  
 
Als u dubbelklikt op een bepaald punt in de mix (golfvorm), zal 
Mix Editor vanaf dat punt gaan spelen.  
 

 ‘Stop’. Sneltoets S 

Met deze knop stopt u het afspelen of opnemen.  

 ‘Zoom alles’. De zoomfactor wordt zodanig ingesteld dat de 
voorgaande en volgende track volledig in beeld komen. 

 
‘Zoom in’. 

 
‘Zoom uit’. 

 
Slotje: Golfvorm van voicetrack en tracks vrij verschuiven.  
 
Met een geopend slot kan een golfvorm vrij en onafhankelijk 
onder een intro gepositioneerd worden. (Voicetracking Xtra). 
De golfvormen van de opvolgende tracks verschuiven met een 
geopend slot niet mee.  
 
Met een gesloten slot verschuiven de golfvormen van 
opvolgende tracks wel automatisch mee als u een golfvorm 
verschuift. 
 

In  Instellingen → Gebruiker → Persoonlijk kunt u instellen 
hoe het slotje reageert. Standaard instelling is slotje dicht. Het 
slotje gaat dan standaard dicht bij het bladeren naar de 

volgende track. Er is ook optie Automatisch waarbij het slotje 
in een aantal situaties vanzelf open springt. 
 

 
Navigatie, opslaan, undo 
De twee groene pijlen laten u door de playlist bladeren om zo 
snel tussen mixpunten te wisselen.  
 
Het oranje vinkje slaat een gewijzigde mix op.  
 
Het pijltje naar rechts is een ‘Undo’ functie, deze maakt de 
laatste wijziging(en) ongedaan. De ‘Undo’ functie kan best 
gebruikt worden voordat een voicetrack her-opgenomen 
wordt. 

 

Opname en input-instellingen 
De opname VU-meter is enkel zichtbaar wanneer het voicetrack spoor is geactiveerd. In 
de VU-meter bevinden zich, onder de rechter muisknop, de VU-meter opties en input 
selectie: 
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Gain aanpassen 
Mix editor speelt af op de ‘Playout output reference’. AerOn studio past per track 
automatisch een gain-correctie toe zodat alle tracks afspelen op het ingestelde playout 

output referentie level. Zie Instellingen → Globaal → Algemeen → Extra → Playout 
output reference. 
 
De gain in Mix-editor is een offset t.o.v. dit algemene playout output referentie level. Met 
de gele lijn die door de golfvorm loopt kunt u snel de gain offset aanpassen, i.p.v. dit via 
het menu te moeten instellen. U kunt een track bijvoorbeeld als ondergrond zachter laten 
afspelen door de gain offset te verlagen.  
 
Als de gele lijn omhoog of omlaag gesleept wordt, dan ziet u de golfvorm ook groter of 
kleiner worden. De golfvormen worden automatisch geschaald naar de Playout output 
reference + de toegepaste gain offset. De gain offset wordt maximaal toegepast tot een 
playout output level van max. peak 0 dB.  Een track of voicetrack zal in totaal nooit harder 
afspelen dan peak 0 dB.  Zie ook de trackgegevens in Databank editor voor de peak en 
RMS waarden. 

  
De kleur van de lijnen verandert zodra u iets wijzigt in de mix. De gele lijn wordt 
donkerder en de blauwe lijn kleurt rood. 

  
 
Auto-cue 
Tracks die in Mix editor zijn geladen worden automatisch gecued zodat ze meteen 
instarten wanneer u op ‘Play’ drukt. Audiobestanden die in Mix editor zijn geladen en dus  
gecued zijn, kunnen niet overschreven worden. Houdt daar rekening mee. Denk 
bijvoorbeeld aan nieuws en verkeer die ieder uur overschreven worden. 
 
Track knippen 
Het begin van een track ‘wegknippen’ doet u alsvolgt: 
- Houdt de shift-toets ingedrukt en sleep de golfvorm van de track naar links. 
 
Track interacief mixen 
In Mix editor Xtra kunt u mixen alsof u live aan het draaien bent:  
- Start de track in spoor 1 met de spatiebalk, start de volgende track met de play knop 

in het spoor waarin de track is geladen.  
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Automatische doorstart (Jingle onder intro) 
Wanneer u een kort item (jingle) volledig onder een lang item schuift, dan wordt in de 
playlist automatisch een doorstart gezet. Als een kort item (jingle) wordt versleept zodat 
die niet meer volledig onder een track valt dan wordt de doorstart ongedaan gemaakt. 
Ook als u in Mix editor een item erbij insleept worden doorstarts ongedaan gemaakt, 
behalve als alle in Mix editor geladen tracks tot dezelfde groep behoren en dus een 
doorstart hebben.  
 
Jingles die volledig onder het intro liggen krijgen in de playlist een aangepaste weergave.  
De starttijd wordt dan cursief  met *  weergegeven. 
 

  
 

Tip!  Bij het slepen van jingles onder een intro kunt u indien nodig de sorteervolgorde 
wijzigen met de playlist-sorteer-optie Begin/Midden. Zo kunt u per mix de ideale 
weergave bekomen. 
 
Tip!  Bij het verschuiven van tracks in Mix editor die vlak na zeer korte stilte-items staan, 
daarbij moet u opletten dat u de startpositie van de muziektrack niet onbedoeld voor het 
zeer korte stilte-item uitschuift. Neem hier als bijvoorbeel een stilte-item dat later wordt 
vervangen door bijvoorbeeld verkeersinformatie. Als het stilte-item volledig onder een 
muziek track is geschoven dan zal na vervangen van dat bestand vanzelfsprekend de 
verkeersinformatie ook volledig onder de muziektrack staan en zo doorelkaar afspelen. 
 
Ook bij gebruik van “Update tijden van muziekdatabank” moet u er rekening mee 
houden, dat tracks in de gewenste volgorde staan na het afmixen. 
 

14.1 Voicetracks opnemen 

Zodra u een opname start, verschijnt automatisch het voicetrack spoor in beeld.  

Droog opnemen (tussen outro en intro) 
Wanneer u een opname start terwijl er niets afspeelt in Mix editor, dan wordt de 
voicetrack gepositioneerd tussen outro en intro. Met in acht neming van uw persoonlijke  

voicetrack-instellingen.  Zie Instellingen → Gebruiker → Persoonlijk 
 
Via Instellingen → Gebruiker → Persoonlijk → Voice track kunt u middels ‘Positie’ 
bepalen hoe de voicetrack na opname wordt gepositioneerd. 

- Na outro:       begin van voicetrack = begin outro 

- Begin track:  begin van voicetrack = begin intro  

- Tegen intro:  einde van voicetrack = einde intro 
 

Bij positie ‘Na outro’ overlapt de voicetrack begin-outro totaan einde-intro, Bij positie 

‘Begin track’ overlapt de voicetrack begin-intro tot aan einde-intro. Neemt u langer op 

dan de intro-lengte dan gaat de voicetrack het outro overlappen. Bij positie ‘Tegen intro’ 
overlapt de voicetrack vanaf einde-intro tot aan begin-outro. Is de voicetrack langer dan 
outro + intro, dan schuiven de tracks uit elkaar. 
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Interactief opnemen (Voicetracking Xtra) 
Naast droog opnemen biedt Mix editor Xtra de mogelijkheid om interactief op te nemen. 
Met deze werkwijze kunt u de positie en plaatsing van de voicetrack geheel zelf bepalen 
d.m.v. de handelingen die u verricht tijdens het opnemen. 
 
Interactief opnemen doet u bijvoorbeeld als volgt:  
- Start het afspelen in spoor 1.  
- Start de opname.  
- Spreek een voicetrack in.  
- Start het afspelen in spoor 3 om de track vanaf dit startpunt te positioneren onder de 

voicetrack.   
- Start eventueel de track in spoor 4. 
- Spreek de voicetrack verder in.  
- Stop de opname.  

 
Met deze wijze van opnemen bepaalt u geheel zelf de positionering van de voicetrack. 
Automatische ducking, fading en levels worden toegepast aan de hand van uw 
persoonlijke instellingen. 
 
Mix editor weergave met opgenomen voicetrack 
 

  
 
Tijdens een opname geven de balkjes, onderaan in het venster, de resterende tijd aan 
tot het outro (linker balk) en het intro (rechter balk). Zodat u op eenvoudige wijze ziet 
hoeveel tijd u nog over heeft om te spreken over het intro of outro. In de middelste balk 
wordt oplopend de lengte getoond van de voicetrack die u aan het opnemen bent.  
 
Persoonlijke voicetrack-instellingen 

Zie Instellingen → Gebruiker → Persoonlijk voor de diverse voicetrack-instellingen. 
Voor gedetailleerde uitleg over deze instellingen raadpleeg hoofdstuk Instellingen. 
 
Automatische ducking en fadecurve 
Na opname van een voicetrack berekent AerOn studio de audioniveau’s en stelt de intro- 
en outro ducking zodanig in zodat de presentatie niet overstemd wordt door de muziek. 
De muziek die onder de voicetrack valt wordt zo automatisch geduckt. Het duck level is 
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instelbaar van 0 tot -12 dB. Stiltes aan het begin en einde van een voicetrack worden 
automatisch  “geknipt” met de fadecurve, zodat er geen witjes ontstaan. U kunt dit zien 
aan de extra punten en lijnen die dan na een opname in de fadecurve verschijnen. U 
kunt de fadecurve na voltooien van een opname altijd nog naar wens aanpassen. Als u 

de voicetrack en/of tracks verschuift en daarna in het menu op ‘Duck’ klikt, dan worden 
de duck levels automatisch herberekend en toegepast op de gewijzigde mix. De ducking 
kunt u per voicetrack naar wens fine-tunen. 
 
Voicetrack her-opnemen 
Wanneer u een voicetrack wil her-opnemen dan moet u eerst een ‘Undo’ uitvoeren om 
weer tot de oorspronkelijke mix te komen.  Vervolgens neemt u de voicetrack nogmaals 
op.  Doet u geen ‘Undo’ uitvoeren dan houdt Mix editor bewust de tijden en duck aan 
zoals die na de eerste opname zijn ontstaan.  
 
Voicetrack verwijderen 
Wilt u na het opslaan alsnog een voicetrack verwijderen, verwijder die dan vanuit Mix-
editor en niet vanuit de playlist. Als u vanuit Mix-editor verwijdert worden de fadecurves 
van de tracks in spoor 1 en 3 automatisch hersteld tot de default waarden. Om te 
verwijderen klik rechts in het voicetrack spoor en selecteer in het menu Verwijder track. 
 
MIC processing met voicetracks 
Om er voor te zorgen dat voicetracks hard genoeg kunnen worden afgespeeld is het 
nodig om altijd in te spreken in een microfoon met voiceprocessing erachter zodat de 
Loudness (RMS-waarde) van de audio wordt verhoogd. Zonder voice-processing 
(compressor/limiter) zijn er meer peaks van 0 dB en is gemiddelde loudness lager. 
Harder dan 0 dB is niet toegestaan binnen AerOn studio. Dus ook al verhoogt u de gain, 
een voicetrack zal niet harder afspelen zodra er een peak 0dB is. Hoe hoger de RMS 
van een voicetrack is, hoe beter die over de muziek heen komt, met als gevolg dat er 
minder ducking van de muziek nodig is waardoor muziek-spraak-muziek-overgangen 
beter zullen klinken. Een voicetrack met RMS-waarde van ongeveer -12dB is goed. Een 
alternatief i.p.v. een voice-processor is gebruik maken van een VST2 plugin. 
 
VST plugin  (VST2 voice track plugin host) 
Mix editor biedt ondersteuning voor VST2 plugins.  
 
Bij AerOn worden standaard enkele free en trial VST2 plugins meegeleverd. 

Om uw VST2 plugin dll in te vullen, zie Instellingen → Algemeen → Voicetrack → 
VST. 
 
Zodra een VST plugin is ingevuld kunt u na het opnemen van een eerste voicetrack de 
plugin naar wens instellen. Tijdens het afspelen van een voicetrack kunt u het VST plugin 
effect en voice-processing beluisteren. De VST plugin moet u eenmalig naar uw eigen 
smaak instellen. Daarna als volgende voicetracks worden opgenomen zal de ingestelde 
VST plugin voice-processing automatisch worden toegepast en opgeslagen in iedere 
voicetrack. 
 
Remote voicetracks opnemen 

Voor informatie over remote voicetracken kunt u terecht in hoofdstuk 39: ‘AerOn studio 
Thuis’. 
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14.2 Bedieningsconsoles 

Het werken met de voicetracks wordt eenvoudiger door gebruik te maken van een 
speciale bedieningsconsole. Deze sluit u direct aan op de USB-poort van de PC. 
 

ShuttlePro 
Voor het aansluiten van de ShuttlePro op de USB-poort zijn geen drivers nodig. Na 
enkele ogenblikken wordt de ShuttlePro herkend en is deze gereed voor gebruik. 
 

 

1 
2 
3 
4 

5 
6 
7 
9 

10 
11 

        
       12 
       13 

 
Shuttle 
Jog 

Play 
Stop 
Record 
Wissel modus (Edit, Rec stand-by) 

Cancel (Wijzigingen ongedaan maken) 
Play Jingle 1 
Play Jingle 2 
Accept (Wijzigingen toepassen) 

Vorige item in playlist 
Volgende item in playlist 
 
Zoom In 
Zoom Uit 
 
Fast-Rewind en Fast-Forward 
Rewind en Forward 
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15 Audio logger 

Audio logger kunt u openen via het menu Tools → Audio logger. Of sneltoets 
SHIFT+CTRL+L 

 
Audio logger is een module die aanvullend kan worden aangeschaft. Deze module wordt 
gebruikt voor het vastleggen van uw radio-uitzendingen. In de meeste landen wordt er 
tegenwoordig door de officiële instanties verlangd, dat radiostations alle uitzendingen 
gedurende een bepaalde periode opnemen en bewaren. Die periode is per land 
verschillend. Zo heeft het Nederlandse Commissariaat voor de Media (CVDM) bepaald, 
dat een radiostation zijn programma’s 14 dagen (24 uur/dag) dient te bewaren, terwijl 
die periode in Vlaanderen (België) bijvoorbeeld 2 maanden (24 uur/dag) bedraagt. Dit 
geldt voor eigen programma’s, maar ook voor raamprogramma’s (programma’s van 
derden die u gebruikt voor heruitzending). Op uren dat uw radiostation niet uitzendt 
(stilte), hoeft u uiteraard niet te loggen. 
 
De eerste stap om Audio logger te gebruiken, is de software correct instellen. Hiervoor 

geeft u in Instellingen → Lokaal → Audio logger aan, wanneer de audio van uw 
radiostation gelogd moet worden, in welk formaat, via welke audio-ingang en hoe lang 
de audio bewaard moet worden. Bij ‘Formaat’ is standaard een lage bitrate ingesteld met 
een voor logging acceptabele geluidskwaliteit. Na het invullen van de bewaarperiode en 
de tijdslots (uren per dag dat het systeem moet loggen), geeft AerOn studio aan hoeveel 
harddiskcapaciteit per week en voor de gehele bewaartermijn noodzakelijk is en of deze 
voldoende beschikbaar is. Om te voorkomen dat uw harddisk vol raakt, zal Audio logger 
na de ingestelde tijd oude opnames verwijderen. Opnames die u langer wilt bewaren, 
moet u zelf veilig stellen.  
 
Als u Audio logger correct heeft ingesteld, klikt u vervolgens op ‘Toepassen’. De software 
begint nu automatisch te loggen. Een opname die gemaakt is op 9 januari 2015 tussen 
15:00 en 16:00 uur, heeft de bestandsnaam 20150109_15h00.wav. Dit bestand vindt u 
terug in de map die u in de Audio logger-instellingen heeft opgegeven. 
 
Bij de configuratie van uw AerOn studio systeem dient u rekening te houden met het feit, 
dat er continu een opname-ingang van uw geluidskaart in gebruik zal zijn als er 24 uur 
op 24 gelogd wordt. Dat is op zich geen probleem, maar u dient uw systeem dan wel uit 
te rusten met een geluidskaart met voldoende inputs, voorzien van opnamemogelijkheid 
voor het opnemen van de reguliere zaken als nieuwe tracks, commercials, voicetracks 
et cetera. Het aanbevolen formaat is mp3 of PCM, omdat met deze codecs meerdere 
opnames simultaan kunnen lopen op dezelfde input. In Audio logger-instellingen geeft u 
bij Audio ingang de input aan, waarop de audio van het te loggen programma wordt 
aangeboden.  
 
Nadat u een aantal uitzendingen heeft gelogd, kunt u de opnames beluisteren in de 

Audio logger-player (menu Tools → Audio logger). U ziet het onderstaande venster: 
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In de kalender wordt met groene en rode cijfers aangegeven op welke dagen er opnames 
gemaakt zijn. De groene cijfers geven aan dat die dag volledig gelogd is, bij rode cijfers 
is slechts een deel van de dag gelogd. Na het aanklikken van een datum geeft de tijdbalk 
onder de kalender met de groene kleur aan voor welk tijdstip er een opname is. Door op 
de golfvorm te klikken geeft u de startpositie voor afspelen aan. Het is ook mogelijk de 
gewenste startpositie exact in te vullen. 
 
Wanneer bijvoorbeeld het CVDM bij u een kopie opvraagt van een bepaalde periode of 
een bepaald programma, zijn er in principe meerdere mogelijkheden om dit materiaal 
aan te leveren, afhankelijk van de eisen die daar in elk land aan gesteld worden. U kunt 
de bestanden aanleveren op een USB-stick of de gevraagde bestanden bijvoorbeeld 
met een DVD-schrijver op een DVD branden (op een DVD+R passen zes hele dagen), 
maar ook via één van de uitgangen van de geluidskaarten die niet voor het nonstop 
programma in gebruik zijn, in real-time weergeven en op een aangesloten 
opnameapparaat opnemen. Daarnaast behoort aanbieden via ftp en http tot de 
mogelijkheden. 
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16 Time shifter 

Time shifter kunt u openen via het menu Tools → Time shifter. Of sneltoets 
SHIFT+CTRL+T 

 
Time shifter is een aanvullend aan te schaffen module die wordt gebruikt om bepaalde 
uitzendingen in hoge kwaliteit op te nemen voor heruitzending op een later tijdstip. Dat 
kan audio aangeboden op een lijningang van een geluidskaart zijn, maar ook een stream 
zoals bijvoorbeeld een internetstream. 
 
Om een uitzending op te nemen, moet er een Time shifter-taak worden toegevoegd. 
Hiervoor klikt u op het rode kruisje rechts onderaan in Time shifter. Bij het toevoegen 
van een taak, wordt het volgende venster zichtbaar: 
 

  
 

Datum Hier vult u de datum in vanaf wanneer de taak uitgevoerd moet 
worden. 

Om Tijdstip waarop de taak start. 

Tot / Duur U kunt ofwel de eindtijd ofwel de duur van de taak invoeren. Het 
andere veld krijgt automatisch de juiste waarde. U vult dus in wat voor 
u het handigste is. 

Herhaling U geeft hier op of de taak herhaald moet worden, dit kan dagelijks, 
wekelijks, twee wekelijks of vier wekelijks zijn. 

Bestands- 
naam 

U geeft hier de bestandsnaam op voor het op te nemen programma. 
De map waarin het bestand wordt opgeslagen moet een submap zijn 
van een audiomap of moet als hoofdmap ingevuld worden in 

Instelingen → Globaal → Audio lokaal. Dit is nodig om de 
opgenomen programma’s te kunnen afspelen in o.a. de playlist. 

Een bestandsnaam mag ook een timestamp bevatten waarbij de 
bestandsnaam dan wordt samengesteld op basis van het tijdstip van 
de opname start. Bijvoorbeeld: 
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C:\Timeshifter\UitzendingGemist\Ochtendshow_"DateTimeFormat(y
yyymmdd_hh_00)".mp3 
 
Tip! De DateTimeFormat moet tussen dubbele quotes staan. 

 
Stel als het tijdstip van de opname is op 20 november 2019 om 
10:00:00 dan wordt de bestandsnaam: 
C:\Timeshifter\UitzendingGemist\Ochtendshow_20191120_10_00.m
p3 
 
Een overzicht van de beschikbare parameters is terug te vinden op 
http://docwiki.embarcadero.com/Libraries/Rio/en/System.SysUtils.F
ormatDateTime Bepaalde parameters zijn afhankelijk van de 
ingestelde taal op de computer. 

FTP upload 
naar 

Hier kunt u een FTP inlog invullen. Het opgenomen bestand wordt 
geupload zodra de opname is voltooid.  

Zie Instellingen → Globaal → FTP upload voor het instellen van 
FTP inlog gegevens. 

Formaat Hier vindt u een aantal keuzes voor de opnamekwaliteit. Voor 
heruitzending is meestal een hoge kwaliteit gewenst. 

Audio ingang Geef hier de ingang op waarop de audiobron is aangesloten. 

Opname 
pauzeren door 
acties 

Items die via acties-triggers gemarkeerd zijn voor het pauzeren en 
hervatten van een Time shifter-taak die zetten Time Shifter in de 
pauze- of opnamestand. Zie verderop in dit hoofdstuk voor meer 
uitleg. 

Stream URL Vul hier de URL in van de stream die moet worden opgenomen. In de 
dropdownlijst kunt u een stream selecteren uit de streams die 

geconfigureerd zijn als externe bron in Instellingen →  
Automatisering → Extern audio stream. 
 

Stream 
formaat 

Stel het audioformaat in waarmee de audiostream wordt opgeslagen.  
 

Stream 
mp2/mp3 
bitrate 

De bitrate van de opgeslagen stream. Dit is enkel van toepassing als 
de stream wordt opgeslagen in mp2 of mp3 formaat. 
 

Beëindigen De actieve opname kunt u met deze knop beëindigen. Bij een taak 
die niet actief is, blijft de knop grijs. 

 

Tip! Time shifter pauzeren of hervatten wordt enkel ondersteund bij een lijningang en 
niet bij een stream. 
 

Audio ingang 
Opnemen met Time shifter staat los van doorgifte van externe bronnen. Externe bronnen 
doorgeven en Time shifter-opnames maken, werkt onafhankelijk van elkaar. Het is 
daardoor mogelijk om een externe bron door te geven en tegelijkertijd, op diezelfde audio 
ingang, met Time shifter of Audio logger een opname te maken.  
 
Bovendien kunt u Time shifter en Audio logger ook zo instellen dat ze beiden opnemen 
op dezelfde audio ingang. Stel: u heeft vier audio-ingangen beschikbaar. Op ingang vier 
heeft u Audio logger geconfigureerd die 24 uur iedere dag opneemt. Time shifter mag u 
dan ook configureren op ingang vier. Aanbevolen formaat is dan wel mp3 of PCM, omdat 
met deze codecs meerdere opnames simultaan naast elkaar kunnen lopen. 

http://docwiki.embarcadero.com/Libraries/Rio/en/System.SysUtils.FormatDateTime
http://docwiki.embarcadero.com/Libraries/Rio/en/System.SysUtils.FormatDateTime
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Streams opnemen 
Bij het opnemen van een stream wordt de opname gestart en gestopt op de in de taak 
opgegeven tijdstippen. Echter door buffering, voornamelijk buitenom AerOn studio , en 
het feit dat het een paar seconden kan duren voordat de stream werkelijk binnenkomt, 
kan de duur van het opgeslagen audiobestand afwijkend zijn.  
 
Om alsnog met een exacte duur te kunnen opnemen, dient te worden ingesteld op een 
formaat verschillend van “Ruw als originele stream”. Daarbij wordt de stream 
gehercodeerd tot een exacte lengte. Er kan alsnog een miniem verschil in de duur 
ontstaan, afhankelijk van de gekozen opslagcompressie, dat is echter te verwaarlozen.  
 
Bij een formaat verschillend van ‘Ruw als originele stream’, kan de opname iets later 
worden gestopt dan ingesteld, in ieder geval is de duur van het audiobestand dan wel 
gelijk aan de ingestelde duur. 
 
Nadat u alle relevante gegevens in een taak heeft ingevuld, klikt u op ‘OK’. 
 

  
 

Tip! Mocht een taak om een of andere reden niet starten dan blijft die entry bewaard. 
Standaard worden mislukte taken niet weergegeven.  U moet het vinkje weghalen bij 
Start >= Datum om deze taken in beeld te brengen.  Bij Info kunt u dan zien waarom die 
taak niet is gestart. Daarna kunt u deze taken beter verwijderen omdat ook deze taken 
resources gebruiken. Klik rechts in het taakoverzicht en kies verwijderen. 
 

De iconen in de kolom ‘Status’ hebben de volgende betekenis: 
 

 De taak is niet uitgevoerd. Dit kan bijvoorbeeld het geval zijn als 
AerOn studio niet actief was op het tijdstip waarop de opname 
plaats had moeten vinden. 

 De taak wordt op dit moment uitgevoerd. 

 De taak staat in de lijst om uitgevoerd te worden. 

 De taak is succesvol uitgevoerd. 
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Links onderaan in het Time shifter-venster wordt aangegeven in welke modus Time 
shifter staat. Met de knoppen Opname pauzeren en Opname hervatten kunt u de modus 
wijzigen. 
 

 Time shifter staat in de opnamestand. 

 Time shifter staat in de pauzestand. 

 
De taken die u ziet in het Time shifter-venster worden uitgevoerd op de betreffende PC. 
Zo kunt u op het OnAir-station of per werkstation verschillende taken invoeren. AerOn 
studio gebruikt de computernaam om te bepalen of een taak uitgevoerd moet worden. 
Bij het wisselen van PC moet u de taken in Time shifter nazien. 
 
Om Time shifter-opnamebestanden in te plannen, is het aan te raden om voor ieder 
herhaalprogramma aparte uurformats aan maken die u vervolgens op de juiste plaats in 
een dagformat zet.  Een Time shifter-opnamebestand kunt u het beste als vaste track in 
een uurformat-item slepen. 
 

Tip! Vanuit de playlist kunt u op eenvoudige wijze een taak toevoegen door de gewenste 
op-te-nemen-items te selecteren. Open vervolgens het Playlist-menu met de rechter 

muisknop en kies de optie ‘Time shifter, toevoegen…’. 

16.1 Time Shift opnames zonder commercials 

Normaalgesproken begint een Time shifter-taak met opnemen op een vast opgegeven 
start-tijdstip en eindigt de opname na een ingesteld aantal minuten of exact op het 
ingestelde eind-tijdstip. Programma’s die u opneemt om op een later tijdstip te 
heruitzenden, beginnen en eindigen vaak met een commercialblok met aan het begin 
van het uur meestal ook nog een nieuwsbericht. Dat nieuwsbericht en die 
commercialblokken wilt u echter niet heruitzenden.  
 
Omdat nieuwsberichten en commercialblokken wisselende lengtes hebben, kunnen in 
een Time shifter-taak geen exacte begin- en eindtijden opgegeven worden die exact 
overeenstemmen met de starttijden in de playlist. We hebben daarom een mogelijkheid 
gecreëerd om actie-triggers te koppelen aan tracks, die bij het starten of stoppen 
(meestal in de playlist) de Time shifter pauzeren of hervatten.  
 

De actie-trigger ‘Time shift pauzeren’ zorgt ervoor dat Time shifter in pauze wordt 

gezet. De actie-trigger ‘Time shift hervatten’ zorgt ervoor dat Time shifter in de 
opnamestand wordt gezet. Een Time Shifter-opname start enkel in opnamestand als er 
een Time shifter-taak is gepland. 
 
Items waaraan zo’n actie-trigger gekoppeld wordt kan een nieuwsbericht of een begin- 
of eind-jingle van een commercial blok zijn, maar het kan bijvoorbeeld ook een stiltefile 
zijn met een lengte van bijvoorbeeld 300 milliseconden. Actie-triggers kunnen gekoppeld 

aan tracks in Acties. Acties kunt u openen via het menu Tools → Acties. Sleep tracks 
bijvoorbeeld vanuit Databank browser in Acties. Vervolgens stelt u in de kolom ‘Actie’ de 

trigger in op ‘Time shift pauzeren’ of ‘Time shift hervatten’. Zie Hoofdstuk 25 Acties 
voor meer informatie.  
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Vast gedefineerde trigger 
U kunt een systeem opzetten met twee vast gedefinieerde items toegevoegd als trigger 
in Acties. U neemt hiervoor twee stilte bestanden met een lengte van bijvoorbeeld 300 

milliseconden. Eén met de titel ‘*** Trigger Time shift pauzeren ***’ en één met de 

titel ‘*** Trigger Time shift hervatten ***’. Beide triggers plant u met Formatplanner of 
Commercialplanner (als voor- of najingle) op posities in de playlist waar Time shifter 
moet worden gepauzeerd of hervat.  In de playlist is bij deze triggers aan de titel duidelijk 
herkenbaar wanneer een Time shifter-taak wordt gepauzeerd of hervat. 
 

Reclame jingles of nieuws als trigger 
U kunt ook Time shifter pauzeren en hervatten met items die al onderdeel uitmaken van 
de huidige planning.  
 
De Time shifter-pauzeren en Time shifter-hervatten triggers kunt u indien gewenst ook 
met één en hetzelfde item laten uitvoeren. Hetzelfde item sleept u dan nogmaals in 
Acties. In het bovenstaande voorbeeld staat het hele uur ANP-nieuws er tweemaal in 
gesleept. 
 
Items die een Time shifter-taak pauzeren en waarbij de actietijd staat ingesteld op 
00:00.0 worden zelf niet meer opgenomen. De mode Live, Nonstop of Jingle moet 
uiteraard zijn aangevinkt om een trigger uit te voeren bij het afspelen in de playlist tijdens 
nonstop of in Live assist of bij het starten van een item in Jingle players. Dit al naar 
gelang uw manier van werken. 
 

Tip! Het is van belang dat de begintijd van een Time shifter-taak later valt dan een actie-
trigger ‘Time shift pauzeren’. De Time shifter-taak zou anders direct starten met 
opnemen en kort daarna meteen weer gepauzeerd worden en zo ongewenst een korte 
opname maken. 
 

Voor stop 
De optie ‘Voor stop’ is bedoeld om Time shifter altijd direct te hervatten na het stoppen 
van een item en zodoende ervoor te zorgen dat het eerstvolgende item geheel wordt 
opgenomen.  
 
Dit is van toepassing op items die Time shifter hervatten en zelf niet opgenomen mogen 
worden. En specifiek voor items met een wisselende lengte, zoals nieuwsberichten, 
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verkeersinfromatie, agendaberichten of items die tijdens afspelen in Live assist eerder 
worden gestopt.  
 

Dynamische items die een Time shifter-taak hervatten, daarbij vinkt u ‘Voor stop’ altijd 
aan. Bij dynamische items is de duur van een item variabel en zodoende vooraf 
onbekend. De ingestelde actietijd moet minimaal gelijk zijn aan of hoger zijn dan de 
langst mogelijke duur van een item.   
 

Samengevat: De actie-trigger ‘Time shift hervatten’ wordt indien ‘Voor stop’ is 
aangevinkt altijd uitgevoerd bij het stoppen van het betreffende item. Dit is met name 
van toepassing bij het stoppen van een item als de ingestelde actietijd niet is bereikt.  
 

Opname starten 
Als de starttijd van een Time shifter-taak is bereikt, terwijl Time shifter door een eerdere 
actie-trigger in pauze staat, dan blijft Time shifter in pauze totdat er een trigger hervatten 
komt.  
 
Aan het einde van bijvoorbeeld een commercialblok zorgt de actie-trigger ‘Time shift 
hervatten’ ervoor dat Time shifter in de opnamestand wordt gezet en zodoende de 
opname definitief wordt gestart. 
 

Wanneer een actie-trigger ‘Time shift pauzeren’ en de aanvangstijd van een Time 
shifter-taak op exact het zelfde moment plaats vinden kan de één of de ander net een 
fractie eerder worden verwerkt waardoor er een mini opname kan ontstaan als de actie-

trigger ‘Time shift pauzeren’ pas als tweede wordt verwerkt.  
Zoals reeds eerder vermeld is het belangrijk om ervoor te zorgen dat de aanvangstijd 
van een taak altijd iets later valt dan het tijdstip waarop het item met de actie-trigger 

‘Time shift pauzeren’ gestart wordt, al is het maar enkele seconden. Time Shifter staat 
dan al in de pauzestand voordat de aanvangstijd van een taak is bereikt. Nog beter is 
Time shifter in de pauzestand zetten na iedere voltooide taak. 
 

Tip! De klassieke fout die gemaakt wordt is om een Time shifter-taak exact op het hele 
uur te laten beginnen en de actie-trigger ‘Time shift pauzeren’ te koppelen aan het 
nieuws dat eveneens op exact het hele uur gepland staat. De aanvangstijd van de 
Timeshifter-taak iets verlaten is dan de oplossing. 
 

Opnames opslaan 
Indien tijdens een lopende opname Time shifter wordt gepauzeerd, dan wordt die 
opname meteen opgeslagen. De eerste opname tijdens een taak krijgt bij het opslaan 

automatisch de toevoeging #01. Indien er tijdens een taak meerdere malen wordt 
gepauzeerd en hervat wordt telkens de opname opgeslagen. De tweede opname krijgt 

de toevoeging #02, de derde #03, et cetera. Het bestand wordt dan bijvoorbeeld 
opgeslagen als Ochtendprogramma#02.mp3. 
 

Overzicht in Historie 
In Historie kunt u een overzicht krijgen van wanneer Time shifter is hervat en 
gepauzeerd. U opent Historie via het menu Bestand → Open → Historie. Vervolgens 
klikt u met de rechter muisknop in de overzichtslijst en selecteert u ‘Time shifter’. 

16.2 Time Shifter met een master/slave studio systeem 

Een master/slave studio systeem is een configuratie met meerdere uitzend PC’s.  Een 
dergelijk systeem bestaat uit een Nonstop PC en een uitzend PC per studio. 
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Met een master/slave studio systeem kunnen alle Time shifter-taken geprogrammeerd 
worden op de nonstop PC.  De op dat moment actieve automatisering verzorgt het 
versturen van de Time shifter pauzeren en hervatten acties, bijv. als er vanuit een studio 
live wordt gedraaid zal dié automatisering de acties verzorgen. Iedere PC die met de 
database verbonden is ontvangt de acties en zal zijn eigen Time shifter-taken starten als 
die geprogrammeerd zijn. 
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17 Gebruikers  (Rechten in AerOn studio) 

Gebruikers kunt u openen via het menu Toegang → Gebruikers. Sneltoets 
SHIFT+CTRL+G 

 
Zodra u bekend bent met alle mogelijkheden van AerOn studio kan de wens ontstaan 
om het systeem te beveiligen tegen ongewenst gebruik. Op één enkele PC met slechts 
enkele gebruikers heeft u daar wellicht niet direct de behoefte aan, maar binnen een 
netwerkomgeving bij een radiostation met veel medewerkers waarschijnlijk wel. In het 
menu Toegang → Gebruikers geeft u op welke personen van de software gebruik mogen 
maken en wat ze precies wel en niet mogen doen. 
 

Op een open systeem zonder gebruikers ziet u bij Toegang op de menubalk enkel de 

optie Gebruikers. Aanmelden of afmelden is dan niet beschikbaar. Als klikt op 

Gebruikers  opent zich het volgend venster: 
 

 
 
 Eerst moet er een beheerder aangemaakt worden. U 
klikt hiervoor op het rode kruisje rechts onderaan. U 
geeft vervolgens een gebruikersnaam en een 
wachtwoord op. De allereerste gebruiker wordt 
automatisch van het type Beheerder.  
 
Maak daarna een groep Administrators, dit is overigens 
niet verplicht maar wel handig voor later als u nieuwe 
beheerders toevoegt. U selecteert bij de groep Administrators alle rechten en slaat 
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daarna de wijzigingen op door op het oranje vinkje rechts onderaan te klikken. Daarna 
maakt u de beheerder lid van de groep Administrators. 
 
Bij het type gebruiker onderscheiden we vier mogelijkheden: 

Gebruiker De meeste gebruikers die u in het systeem invoert zullen ‘gewone’ 
gebruikers zijn. U kent ze de opties in AerOn studio toe die ze 
mogen gebruiken. 

Beheerder Een beheerder kan in dit venster nieuwe gebruikers aanmaken, 
rechten van gebruikers wijzigen of gebruikers verwijderen. Het 
spreekt voor zich dat er altijd minimaal één beheerder moet zijn. 

Auto logon De ‘auto logon’-gebruiker wordt op de OnAir PC automatisch 
aangemeld, zodra u AerOn studio start. Deze gebruiker heeft geen 
wachtwoord of tijdbeperking. 

Groep Voor gebruikers die u dezelfde rechten wilt geven, maakt u een 
groep waar u deze rechten aan toekent. Later maakt u de 
gebruikers lid van de gewenste groep om ze de bijbehorende 
rechten te geven. Met een groep-naam kunt u zich niet aanmelden 
op het systeem, dat kan alleen individueel. 

 
Als er één of meer gebruikers zijn aangemaakt, wordt het gebruikerssysteem binnen 
AerOn studio actief. U moet er wel rekening mee houden, dat er minimaal één persoon 
moet zijn met de status van beheerder, anders zou u de beveiliging activeren zonder de 
mogelijkheid te hebben ooit wijzigingen daarin aan te brengen. In de lijst met gebruikers 
kunt u eenvoudig zien of er iemand is met die status. Normaal gezien is dat het geval, 
want de allereerste gebruiker die is aangemaakt wordt automatisch beheerder. 
 
Zodra u van plan bent om meer dan pakweg twee of drie gebruikers in het systeem te 
zetten, raden we aan om eerst groepen aan te maken. Een groep maakt u op dezelfde 
wijze aan als een nieuwe gebruiker. U vult dan enkel een naam in en na het opslaan 
stelt u het type in op Groep. U maakt bijvoorbeeld een groep ‘DJ’s’ die u rechten geeft 
om Playlist, Mix editor en Databank browser te openen. Daarna maakt u de juiste 
personen lid van de groep ‘DJ’s’. Ieder van deze gebruikers heeft dan meteen alle 
rechten van die groep. Uiteraard is het mogelijk om een gebruiker lid te maken van meer 
dan één groep. Naast de rechten die iemand heeft op basis van lidmaatschap van één 
of meerdere groepen kunt u individueel nog extra rechten per gebruiker toekennen. 
  
Als u de rechten voor de gebruikers ingesteld 
heeft, hebben de gebruikers standaard alle 
uren van de dag toegang tot het systeem. U 
kunt gebruikers ook slechts op beperkte uren 

toegang geven door op het tabblad ‘Toegang’ 
de toegestane uren aan te geven. Selecteren 
kunt u met de muis door in het raster een 
rechthoekig blok te kiezen of door een 
weekdag of een uur aan te klikken. Met de 

twee knoppen Toestaan en Niet Toestaan 
bepaalt u of de gebruiker dan juist wel of juist 
niet in de geselecteerde uren zich in AerOn 
studio mag aanmelden. Zodra de toegang tot 
AerOn studio beperkt is wordt de titel van het 
tabblad vet weergegeven. Op het tabblad 

‘Wijzigen playlist’ geeft u de gebruiker 
toegang tot de playlisturen die hij of zij mag bewerken. 
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Sommige radiostations hebben niet de behoefte om gebruikers aan te maken. Het risico 
is dan wel, dat een willekeurige gebruiker van het systeem zelf weer gebruikers gaat 
aanmaken en zichzelf of anderen alle rechten toe kent. U wordt dan buitengesloten. Om 

dit te voorkomen maakt u toch gebruikers aan en creëert u een Auto logon account met 
alle rechten. Deze gebruiker is dan direct actief, zodra u AerOn studio start, met alle 
rechten die u aan deze gebruiker toekent. 
 
Nadat u alle gewenste gebruikers heeft toegevoegd, kunt u het venster ‘Gebruikers’ 
sluiten. Als u nu op het tabblad ‘Toegang’ klikt, ziet u dat er een aantal opties aan het 
tabblad zijn toegevoegd. 
 

• Aanmelden 
U meldt zich aan om AerOn studio te gebruiken met de opties die voor u zijn 
geactiveerd. In het historiebestand wordt naam en tijdstip van aanmelden (en in een 
netwerkconfiguratie tevens de naam van het werkstation) opgenomen. De vensters 
die u tijdens de laatste sessie geopend had, verschijnen weer op dezelfde positie op 
het scherm. 
 

• Afmelden 
U meldt zich hiermee af, de vensters worden gesloten en de instellingen, zoals 
positie en grootte, onthouden. In het historiebestand wordt het tijdstip van afmelden 
opgenomen. 
 

• Wachtwoord wijzigen 
Het is raadzaam een niet voor de hand liggend wachtwoord te gebruiken. Onder voor 
de hand liggende wachtwoorden verstaan we bijvoorbeeld de naam van uw partner, 
uw merk auto, postcode, en dergelijke. Voordat u uw wachtwoord kunt wijzigen moet 
u eerst uw huidige wachtwoord intypen. Het nieuwe wachtwoord voert u tweemaal in 
om typfouten te vermijden. Tijdens het intypen worden er sterretjes weergegeven, 
zodat iemand die over uw schouder meekijkt niet meteen uw nieuwe wachtwoord 

kent. Een wachtwoord is niet verplicht, gebruikers die een Beheerder zijn binnen 
AerOn studio raden we aan om wel een wachtwoord in te voeren. 

17.1 Overzicht gebruikersrechten 

Hieronder vindt u een overzicht van de in AerOn studio beschikbare gebruikersrechten. 
 

Databank browser  

Openen Databank browser openen. 

Beschikbaar Alle tracks zichtbaar kunnen maken. Ook de tracks die in de 
database gemarkeerd zijn als "Niet beschikbaar voor 
gebruiker". 

Databank editor  

Openen Databank editor openen. 

Wijzigen algemeen Wijzigen algemeen. 

Wijzigen criteria 1 Criteria 1 invullen en wijzigen. 

Wijzigen criteria 2 
 

Criteria 2 aanvinken en wijzigen. 

Wijzigen 
audioeditor 
 

Toegang tot Audio editor of Externe audio editor openen. 
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Opnemen 
 

Audio van een geluidskaart opnemen. 

Playlist  

Openen Playlist openen. 

Wijzigen algemeen 
 

Playlist wijzigen, voicetracks opnemen. 

Wijzigen 
commercials 
 

Commercialblokken in playlist wijzigen. 

Toevoegen en 
wijzigen 
 

Tracks inslepen, tracks verwijderen en tracks wijzigen. 

Opslaan als 
 

Opslaan als een bestand of opslaan als een ander playlist kopie. 

Mix editor  

Openen Mix editor openen. 

Wijzigen Mixen en fadecurves in playlist wijzigen. 

Opnemen 
 

Voicetracks opnemen. 

Jingle player  

Openen Jingle player openen. 

Wijzigen Het geladen jingle pakket wijzigen. 

Opslaan Het geladen jingle pakket opslaan. 

Aantal carts Aantal carts dat zichtbaar is instellen.  

Jingle player Xtra maximaal acht carts zichtbaar. 

Pakket kiezen Een ander jingle pakket kiezen dan standaard toegewezen 

Pakket A & B Standaard jingle pakket in Carts A & B. Hiermee kunt u optioneel 
een gebruiker een bepaald jingle pakket toekennen. 

Pakket C & D Standaard jingle pakket in Carts C & D. 

Pakket E & F Standaard jingle pakket in Carts E & F. 

Pakket G & H 
 

Standaard jingle pakket in Carts G & H. 

Formatplanner  

Openen Formatplanner openen. 

Wijzigen formats Wijzigen uur- en dagformats. 

Planning 
aanmaken 
 

Playlists plannen. 

Automatisering  

Bedienen 
 

De automatisering handmatig starten/stoppen. 

Live assist & 
Regionale jingle 
player 
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Openen Live assist openen of regionale jingle player (edities). 

Bedienen 
 

Live assist interactief bedienen. 

Time shifter  

Openen Time shifter openen. 

Wijzigen Time shifter taken aanmaken en wijzigen. 

Synchronisatie 
 

 

Remote naar 
lokaal 

Synchroniseer audiobestanden van de Studio naar Thuis. 

Lokale voice-tracks 
naar remote 

Synchroniseer voicetracks vanaf Thuis naar de Studio. 

Lokaal alles naar 
remote 
 

Synchroniseer audiobestanden en voicetracks vanaf Thuis naar  
de Studio. 

Instellingen  

Openen Instellingen openen. 

Wijzigen 
 

AerOn studio instellingen wijzigen. 

Item browser & 
File browser 
 

 

Openen Item browser openen. 

Algemene 
categorieen 
wijzigen 
 

Categorieën wijzigen die voor alle gebruikers beschikbaar zijn. 

Groep categorieen 
wijzigen 
 

Categorieën wijzigen die zijn toegekend aan de 
gebruikersgroep(en) waarvan de gebruiker lid is. 

File browser 
openen. 
 

Toegang tot file browser. 

File browser root 1 Geef toegang tot een bepaalde audiomap. Geen map ingevuld 
geeft toegang tot alle in AerOn studio bekende audiomappen. 

File browser root 2 Geef toegang tot een tweede audiomap. Bijvoorbeeld een map 
met audiobestanden van deze gebruiker. 

Overig  

Commercialplanner Commercialplanner openen. 

Beheer Beheer module openen. 

Acties Acties venster openen. 

Historie Historie playoutlog openen. 

Buma export Buma rapportage venster openen. 

Databank import Databank import venster openen. 

Databank export Databank export venster openen. 
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Databank backup 
 

Databank backup venster openen. 

Algemeen  

Voorafluisteren Tracks voorafluisteren in de PFL player op de werkbalk 

Zoeken op internet Zoeken op het internet. 

Audio slepen uit 
verkenner 

Audiobestanden uit Windows verkenner slepen in AerOn studio 
of een map audiobestanden in Windows verkenner openen 
vanuit AerOn studio. Uit Windows verkenner kunnen bestanden 
gesleept vanuit een map of vanuit een zoekresultaat. 

Gesleept audio 
toevoegen aan de 
databank 

Uit Windows Verkenner of File browser gesleepte 
audiobestanden toevoegen aan de databank.  

Met de Toevoegen databank-optie, onderin op de statusbalk, 

kan een gebruiker alsnog bepalen of de gesleepte 
audiobestanden aan de databank worden toevoegd. 

Audio afspelen van 
USB-drive 

Audio afspelen van Externe harde schijf of USB-stick. 

Als de gebruiker een schijf in de USB poort doet, opent zich in 
AerOn een venster van waaruit bestanden in de playlist kunnen 
worden gesleept. Afhankelijk van de optie “Toevoegen 
databank” worden de gesleepte tracks wel of niet aan de 
databank toegevoegd. 
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18 Databank import 

Databank import kunt u openen via het menu Databank → Import. 

 
Voor gedetailleerde informatie over het configureren van de databaseserver en het 
overzetten van uw bestaande muziekdatabank, raden we u aan om hoofdstuk 30 door 
te nemen. Gebruikers van AerOn studio die audiobestanden en databanken onderling 
willen uitwisselen, kunnen dit op eenvoudige wijze met de beschikbare import- en 
exportfuncties doen. De databank die u (gedeeltelijk) gaat importeren, moet gemaakt zijn 
met AerOn studio.   
 

Databank import 
De importmodule herkent automatisch of AeronExport.xml in de map staat. Als dit 
bestand aanwezig is in de map “Importeren uit”, wordt dit automatisch ingelezen. De 
inhoud van AeronExport.xml wordt weergegeven op het tabblad “Databank”. 
 

    
 
Importmap 

In  Instellingen → Globaal → Algemeen → Extra → Importmap  kunt u een vaste 
importmap instellen. Is er geen vaste importmap ingesteld, dan kunnen gebruikers die 
tracks in de database mogen importeren zelf een map selecteren bij “Audiobestanden 
kopieren naar”. 
 
De importfunctie geeft u een aantal opties om te bepalen welke tracks u gaat importeren 
en hoe dat moet gebeuren. In de kolom Import metadata en via het menu onder de 
rechter-muisknop kunt een selectie maken. Standaard staat alles aangevinkt. 
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Actie 
Audiobestanden 
kopieren naar 

Als er geen vaste importmap is ingesteld, dan kunt U hier een 
doelmap selecteren uit de mappen die u heeft ingesteld in 

Instellingen → Globaal → Audio lokaal. 

Importeer 
databank 

Hiermee geeft u aan dat u enkel metadata gaat importeren en niet 
de audiobestanden wil kopieren. 

Importeer 
databank en 
audio 

Hiermee geeft u aan dat u de metadata gaat importeren en ook de 
audiobestanden wil kopieren naar de ingevulde doelmap. 

Importeer audio Hiermee geeft u aan dat u de audiobestanden wil kopieren en de 
informatie aanwezig in ID3-tags wil importeren in de databank. 

Aanvullen 
trackinfo en 
afbeeldingen 

Als u deze optie aanvinkt, zijn de opties hierboven niet meer 
relevant. In dit geval zal AerOn studio enkel informatie overnemen 
als die nog niet in uw eigen databank aanwezig is. Ingevulde velden 
zullen nooit overschreven worden. De volgende velden  worden 
overgenomen: 

Track afbeelding 
Track informatie 
Track songtekst 
Artiest website 
Artiest afbeelding 
Artiest informatie 
Album afbeelding 
Album informatie 
 

Tip! Er worden geen extra tracks aan uw databank toegevoegd 
bij deze optie, waardoor deze bij uitstek geschikt is om 
genoemde gegevens uit te wisselen met een ander radiostation 
dat ook gebruik maakt van AerOn studio. 

 

Extra 
De databank waaruit u de tracks wil importeren kan records bevatten die ook al in uw 

eigen databank opgenomen zijn. In het kader ‘Extra’ geeft u aan op welke wijze u de 
informatie uit het importbestand overneemt. 
 

Criteria informatie 
overnemen/overschrijven 

Hiermee geeft u aan of u de gegevens, die betrekking 
hebben op de criteria voor Formatplanner, uit de tracks in 
de importdatabank wel of niet wilt overnemen. 

De criteria van bestaande tracks in uw eigen databank 
worden overschreven door die van de importdatabank. 
Verzeker u van de juistheid van de importdatabank 
voordat u deze keuze maakt.  

Tip! Dit zijn de criteria die in Databank editor worden 
weergegeven op de tabbladen “Criteria 1” en “Criteria 2”. 

 

Metadata overschrijven 
in bestaande tracks 

De metadata van tracks in uw eigen databank worden 
overschreven door die van de importdatabank.  
Verzeker u van de juistheid van de importdatabank 
voordat u deze keuze maakt. 
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Tip! Dit is de metadata die in Databank editor wordt 
weergegeven op de tabbladen “Track”, “Songtekst” en 
ook BPM, Key en Mix mode op het tabblad “Editor”. 
 

Tijden overschrijven in 
bestaande tracks 

De tijden, en ook de gain, van tracks in uw eigen databank 
worden overschreven door die van de importdatabank. 
Verzeker u van de juistheid van de importdatabank 
voordat u deze keuze maakt. 
 

Tip! Dit zijn alle tijden (Fade-in/uit, Volgende, Lengte, 
etc…) inclusief Refrein, die in Databank editor worden 
weergegeven op het tabblad “Editor”. 
 

Audiobestanden 
overschrijven 

Audiobestanden reeds aanwezig in de doelmap worden 
overschreven. 

 
Artiestinformatie 
In de muziekdatabank kunt u extra informatie opgeven over de artiest en drager (zie 

tabblad ‘Artiest en Album’ in Databank editor). Bij alle tracks van een bepaalde artiest 
ziet u altijd dezelfde artiestinformatie, de artiestinformatie heeft u eenmalig bij een track 
ingevoerd, maar die informatie geldt automatisch voor alle tracks van die artiest. 
 
AerOn studio houdt bij het importeren rekening met de artiest- en albuminformatie en zal 
deze niet overschrijven. Bij het importeren van nieuwe tracks worden nieuwe artiesten 
inclusief artiestinformatie en nieuwe albums wel aan uw databank toegevoegd. 
 

Audio import 
Op het tweede tabblad “Audiobestanden” is de inhoud van de bronmap zichtbaar. Is er 
in de map “Importeren uit” geen database aanwezig dan is enkel de optie Importeer 
audio beschikbaar en importeert u vanuit dit tabblad “Audiobestanden”. 
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Gebruikt u de import op dit tabblad, dan kunt u audiobestanden vanaf bijvoorbeeld een 
usb-stick of externe harde schijf zonder bijbehorende databank importeren naar uw 
systeem. 
Bestanden selecteren 
Houd de CTRL-toets ingedrukt en selecteer één voor één de gewenste audiobestanden. 
Of om aansluitend of alles te selecteren, klik op het bovenste bestand, houd de SHIFT-
toets ingedrukt en selecteer het onderste bestand.  
De metadata in de ID3 tags van mp3 bestanden zoals artiest, titel, album, jaartal, 
commentaar (track info), BPM, initial key en track cover worden automatisch ingevuld in 
de databank. 
 

Voorbeeld 
U  gaat een nieuw radiostation starten en kunt de databank en harddisk tracks van een 
ander radiostation overnemen. U bent echter alleen geïnteresseerd in de muziektracks 
(en niet in de jingles en commercials). Het andere (leverende) radiostation gebruikt de 
databank export om de audiobestanden samen met de databankgegevens voor u op 
een USB-drive te plaatsen. Thuis of in de studio sluit u de USB-drive met databank en 
audiobestanden op een USB-poort aan en opent u Databank import. Als u ‘Importeren 
databank en audio’ kiest, neemt het programma de metadata en de audiobestanden 
over. 
 
De opties voor het overnemen van specifieke informatie uit een importbestand gebruikt 
u bijvoorbeeld in de volgende situatie. U neemt een aantal nieuwe tracks op en voert 
naast het AudioID enkel de titel en artiest in de databank in. U geeft een kopie van de 
databank aan een collega, die thuis in de muziekdatabank de juiste criteria invoert. 
Tegelijkertijd zorgt u ervoor dat de tijden (introtijd, volgende tijd, enzovoorts) in Databank 
editor juist staan. Zodra uw collega gereed is met het invoeren van de gegevens en 
exporteren, gaat u die gegevens importeren. U geeft aan dat u bestaande tracks wilt 
overschrijven en de criteria-informatie overnemen. 
 

Audio bestanden slepen uit Windows verkenner of File browser 
Vanuit Windows Verkenner of File browser kunt u (multi-select) audiobestanden op het 
bureaublad van AerOn studio of in Databank editor slepen.  Vanuit Windows kunt u 
bestanden slepen vanuit een map of vanuit een zoekresultaat. U plaatst nieuwe 
audiobestanden in een lokale audio-hoofdmap of in een nieuwe submap of u voegt een 
nieuwe hoofdmap toe aan AerOn studio in Instellingen → Globaal → Audio lokaal.  
 
Vervolgens selecteert u de nieuwe audiobestanden in Windows Verkenner of File 
browser en u sleept deze op het bureaublad van AerOn studio. Nadat alle tracks zijn 

geladen opent AerOn studio een nieuw venster ‘Slepen audiobestanden’ en geeft 
daarin weer welke audiobestanden er geïmporteerd zijn. Vanuit dit venster kunt u de 
tracks voorbeluisteren, multi-select de criteria toekennen via Multi criteria editor. 

Sneltoets CTRL+M. U kunt ook de tracks openen in Databank editor. Sneltoets 

ALT+F11. In batch de cue-tijden globaal goed zetten kunt u uitvoeren met Tools → 

Beheer → Golfvorm. Het fine-tunen van de cue-tijden kunt u daarna doen in Databank 
editor. 
 

  
 

Tip! De ‘Toevoegen databank-optie’ moet zijn aangevinkt om tracks te kunnen 
toevoegen aan de databank. U moet voldoende rechten hebben om deze optie te mogen 
aanvinken. 
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(Zie onderin op de statusbalk) 
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19 Databank export 

Databank export kunt u openen via het menu Databank → Export. 

 
Voor de uitwisseling van audiobestanden en de bijbehorende databankgegevens tussen 
de radiostudio en AerOn studio thuis of tussen radiostations onderling, maakt u gebruik 
van de Databank export-module. 
 

Open het exportvenster (Databank → Export). Vanuit Databank browser, Item browser 
of een playlist sleept u de gewenste bestanden naar het exportvenster. Deze 
mogelijkheid kunt u uitstekend gebruiken om de data met een USB-drive te 
transporteren. 
 
Gebruikt u de export een tweede keer met een USB-drive waar al audiobestanden en 
een databank op staan, dan worden de nieuwe audiobestanden er bijgezet en de 
databank aangevuld. Wilt u dat niet, dan kunt u de map het beste vooraf leegmaken. 
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20 Databank backup 

Databank backup kunt u openen via het menu Databank → Backup. 

20.1 Databank backup maken in AerOn studio 

U opent deze functie via het menu Databank → Backup. 
 

  
 
Voor het maken van een databank backup wordt gebruik gemaakt van de PostgreSQL 
tool pg_dump. Als de backup mislukt, dan moet de PostgreSQL bin map nog ingesteld. 
 

  
 
Om een databank backup te kunnen maken moet de PostgreSQL map met 

hulpprogamma’s zijn ingevuld. Zie Instellingen → Lokaal → Algemeen → 
PostgreSQL 
Bij een PostgreSQL versie 16 installatie is dit C:\Program Files\PostgreSQL\16\bin. 

  
 

Zodra u op ‘Backup’ klikt, wordt er een databank backupbestand aangemaakt. 
Afhankelijk van de grootte van uw databank kan dit enkele minuten duren.  

20.2 Databank backup maken via een script  

Met behulp van een command-line script maken we een database backup met pg_dump. 
Pg_dump is een PostgreSQL command-line programma waarmee o.a. een backup van 
de gehele AerOn database genomen kan worden. 
 
Backup script voorbeeld met parameters: 
 

Parameters 
SET HOST=127.0.0.1 
SET PORT=5416 
SET DATABASE=aeron_prod_db 
SET DBADMIN=aeron_dba 
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SET PGBINDIR=C:\Program Files\PostgreSQL\16\bin 
SET PGDUMP="%PGBINDIR%\pg_dump.exe" 
SET PGPASSWORD=aeron_dba 
 
SET BACKUPDIR= C:\Aeron Database\PostgreSQL\16\Backup 
SET FILENAME= backup-%DATABASE% 
 

Backup de database naar bestand 
%PGDUMP% -v -Fc -T automation -O -h %HOST% -p %PORT% -U %DBADMIN% -d %DATABASE% -f 
"%BACKUPDIR%\%FILENAME%.cst" 

 

Tip! In Windows taakplanner kunt u taak maken met verwijzing naar het script en 
hiermee dagelijks of wekelijks een automatische backup uitvoeren. 

20.3 PostgreSQL database backup terugzetten 

Hier beschrijven we twee mogelijkheden om een database te restoren vanuit een 
database backup bestand. 
 

20.3.1 Restore database via pgAdmin 4 
 

PgAdmin 4 
 
Om een database te restoren vanuit een bestand, klikt u 
met de rechter-muistoets op de database waarin u het 
bestand wil laden. 
 
 
 
 
 
 
 
 
 
 

Restore options: 
 
Do not save: 
 
Owner = Yes 
Privilege = Yes 
Tablespace = Yes 
 
Queries: 
Clean before restore = Yes 
 
 
 
Selecteer uw database backup bestand. 
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Selecteer bij Role name vullen de beoogde ‘Database Owner’. 
Klik op Restore om het proces te starten. 
 

 
 
 

 
 
 
Database met schema aeron 
 
Ziet u na een restore geen data in AerOn studio, dan bevat de database mogelijk een 

schema aeron. Indien de database een schema aeron bevat, dan moet u na restore in 
pgAdmin nog onderstaande sql uitvoeren.  
 

ALTER DATABASE aeron_prod_db SET search_path = "$users", aeron, public; 
REVOKE CONNECT ON DATABASE aeron_prod_db FROM public; 
 
Start daarna opnieuw AerOn studio. 
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20.3.2 Restore database via een script 
 
Met behulp van een command-line script laden we de inhoud van een AerOn studio 
database backup .cst bestand in een PostgreSQL database. 
 

Restore script voorbeeld met parameters: 
 
Parameters 
SET HOST=127.0.0.1 
SET PORT=5416 
SET DATABASE=aeron_prod_db 
SET SUPERUSER=postgres 
SET DBADMIN=aeron_dba 
 
SET PGBINDIR=C:\Program Files\PostgreSQL\16\bin 
 
SET DROPDB="%PGBINDIR%\dropdb.exe" 
SET CREATEDB="%PGBINDIR%\createdb.exe" 
SET PSQL="%PGBINDIR%\psql.exe" 
SET PGRESTORE="%PGBINDIR%\pg_restore.exe" 
 
SET BACKUPDIR=C:\Aeron Database\PostgreSQL\16\Backup 
SET FILENAME=backup-full-aeron_prod_db 
 
Wachtwoord van de postgres superuser 
SET PGPASSWORD=postgres 
 
Database verwijderen indien nog aanwezig 
%DROPDB% -h %HOST% -p %PORT% -U %SUPERUSER% %DATABASE% 
 
Database aanmaken 
%CREATEDB% -h %HOST% -p %PORT% -U %SUPERUSER% -E UTF8 -O 
%DBADMIN% %DATABASE% 
 
Wachtwoord van de database owner voor restore 
SET PGPASSWORD=aeron_dba 
 
Database inladen uit het bestand 
%PGRESTORE% -v -h %HOST% -p %PORT% -U %DBADMIN% -d %DATABASE% 
"%BACKUPDIR%\%FILENAME%.cst" 
 
Indien de database een schema aeron bevat: 
%PSQL% -c "alter database %DATABASE% set search_path = '"$users"', aeron, 
public;"  -h %HOST% -p %PORT% -U %DBADMIN% -d %DATABASE% 
 
%PSQL% -c "revoke connect on database %DATABASE% from public;" -h %HOST% -
p %PORT% -U %DBADMIN% -d %DATABASE% 
 
Indien de role ‘aeron_app_role’ aanwezig is: 
%PSQL% -c "grant connect on database %DATABASE% to aeron_app_role;" -h 
%HOST% -p %PORT% -U %DBADMIN% -d %DATABASE% 
 
%PSQL% -c "GRANT ALL ON ALL TABLES IN SCHEMA aeron to aeron_app_role;" -h 
%HOST% -p %PORT% -U %DBADMIN% -d %DATABASE% 
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Database onderhoud 
 
VACUUM defragmenteert als het ware de database. Als database performance 
vemindert kan VACUUM helpen om performance te herwinnen. 
 
Vacuum analyze 
%PSQL% -c "VACUUM VERBOSE ANALYZE;" -h %HOST% -p %PORT% -U 
%SUPERUSER% -d %DATABASE% 
 
VERBOSE toont het resultaat.  
ANALYZE analyseert de database tabellen en calibreert o.a. de queryplanner van 
PostgreSQL. 
 
 
%PSQL% -c "VACUUM FULL" -h %HOST% -p %PORT% -U %SUPERUSER% -d 
%DATABASE% 
 
Vacuum full 
VACCUM FULL herwint opslagruimte op HDD of SSD.  Na een full vacuum is het 
aanbevolen om ook nog een VACUUM ANALYZE uit te voeren zodat de query planner 
van up-to-date statistics wordt voorzien. 
 
Let op! Tijdens het uitvoeren van VACCUM FULL mogen er geen clients met de 
database verbonden zijn. U moet alle AerOn clients afsluiten voordat VACUUM FULL 
wordt uitgevoerd. 
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21 Aanwezig scannen 

Het is voor AerOn studio van groot belang om te weten van welke tracks in de databank 
de audiobestanden effectief aanwezig zijn. Dit is voornamelijk van belang voor 
Formatplanner en Databank browser. Formatplanner hoort enkel muzieknummers te 
kiezen waarvan het audiobestand aanwezig is. Ook in Databank browser wil een 
presentator of DJ enkel werken met tracks die effectief aanwezig en beschikbaar zijn 
voor gebruik in zijn uitzending. Bij het opstarten van AerOn studio worden alle 
audiobestanden gezocht en het gehele pad naar ieder audiobestand wordt in cache 
ingelezen. Met Aanwezig scannen kunt u ook de bestands cache vernieuwen. 
 
Via het menu Databank → Aanwezig scannen worden alle databank records gescand 
om te controleren of de audiobestanden van de tracks effectief aanwezig zijn. Als u na 
Aanwezig scannen op Vernieuwen klikt in Databank browser worden alle beschikbare 
tracks waarbij een audiobestand gevonden is zichtbaar gemaakt. Formatplanner voert 
altijd automatisch een scan uit voordat deze begint met plannen. Ook in het playlistmenu 

is een optie Controle aanwezig om beschikbaarheid van audiobestanden te scannen 
van alle in die playlist aanwezige tracks. 
 
De functie Aanwezig scannen kan enkel uitgevoerd worden op een computer met 

scanrechten. Bij deze computers is de locatie ingesteld op Studio. Het scanrecht kan 

toegewezen worden in Instellingen → Globaal → Scan rechten. Normaliter wijst u het 
scanrecht enkel toe aan computers binnen het lokale AerOn studio netwerk. PC’s in de 

studio stelt u in op Locatie ‘Studio’.  PC’s bij mederwerkers thuis, die meestal via VPN 

zullen verbinden, stelt u in op Locatie ‘Remote’. 
 
Scan rechten bij thuisgebruikers 
Thuisgebruikers zult u in het algemeen geen scanrechten geven omdat deze meestal 
niet alle audiobestanden in hun bezit hebben. Een andere reden is dat het bij 
thuisgebruik ook kan gebeuren dat iemand tracks toevoegt in de databank waarvan de 
audiobestanden (nog) niet op het lokale netwerk in het radiostation aanwezig zijn.  
 
Omdat thuisgebruikers normaliter geen scanrechten bezitten, is het wel nodig om van 
tijd tot tijd de volledige databank te scannen op de aanwezigheid van audiobestanden, 
zodat deze up to date blijft. Dit om te voorkomen dat tracks die wel in de studio aanwezig 
zijn door toedoen van de thuisgebruiker niet meteen zichtbaar zijn in de studio als bij zijn 
pc de locatie toch staat in gesteld op Studio. Mocht het onverhoopt toch gebeuren dat 
tracks opeens verdwenen zijn dan moet de presentator of DJ de databank opnieuw 
scannen op aanwezige tracks en Databank browser vernieuwen. 
 
Als een thuisgebruiker tracks toevoegt aan de databank en daarna de audiobestanden 
upload naar de audiomappen in de studio (remote mapppen) m.b.v. de Synchronisatie-
module in AerOn studio dan worden die tracks in de databank automatisch gekenmerkt  

met Aanwezig. 
 
Aanwezig scannen na toevoegen van audio bestanden.  
Met Aanwezig scannen kunt u ook de bestands-cache in AerOn studio vernieuwen na 
het toevoegen van nieuwe audiobestanden. En hiermee wordt ook afgedwonen dat 
Windows e.e.a. in cache inlaadt en indexeert. Dit kan de zoektijd naar audiobestanden 

verkorten wat de algemene prestaties ten goede komt. Ook via Beheer de golfvormen 
scannen na het toevoegen van audio bestanden kan helpen de prestaties te verbeteren. 
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22 Historie playout log 

Historie kunt u openen via het menu Bestand → Open → Historie. Of sneltoets 
SHIFT+CTRL+H 

 
In Historie houdt AerOn studio alle items bij die door de automatisering gespeeld zijn. 
Het maakt niet uit of deze in nonstop of tijdens live-uitzendingen on air gekomen zijn. 
Naast de items die gespeeld zijn, houdt Historie ook het aan- of afmelden van gebruikers 
bij en het starten of stoppen van de automatisering op met het exacte tijdstip van deze 
gebeurtenis. Met de historie krijgt u antwoorden op vragen als: Wie heeft afgelopen 
woensdag de live uitzending ’s avonds gedaan? Hoeveel keer draaide de commercial 
van deze klant in de maand maart op ons station? 
 

Voor het bekijken van de historie gaat u naar Bestand → Openen → Historie. 
 

   
 
U ziet de historie van vandaag. Met de kalender aan de linker onderzijde kiest u een 
andere dag uit het verleden. In plaats van een overzicht per dag kunt u ook een overzicht 
per week, maand, kwartaal, jaar of complete historie weergeven. Met de groene pijltjes 
navigeert u per periode door de historie heen. 
 
Rechtsonder is het aantal items voor de geselecteerde periode zichtbaar. Zolang er niet 
meer dan 10.000 records zichtbaar zijn, kunt u sorteren op de verschillende kolommen. 
Bij grotere aantallen is sorteren niet mogelijk vanwege de benodigde rekentijd voor het 
sorteren van de gegevens. 
 
Onder de rechter muisknop vindt u onderstaande menu.  Met de diverse opties in dit 
menu kunt u specifieke gegevens of gebeurtenissen filteren: 
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Editor Open het geselecteerde item in Databank editor. 

Titel Filter alle items met dezelfde titel. 

Artiest Filter alle items met dezelfde artiest. 

Titel en artiest Filter alle items met dezelfde titel en artiest. 

Commercials Filter alle commercials. Commercials zijn alle items waarbij in  

Databank editor op het tabblad ‘Track’ de categorie op ‘Reclame’ 
is gezet. 

Niet gespeeld Filter alle items die niet gespeeld zijn, deze zijn herkenbaar aan de 
rode kleur. 

Time shifter Filter alle Time shifter-items, deze zijn herkenbaar aan de groene 
kleur. 

Acties Filter alle Acties die zijn ingesteld in het menu Tools → Acties. 

Reset Zet het filter uit zodat alle gegevens van de gekozen periode 
zichtbaar zijn. 

 

Nadat u een filter actief hebt gezet, kunt u het tabblad Grafiek aanklikken om een grafiek 
van de gefilterde data zichtbaar te maken. 
 

  
 
In het voorbeeld ziet u rechtsonder hoeveel tracks er totaal zijn en wat het aantal is in de 
gekozen periode. Bij grote aantallen gespeelde tracks kunnen in de legenda naar wens 
bepaalde tracks onzichtbaar gemaakt worden. 
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Op het derde tabblad heeft u de mogelijkheid om een hitlijst over de geselecteerde 
periode weer te geven. Zo kunt u bijvoorbeeld sorteren op de kolom ‘Aantal’ om te zien 
welk item het vaakst is afgespeeld. De kolom ‘Categorie’ maakt het mogelijk om daarop 
een fillter te zetten bijvoorbeeld alleen de muziek weer te geven. 
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22.1 Afdrukken 

U kunt Historie ook altijd afdrukken via het menu Bestand → Afdrukken. Heeft u een filter 
actief of een bepaalde kolom gesorteerd, dan wordt op dezelfde manier afgedrukt. Bij 
een actieve filter wordt op de laatste pagina de grafiek afgedrukt. 
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23 Buma/Sabam rapportage 

In Nederland is de Vereniging Buma (oorspronkelijk in 1913 
opgericht als Bureau voor Muziek Auteursrecht) de 
auteursrechtorganisatie van componisten, tekstdichters en 
muziekuitgevers. In België is er een gelijkaardige 
vereniging: Sabam. Buma en Sabam brengen auteursrechten in rekening voor ieder die 
muziek in het openbaar ten gehore brengt en verdelen de ontvangen bedragen onder de 
rechthebbenden. Op de websites van Buma en Sabam (respectievelijk en 
www.sabam.be) is uitgebreide informatie te vinden over het opgeven van muziekgebruik.  
 
Radiostations zijn verplicht te rapporteren aan Buma en Sabam. AerOn studio is in staat 
een opgave van muziekgebruik te maken die direct door deze verenigingen verwerkt kan 
worden. Op papier bijhouden welke tracks er zijn gedraaid en dan de juiste gegevens er 
bij zoeken, is niet nodig. AerOn studio maakt een file aan die direct verstuurd kan 
worden. 
 
Op een tweetal plaatsen voert u gegevens in om het AerOn studio mogelijk te maken 
een Buma-rapportage te maken. 
 

1. Als eerste geeft u in Instellingen → Globaal → Algemeen → Buma rapportage 
een aantal zaken op. Wat u in de meeste velden in moet vullen krijgt u van Buma en 
Sabam te horen. 

 

2. Voor elke track in de muziekdatabank (Databank editor) geeft u op het tabblad 

‘Track’ de gegevens op die voor elke track van belang zijn. 
 
De automatisering van AerOn studio houdt steeds bij welke track er speelt, wanneer dat 
precies is en hoe lang. Samen met de gegevens die voor een Buma/Sabam-rapportage 
van belang zijn, wordt dit per dag opgeslagen in Historie. 
 
U kunt een Buma/Sabam-rapportage maken zodra de periode waarover dat moet 

gebeuren verstreken is. Via de menu’s (Databank → Buma rapportage) gaat u naar 
de Buma/Sabam-rapportage. 
 

  
 
De begindatum is door AerOn studio afgeleid van de periode die u in de Buma 
rapportage-instellingen heeft opgegeven. 
 

file:///C:/Users/Dannis.vd.Heiden/AppData/Local/Microsoft/Windows/Temporary%20Internet%20Files/Content.Outlook/I5GDRMFG/www.sabam.be
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24 Export (HTML, XML en tekst) 

AerOn studio biedt de mogelijkheid playlists als HTML (HyperText Mark-up Language), 
XML of tekst te exporteren. HTML is het bestandsformaat dat gebruikt wordt bij 
internetbrowsers, maar het bestandsformaat wordt ook door tekstverwerkers, e-mail-
programma’s en vele andere software ondersteund. De brede ondersteuning en ruime 
mogelijkheden stellen u dan ook in staat om de HTML export geheel naar uw eigen 
wensen en inzichten te benutten. Hoe u de uitvoer van playlists er uit laat zien, kunt u 
zelf bepalen door het maken en wijzigen van sjablonen. Wij gaan ervan uit dat u 
voldoende kennis van HTML bezit of in staat bent de bijgeleverde voorbeelden naar 
eigen smaak aan te (laten) passen. 
 
Vooraleer er geëxporteerd kan worden, is het van belang dat u correct aangeeft welke 
tracks wel en niet gepubliceerd mogen worden. Zo worden jingles bijvoorbeeld door veel 
omroepen niet gepubliceerd. In Databank editor kunt u in het tabblad ‘Track’ in de 
categorie ‘Publiceren’ aangeven welke tracks u wilt publiceren, dat wil zeggen: 
weergeven in de HTML export. 
 
Nadat u aangegeven heeft welke tracks wel en niet gepubliceerd mogen worden, kiest  

U in Instellingen → Automatisering → Export HTML/XML/Tekst welke sjablonen 
gebruikt moeten worden. Standaard levert Broadcast Partners in de map Export\Source 
een aantal voorbeeldsjablonen. Deze zijn overzichtelijk opgezet, zodat u er snel mee 
aan de slag kunt. In dit hoofdstuk leggen we ook uit welke mogelijkheden u heeft voor 
uw eigen sjablonen.  
 
Het principe dat we voor de verschillende typen documenten gebruiken is steeds 
dezelfde. Normaliter wilt u de HTML export voorzien van een koptekst, gevolgd door een 
reeks items en daaronder een voettekst. We splitsen de definitie van de sjabloon in twee 
of meer delen, namelijk een exportsjabloon en een itemsjabloon. Steeds bevat de 
exportsjabloon (degene die u opgeeft in de instellingen) de verwijzing naar de juiste 
itemsjabloon. 
 

 
 
In de sjablonen kunt u gebruik maken van een aantal ‘tags’ voor het zichtbaar maken 

van gegevens uit AerOn studio. De tags zijn te herkennen als <#tag>, waarbij u tag 
vervangt door de gewenste tekst. Verder staat het u vrij alle mogelijkheden van HTML 
te benutten. 
 
Gaat u gebruik maken van de export in XML formaat, dan moet u er op letten dat de 
eerste regel van het sjabloon er als volgt uitziet: 
<?xml version="1.0" encoding="utf-8" standalone="yes"?> 
De HTML export gebruikt dit om te bepalen of export in HTML of XML gewenst is. 
 

Het is ook mogelijk om playlists te exporteren naar Pluxbox Radio Manager. 

Hoofdsjabloon
Opmaak van het 

bestand. Denk hierbij 
aan de stylesheet. 

Inhoud/tags
Gebruik onderstaande 

tags voor de juiste 
inhoud.

Eindbestand
XML, HTML of .JSON.

Deze kun je plaatsen op 
je website via bijv. FTP.
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24.1 Playlist 

De sjabloon voor de playlist is opgedeeld in twee delen, namelijk de definitie van de 
koptekst die eenmalig bovenaan de webpagina komt en de definitie van een playlistitem 

dat steeds herhaald wordt. In Instellingen → Automatisering → Export 
HTML/XML/Tekst  geeft u de sjabloon met de koptekst op. Afhankelijk van de opbouw 
bevat sjabloon een verwijzing naar het tekstbestand met daarin de itemdefinitie. Dit 
tekstbestand waar naar verwezen wordt, wordt repetief gebruikt om de tags te vullen met 
metadata. 
 
De volgende tags kunt u gebruiken in de sjabloon voor de koptekst: 
 

Date_Now De datum van vandaag. 

Playlist_Name Bestandsnaam van de geëxporteerde playlist. 

Playlist_Date De datum van vandaag of ‘Datum onbekend’ als de bestandsnaam 
van de playlist geen geldige datum representeert. 

Items_BESTAND Dit is de verwijzing naar de sjabloon dat de beschrijving van een 

enkel item uit de playlist. Hier geeft BESTAND de bestandnaam 
van de sjabloon zonder extensie aan. 

 
De volgende Tags kunt u gebruiken in de sjabloon voor de items die aanwezig zijn in de 
muziekdatabank: 
 

AudioID AudioID van de track.  <#AudioID> 

Title Titel van de track.        <#Title> 

Artist Artiest van de track.     <#Artist> 

Title_Artist Geeft titel en artiest van de track weer op dezelfde wijze als in de 
playlist (met een liggend streepje). 

Author Auteur van de track. 

Track_Start Starttijd van het item uit de playlist in hh:mm:ss. 

Track_Start_Short Starttijd van het item uit de playlist in hh:mm. 

Track_Length Lengte van de track. 

Start_Next Starttijd van het volgende item uit de playlist. 

Album  

Year Jaartal datum hoogst behaalde notering 

Publication Het veld Publiceren van de track uit de muziekdatabank. Deze 
tag is nodig als u ook aangepaste tekst wil publiceren. 

De tag <#Publication> publiceert in de vorm die per track is 
aangegeven in de database. 
Dat kan zijn in deze vormen: 

- Niet 
- Titel - Artiest 
- Titel 
- Artiest - Titel 
- Artiest 
- Aangepast 

Info Info van de track. 
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Artist.instagram Het instagram account van de artiest 

Artist.twitter Het twitter account van de artiest.  

Website Website van de track. 

SongType Songtype (eerste kolom van de criteria) van de track. 

Songtext Songtekst van de track. 

 
Dit is een selectie van de belangrijkste tags die gebruikt kunnen worden met AerOn 
studio, er zijn echter nog veel meer tags mogelijk om te gebruiken. Tags kunnen worden 
gedefineerd met databasetabel.veldnaam. Op deze manier kun je de vele informatie 
die AerOn studio in de database heeft gebruiken in je export. Mocht je hier vragen over 
hebben neem dan contact op met onze support afdeling.  
 

Als het item extern audio betreft, dan worden enkel de tags Artist, Title_Artist en 
Publication ondersteund. Bij gebruik van één van deze drie tags wordt dezelfde tekst 
ingevuld. Bij het gebruik van andere tags in de sjabloon wordt er geen tekst ingevuld. 

Bij extern audio is dit de naam die u in de instellingen bij ‘Publiceren’ hebt opgegeven. 

(Instellingen →  Automatisering → Extern audio …) 
 
Nadat u één of meerdere sjablonen ontworpen heeft, kunt u de HTML-export als volgt 

gebruiken: open een playlist en ga dan via de menu’s naar Bestand → OnAir export. 
AerOn studio maakt hier de beschikbare sjablonen zichtbaar. Na aanklikken van de 
gewenste sjabloon wordt de HTML-export uitgevoerd. 

24.2 Playlist OnAir 

De Playlist OnAir is een uitbreiding op de standaard playlist. Deze geeft de playlist weer 
die nu speelt (OnAir is). In de sjabloon met de koptekst kunt u dezelfde tags gebruiken. 
Er zijn nu drie verwijzingen naar sjablonen met de items. De eerste  sjabloon is voor het 
weergeven van de items die gespeeld hebben. De tweede sjabloon is voor het 
weergeven van het actieve item. De derde sjabloon definieert de opmaak van de 
komende items. 
 

ItemsOnAir_LastXX_BESTAND Dit is de verwijzing naar de sjabloon met de 
beschrijving van de reeds gespeelde items. Voor 

XX vult u het aantal reeds gespeelde items in dat 

u in de playlist wilt zien.  BESTAND geeft de 
bestandnaam van de sjabloon zonder extensie 
aan. 

ItemsOnAir_BESTAND Dit is de verwijzing naar de sjabloon met de 
beschrijving van het actieve item. 

ItemsOnAir_NextXX_BESTAND Dit is de verwijzing naar de sjabloon met de 
beschrijving van de items die nog moeten spelen. 
Sommige radiostations geven er de voorkeur aan 

om niet te laten zien wat er nog komt, voor XX vult 
u dan 0 in. 

 

In Instellingen → Automatisering → Export HTML/XML/Tekst kunt u bij ieder 

sjabloon, die u opgegeven heeft, de optie ‘Actief’ aanvinken. AerOn studio gebruikt deze 
actieve sjablonen voor de playlist die u op een website publiceert. De export vindt 
automatisch na elke trackwisseling plaats. 
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De volgende tags kunt u gebruiken in het sjabloon voor plaatjes te tonen:  
 

Track Singlehoes van de track. 

Disc Albumhoes. (waar de track op is verschenen.) 

Artist Foto van de artiest. 

Available Foto van de track, disc of artiest. Bij voorkeur wordt de foto van de 
track getoond. Is deze niet aanwezig dan wordt de foto van de disc 
getoond en eventueel die van de artiest. 
 

Voorbeeld <#image src="Disc" alt="Albumhoes"> 

 

Handmatige HTML-export is eveneens mogelijk via de menu’s. U ziet bij Bestand → 
OnAir export de beschikbare sjablonen. Boven de streep ziet u de ‘normale’ 
playlistsjablonen en onder de streep de ‘on air’ sjablonen. 

24.3 Publicatie op internet 

Veel AerOn studio-gebruikers zijn geïnteresseerd in de publicatie van de actieve playlist 
op internet. Aangezien het uploaden van de HTML-bestanden per website host 
verschillend kan zijn, is het hier niet mogelijk een kant en klare oplossing aan te bieden. 
We volstaan daarom met een voorbeeld. 
 
Elke keer dat de automatisering van AerOn studio een nieuwe track start, wilt u deze 
wijziging zichtbaar maken op internet. Hiervoor is het nodig dat een zogenaamd ftp-

commando wordt gestart. Dit commando kunt u in Instellingen → Automatisering → 
Export HTML/XML/Tekst ingeven in Uitvoeren bij actief sjabloon. 
 
U vult daar bijvoorbeeld het volgende commando in: 
”P:\AerOn Data\HTML\Upload.bat” 

 
Het bestand ‘Upload.bat’ op de aangegeven locatie bevat de commando’s die nodig zijn 
om de daadwerkelijke upload uit te voeren. Er wordt hier gebruik gemaakt van het 
programma ftp dat een standaardonderdeel van Windows is. 
Bijvoorbeeld: 
ftp –s:”P:\AerOn studio Data\Export\Source\UploadFtpcmd.txt” 
 
Eventueel kunt u aan het einde van bovenstaande commandoregel nog het volgende 
toevoegen: 
> ”P:\AerOn studio Data\Export\Source\FtpResult.txt” 

Hiermee wordt de uitvoer van het ftp-commando bewaard in het bestand result.txt. 
Hiermee kunt u controleren of de ftp-opdracht goed is uitgevoerd. Indien de server van 
de website host tijdelijk niet toegankelijk is, kunt u dat in dit bestand nazien. 
 
Het bestand ‘UploadFtpcmd.txt’ bevat een script voor het ftp-programma. De haken en 
de tekst tussen de haken dient u door de juiste gegevens te vervangen. De haken staan 
hier enkel ter verduidelijking. De haken mogen niet opgenomen worden in het bestand 
‘UploadFtpcmd.txt’. 
 
open <<URL van de internetprovider>> 
<<username>> 
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<<password>> 
cd AerOn studio 
put ”P:\AerOn studio Data\Export\Target\NewStyle1.htm” 
put ”P:\AerOn studio Data\Export\Target\Available.jpg” 
quit 

 
De regel cd AerOn studio doet hetzelfde als het DOS-commando CD maar dan op de 
webserver. Dit kan nodig zijn als het bestand dat u gaat uploaden niet in de root van de 
internetserver staat maar ergens in een submap. 
 
Bestanden zoals plaatjes en sjablonen moeten ook op de webserver aanwezig zijn. 
 
Sjabloon bestanden 
UploadFtpcmd.txt 
Upload.bat 

24.4 Voorbeelden 

Hieronder overlopen we de verschillende standaardsjablonen die met AerOn studio 

worden meegeleverd. U kunt deze sjablonen vinden in Instellingen → Automatisering 
→ Export HTML/XML/Tekst. U kunt de sjablonen vervolgens selecteren en bekijken 
met de knop ‘Bekijken’ rechts onderaan. 
 

24.4.1 Playlist op website 
De sjablonen NewStyle1 en NewStyle2 geven de actieve playlist in HTML weer met één 
afbeelding of de afbeelding van track, disc en artiest. 
 
NewStyle1 NewStyle2 
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Sjabloon bestanden 
NewStyle1.txt / NewStyle2.txt 
NewStyle1OnAir.txt / NewStyle2OnAir.txt 
NewStyleItems.txt 
NewStyle.css 
NewStyleBackground.bmp 

24.4.2 Playlist op website – meer afbeeldingen 
NewStyle3 voegt de afbeeldingen van de gespeelde en toekomstige tracks toe. 
 

 
 
Sjabloon bestanden 
NbewStyle3.txt 
NewStyle3OnAir.txt 
NewStyle3Items.txt 
NewStyle.css 
NewStyleBackground.bmp 
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24.4.3 Actieve track in bestand 
Sommige gebruikers willen de actieve track niet rechtstreeks naar de website(s) laten 
publiceren, maar deze door een andere applicatie laten verwerken met een bestand, 
waar op de eerste regel de artiest staat en op de tweede regel de titel van de track of 
omgekeerd. 

 
Sjabloon bestanden 
TitleArtist.txt 
TitleArtistOnAir.txt 
 

24.4.4 Vorige, actieve en volgende track in bestand 

 
 
Sjabloon bestanden 
Compact.txt 
CompactOnAir.txt 
 

24.4.5 Playlist zonder opmaak 
Voor bewerking van de playlist in een andere applicatie kan dit sjabloon als basis dienen. 
Merk op dat er hier geen ‘OnAir’-bestand is. 

 
Sjabloon bestanden 
Simple.txt 
SimpeItem.txt 
 

24.4.6 Actieve track als billboard 
 
Met dit sjabloon brengt u de afbeelding (track, disc of artiest) van de actieve track in 
beeld op een grote monitor in de studio. Met de functietoets F11 in Firefox en Internet 
Explorer blijft enkel de afbeelding zichtbaar. 
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Sjabloon bestanden 
BigPicture.txt 
BigPictureOnAir.txt 

24.4.7 XML 
AerOn studio herkent in het sjabloon de codering encoding="utf-8" om een XML-bestand 
te genereren.  

 
Sjabloon bestanden 
Xml.txt 
XmlOnAir.txt 
XmlItemsLast.txt 
XmlItemsNext.txt 

24.4.8 Klokken 
De klokken van de automatisering zijn met deze sjablonen eenvoudig in beeld te brengen 
op een andere PC in het netwerk. Voor het weergeven van de klokken moet Java 
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geïnstalleerd zijn op het apparaat zoals bvb. op de PC, tablet, of smartphone waarop de 
webpagina wordt bekeken. Java kan worden gedownload van www.java.com  
Verder is het handig dat op alle PC’s de tijd synchroon loopt.  Met een tool zoals NetTime 
kan de PC klok gesynct worden met een NTP server. 
http://www.timesynctool.com/NetTimeSetup-314.exe 

 
Sjabloon bestanden 
Bron: clocksdigital.txt 
Doel: clocksdigital.htm 
 

Tip! in de meeste webbrowsers kunnen de menu’s en adresbalken worden verborgen 
met de functietoets F11 zodat er op één monitor enkel de klokken worden weergegeven. 
 

 
Bestand 
Bron: clocksdigital.txt 
Doel: clocks.htm 
 

24.4.9 Shoutcast en Icecast 
Met dit sjabloon stuurt u de artiest en titel als metadata naar een Shoutcast of Icecast 
server of bijvoorbeeld een Barix Instreamer. De metadata wordt via het php script 
ShoutcastSongInfo.php ingelezen en verzonden. In dit script moet u de parameters voor 
IP-adres, poort, wachtwoord, Stream ID en Mount point aanpassen naar uw eigen 
situatie. 

http://www.java.com/
http://www.timesynctool.com/NetTimeSetup-314.exe
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Ook het pad naar het metadatabestand moet u in het script aangeven. 
Bijvoorbeeld: 
"P:\AerOn studio Data\Export\Target\Shoutcast.htm" 
 
Om het script ShoutcastSongInfo.php uit te kunnen voeren moet php geïnstalleerd zijn. 
 
Php kunt u downloaden van de website http://windows.php.net/download/ 
Aanbevolen versie: PHP 5.3.10 of hoger  VC9 x86/x64 Thread Safe 
 
Voor php zijn de components of Visual C++ Libraries een vereiste. Indien deze nog niet 
zijn geïnstalleerd kunt u deze via onderstaande links downloaden: 
 
Microsoft Visual C++ 2008 Redistributable Package (x86) voor 32 bit windows 
http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=29 
 
Microsoft Visual C++ 2008 Redistributable Package (x64) voor 64 bit windows. 
http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=15336 
 
Het bestand ShoutcastUpdateSongInfo.bat bevat het commando waarmee u het script  
ShoutcastSongInfo.php  kunt uitvoeren. 
Bijvoorbeeld: 
cmd /c ""C:\Program Files\php\php.exe" -f "P:\AerOn studio 
Data\Export\Source\ShoutcastSongInfo.php"" 
 
Het bestand Upload.bat bevat het commando waarmee u het bestand 
ShoutcastUpdateSongInfo.bat kunt aanroepen. 
Bijvoorbeeld: 
call "P:\AerOn studio Data\Export\Source\ShoutcastUpdateSongInfo.bat" 
 

 
 
Sjabloon bestanden 
Shoutcast.txt 
ShoutcastOnAir.txt 
ShoutcastSongInfo.php 
ShoutcastUpdateSongInfo.bat 
 

Tip! Zie ook export streamtitle in de automatiseringsinstellingen waar u rechtstreeks via 

een url metadata naar uw streaming server kunt laten sturen. Zie Instellingen → 
Automatisering → Algemeen → Export streamtitle 
 
 

24.4.10 Orban Opticodec 
Met dit sjabloon stuurt u de artiest en titel naar de stream van de Orban Opticodec. 
Daarbij heeft u de keuze uit een tekstbestand of XML-bestand. 
 

http://windows.php.net/download/
http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=29
http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=15336
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Standaard is in Windows de UAC actief. De Orban Opticodec software moet daarom 
uitgevoerd worden als Administrator om de software voldoende rechten te geven. 
 

Text 

 
In de Opticodec stelt u in waar het bestand gevonden kan worden, de scheiding tussen 
artiest en titel en hoe deze informatie wordt afgesloten in het bestand. 

 
Sjabloon bestanden 
OrbanOpticodec.txt 
OrbanOpticodecOnAir.txt 
 

XML 

 
 

 
Sjabloon bestanden 
OrbanOpticodecXml.txt 
OrbanOpticodecXmlOnAir.txt 
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25 Acties 

Acties kunt u openen via het menu Tools → Acties. Of sneltoets SHIFT+CTRL+A 

 
Met Acties kunnen bepaalde handelingen worden uitgevoerd. Dit kunnen acties zijn in 
AerOn studio op dezelfde computer of acties naar andere computers waarop AerOn 
studio (bijvoorbeeld Editiesystemen) of Radix draait. Radix is RDS software van 
Broadcast Partners, waarmee bijvoorbeeld actuele titel en artiest kan worden 
meegezonden in de PS of RT van RDS. Ook het automatisch aan- en uitschakelen van 
TA (Traffic Announcement) of Regio-uitzendingen zijn daarbij mogelijk. AerOn studio kan 
bijgevolg ook acties ontvangen van andere computers waarop AerOn studio draait. 
Vandaar dat er onderscheid wordt gemaakt tussen enerzijds uitgaande acties en 
anderzijds inkomende acties. 
 
De uitgaande acties worden uitgevoerd bij het afspelen van een audiobestand. In de 
recente historie is terug te vinden wanneer en welke acties zijn uitgevoerd in het nabije 
verleden. 
 

  

25.1 Uitgaande acties 

Uitgaande acties worden uitgevoerd door middel van het afspelen van een 
audiobestand. Een actie kan enerzijds worden toegevoegd met de kleine knoppen 
onderaan de lijst. Een andere en meer eenvoudige manier is, om een audiobestand naar 
het venster van de uitgaande acties te slepen. Dit kan bijvoorbeeld gebeuren o.a. vanuit 
Databank browser, Item browser, Playlist, Jingle players en ook vanuit Windows 
Verkenner, voor zover die audiomap deel uitmaakt van de lokale zoekpaden in Audio 
lokaal. De AudioID, titel en artiest worden automatisch ingevuld. De overige velden 
worden hieronder nader beschreven. 
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25.1.1 Actietijd 
Dit is de tijd relatief aan het werkelijke begin van het audiobestand waarop de actie wordt 
uitgevoerd. Deze tijd is dus niet gelijk aan de tijd na het starten van het audiobestand. 
Bijvoorbeeld: de actietijd is 5 seconden en het audiobestand wordt gestart op seconde 
2. Dit betekent dat de actie wordt uitgevoerd 3 seconden nadat het audiobestand is 
gestart. 

25.1.2 Voor stop 
Hiermee wordt aangegeven, dat de actie ook uitgevoerd dient te worden indien de 
actietijd nog niet is bereikt op het moment dat het audiobestand reeds is gestopt met 
spelen. Dit is bijvoorbeeld van toepassing als de presentator / Dj een bedje gebruikt 
tijdens het aflezen van verkeersinformatie. Het bedje is meestal vrij lang en wordt in 
principe altijd eerder beëindigd dan de eigenlijke duur van het bedje. Zodra het bedje 
wordt gestopt, dient ook de RDS TA functie uitgeschakeld te worden. Als Voor stop is 
aangevinkt wordt bij het stoppen van het bedje meteen de actie uitgevoerd en wordt RDS 
TA uitgeschakelt. 
Het aanvinken van Voor stop is ook van toepassing voor bestanden met een wisselende 
lengte. Denk hierbij o.a. aan het nieuws, verkeersinformatie en agendaberichten. 
 

25.1.3 Actie 
Hier wordt ingesteld welke actie uitgevoerd moet worden. Indien bij een audiobestand 
meerdere acties uitgevoerd moeten worden, dan dient dit audiobestand meerdere keren 
te worden toegevoegd aan de lijst, telkens met dezelfde AudioID. 
 

Ondersteunde acties 
 
Extern audio afbreken 
Dit wordt gebruikt bij editiesystemen waarbij ontkoppelde programma’s of 
reclameblokken worden uitgezonden. Zodra van een andere AerOn studio systeem deze 
actie ontvangen wordt, wordt het extern audio afgebroken en gaat deze AerOn studio 
verder met zijn eigen playlist. Bijvoorbeeld een eigen, lokaal en ontkoppeld reclameblok. 
 
Time shift pauzeren / hervatten 
Voor programma’s die met Time shifter worden opgenomen voor latere heruitzending, is 
het mogelijk de opname tijdens reclameblokken tijdelijk te onderbreken. Zodoende kan 
tijdens de heruitzending van het opgenomen programma worden gewerkt met andere 
reclameblokken. 
 
Uitgaande actie 1 / 2 ACM/CIM 
Voor het aansturen van één van de uitgangen op de ACM of CIM 
 
RDS TA aan / uit 
Voor het aan- of uitschakelen van de RDS TA (Traffic Announcement) functie in Radix. 
 
RDS Regio uitzendingen aan / uit 
Voor het aan- of uitschakelen van de regionale uitzendingen met Radix. 
 
Voor de RDS acties wordt een verzoek gedaan aan Radix om de betreffende actie uit te 
voeren. Het is uiteindelijk Radix die zal bepalen of de actie wordt uitgevoerd. 
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Regionaal afspelen 
Dit wordt gebruikt bij editiesystemen waarmee ontkoppelde jingles, nieuws of andere 
items worden uitgezonden. Zodra van een andere AerOn studio systeem deze actie 
ontvangen wordt, wordt de lokale jingle of nieuws gestart. 
 
Commando 
Voor het uitvoeren van scripts,  urls, etc... 

25.1.4 Live, Nonstop en Jingle 
Hiermee wordt aangegeven van waaruit een actie uitgevoerd moet worden: vanuit Jingle 
players, tijdens afspelen in Live assist of tijdens nonstop. 

25.2 Inkomende acties 

Inkomende acties zijn acties die afkomstig zijn van een ander AerOn studio systeem op 
een andere computer in het netwerk. De acties communiceren via de Postgres database 
server. Logisch gevolg is dat in inkomende acties de AerOn studio Postgres database 
server ingesteld moet worden vanwaar de acties vandaan komen. 
 
In de recente historie is terug te vinden wanneer en welke acties zijn binnengekomen in 
het nabije verleden. 
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26 Beheer 

Beheer kunt u openen via het menu Tools → Beheer. Of sneltoets SHIFT+CTRL+B 

 
Met Beheer kunt u (overbodige) bestanden of databankrecords beheren. Per tabblad 
krijgt u de gegevens op een overzichtelijke wijze gepresenteerd. 
 

Zodra u de knop Toepassen indrukt worden alle geselecteerde bestanden of records 
verwijderd. Daarna is het onmogelijk om ze terug te halen. Als u naar een ander tabblad 
gaat, zoekt AerOn studio eerst uit welke items in aanmerking komen om verwijderd te 
worden. Dit gebeurt slechts eenmalig, maar kan wellicht enige tijd duren. 
 

  
 

In het schermvoorbeeld ziet u linksonder het totaal aantal. In de kolom Verwijderen ziet 
u de items die gemarkeerd zijn voor verwijdering en onderaan het aantal. Items kunt u 
per stuk markeren, maar u kunt ook eerst een selectie maken met muis of toetsenbord 

en deze ineens markeren met de sneltoets CTRL+M. U kunt ook alle items in één keer 

selecteren met de sneltoets CTRL+A en Alles markeren via het menu. 

 

  
 

Historie 
Hier ziet u vanaf welke dag er historie in de databank aanwezig is. U kiest een bepaalde 
datum, Beheer zal de historie van voor die datum verwijderen. AerOn studio gebruikt de 
historie voor het maken van een Buma of een SABAM-rapportage. Verwijder de historie 
pas als u de rapportage gemaakt hebt. 
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Playlist 
In tegenstelling tot de historie waar u later één en ander van wilt terugkijken heeft het 
bewaren van oude playlists niet veel nut. AerOn studio toont op gelijkaardige manier 
vanaf en tot welke datum er playlists zijn. Verder biedt AerOn studio de mogelijkheid om 
playlists met een alternatieve naam op te slaan. Deze naamplaylists zijn apart zichtbaar 
en selecteerbaar. 
 

Voice track 
AerOn studio bepaalt automatisch welke voicetracks verwijderd mogen worden. Daartoe 
worden eerst alle playlist doorlopen omdat daarin een vermelding naar de voicetracks 
staat. Het kan dus enige tijd duren voordat de voicetracks zichtbaar zijn. Beheer 
markeert automatisch de voicetracks die niet meer in een playlist gebruikt worden. 
 

Audio 
De verwijderfunctie ‘Audio’ zoekt naar alle audiobestanden die in de lokale audiomappen 
staan, maar die niet voorkomen in de muziek databank. 
 
De voorafluisterfunctie (de luidspreker in de knoppenbalk bovenaan) kunt u gebruiken 
als controle voordat u ze definitief verwijdert. 
 

Kopieën 
Op systemen met meerdere audiomappen en werkstations met afwijkende instellingen, 
kan het voorkomen dat bepaalde (veel gebruikte) items, bijvoorbeeld nieuwsflitsen, 
opnieuw worden opgenomen in een andere map. U heeft daar normaliter niet direct zicht 
op. AerOn studio gaat bij het afspelen van een item op zoek naar het bestand in de 

mappen die in Instellingen → Globaal → Audio lokaal opgegeven zijn. Deze mappen 
worden afgezocht van boven naar beneden in de volgorde die u heeft aangegeven. Het 
bestand dat als eerste wordt gevonden zal AerOn studio afspelen. Het is ook mogelijk 
dat u een oud item met de extensie .mp3 opnieuw heeft opgenomen en opgeslagen als 
.wav. U heeft dan twee maal dezelfde bestandsnaam op het systeem staan maar met 
een verschillende extensie. 
 

Als u naar het tabblad ‘Kopieën’ gaat, zoekt AerOn studio automatisch alle mappen af 
naar dubbel voorkomende bestanden. Beheer zal de bestanden die normaliter niet door 
AerOn studio afgespeeld zullen worden, automatisch markeren voor verwijderen.  
 
De voorafluisterfunctie kunt u gebruiken ter controle voordat u ze definitief verwijdert. 
Nadat u de te verwijderen bestanden heeft geselecteerd, kunt u op ‘Toepassen’ klikken 
om ze definitief van harddisk te verwijderen. 
 

Databank 
In het tabblad ‘Databank’ onderzoekt AerOn studio van welke tracks in de 
muziekdatabank geen audiobestand in de lokale audiomappen aanwezig is. Van de 
tracks waarbij geen audiobestand aanwezig is, toont AerOn studio  AudioID, titel en 
artiest.  
 

Let op!  Houdt er rekening mee dat audiomappen in Instellingen → Globaal → Audio 
lokaal juist ingevuld zijn. Als daar mappen ontbreken dan ziet u mogelijk een grote 
hoeveelheid tracks die eigenlijk niet verwijderd mogen worden. 
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Selecteer de records en klik op toepassen om ze definitief uit de database te verwijderen. 
 
Databank analyse 
Als u merkt dat de database wat trager wordt, kan het nodig zijn om een database 
analyse uit te voeren. Druk op de knop “DB Analyse” om dat uit te voeren. 
 
Mocht enkel “DB Analyse” niet afdoende zijn dan kunt u de volgende:stappen uitvoeren. 
 
1) Optioneel: Check of er optimalisatie mogelijk is in PostgreSQL settings. Zie 
hoofdstuk 30.3.10. 
2) Stop AerOn studio en sluit af. 
3) In pgAdmin SQL tool: ‘VACUUM FULL’ // Dit defragmenteert de database volledig. 
4) In pgAdmin SQL tool: ‘VACUUM VERBOSE ANALYZE’ // Dit optimaliseert de 
PostgreSQL query planner statistics 
5) Herstart de PostgreSQL service. 
6) Start Aeron. 
7) In AerOn studio Beheer, ga naar tabblad database en klik op “DB Analyse” om een 
aanvullende analyse uit te laten voeren. 
 

Artiest 
Deze functie controleert welke artiesten nog wel in de databank staan maar waarvan 
geen track meer aanwezig is.  
Na verloop van tijd kan het voorkomen dat tracks van bepaalde artiesten uit het systeem 
verwijderd worden of dat een spelfout in de naam van een artiest wordt gecorrigeerd. 
Deze artiesten of verkeerd gespelde namen blijven in de databank zichtbaar en 
selecteerbaar totdat u ze hier verwijderd. 
Selecteer de artiesten en klik op toepassen om ze uit de database te verwijderen. 
 
Controle en corrigeren 
De knoppen Controle en Corrigeren kunt u gebruiken om de artiest database op foutieve 
artiesten en fouten te controleren en te corrigeren. 
 
Hoofdletters en kleine letters 
De knoppen Hoofdletters en Kleine letters en de dropdown-menus kunt u gebruiken om 
artiesten en track titels om te zetten naar hoofdlettters of kleine letters. 
 
Omzetten naar hoofdletters 
 

 
 

 
 
Omzetten naar kleine letters 
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Golfvorm 
Op dit tabblad krijgt u de mogelijkheid om ineens alle audiobestanden na te laten lopen 
en waar nodig de golfvormen uit te rekenen. 
 
Als een nieuwe track in Databank editor of in een andere module wordt geopend, zal 
AerOn studio automatisch de golfvorm uitrekenen en aanmaken. Het berekenen van 
golfvormen zal bijvoorbeeld ook gebeuren als u met Mix editor door de playlist bladert 
en er nieuwe tracks voor het eerst ingeladen worden. 
 
Bij nieuwe tracks wordt ook de cue tijden berekend aan de hand van het start level en 

het end level in Instellingen → Globaal → Algemeen → Databank editor.   
 
Klik op de knop toepassen om het golfvorm scan-proces te starten. 
 
Beheer gebruikt alle cores van de processor voor het maken van de golfvormen. Het 
golfvorm scanproces blijft op de achtergrond doorlopen als u het Beheer-venster afsluit. 
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27 Instellingen 

Instellingen kunt u openen via het menu Tools → Instellingen. Of sneltoets 
SHIFT+CTRL+I 

 
AerOn studio kent diverse instellingen zoals de zoekpaden voor de harddisk audio of de 
criteria die u in Databank editor bij de tracks invult. In dit hoofdstuk beschrijven we per 
categorie de instellingen die u kunt maken. Houd er rekening mee dat sommige 
wijzigingen grote gevolgen kunnen hebben. Wij adviseren dan ook dat slechts één 
persoon (en één vervanger) bij het radiostation hier toegang toe heeft. 
 

De instellingen zijn verdeeld in de categorieën ‘Globaal’ (instellingen voor alle PC’s in 

het netwerk), ‘Automatisering’ (instellingen die enkel van toepassing zijn op de 

automatisering en de OnAir PC waarop u deze bekijkt) ‘Lokaal’ (instellingen die enkel 

van toepassing zijn voor de PC waarop u deze instellingen bekijkt) en ‘Gebruiker’ 
(instellingen die enkel van toepassing zijn op de ingelogde gebruiker) 
 

Aan de onderzijde ziet u in het venster de knop ‘Controle’. Hiermee kunt u een controle 
van uw instellingen laten uitvoeren. Met name de mappen die u opgeeft voor harddisk 
audio en bijvoorbeeld HTML-sjablonen worden op hun bestaan gecontroleerd. 
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27.1 Globaal 

De globale instellingen gelden voor iedere PC en worden toegepast als een PC zich 
aanmeldt op de database. Deze instellingen kunnen enkel bewerkt op een PC waarbij in 
Scan rechten de locatie staat ingesteld op ‘Studio’. Thuiswerkers werken doorgaans op 
een PC waarbij de locatie in Scan rechten op ‘Remote’ staat ingesteld. Zij kunnen deze 
globale instellingen niet bewerken. Zie Instellingen → Globaal → Scan rechten. 
 
 

27.1.1 Algemeen 
Bij de algemene instellingen, die gelden voor alle PC’s in het netwerk, vindt u het 
onderstaande. 
 

Naamgeving 
Radionaam Hier vult u de naam van het radiostation in. 

Locatie Hier vult u de plaatsnaam van het radiostation in. 

 
Deze velden worden in rapporten gebruikt. 
 

Database verbinding 
Hier ziet u de databaseverbinding die momenteel gebruikt wordt. U kunt een andere 
verbinding kiezen door deze in de lijst te selecteren. De knop (…) gebruikt u om een 
nieuwe verbinding te selecteren. Nadat u de verbinding gewijzigd hebt, moet u AerOn 
studio afsluiten. De nieuwe databaseverbinding wordt actief de eerstvolgende keer dat 
u AerOn studio opstart. 
 

Kleuren 
Skin Hier kunt u de AerOn skin wijzigen en een andere inladen. 

Achtergrond Achtergrondkleur van ondermeer Playlist en Databank browser. 

Actieve item Actieve item in Playlist en Live assist. 

Voice track 
(detail) 

Kleur van voicetracks in playlist bij detailweergave. 

Voice track 
(tegel) 

Kleur van voicetracks bij Playlist-tegelweergave. In tegelweergave 
is veelal een donkerder kleur voor voicetracks gewenst. 

Track uit 
Verkenner 
(detail) 

Kleur van een track gesleept uit Windows verkenner of File 
browser. Kleur-weergave bij een track die niet in Database editor 
of browser staat. Van toepassing bij Playlist in detailweergave. 

Track uit 
Verkenner 
(tegel) 

Kleur van een track gesleept uit Windows verkenner of File 
browser. Kleur-weergave van een track die niet in Database editor 
of browser staat. Van toepassing bij Playlist in tegelweergave. 

Golfvorm links Kleur van het linker audiokanaal in de golfvorm. (Boven) 

Golfvorm rechts Kleur van het rechter audiokanaal in de golfvorm. (Onder) 

 

Auteursrechten rapportage 
In Nederland zijn radiostations verplicht de gespeelde muziek, jingles, enzovoorts te 
rapporteren aan Buma. Sabam is de tegenhanger van Buma in België. De velden bij 

Auteursrechten rapportage hebben hierop betrekking. Wat u bij de eerste vier velden 
moet invullen wordt door Buma/Sabam bepaald. 
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Auteursrechten 
vereniging 

Buma Nederland, Gramo Noorwegen. 

Organisatie Buma/Stemra/Sena/Sabam kent per uitzendorganisatie een code 
toe, zodat het voor Buma/Stemra/Sabam en Sena duidelijk is wie 
de toeleverancier is van deze gegevens. Deze code is uniek per 
zender en wordt samengesteld uit 3 of 4 letters en/of cijfers. 

Soort rubriek Aan alle gelden welke door Buma/Stemra/Sabam worden 
ontvangen, wordt een code tegekend. Standaard wordt R (radio) of 
T (televisie) door Buma/Stemra/Sabam toegekend. 

Rubriek Buma Binnen de soort rubriek maakt Buma/Stemra/Sabam een 
onderverdeling voor verschillende sub-rubrieken bestaande uit 2 
letters. Bijvoorbeeld EN (Ether Nationaal), LT (Lokale Televisie) of 
NC (Niet landelijke Commerciële radio). Op basis van deze code 
kan Buma/Stemra/Sabam de rechthebbende mededelen uit welke 
sub-groep de muziekgegevens afkomstig zijn. In combinatie met 
de zendercode worden de door u verstrekte gegevens uniek 
gemaakt. 

Zendercode Omdat binnen een uitzendorganisatie meerdere kanalen (zenders) 
van toepassing kunnen zijn, is hier een mogelijkheid aanwezig om 
per zender een unieke aanduiding toekennen, bijvoorbeeld NPO 
zendercode: NL1, NL2, NL3. 

Periode De periode waarover de rapportage plaatsvindt, kan variëren van 
een week tot een jaar. Buma/Sabam geeft deze periode op. De 
meeste lokale radiostations zijn verplicht om één week per jaar te 
rapporteren. 

Gecomprimeerd Bij de Buma-rapportage ontstaan grote bestanden die meestal niet 
op een diskette passen. Door deze optie aan te vinken vindt er na 
de rapportage nog een verwerkingsslag plaats waarbij het bestand 
met dezelfde naam wordt gecomprimeerd in het ZIP-formaat. 

Export map De map waar de rapportage in geplaatst moet worden geeft u 
hiermee op. 

 

Databank editor 

Start level AerOn studio bepaalt bij nieuwe tracks automatisch het ‘fade-in 
start’ punt aan de hand van het niveau in het bestand. Geef hier het 
gewenste level in. 

End level AerOn studio bepaalt bij nieuwe tracks automatisch het ‘volgende’ 
punt aan de hand van het niveau in het bestand. Geef hier het 
gewenste level in. 

Publiceren Nieuwe tracks in de databank worden gepubliceerd zoals u dat hier 
instelt. Gebruik in uw sjabloon de tag <#Publication>. 

Beschikbaar 
planner 

Nieuwe tracks in de databank komen beschikbaar voor  
Formatplanner. 

Beschikbaar 
gebruiker 

Nieuwe tracks in de databank komen beschikbaar in Databank 
browser en zichtbaar voor alle gebruikers. 

Uurgetal track Nieuwe tracks in de databank krijgen dit uurgetal. 

Uurgetal artiest Nieuwe artiesten in de databank krijgen dit uurgetal. 

Opname 
formaat 

Het opnameformaat kunt u instellen op ‘vrij instelbaar’ of aangeven 
in welk bestandsformaat nieuwe opnames moeten plaatsvinden. 
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Opname bitrate Als het opnameformaat ingesteld is, kunt u ook de bitrate instellen. 

Opname 
samplerate 

De samplerate is ‘vrij instelbaar’, 44100 Hz of 48000 Hz. 

 

Voice track 
Opname 
formaat 

Het opnameformaat kunt u instellen op ‘vrij instelbaar’ of aangeven 
in welk bestandsformaat voicetracks opgenomen moeten worden. 

Opname bitrate Als het opnameformaat ingesteld is, kunt u ook de bitrate instellen. 

Opname 
samplerate 

De samplerate is ‘vrij instelbaar’, 44100 Hz of 48000 Hz. 

Afbeelding Afbeelding bij tegelweergave in de playlist. 

 
Extra 

 
Playout output 
reference 

 
Hier stelt u het algemene playout output referentie level in waarop 
Automatisering, Live assist, Databank editor, Mix editor en Jingle 
players afspelen. Per track wordt een gain-correctie toegepast 
zodat alle tracks op de ingestelde playout output reference level 
afspelen. 
 
Standaard staat dit level ingesteld op RMS -18 dB.  
 
In Databank editor en Mix editor kunt u per track, en ook per 
voicetrack, een gain-offset instellen die wordt toegepast t.o.v. de 
Playout output reference. Hiermee kunt u bepaalde tracks zachter 
of harder laten afspelen. 
 
De ingestelde playout output reference en de gain-offset bij elkaar 
opgeteld zullen nooit harder worden afgespeeld dan peak 0 dB. 
  

Tip! Voor het geval u de output van AerOn studio rechtstreeks 
aanbiedt op Orban soundproccesing wordt een reference level van 
Peak -9 dB aanbevolen. Wanneer deze instelling op peak staat 
ingesteld staat dan neemt het menselijkgehoor het volumeverschil 
tussen alle tracks onderling waar. Om te voorafluisteren bij 
afspelen op Peak kunt u de audio beter beluisteren via een 
leveler/compressor/limiter. 
 

Marge semi-
vaste items 

Hier vult u een tijd in minuten en seconden in, die aangeeft hoeveel 
eerder een semi-vast item mag starten dan de ingestelde tijd. U 
maakt hiermee mogelijk dat het nieuws bijvoorbeeld maximaal 1 
minuut voor het hele uur start. 
 

Standaard 
afbeelding 

Indien er bij een track geen afbeeldingen aanwezig zijn in de 
databank zullen de playlist (in tegelweergave) en het 
monitorscherm deze standaardafbeelding tonen. 

Monitor 
commercial-
afbeelding 

Hier stelt u in welke afbeelding voor commercials wordt getoond in 
het monitorscherm. 

Playlist auto-
matisch volgen 
na 

Met deze time-out waarde stelt u in na hoeveel tijd (in uren en 
minuten) de playlist het actieve item van de automatisering volgt. 
Als er langer dan de ingestelde time-out niet in de playlist wordt 
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gewerkt, wordt het actieve item bij iedere track wissel gevolgd. Als 
u deze time-out instelt op 00:00 wordt het actieve item nooit 
gevolgd. 

Importmap Hier kunt u opgeven in welke map de audiobestanden geplaatst 
worden bij het importeren van tracks. Laat u deze optie leeg, dan 
kan de gebruiker zelf een map instellen in het import venster. 

 

AerOn installatie 
Software map Dit is de map waarin de uitvoerbestanden van AerOn studio zijn 

geïnstalleerd. Met de knop ‘Verkenner’ kunt u deze map openen. 

Data map Dit is de map waarin de data- en configuratiebestanden van AerOn 
studio staan. Met de knop ‘Verkenner’ kunt u deze map openen. 

De “Data map” wordt als parameter uit de snelkoppeling van AerOn 
gelezen 

Logs map Dit is de map waarin AerOn studio logbestanden opslaat. Met de 
knop ‘Verkenner’ kunt u deze map openen. 

De “Logs map” is instelbaar in de lokale instellingen. 

Zie Instellingen → Lokaal → Algemeen → Logs map 

Dalet 
Database 
verbinding 

Geef hier de verbinding met de database van Dalet op. 

Radio ID De Radio ID is van belang bij het exporteren van playlists naar de 
database van Dalet. 

 

Visual Radio 
Actief Activeer de koppeling met de Visual Radio server. 

Host Host name of IP adres. 

Port Standaard poort is 8082. 

Map met 
afbeeldingen 

De map waarin AerOn studio afbeeldingen plaatst die vervolgens 
door het Visual Radio systeem kunnen worden gebruikt.  

Video playout Hier stelt u het merk in: 
- Multicam 
- 1080dots 

Automix  

Duck level Het level waarmee geduckt wordt. Standaard is dit -6 db. 
 

Position De positie waar de automix geplaatst wordt.  
- Na outro 
- Begin track 
- Tegen intro 

Duck snelheid Hiermee bepaal je de ducksnelheid (fade-duur) van de automix. 
Deze staat standard op 3s / 10 db.  

27.1.2 Criteria 
 
De criteria voor Formatplanner kunt u op dit tabblad invullen. De instellingen worden 
door Broadcast Partners standaard ingevuld volgens een systeem, dat door de veel 
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radiostations wordt gehanteerd. Hierdoor kan elk radiostation de muziekdatabank van 
Broadcast Partners, die door verschillende AerOn studio-gebruikers steeds wordt 
uitgebreid, direct gebruiken. Hoewel u helemaal vrij bent in het gebruik van de criteria, 
raden wij u aan de standaardinstellingen te handhaven en indien nodig uit te breiden. 
 
Bij de categorie ‘Taal’ treft u slechts 6 talen aan. U kunt eenvoudig nog een aantal extra 
talen opgeven die niet in het rijtje vermeld zijn. U moet zich echter wel realiseren, dat de 
meeste radiostations in Formatplanner nooit een selectie zullen doen op bijvoorbeeld de 
taal Pools. Tracks die buitensporige criteria meekrijgen, hebben minder kans om door 
Formatplanner geselecteerd te worden. 
 

  
 
De namen van criteria kunt u zelf invoeren en aanpassen. Bij het eerste criterium 
(Songtype) heeft u ook de mogelijkheid om voor alle 25 soorten een kleur in te stellen. 
Deze kleur gebruikt AerOn studio o.a. in de playlist voor de titel en artiest, zodat u daar 
snel het songtype van een track ziet. 
 

Songtype Extra Doelgroep Taal 

Tip Pop 15 - 25 jaar Nederlands 

Hit Dance 25 - 30 jaar Engels 

Current Rock 31 - 40 jaar Duits 

Recurrent Hard Rock 41 - 55 jaar Frans 

Golden Oldie House 56 - 99 jaar Romaans 

Oldie Klassiek  Instrumentaal 

Antiek Dance Classic   

Reclame Rhythm & Blues   

Promo Reggae A-rotatie  

Jingle Love Song B-rotatie  

Pingel / Leader Soft Classic C-rotatie  

FX / Bedje Levenslied D-rotatie  
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Nieuwstune Country   

Tijdsein Kerst   

 Carnaval   

 Soft / Easy   

 Rock ’n Roll   

27.1.3 Audio lokaal 
 

 
 
Lokale audio 
mappen 

Hier geeft u op in welke mappen AerOn studio de audiobestanden 
moet zoeken die u in de automatisering gebruikt. Submappen 
worden automatisch doorzocht, deze hoeft u hier niet in te stellen. 
Het maximum aantal mappen dat u kunt opgeven is 99. AerOn 
studio doorzoekt de mappen van boven naar beneden. De 
bovenste audiomap heeft dus de hoogste priotiteit. Met de blauwe 
pijltjestoetsen kunt u mappen naar boven of naar beneden 
verplaatsen. Op iedere PC moeten deze mappen zijn ingesteld. 

Tip! Door het slepen van audiomappen vanuit Windows Verkenner 

kunt u snel en eenvoudig de lokale audio mappen instellen. 

Map voice 
tracks 

Dit is de map waarin de opgenomen voicetracks door AerOn studio 
worden bewaard. 

Zoektijd  Bij zoektijd kunt u terugzien hoe snel AerOn studio 
alle audiobestanden kan vinden. Tijdens het zoeken 
naar alle audiobestanden in alle mappen controleert 
AerOn studio ieder bestand of het een audiobestand 
is en zet de locatie van ieder audiobestand in de 
bestandscache. De totale tijd die daarvoor nodig is wordt 
weergeven bij zoektijd. Een normale waarde is ±10.000 bestanden 
per seconde als bestanden op een lokale HDD staan. 
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27.1.4 Scan rechten 

Zoals ook in hoofdstuk ‘Aanwezig scannen’ beschreven staat, is het voor AerOn studio 
belangrijk om te weten of het audiobestand van ieder item in de databank effectief 
aanwezig is. De aanwezig status wordt (onzichtbaar) en automatisch bijgehouden in de 
muziekdatabank. Omdat niet alle computers altijd toegang hebben tot alle 
audiobestanden, is het voor AerOn studio belangrijk om te weten welke computers 
rescan rechten hebben. Dit is nodig om het onzichtbare veld Aanwezig correct bij te 
houden. 
 
Computers die zijn aangesloten op het lokale netwerk van het radiostation hebben 
bijgevolg directe toegang tot alle audiomappen in het lokale netwerk. Deze computers 

moeten Scan rechten bezitten. Bij deze computers moet Locatie ingesteld zijn op 

‘Studio’.   
Computers van thuiswerkers zijn niet direct aangesloten op het lokale netwerk van het 
radiostation, omdat deze via VPN over het internet met het radionetwerk zijn verbonden. 

Normaliter krijgen deze computers geen Scan rechten. Bij deze computers moet Locatie 

ingesteld zijn op ‘Remote’. 
 
Stel een thuiscomputer met Scan rechten heeft geen toegang tot alle audiobestanden. 
Na het thuis Aanwezig scannen uitvoeren en vernieuwen van Databank browser worden 
enkel die tracks weergegeven waarvan de audiobestanden thuis op schijf aanwezig zijn. 
Dit zou voor verwarring zorgen als de Databank browser daarna in de studio wordt 
geopend.  
 
Formatplanner mag bijvoorbeeld enkel muzieknummers plannen waarvan de 
audiobestanden aanwezig zijn op de On Air playout computer. Ook Databank browser 
geeft standaard enkel de tracks weer die als aanwezig zijn gescand.  
 
Thuis computers mogen daarom enkel het Scan recht bezitten als ook alle 
audiobestanden van de in de database aanwezige tracks lokaal (thuis) op de harde schijf 
staan. Laptop computers zijn ook niet altijd aangesloten op het lokale netwerk van het 
radio station en hebben bijgevolg niet altijd of geen toegang tot alle audiomappen. 
 

Tip! Als in de studio opeens tracks uit de databank browser ‘Verdwenen’ zijn, Voer dan  
uit menu Databank → Aanwezig scannen en vernieuw daarna Databank browser. 
 
Op een computer zonder Scan rechten, worden nieuw toegevoegde databankitems niet 
meteen zichtbaar in Databank browser, tenzij de audiobestanden via de module 

Synchronisatie audiobestanden zijn geupload naar de studio. 
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Computernaam De naam van de computer om Scan rechten voor in te stellen. 

Hardwareid Het HardwareID van de betreffende computer. 

Locatie Geef aan waar deze computer zich bevindt. In de studio (wel Scan 
rechten) of remote (thuis, geen Scan rechten). 

Laatste toegang Hier wordt getoond wanneer de computer voor het laatst heeft 
ingelogd op de database. 

Beschrijving Een willekeurige beschrijving van de computer. Dit is handig als de 
computernaam niet duidelijk weergeeft om welke computer het 
precies gaat. 

 
Iedere computer die een verbinding met de database maakt zal automatisch in de scan 
rechten lijst worden toegevoegd met locatie ‘Remote’. De AerOn systeembeheerder 

moet indien nodig de Scan rechten toekennen en Locatie instellen op ‘Studio’.  
 
Bij installatie van een nieuwe computer in het lokale netwerk moet het Scan recht 
opnieuw herzien en ingesteld worden. 
 

Zie ook hoofdstuk ‘Aanwezig scannen’. 
 

27.1.5 Radio 
Er kunnen meerdere automatiseringen tegelijkertijd op één database draaien met ieder 
per Radio ID een eigen unieke playlist.  De Radio ID’s kunt u hier toevoegen, instellen 
en benoemen. 
 
In de lokale instellingen kunt u daarna een PC toewijzen aan een bepaald Radio ID. Na 
opnieuw opstarten van AerOn studio, worden dat Radio ID in AerOn studio geladen. 
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27.1.6 FTP upload 
 
Op dit tabblad kunt u inlog en host gegevens van FTP servers instellen. 
 

  
 
Bestanden die u met Timeshifter opneemt kunnen naar een FTP server worden 
geupload.  Per Timeshifter-taak kunt u een FTP server invullen. 

27.2 Automatisering 

De instellingen op dit tabblad hebben betrekking op de werking van de automatisering. 
Deze instellingen kunnen enkel worden aangepast op een PC met playout licentie, 
AerOn Playout, AerOn Slave studio, AerOn Event of AerOn Web. Deze instellingen zijn, 
op een paar uitzonderingen na, per uitzend PC uniek. 
 

Extern audio afspelen op deze PC 
Deze optie is bedoeld voor een configuratie met meer dan één OnAir PC. Een aantal 
externe bronnen, denk aan audiokaarten, zijn gekoppeld aan een fysieke PC. In een 
master/slave configuratie is het de bedoeling dat de nonstopserver alle extern bronnen 
speelt. Op de nonstopserver vinkt u deze optie aan zodat ‘deze’ PC de externe bronnen 
afspeelt. Op de andere OnAir PC’s in iedere studio, meestal met Slave studio licentie, 
zijn de externe bronnen niet instelbaar.  Externe bronnen zijn enkel instelbaar op een 
OnAir PC.  Internet streams kunnen worden gespeeld en voorbeluisterd op alle PC’s. 
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Tijd instellingen 
Fade moment 
bij glijdende 
items voor vast 
begin of 
uitvullend blok 

Met deze optie stelt u het moment in waarop AerOn studio begint 
met het uitfaden van het actieve onair spelende item of de externe 
audio vlak voor de start van een uitvullend blok of item met semi-
vaste of vaste begintijd. Gebruik deze instelling in combinatie met 
de volgende instelling voor de fadeout duur. 
 

Fadeout duur 
glijdende items 
bij start van vast 
begin of 
uitvullend blok 

Met deze instelling geeft u de duur op van de fadeout van het 
actieve item of de externe audio voor de start van een uitvullend 
blok of item met vaste begintijd. Gebruik deze instelling in 
combinatie met de voorgaande instelling. 

 

  
 
Opties lokaal  (deze PC) 
 
Automatisering 
starten bij 
opstarten AerOn  

Als u deze optie aanvinkt, start de automatisering automatisch op, 
zodra u AerOn studio opstart. Na een onverhoopte span-
ningsonderbreking zorgt u er hiermee voor, dat de automatisering 
weer zo snel mogelijk gaat lopen zonder tussenkomst van 
iemand. 
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Live assist 
automatisch 
uitschakelen bij 
starten van een 
uitvulblok of vast 
item 

Live assist wordt gedeactiveerd en de automatisering gaat in 
nonstop mode spelen als Autostart Vast uit staat. 

Het gebeurt soms dat de DJ / presentator vergeet Live assist uit 
te zetten bij de start van het uitvulblok. Als er na de uurwisseling 
geen live uitzending is en de DJ / presentator niet meer aanwezig 
is, wordt het onverwachts stil in de ether. Met deze optie voorkomt 
u dit. De DJ / presentator moet dan in het reclameblok na de 
uurwisseling zelf de Live assist functie weer activeren. 
  

Autostart Vast of 
Semi-Vast en 
Live assist blijft 
actief 
 

Een Vaste of Semi-vaste track wordt in Live assist automatisch 
gestart zodra de starttijd is bereikt. De voorgaande track wordt 
automatisch uitgefade als die glijdend is en Live assist blijft 
geactiveerd. Deze instelling overruled de voorgaande instelling. 
Indien deze optie is ingeschakeld blijft Live assist actief. 

Als deze optie uit staat dan kan een gebruiker deze optie 
aanzetten in zijn of haar persoonlijke instellingen. 

  

Functietoetsen 
F1 t/m F4 voor 
Live assist 
gebruiken 
 

De functietoetsen F1 t/m F4 kunt u gebruiken voor het bedienen 
van Live assist. Met name voor gebruikers van een laptop kan 
deze optie handig zijn.  F1 = Stop Cart A;  F2 = Start Cart A;  F3 
= Stop Cart B;  F4 = Start Cart B. 

Toon labels 
Semi-Vast 
margetijd 
 

Indicatoren van de Semi-vast-margetijd en de starttijd van 
Uitvullend of Semi-vast worden weergegeven onder de klokken. 
 
De starttijd van Semi-vast wordt o.a. opnieuw berekend bij het 
starten van een track en het slepen van tracks in het actieve 
playlistblok. Een uitvulblok schuif automatisch mee. Het label 
toont telkens de nieuwe starttijd van het uitvullend blok of Semi-
vast. 
 
De Semi-vast-marge-tijd is het vroegste tijdstip waarop het 
uitvullend blok of Semi-vast kan starten. Dit is de hele uurtijd 
minus de instelbare marge Semi-vast en indien aanwezig minus 
de lengte van het uitvullend blok. 
 
Als deze optie uit staat dan kan een gebruiker deze optie 
aanzetten in zijn of haar persoonlijke instellingen. 

 

Tip! Door het instarten van een kort item na het overschrijden van 
de Semi-vast-margetijd kunt u een uitvulblok of Semi-vast eerder 
laten starten. 
 
 
  

Studio vrijgeven 
bij het starten 
van een 
uitvulblok 

Deze optie is van toepassing bij een master/slave configuratie.  

De studio wordt automatisch vrijgegeven en een uitgevuld 
commercialblok wordt automatisch gestart en gespeeld op de 
nonstop-server. 

 

Studio vrijgeven 
bij het starten 
van glijdend 

Deze optie is van toepassing bij een master/slave configuratie.  

De studio wordt automatisch vrijgegeven vlak voor de start van 
een glijdend commercialblok als de automatisering in nonstop 
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commercialblok 
(Nonstop mode) 

mode draait. De playlist wordt dan automatisch gespeeld op de 
nonstop-server. 

 

Studio vrijgeven 
bij het starten 
van glijdend 
commercialblok 
(Live assist) 

Deze optie is van toepassing bij een master/slave configuratie.  

De studio wordt automatisch vrijgegeven vlak voor de start van 
een glijdend commercialblok als de automatisering in Live assist 
draait. De playlist wordt dan automatisch gespeeld op de nonstop- 
server. 

 

Opties globaal 
 
Nonstop altijd 
spelen in Cart A 

Standaard staat deze optie aan en zal de automatisering na de 
overgang van live naar nonstop zo snel mogelijk terug 
overschakelen op Cart A. Als deze optie uitgevinkt is, kan de 
automatisering op Cart B blijven spelen als Cart B de laatste 
actieve cart was in Live assist. 
  

Uitvulblok altijd 
spelen in Cart A 

Als deze optie geactiveerd is, zal de automatisering het uitvulblok 
altijd starten in Cart A, ook als deze al in Cart B gecued staat. 
  

Update 
fadecurve in 
playlist bij eerder 
stoppen in Live 
assist 

Als deze optie is aangevinkt dan wordt de fade curve van de track 
in de playlist opgeslagen zoals die is afgespeeld in Live assist.  

 

Bij het voorafluisteren of later terugluisteren van de mix, wordt de 
track gespeeld zoals die onair heeft gedraaid. Het deel van de 
track dat niet onair gespeeld is, is dan ook niet hoorbaar als deze 
mix-overgang in Mix editor wordt gespeeld.  

Activeer de 
studio pas als de 
nonstop server 
bijna is 
uitgespeeld 

Deze optie is van toepassing bij een master/slave configuratie.  

Na het aanvragen van een studio zet de nonstop server de studio 
pas onair als de nonstop server nog 30 seconden te spelen heeft. 
Als in de studio de gele aftelklok 00:30 aangeeft wordt de studio 
ingeschakeld. Met de instelling Studio eerder activeren kunt u het 
aantal seconden bepalen. 

Studio eerder 
activeren 

Aantal seconden dat de studio eerder wordt geactiveerd indien de 
bovenstaande optie actief is. 

 
Activeer de 
Automationlogger 

Met deze optie kan de Automationlogger worden aangezet.  
De automatisering moet gestopt en gestart om de log te activeren. 
 
Er vindt dan uitgebreide logging plaats van wat de automatisering 
uitvoert.  Deze logging kan Broadcast Partners gebruiken om 
indien nodig problemen op te sporen. 
 
De logbestanden worden standaard opgeslagen in de Logs map 

in Datamap\Logs\Computernaam.  In Globaal → Algemeen → 
Aeron Installatie bevindt zich een knop Verkenner waarmee u 
deze map kunt openen. 
 
De map waarin logbestanden worden opgeslagen is instelbaar in 

de lokale instellingen. Lokaal → Algemeen → Logbestanden 
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Extern audio 
 

  
 

Geforceerd item Bij aanklikken van de menu-optie ‘Extern audio toevoegen’ in 
menu Automatisering wordt de externe bron die hier is ingesteld 
toegevoegd in de playlist na het huidige onair spelende item. 

Activeren bij 
stoppen 
automatisering 

De externe audiobron die hier is ingesteld wordt ingeschakeld op 
het moment dat u de automatisering stopt. 

Extern audio 
maximaal 
verlengen 

Deze optie is enkel van belang voor radios die met edities werken. 
Op de editie-slavestations geeft u met deze instelling aan met 
hoeveel minuten extern audio verlengd mag worden in afwachting 
van een puls om een commercialblok te starten. Zodra de starttijd 
van een commercialblok is overschreden, dan treedt deze optie in 
werking. In de verlenging zal de klok opnieuw aftellen, maar dan 
met gele cijfers in plaats van groen. Zodra er een puls binnenkomt 
zal het commercialblok starten. 
 

Export streamtitle  (Publiceren naar o.a. Icecast en SHOUTcast) 
 
Bij een trackwissel kan informatie van de track die onair is gestart, worden meegestuurd 
in een audiostream. Een typische toepassing om deze informatie door te geven is het 
doorgeven via een URL naar een Barix Instreamer, Icecast server of SHOUTcast server.  
 
Er kunnen maximaal 10 export URL’s worden ingevuld. Deze kunt u afzonderlijk 
activeren tot een maximum van alle 10 tegelijkertijd. In iedere URL kunt u o.a. de tags 
opnemen voor Artiest, Titel en Publiceren. 
 
Ondersteunde tags zijn:  
 
<#publication>, <#artist>, <#title>, <#title_artist> <#titleid>, <#duration>, 
<#duration_hh>, <#start_next>,  
<#start_next_hh>,  <#start_next_short>, <#year>, <#author>, <#info>, <#website>, 
<#songtype>, <#songtext>, <#album> . 
 
Het combineren van deze tags in de export URL’s is mogelijk. 
 

  
 
Voorbeeld Barix Instreamer: 
http://[BARIX_INSTREAMER_URL]/rc.cgi?E=StreamTitle='<#Publication> 
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Voorbeeld SHOUTcast versie 1.x: 
http://[SHOUTCAST_V1_URL]/admin.cgi?pass=[YOUR_PASSWORD]&mode=updinfo
&song=<#Publication> 
 
Voorbeeld SHOUTcast versie 2.x: 
http://[SHOUTCAST_V2_URL]/admin.cgi?sid=[S_ID]&pass=[YOUR_PASSWORD]&mo
de=updinfo&song=Now%20OnAir:%20<#Artist>%20-%20<#Title> 
 
 
Voorbeeld Icecast: 
http://[YOUR_USERNAME]:[YOUR_PASSWORD]@[ICE_CAST_URL]/admin/metadat
a?mount=%2F[MOUNT_POINT_NAME]&mode=updinfo&song=<#Artist%20-
%20T<#Title> 
 
Voorbeeld TuneIn: 
http://air.radiotime.com/Playing.ashx?partnerId=[YOUR_ID]&partnerKey=[YOUR_KEY]
&id=[YOUR_STATION_ID]&title=<#Title>&artist=<#Artist> 
 

De blokhaken inclusief de tekst daartussen, moet u vervangen door de juiste 
gegevens zoals username en password. 
 

27.2.1 Export HTML / XML / Tekst 
Op dit tabblad kunt u de sjablonen instellen voor het publiceren van o.a. Artiest en Titel 
informatie naar HTML-, XML- en tekstbestanden. 
 

  
 

Bronjabloon Dit is de basissjabloon die gebruikt wordt voor de export. De 
voorbeeldsjablonen en bijbehorende bestanden staan in de map 
Datamap\Export\Source. 

Doelbestand Hier geeft u het volledige pad en bestandsnaam op van het bestand 
dat gegenereerd moet worden. Standaard doelmap is 
Datamap\Export\Target. 

http://[YOUR_USERNAME]:[YOUR_PASSWORD]@[ICE_CAST_URL]/admin/metadata?mount=%2F%5bMOUNT_POINT_NAME%5d&mode=updinfo&song=%3c#Artist
http://[YOUR_USERNAME]:[YOUR_PASSWORD]@[ICE_CAST_URL]/admin/metadata?mount=%2F%5bMOUNT_POINT_NAME%5d&mode=updinfo&song=%3c#Artist
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Actief Indien deze optie actief is, ververst AerOn studio automatisch het 
doelbestand als er een nieuwe track start. 

Uitvoeren bij 
actief sjabloon 

Hier geeft u een commando-regel op voor een script dat AerOn 
studio steeds zal uitvoeren na een update van de export.  
 
Dit werkt enkel bij sjablonen die gemarkeerd zijn als actief (zie 
bovenstaande optie). U kunt hier bijvoorbeeld m.b.v. een script een 
ftp commando starten en zo de nodige bestanden uploaden. 
 

Standaard 
afbeelding 

Bij het gebruik van afbeeldingen in de sjablonen is het aan te raden 
om ook een standaard afbeelding op te geven. Deze afbeelding 
wordt getoond als er geen afbeelding van track, disc of artiest in de 
databank aanwezig is. 

 
De knoppen gebruikt u voor de volgende acties: 
 

Verkenner Opent de bronmap van het sjabloon in Windows verkenner. Via een 
submenu, dat wordt geopend bij een rechtsklik, kan ook de 
doelmap worden geopend. 

Bekijken Opent de sjabloon in Internet Explorer zodat u het resultaat kunt 
zien. 

Bewerken Opent de sjabloon in Kladblok voor het bewerken van de broncode. 

 
Meer functies zijn beschikbaar in het popup-menu, bijvoorbeeld de doelmap openen. 
 
Hoe u de export sjablonen samenstelt en in gebruik neemt voor publicatie kunt u in het 
betreffende hoofdstuk in deze handleiding lezen. 
 
Tip! Bij een Master-slave studio switch systeem moet u ervoor zorgen dat alle playout 
systemen de bronbestanden en de doelbestanden van dezelfde locatie met dezelfde 
schijfletter kunnen benaderen. Iedere automatisering kan dan de export uitvoeren. 
 

 (Hoofdstuk 24: Export HTML, XML en tekst). 

27.2.2 Radix RDS 
Op dit tabblad configureert u de communicatie met de Radix RDS software. 
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U vult ‘Host’ en ‘Poort’ in en zet de verbinding op ‘Actief’. Nadat u op ‘Toepassen’ 
drukt, wordt de verbinding opgebouwd. In het onderste deel op het tabblad onder On air 
ziet u dan de meest relevante data.  De Radix RDS server moet eerst gestart zijn voordat 
u de RDS client in AerOn studio actief zet. 
 

Tip! In de statusbalk van AerOn studio is de Radix RDS Program Service tekst 
zichtbaar. 
 

27.2.3 Extern audio 
De externe bronnen die u hier configureert kunt u in de dagformats van Formatplanner 
programmeren of handmatig in een playlist toevoegen. U kunt dan kiezen uit een 
totaallijst met daarin alle namen van extern audio bronnen die zijn ingesteld.  
 
De Extern audio namen die worden weergegeven in de playlist. De tekst die u invult bij 
Publiceren wordt gebruikt om te publiceren naar Radix RDS, HTML, XML en tekst export 
om dat elders te kunnen publiceren, bijvoorbeeld op uw website. Als er bij Publiceren 
niets is ingevuld, wordt die extern audio bron niet gepubliceerd. 
 
Broadcast Partners beveelt de RME audio kaarten aan voor de doorgifte van externe 
bronnen. RME audio kaarten hebben een matrix mixer waarmee op iedere output een 
afzonderlijke mixer kan worden ingesteld. 
 

Extern audio via DirectSound  
Voorwaarde voor goed functioneren is, dat input en output op dezelfde audiokaart 
aangesloten en ingesteld zijn. Er zit een vertraging van ongeveer 700 msec tussen 
ingang en uitgang. Gebruik dit niet voor audiokaarten van het merk RME.  Gebruik bij 
RME audiokaarten de optie Extern audio via RME mixer. Deze vorm van Extern audio 
biedt stilte detectie. Stilte detectie kunt u uitschakelen door 00:00 in te vullen. De 
threshold voor stiltedetectie is -30 dB. 
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Extern audio via ASIO 
Voorwaarde voor goed functioneren is, dat de ingestelde input en output op dezelfde 
audiokaart aangesloten en ingesteld zijn. Deze optie kan gebruikt worden met 
audiokaarten die goede ondersteuning bieden voor ASIO.  
 

Extern audio via stream  
U kunt diverse soorten http (internet)streams doorgeven. AerOn studio ondersteunt 
standaard oa. AAC, mp3 en OggVorbis. Sommige streams worden met een listen.pls of 
.asx bestand beschikbaar gesteld. Het hangt van de aanbieder af of u deze kunt 
gebruiken. Bij deze externe bronnen bent u afhankelijk van de kwaliteit van het eigen 
netwerk en internet voor het ononderbroken uitzenden. Op de website van Thesyscon 
(http://www.thesycon.de/eng/free_download.shtml) vindt u documentatie over 
vertragingen in het netwerk en een programma om deze te controleren.  
 
Per stream is er een stilte detectie met instelbare time-out. Wanneer u de time-out instelt 
op 00:00 wordt de stilte detectie bij de betreffende stream uitgeschakeld. De threshold 
voor stiltedetectie is -40 dB. 
 
Als een stream wordt onderbroken probeert AerOn studio vijf maal opnieuw te verbinden, 
met tussenpozen van twee seconden.  
Dit is instelbaar tot 15 keer. 
 
Tijdens het afspelen van een stream wordt inkomende streamtitle metadata 
geëxporteerd naar HTML/Tekst export en naar de automatisering stream title export die 
het vervolgens weer doorstuurt naar bijvoorbeeld een Icecast stream server.  
Deze optie is ook hier instelbaar. 

 
Extern audio via RME mixer 
Bij deze vorm van Extern audio moet een audiokaart van het merk RME geinstalleerd 
zijn.  Voorwaarde voor goed functioneren is, dat de ingestelde input en output beide op 
dezelfde RME audiokaart aangesloten en ingesteld zijn. RME audiokaarten 
ondersteunen met hun ingebouwde matrix mixer het routeren en faden van audio-
ingangen naar één of meerdere uitgangen. Het externe audio of raamprogramma kan 

http://www.thesycon.de/eng/free_download.shtml
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zo direct naar een uitgang doorgegeven worden zodat een extra faderkanaal op het 
mengpaneel overbodig is. 

 
 
RME Matrix mixer (Studio Switch) 
De RME Matrix mixer kunt u gebruiken voor: 
- Het off-line schakelen van uw mengtafel. 
- Het schakelen van studios op een nonstopserver. 

 
 
Off-line schakelen van uw mengtafel 
U moet daar het volgende voor doen. de PGM-uitgang van de mengtafel sluit u aan op 
één van de beschikbare inputs van de RME audiokaart. Een uitgang van de RME 
audiokaart sluit u aan op de zendstraat.  
 
De schakeling wordt bedient bij het activeren/de-activeren van Live assist. Wanneer Live 
assist wordt gedeactiveerd (nonstop) wordt de mengtafel off-line geschakeld. 
 
Het schakelen van studios op een nonstopserver 
U moet daar het volgende voor doen. De PGM-uitgang van de mengtafel in iedere studio 
sluit u aan op één van de beschikbare inputs van de RME audiokaart. AerOn studio kan 
tot drie studio’s schakelen. Een uitgang van de RME audiokaart sluit u aan op de 
zendstraat. 
. 
Wanneer een studio wordt aangevraagd schakelt de nonstopserver die studio online. 
Wordt een studio vrijgegeven dan schakelt de nonstopserver zichzelf in en neemt die de 
uitzending over. 
 
Extern audio via D&R Axum 
Voor deze vorm van extern audio heeft u een D&R Axum of D&R Axite digitale mengtafel 
nodig. 
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27.3 Lokaal 

Hier vindt u instellingen die u voor elke PC in het netwerk afzonderlijk opgeeft. Deze 
instellingen zijn per PC uniek. 
 

27.3.1 Algemeen 
 

  
 

Algemeen 

Radio ID 

Bij configuraties met meerdere radiostations op één database geeft 
u de Radio ID op. Wanneer AerOn studio opstart zal die zich 
aanmelden op deze Radio ID. 

Studio Bij master/slave configuraties met meerdere OnAir PC’s geeft u per 
PC het studionummer op.  

0 = Nonstop server  

1 = Studio 1  
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2 = Studio 2  

3 = Studio 3 

AerOn studio 
full screen 

Met deze optie actief wordt de bovenste balk van de applicatie 
onzichtbaar gemaakt en gaat AerOn studio aan de onderzijde over 
de Windows taakbalk heen. Hierdoor krijgt u meer ruimte voor de 
weergave van de vensters in AerOn studio. 

Jingles full 
screen 

Deze optie kunt u gebruiken bij een configuratie met twee of meer 
beeldschermen. Als de Windows desktop is uitgebreid naar 
meerdere schermen, kunt u door dit te activeren Jingle players op 
het tweede of derde scherm zetten. 

Automonitor full 
screen 
 

Deze optie maakt het mogelijk de monitor op een tweede of derde 
scherm te zetten op dezelfde wijze als voor Jingle players. 

Playlist full 
screen 
 

Deze optie maakt het mogelijk de playlist op een tweede of derde 
scherm te zetten op dezelfde wijze als voor Jingle players. 

Interne web 
browser 

Het resultaat van de knop ‘Internet zoeken’ en de HTML-export van 
de playlist wordt getoond in een browservenster in AerOn studio in 
plaats van de webbrowser die in Windows geïnstalleerd is. 

  

ShuttlePro  

Actief Shuttle Pro inschakelen. 
 

Status De bedieningsconsole ShuttlePro sluit u aan op een vrije USB poort 
van de PC. U ziet hier de status van de ShuttlePro. Lees  hoofdstuk 
14.1 voor meer informatie over de ShuttlePro. 

Tipro 
toetsenbord 

 

Actief Tipro toetsenbord inschakelen. 
 

Status Voor Jingle players is een toetsenbord beschikbaar voor directe 
toegang tot de jingles. Eerst moet u het toetsenbord aansluiten op 
een vrije USB-aansluiting. Daarna moet u de drivers installeren. 
Lees hoofdstuk 13.2 voor meer informatie over het Tipro 
toetsenbord. 

 

D&R 
MambaNet  

Voor het gebruik van een D&R AXUM of een D&R AXITE mengtafel 
moet u eerst Npcap installeren. Npcap moet geinstalleerd worden 
in WinPcap compatible mode, dit kunt u aangeven in het npcap 
installatieprogramma. AerOn studio communiceert over Ethernet 
met de D&R AXUM of AXITE. Een IP-adres invullen is daarom 
overnodig. 
 

Actief Vink aan om MambaNet te activeren.  Herstart daarna AerOn 
studio. 
 

Status Dit info veld geeft de statis van MambaNet weer. 
 

Driver versie Versie van de mbn.dll voor de communicatie met de D&R AXUM of 
AXITE. 

https://nmap.org/npcap/


Handleiding AerOn Instellingen 

 we make radio happen 237 

Aeron UI adres Broadcast Partners heeft een speciale hardware-
bedieningsmodule voor de D&R AXUM mengtafel ontwikkeld.  U 
kunt hier zien of een module aanwezig is, en het adres selecteren 
van de module die u wilt gebruiken. Wanneer u meerdere D&R 
AXUM bedieningunits heeft, selecteert u het MambaNet Address 
van de module uit de juiste studio. Na instellen moet u AerOn studio 
herstarten om de module te koppelen. 
 

Axite adres De control buttons van een D&R AXITE kunt u gebruiken om de 
Jingle players te bedienen. Wanneer u meerdere D&R AXITE 
mengtafels heeft, selecteert u het MambaNet Address van de 
module uit de juiste studio. Na instellen moet u AerOn studio 
herstarten om de module te koppelen. 

 

Externe audio 
editor 
 
Gebruik 
 
 

Vanuit het menu Bewerken en diverse menus kan een externe 
editor worden gebruikt om audiobestanden in te bewerken. 

Sneltoets CTRL+ALT+E 

 
Hier stelt u in welke applicatie er gestart dient te worden. 
Instelmogelijkheden: 

- Volgens extensie bestandstype 
- Opgegeven audio editor 

 
U kunt bepalen de opgegeven audio editor wordt geopend, of dat 
de applicatie wordt gestart die in Windows is gekoppeld aan de 
bestandsextensie.  Een veel gebruikte audio editor is Audacity. 
https://www.audacityteam.org/ 

  

Audio editor Vul hier het volledige pad in naar het uit te voeren .exe bestand. 
 

Commando Afhankelijk van de gebruikte editor is er soms een commando 
nodig. De twee karakters %1 worden vervangen door de naam 
van het betreffende audiobestand bij het aanroepen van de 
externe audio editor. Meestal volstaat het commando “%1” 
(inclusief de dubbele aanhalingstekens). 
 

  

Voice track  
VST 

Hier kan een VST2 plugin worden ingesteld. De VST2 plugin kan 
na instellen geconfigureerd worden in Mix editor via de groen/rode 
knop in het voicetrack spoor. 

  
Voice track vMix 
Visual Radio 

De licentie-opties Visual Radio en Mix editor Xtra zijn vereist. 
 
In Mix editor Xtra kan iedere gebruiker de menu optie vMix 
voicetrack video activeren om een vMix video op te nemen. 
 
Onderstaande vMix voicetrack instellingen worden toegepast bij 
het opnieuw openen van Mix editor Xtra. 
 

Actief Verbinding met vMix Visual Radio inschakelen. 
 

Http host Hostname of IP-adres van de vMix PC. 
 

Http port vMix Web controller port. 
 

https://www.audacityteam.org/
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vMix recording 
map 

Hier moet u de map instellen waarin vMix zijn opgenomen video 
opslaat. 
 

vMix vt 
afspeelmap 
 

Hier moet u de map instellen waar vMix de voicetrack videos 
afspeelt. AerOn zal een door vMix opgenomen voicetrack video 
naar deze map kopieren en hernoemen naar de juiste voicetrack 
naam. 
  

vMix record start 
delay (ms) 

Met deze optie kan de video-opname in vMix later worden gestart. 
Instelbaar tot maximaal 2000 milliseconden. 
 

Video player / 
editor 

Hier kunt u een externe video speler instellen.  
Vul het volledige pad in naar het uit te voeren .exe bestand.  
Bijvoorbeeld  C:\Program Files\VideoLAN\VLC\vlc.exe. 
 
Via de menus in o.a. Playlist en Mix editor kan het worden 

aangeroepen. Sneltoets CTRL+ALT+M 

 
PostgreSQL 
 
Map met 
hulpprogramma’s 

 
Om een backup van de database te kunnen maken moet AerOn 
studio weten waar die de PostgreSQL tools kan vinden 
 
Het pad naar de “Bin”map van Postgres met daarin de Postgres 
tools om een backup van je database te kunnen maken. 
 
Bij een PostgreSQL versie 12 installatie is dit C:\Program 
Files\PostgreSQL\12\bin. 
 
Als u ook een database backup wil kunnen maken op een 
werkstation dan moet u ook daar de PostgreSQL tools installeren. 
Dit kan met behulp van het PostgreSQL-installatieprogramma 
waarin u kunt aangeven dat u enkel de command-line tools wil 
installeren. 
 

Pg_dump 
parameters 

Standaard staat deze als volgt ingevuld: 
-F c -O -T automation 

• -F c bepaald het compressed format van export 

• -O bepaald dat de owner gegevens niet worden 
ge-exporteerd.  

• -T automation zorgt er in dit geval voor dat de 
tabel automation uitgesloten wordt van export.  

 
Deze parameters kunnen op maat worden aangepast of 
uitgebreidt wanneer u dit nodig acht.  

Logs map Hier kunt u de map instellen waarin de logbestanden van de 
Automationlog en Aeron.el worden opgeslagen.   
 
De map die u hier instelt daarin wordt door AerOn automatisch een 
submap met de computernaam aangemaakt waarin de 
logbestanden geplaatst zullen worden. 
   
Voor gebruikers met meerdere systemen biedt dit de mogelijkheid 
om logbestanden in een centrale omgeving op te slaan. 

EMail  

SMTP start 
command 

Het SMTP start command wordt gebruikt bij document export met 
afdruksjablonen bij het direct per email verzenden. 
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SmartGPIO Met SmartGPIO kan diverse externe apparatuur, zoals 
mengtafels, MIDI  en Elegato Stream Deck, aan AerOn studio 
worden gekoppeld. 
 
De SmartGPIO applicatie koppelt meerdere protocollen van 
hardware apparatuur met Aeron Studio op basis van triggers. De 
ondersteunde protocollen zijn: Ember+, Axia (LWRP), D&R Airlite, 
Tipro keyboards en Midi-in. Daarbij wordt ook de Shuttle Pro 
ondersteund. De SmartGPIO is een client server applicatie. Vanop 
meerdere computers kan de configuratie worden aangemaakt en 
gewijzigd. 
 

Poort Hier stelt u de poort in waarop AerOn studio luistert. 
 

Actief Verbinding met SmartGPIO inschakelen. 
 

27.3.2 Audio 
Op dit tabblad geeft u de instellingen op voor in- en uitgangen van geluidskaarten. 
 

  
 

Output routering 
De instelling ‘Output routering’ hangt af van het aantal kanalen dat u tot uw beschikking 
heeft. AerOn studio ondersteunt maximaal 32 stereo kanalen. Voor elke functie geeft u 
op naar welk kanaal (apparaat) de audio gerouteerd dient te worden.  
  

Live A / Auto Het kanaal dat u hier aan toewijst wordt tijdens live-uitzendingen 
gebruikt voor de Live assist Cart-A speler. AerOn studio gebruikt 
deze uitgang eveneens tijdens de nonstop-uitzendingen. 
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Live B 
 

Het kanaal dat u hier aan toekent wordt gebruikt wordt tijdens live-
uitzendingen gebruikt voor de Live assist Cart-B speler. Afhankelijk 
van de automatiseringsinstellingen gebruikt AerOn studio deze 
uitgang eveneens tijdens de nonstop-uitzendingen. 

Commercials Als u dit kanaal toewijst, dan worden de commercials over dit 
kanaal afgespeeld. Als u hier niets invult, dan worden de 
commercials op reguliere wijze afgespeeld over de Live A en B 
kanalen. Deze optie is bedoeld voor editie systemen. 

Jingle A .. D De jingles die u afspeelt in een jingle player gaan naar het gekozen 
kanaal. 

VT 1 .. 4 De audio van Mix editor komt op het kanaal dat u hier kiest. Deze 
VT 1 t/m 4 corresponderen elk met een spoor in Mix Editor. De 
audio van dat spoor komt terecht op het kanaal dat u hier kiest. 
Normaliter zal u voor elk spoor hetzelfde kanaal instellen. Deze 
optie is bedoeld voor het opnemen van voicetracks middels 
faderregistratie via de Axum. Vult u één of meerdere van de VT-
kanalen niet in, dan maakt AerOn studio gebruik van de kanalen 
die bij PFL 1 .. 2 ingesteld staan. 
 

PFL 1 .. 2 De audio van Databank editor en Voorafluisteren komt op het 
kanaal dat u hier kiest. De audio wordt standaard over PFL 1 
afgespeeld. De audio wordt over het PFL 2 kanaal afgespeeld 
indien het PFL 1 kanaal in gebruik is in bijvoorbeeld Live assist bij 
een overeenkomstige apparaat instelling. 

 
 

Livewire labels 
Om de titel van een track zichtbaar te maken op een AXIA fader display kunt u het vinkje 
Livewire labels actief zetten.  
 
Als AerOn als output apparaat met de Livewire AXIA IP-Driver werkt kunt u de host 
instellen op localhost of het IP-adres van de Livewire LAN-adapter. Indien de audiokaart 
analoog of digitaal SPDIF/AES/ADAT is aangesloten, dan moet u bij host het IP-adres 
van de AXIA Console Engine of AXIA xNode invullen. 
 
Nadat u dit hebt ingesteld moet u de instellingen eenmalig sluiten en opnieuw openen 
om het te activeren. 
 
Als het actief is gezet kan per output bij het apparaat van Live assist, Jingle player of 
PFL player het juiste livewire kanaal nummer ingesteld worden. AerOn haalt automatisch 
de Livewire sources van het apparaat op zodat die bij Livewire kanaal geselecteerd 
kunnen worden. 
 
 

Input alias en gain 
Bij Input alias kunt u een duidelijke naam geven aan de opnamekanalen die u in AerOn 
studio tot uw beschikking heeft. Gain werkt enkel bij Digigramkaarten. Bij andere 
audiokaarten moet de gain worden ingesteld in het control panel van de geluidskaart. 

27.3.3 Audio logger 
Met Audio logger kunt u uw radio-uitzendingen automatisch laten opnemen. Voor meer 
informatie over Audio logger zelf kunt u terecht in hoofdstuk 15. Om Audio logger correct 
te laten functioneren, is het in de eerste plaats van belang dat instellingen goed worden 
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afgesteld. Daarom worden de verschillende instellingen hieronder nog eens in detail 
beschreven. 
 

  
 

Bewaar pad Hier geeft u de mappen op waar AerOn studio de opgenomen 
audiobestanden moet opslaan. Het is mogelijk om meerdere 
mappen op te geven, deze moet u dan scheiden met puntkomma’s. 
Met de knop rechts naast het invoerveld kunt u de mappen 
invoeren. 

Formaat Deze instelling gebruikt u om de kwaliteit van de opnames op te 
geven. Meestal kunt u die op ‘44100 Hz Stereo MP3 128 kbps’ laten 
staan, deze kwaliteit is toereikend voor het herbeluisteren van een 
uitzending. Hoe hoger de kwaliteit van de opname, hoe meer 
schijfruimte u nodig heeft. 
 

Audio ingang Op systemen met meer dan één opnamekanaal kunt u aangeven 
op welk kanaal u de audio aanbiedt. 

Bewaar termijn Hier geeft u op hoe lang de audiobestanden bewaard moeten 
blijven voordat AerOn studio ze mag verwijderen. De termijn kan 
variëren van 1 week tot 1 jaar. Net als bij de opnamekwaliteit geldt: 
hoe langer de bewaartermijn, hoe meer opslagcapaciteit u nodig 
heeft. 

 

Tijdslots Hier geeft u voor elke dag van de week en voor elk uur van de dag 
op of er wel of geen automatische logging van de audio moet 
plaatsvinden. 

Historie info AerOn studio kan geen opnames maken als er onvoldoende 
opslagcapaciteit aanwezig is of als er geen geldige bewaarmap is 
ingevuld. Met deze knop krijgt u een overzicht van de status. 
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FTP Upload Vink ‘Actief’ aan om Audiologger FTP upload te activeren en vul de 
nodige ftp gegevens in. Host, Gebruikersnaam, Wachtwoord en 
een map op ftp. 
 

27.3.4 D&R Airence 
AerOn studio heeft directe ondersteuning voor de D&R Airence mengtafels. Na het 
aansluiten van de D&R Airence op de PC wordt deze automatisch in AerOn studio 
herkend.  AerOn studio heeft voor start/stop bediening een continu contact nodig. 
 
De 4 USB-faderkanalen kunt u hier toewijzen voor het bedienen van Live assist en Jingle 
players met de corresponderende fader op uw D&R Airence.  
 

  
 
Met de 16 knoppen aan de rechterzijde bedient u een compleet pakket in Jingle players 
 
De overige 8 knoppen kunt u bij ‘User button’ zelf een functie geven. In de afbeelding 
hieronder ziet u een voorbeeld van een mogelijke configuratie. 
 

De routering van de D&R Airence USB audio kunt u instellen bij Instellingen → Lokaal 
→ Audio → Output routering. 
 

27.3.5 D&R Airlite / Webstation 
Voor het gebruik van de D&R Airlite of D&R Webstation moet in de map waarin Aeron 
geinstalleerd is het bestand ‘airlite.dll’ staan. Deze is benodigd voor de communicatie 
met de Airlite Contol applicatie. 
 
Voer de juiste host en port gegevens in om verbinding te maken. Meestal zal de Airlite 
of Webstation aan de eigen PC aangesloten zijn en voert u bij host ‘127.0.0.1’ in. De 
waarden die bij ‘Receive port’ en ‘Send port’ staan, zijn de standaard D&R Airlite 
waarden en hoeven meestal niet veranderd te worden. 
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D&R Airlite 
Receive port  =  Airlite custom port  = 19550 
Send port       =  Airlite listen port     = 19551 
 
D&R Webstation 
Receive port  =  Webstation custom port = 18152  
Send port       =  Webstation listen port    = 18153  
 
Bij Live AB en Jingle ABCD moet u de corresponderende nummers van de faderkanalen 
intoetsen. 
 

Tip!  AerOn studio heeft voor start/stop bediening een continu contact nodig. 
 

 
 
Met de 16 jingle-knoppen op de D&R Airlite start of stopt u de jingles in de Jingle player. 
 
De routering van de D&R Airlite / Webstation USB audio kunt u instellen bij 

Instellingen → Lokaal → Audio → Output routering. 
 
 

27.3.6 Studer 

 
 

In het tabblad ‘Studer’ configureert u de interface voor de Studer OnAir 3000 en 1500 
mengtafels. Deze interface maakt gebruik van het Ember-protocol. Na het instellen van 
de juiste host en port, zal bij de status zichtbaar zijn of de verbinding is geslaagd. 
 
Voor Live assist en Jingle players geeft u de inputs op de mengtafel aan, de namen van 
de inputs zijn zichtbaar zodra er een verbinding met de mengtafel is gemaakt. 
 
Standaard bedient u Live assist en Jingle players met de ‘ChannelOnAir’ startfunctie 
(knop ON). Het is ook mogelijk de TB-knop (vrij instelbare knop) te gebruiken, dan kiest 
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u ‘UserButton’ en ‘TA aan/Uit’. De TB-knop heeft een jokerfunctie die u in dat geval in de 
Studer configuratie moet instellen als userbutton. 
 
De OnAir 3000 mengtafel heeft de mogelijkheid om maximaal 20 zogenaamde ‘user 
buttons’ te definiëren. (maximaal 6 buttons bij model 1500) Deze buttons kunt u 
vervolgens koppelen met een aantal functies in AerOn studio, zoals het (de)activeren 
van Live assist. 
 

27.3.7 DHD 52SX 

 
In het tabblad ‘DHD 52SX’ configureert u de interface voor de DHD 52SX mengtafels. 
Na het instellen van de juiste host en port zal bij ‘Status’ zichtbaar zijn of de verbinding 
is geslaagd. 
 
Voor bediening van Live assist, Jingle players en Studio switch moeten hier de 
corresponderende faderkanaalnummers op de mengtafel ingevoerd worden. AerOn 
studio heeft voor start/stop bediening een continu contact nodig. 
 

27.3.8 GatesAir 
De configuratie voor de GatesAir Oasis mengtafel is gelijkaardig aan die van de 
mengtafels die hierboven bescchreven staan. De GatesAir Oasis heeft als optie wel 4 
ingebouwde USB-kanalen die u onder ‘Audio’ configureert. Daarnaast bedient u Live 
assist of Jingle players met de knoppen onder de faders van de betreffende module. 
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27.3.9 Ember plus 
 
Om Ember plus te configureren gaat u aan de slag met ‘Ember+ Viewer’. U navigeert 
door de boomstructuur naar de objecten die u heeft geconfigereerd voor GPIO bij de 
Ember plus GPIO Output Signals. U kopieert het volledige pad naar iedere GPIO state 
en plakt dat in AerOn studio op de corresponderende regel in de Ember plus instellingen.  
 
Voor start/stop heeft AerOn studio een continu contact nodig, d.w.z. dat de state continu 
‘True’ moet zijn als u een fader openzet (faderstart) en/of een kanaal activeert met ON 
(buttonstart) en met de fader dicht continu ‘False’. 
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Om verbinding te maken met de Ember Plus provider in uw apparatuur vult u in AerOn 
studio in de Ember plus instellingen het IP-adres en de port in.  
 
Nadat u gereed bent met het configureren van uw mengtafel en het instellen in AerOn 
studio kan het nodig zijn om de engine van uw mengtafel te rebooten voordat de 
communicatie met AerOn studio in zijn geheel werkt. 
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27.3.10 Axia xNode 
 
AerOn studio biedt ondersteuning om met een Axia xNode een Studio Switch te maken. 
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27.3.11 AXIA Livewire 
 

Bij AXIA Livewire worden GPIO commands in het protocol verzonden over netwerk.  
Om remotestarts voor Aeron Studio te configureren moet e.e.a. worden ingesteld in de 
AXIA IP-Audio driver.  De GPIO moet de channels toegewezen krijgen waarop Cart-A, 
Cart-B, enz… afspelen. Daarnaast moet er een .gpiovk bestand worden geladen met 
daarin het profiel voor remotestarts.  
 

 
 

 
 
 
Inhoud gpiovk profiel voor Aeron remote starts 
 
WINCLASS=Aeron 
DEV0.3 MSG=0x40D WPARAM=0x1107 LPARAM=-1 
DEV0.4 MSG=0x40D WPARAM=0x1106 LPARAM=-1 
DEV1.3 MSG=0x40D WPARAM=0x1207 LPARAM=-1 
DEV1.4 MSG=0x40D WPARAM=0x1206 LPARAM=-1 
DEV2.3 MSG=0x40D WPARAM=0x2107 LPARAM=-1 
DEV2.4 MSG=0x40D WPARAM=0x2108 LPARAM=-1 
DEV3.3 MSG=0x40D WPARAM=0x2207 LPARAM=-1 
DEV3.4 MSG=0x40D WPARAM=0x2208 LPARAM=-1 
DEV4.3 MSG=0x40D WPARAM=0x2307 LPARAM=-1 
DEV4.4 MSG=0x40D WPARAM=0x2308 LPARAM=-1 
DEV5.3 MSG=0x40D WPARAM=0x2407 LPARAM=-1 
DEV5.4 MSG=0x40D WPARAM=0x2408 LPARAM=-1 

27.3.12 D&R MambaNet  (AXUM / AXITE) 
 
Om AerOn studio te kunnen verbinden met D&R MambaNet en een D&R AXUM of 
AXITE mengtafel moet het volgende worden geinstalleerd: 
- Npcap. https://npcap.com (nodig voor MambaNet) 
- Mbn.dll. Deze dll moet geplaatst worden in de AerOn studio installatie-map. 
- WinPcap.  https://www.winpcap.org  (Werkt wel maar is verouderd/deprecated) 
Npcap moet geinstalleerd worden in WinPcap compatible mode, dit kunt u aangeven in 
het npcap installatieprogramma. 
 

https://npcap.com/
https://www.winpcap.org/
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AerOn studio maakt over Ethernet verbinding met MambaNet. In de D&R AXUM / AXITE 
moet het ethernet protocol geactiveerd zijn in de IP-config. Een ip-adres is voor 
communicatie over ethernet niet nodig. Het is voldoende dat de PC waarop AerOn studio 
draait in hetzelfde netwerk zit als de D&R AXUM of AXITE 
 
Zodra AerOn studio verbinding heeft gemaakt met de D&R AXUM of AXITE wordt de 

status weergegeven in Instellingen → Lokaal → Algemeen → D&R MambaNet 
 

 
 
Status OK geeft aan dat er communicatie is. Bij storing wordt hier een melding vanuit 
MambaNet weergegeven. 
 
De eerste keer dat AerOn studio verbinding heeft met de D&R AXUM / AXITE wordt er 
op basis van de AerOn studio licentie en de hardwareID een unieke node met uniek 
MambaNet Address aangemaakt. Per AerOn studio licentie die zich aanmeldt zal er in 
de D&R AXUM / AXITE een Aeron node aanwezig zijn. Per Aeron node kan de 
configuratie voor o.a. remotestarts worden ingesteld.  Daarnaast zijn er  voorzieningen 
voor Studio switch, Externe bronnen, Voice track, PFL en User login profielen. 
 
Tip! Als de hardwareID wijzigt zal er een nieuwe Aeron node worden aangemaakt. In de 
D&R AXUM / AXITE moet u dan een export van de oude node uitvoeren en vervolgens 
importeren in de nieuwe Aeron node. 
 

Bij Aeron UI adres kunt u het MambaNet Address instellen van een AerOn-
bedieningsmodule als die is geinstalleerd in het D&R AXUM bedieningspaneel. Met deze 
hardwaremodule kunt u diverse opties in AerOn studio bedienen. 
 
Bij Axite adres kunt u het MambaNet Address instellen van een D&R AXITE CRM. De 
control buttons van een D&R AXITE kunt u daarna gebruiken om de Jingle players te 
bedienen. Wanneer u meerdere D&R AXITE mengtafels heeft, selecteert u het 
MambaNet Address van de module uit de juiste studio. 
 

Na instellen van het Aeron UI adres of het Axite adres moet u AerOn studio herstarten 
om de module te koppelen. 
 
Als u in de D&R AXUM of AXITE modules voor een studio switch heeft geconfigureerd 
dan moet u deze modules instellen in de Aeron node bij Object 1033 t/m 1035. 
Afhankelijk van de configuratie van uw Aeron systemen kan deze studio switch 
geschakeld worden via Live assist activeren/de-activeren of Studio aanvragen/vrijgeven. 
 
AerOn node voorbeeld in de D&R AXUM / AXITE surface configuration 
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27.4 Gebruiker / Persoonlijk 

Elke gebruiker die zich aanmeld in AerOn studio heeft een aantal persoonlijke 
instellingen tot zijn/haar beschikking. 
 

  
 

Algemeen 
Einde 
afluisteren 

Met de voorafluisterknop in de werkbalk is het ook mogelijk het 
einde van de tracks te beluisteren. Hiermee geeft u aan hoeveel 
seconden u van het einde wilt horen. Gebruik het submenu in de 

voorafluisterknop of gebruik sneltoets CTRL+ALT+P. 

Afbeelding 
weergeven bij 
slepen 

Bij het slepen van items (bijvoorbeeld van Databank browser naar 
de playlist) zal AerOn studio de afbeelding of golfvorm weergeven. 
Indien dat niet gewenst is, kunt u dat uitzetten of enkel aanlaten als 
Mix editor geopend is. 

 

Voice tracks 
Duck level Hier stelt u in wat het maximale verschil is in audioniveau tussen 

de voicetrack en de tracks waarmee deze mixt. Het outro en het 
intro dat onder de voicetrack ligt wordt autromatisch geduckt tot 
maximaal de hier opgegeven waarde. 

Tracks met een luid outro of intro daarbij zal vaker het maximale 
duck level worden toegepast.  

Start level Mix editor doet stiltedetectie aan het begin van de voicetrack.  Hier 
geeft u de waarde op van het niveau waarmee de voicetrack aan 
het begin met de fadecurve wordt “Geknipt”. Alles wat lager is dan 
het hier ingestelde niveau wordt er aan het begin afgeknipt. 
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Start offset Naast de instelbare stiltedetectie heeft u de mogelijkheid om de 
voicetrack iets te verlengen aan het begin.  

Dit is bijvoorbeeld toepasbaar als er net een stukje van de G van 
“Goedemorgen” wegvalt. 

U geeft de offset in milliseconden op. 

End level Stiltedetectie aan het einde van de voicetrack. Hier geeft u de 
waarde op van het vanaf-niveau waarmee de voicetrack totaan het 
einde met de fadecurve wordt “Geknipt”. 

End offset Offset vanaf knip-einde van de voicetrack. U geeft de offset in 
milliseconden op. 

Auto gain Standaard staat deze optie aan.  

Mix editor past de gain van de voicetrack aan als offset t.ov. de 
Playout output reference. De gain wordt effectief toegepast tot een 
maximaal playout level van peak 0 dB. 

Extra gain Hiermee wordt extra gain toegepast tot een maximum van +15 dB. 

Position (mode 
1) 

De positie wordt toegepast bij het droog opnemen van voicetracks. 
Hier geeft u de voorkeur voor plaatsing op. 

Na outro:       begin van voicetrack = begin outro 

Begin track:  begin van voicetrack = begin intro  

Tegen intro:  einde van voicetrack = einde intro 
 

Bij positie ‘Na outro’ overlapt de voicetrack begin-outro totaan 

einde-intro, Bij positie ‘Begin track’ overlapt de voicetrack begin-
intro tot aan einde-intro. Neemt u langer op dan de intro-lengte dan 

gaat de voicetrack het outro overlappen. Bij positie ‘Tegen intro’ 
overlapt de voicetrack vanaf einde-intro tot aan begin-outro. Is de 
voicetrack langer dan outro + intro, dan schuiven de tracks uit 
elkaar. 
 

Duck snelheid Deze optie bepaalt de steilheid van de fadecurve bij het ducken. 
Hoe hoger deze waarde, hoe langer de fadeout-duur wordt. 
 

Slot open / dicht 
bij laden andere 
mix 

Deze optie bepaalt de reactie van het slot bij het bladeren in Mix 
editor. Instelbaar op Dicht en Automatisch. 
 
Als het slot wordt open gezet, dan  kan de track in het derde spoor 
los geschoven worden. De achterliggende tracks blijven dan op 
hun posities staan. 
 

Autozoom 
outrotrack  links  
 
Autozoom 
introtrack rechts 
 

Hier kunt u instellen hoe een mix wordt weergegeven tijdens het 
bladeren in Mix editor.  
 
Het aantal seconden van Autozoom outrotrack links en Autozoom 
introtrack rechts bij elkaar opgeteld bepaalt hoeveel seconden er 
van een mix wordt weergegeven in het Mix editor-venster, dit 
bepaalt de zoomfactor.   
 
Verhoogt u het aantal seconden bij Autozoom outrotrack links dan 
wordt er meer zichtbaar van de outtrotrack. Verhoogt u het aantal 
seconden bij Autozoom introtrack rechts dan wordt er meer 
zichtbaar van de opvolgende tracks. 
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Shuttle Pro 
achtergrondkleur 

Achtergrondkleur van Mix editor die wordt toegepast indien er een 
Shuttle Pro is aangesloten c.q. aanwezig is. 

  

Live assist 
Laad de 
volgende track 
in beide carts 

Bij inschakelen van deze optie wordt het volgende item in beide 
carts geladen als er in beide carts niets speelt. Het gemak voor de 
DJ / presentator is dan dat het niet uitmaakt welke fader hij 
openschuift om de volgende track te starten. 
 

Kort gespeelde 
track niet in 
ReCue, meteen 
de volgende 
inladen 

Met deze optie wordt een track bij het stoppen of het in pause 
zetten, ongeacht de speelduur, meteen uit de cart verdwijderd en 
wordt de volgende track uit de playlist inladen. 
 
Standaard staat deze optie uit en wordt een track die vanaf het 
laatste play command korter dan 1 minuut onair heeft gespeeld 
opnieuw in de Live cart gecued.  

  

Cross Fade Crossfade. Fade-out de spelende en Fade-in de volgende track. 
 

Autostart Vast 
of Semi-Vast en 
Live assist blijft 
actief 
 

Met deze optie wordt een Vaste of Semi-vaste track in Live assist 
automatisch gestart zodra de starttijd is bereikt, behalve als een 
studio automatisch wordt vrijgegeven. De voorgaande track wordt 
automatisch uitgefade als die glijdend is en Live assist blijft 
geactiveerd. Deze instelling overruled het automatisch 
uitschakelen van Live assist. 

 

Toon labels 
Semi-Vast 
margetijd 
 

Indicatoren van de Semi-vast-margetijd en de starttijd van 
Uitvullend of Semi-vast worden weergegeven onder de klokken. 
 
De Semi-vast-marge-tijd is het vroegste tijdstip waarop het 
eerstvolgende uitvullend blok of Semi-vast kan starten. Dit is de 
hele uurtijd minus de instelbare marge Semi-vast en indien 
aanwezig minus de lengte van het uitvullend blok. 
 
De starttijd van Semi-vast wordt opnieuw berekend bij het starten 
van een track en bij het slepen van tracks in het actieve 
playlistblok. Een uitvulblok schuift automatisch mee met semi-
vast. Het label fixed toont de actuele starttijd van het uitvullend 
blok of Semi-vast. 
 

Tip! Door het starten van een korte track na het overschrijden van 
de Semi-vast-margetijd kunt u een uitvulblok of Semi-vast eerder 
laten instarten. 
 
  

Einde track 
indicatie 

Als een track of een groep nog een x aantal seconden te spelen 
heeft gaat de titelbak in de actieve cart-player knipperen.  Einde 
track indicatie is instelbaar van 1 tot 30 seconden. 

  

Jingles 
Tipro 
achtergrond 
kleuren 

Indien er een Tipro jingle pad is aangesloten bepaald deze optie of 

het kleuren pallet in Jingle players wordt weergegeven.  
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Playlist 
Fadecurve 
herstellen bij 
droppen, 
verplaatsen en 
verwijderen 

Bij het droppen, verplaatsen of verwijderen van een track in de 
playlist, wordt de fadecurve hersteld volgens de standaard 
mixtijden van die track in de databank.  
 
Wanneer deze optie is uitgeschakeld wordt bij het droppen, 
verplaatsen of verwijderen van een track een aangepaste 
fadecurve ongewijzigd gelaten. Een met Mix editor aangepaste 
mix en fadecurve blijft dan behouden. 
 
Als u een voicetrack verwijdert dan wordt de mix altijd hersteld 
zodat duckings dan altijd ongedaan gemaakt worden. 
 

Open playlist-
wijzigen-venster 
bij dubbelklik 

Standaard staat deze optie aan. Bij dubbelklikken in de playlist 
opent zich het Playlist wijzigen-venster. 
 
 

Zoek bestand in 
audio remote 
indien niet 
aanwezig in 
audio lokaal 

Dit is enkel van toepassing bij het remote voicetracken. 
 
Als deze optie is aangevinkt dan doorzoekt AerOn ook de mappen 
die zijn ingesteld in Globaal → Audio remote 
 
AerOn studio doorzoekt altijd eerst de audio lokaal mappen. De 
mappen die zijn ingesteld in Globaal → Audio lokaal.  Is het 
bestand daar niet gevonden en deze optie staat aangevinkt, dan 
doorzoekt AerOn de audio remote mappen. 
 

Tip! Om remote audiobestanden en voicetrackbestanden te 
kunnen synchroniseren moet in menu Toegang de optie Remote 
audio mappen actief geactiveerd zijn. 
 

Geef een 
melding als een 
track al in de 
playlist staat. 
 

Als u een track in de playlist sleept krijgt u een melding als die track 
reeds in de playst van gisteren, vandaag of morgen staat. 

Verberg het stop 
icon bij 
doorstartgroepen 

Bij doorstartgroepen wordt geen stop icon getoond. 

 

File browser 
Zoek Bpm en 
Initial Key in 
ID3Tag tekst 
velden 
 

Zoekt bij het inladen van ID3tags de Bpm en Key waarden 
ook in de ID3tag aanwezige custom tekstvelden als de default 
waarden in de ID3tag niet zijn ingevuld. 

Mappen 
audiomatisch 
uitvouwen 

Mappen automatisch uitvouwen zodat de inhoud met 
submappen en bestanden meteen worden getoont bij het 
aanklikken van een map. 

  
Skin preset  
Globale skin 
preset inladen 
 

De globaal ingestelde skin preset en kleur instellingen inladen. Als 
u deze optie afvinkt wordt uw persoonlijke skin preset ingeladen. 



Handleiding AerOn Instellingen 

 we make radio happen 255 

Skin Hier kunt u de AerOn studio-skin wijzigen en een andere inladen. 

  
Achtergrond 
algemeen 

Achtergrondkleur van ondermeer Playlist en Databank 
browser. 
 

Actieve item Actieve item in Playlist en Live assist. 
Voice track 
(detail) 

Kleur van voicetracks in playlist bij detailweergave. 

Voice track 
(tegel) 

Kleur van voicetracks bij Playlist-tegelweergave. In 
tegelweergave is veelal een donkerder kleur voor voicetracks 
gewenst. 

Track uit 
Verkenner 
(detail) 

Kleur van een track gesleept uit Windows verkenner of File 
browser. Kleur-weergave bij een track die niet in Database 
editor of browser staat. Van toepassing bij Playlist in 
detailweergave. 

Track uit 
Verkenner 
(tegel) 

Kleur van een track gesleept uit Windows verkenner of File 
browser. Kleur-weergave van een track die niet in Database 
editor of browser staat. Van toepassing bij Playlist in 
tegelweergave. 

Golfvorm links Kleur van het linker audiokanaal in de golfvorm. (Boven) 
Golfvorm rechts Kleur van het rechter audiokanaal in de golfvorm. (Onder) 
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28 Afdruksjablonen 

Afdruksjablonen kunt u openen via het menu Tools → Afdruksjablonen. 

 
Op diverse plaatsen in AerOn studio hebt u de mogelijkheid om een afdruk (print) te 
maken. Hoe die afdruk er uitziet (opmaak, lettertype, kop- en voettekst) is vastgelegd in 
een afdruksjabloon. Voor elke afdruk is er een apart standaardsjabloon meegeleverd 
met AerOn studio. AerOn studio biedt daarnaast ook de mogelijkheid om de sjablonen 
naar eigen inzicht en voorkeur aan te passen. Zo kunt u bijvoorbeeld uw eigen logo en 
adresgegevens aan de sjablonen toevoegen of een ander lettertype instellen. Let er wel 
op, dat het wijzigen van de datavelden de sjablonen onbruikbaar kan maken. Maak 
daarom vooraf steeds een kopie van de originele bestanden. 
 

Om een afdruksjabloon te openen in de Designer gaat u via de menu’s naar Tools → 

Afdruksjablonen en kiest u één van de volgende sjablonen: 
 

Campaign.fr3 Commercialplanner: overzicht van alle geplande 
campagnes. 

CampaignOverview.fr3 Commercialplanner: overzicht van één geplande 
campagne. 

Customer.fr3 Commercialplanner: overzicht van alle klanten. 

Dayview.fr3 Commercialplanner: dagoverzicht. 

FormDay.fr3 Formatplanner: dagformat. 

FormHour.fr3 Formatplanner: uurformat. 

FormInfo.fr3 Formatplanner: infovenster. 

History.fr3 Historie. 

Playlist.fr3 Playlist. 

 
Als u het gewenste sjabloon (in voorbeeld: History.fr3) opent, krijgt u het volgende 
venster: 
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De rapporten worden opgebouwd middels een aantal banden. Dit zijn de rechthoekige, 
grijze vlakken in het voorbeeld. Op deze banden kunnen componenten geplaatst worden 
die dan afgedrukt worden. De rapportsjablonen maken gebruik van de volgende banden 
die elk een functie hebben. 
 

ReportTitle Deze band verschijnt op de eerste pagina van het rapport. 

PageHeader Deze band verschijnt bovenaan elke pagina. 

MasterData Deze band bevat de gegevens die afgedrukt gaan worden. 

Footer Deze band komt aan het einde van de gegevens en bevat 
bijvoorbeeld totalen. 

PageFooter Deze band verschijnt onderaan elke pagina. 

 

Op de banden zelf zijn diverse elementen met tags (bijvoorbeeld [REPORTTITLE]) 
geplaatst die bij het afdrukken worden ingevuld. De tags die aan de rechte haken 
herkenbaar zijn, mogen niet veranderd worden, lettertype en –grootte kunt u wel 
aanpassen. 
 
Aan de linkerzijde is de werkbalk ‘Objecten’ zichtbaar. 
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 Selecteer een object. Met de Object inspector (F11) zijn diverse 
instellingen van het object te wijzigen. 

 
Tekstvlak invoegen. Een tekstvlak plaatst u op één van de hier 
boven beschreven banden. Als tekst kunt u bijvoorbeeld naam, 
adres en telefoonnummer van de omroep invullen.  

 
Band invoegen. 

 
Afbeelding invoegen. U kunt bijvoorbeeld het logo van de omroep 

op de band ReportTitle laten afdrukken. 
 

De Designer biedt zeer geavanceerde mogelijkheden voor het ontwerpen van een 
sjabloon. De hier beschreven functies zijn de meest gebruikte. Voor specifieke vragen 
over het ontwerpen van sjablonen kunt u contact opnemen met Broadcast Partners. 
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29 Venster 

In het menu ‘Venster’ heeft u verschillende mogelijkheden om het aanzicht van AerOn 
studio aan te passen naar uw voorkeur. 
 
Bij afmelden in AerOn studio worden de venster postities, grootte en lettergrootte per 
gebruiker opgeslagen. Als u zich opnieuw aanmeld worden de vensters opnieuw geladen 
zoals u ze heeft achtergelaten bij de laatste keer afmelden.   
 
Met de functietoets F6 kunt u de vensters automatisch schikken. 

29.1 Venster voorkeuren (Databank browser Xtra) 

In AerOn studio kunt u diverse acties uitvoeren zoals: live programma maken, 
voicetracks opnemen, audio importeren, databank gegevens verwerken, formatplanning, 
commercialplanning. Iedere actie benodigt zijn eigen venster(s), met bijhorende 
vensterposities op het AerOn studio bureaublad.  
 
AerOn studio biedt diverse workflows waarbij u tracks en items kunt slepen van en naar 
de diverse vensters o.a. Playlist, Live assist, Jingle players, Item browser, Mix-editor, 
Acties, Databank export,  Formatplanner uurformat, Commercialplanner spots, 
Commercialplanner jingles, Synchronisatie audiobestanden.  
Voor elke workflow kan iedere gebruiker voor zichzelf een venster-preset maken. 
 
Venster presets maken en opslaan 
Als u de vensterposities en de lettergrootte (zie hoofdstuk 29.2) naar uw voorkeur heeft 
ingesteld, dan kunt u de posities van de geopende vensters bewaren in een venster 

preset via menu Venster → Voorkeuren → Opslaan. Iedere voorkeur-preset kunt u 
opslaan met een voor u herkenbare naam zoals Live, voicetrack, enz…  
 
Als u een aantal voorkeuren heeft ingegeven, kunt u de vensters snel opnieuw oproepen 

via menu Venster → Voorkeuren → Kies preset  zonder manueel ieder venster telkens 
opnieuw te hoeven openen en te verslepen naar de gewenste positie. Daarbij wordt van 
ieder venster ook de lettergrootte bijgehouden. Omdat iedere gebruiker zo zijn eigen 
voorkeuren heeft op het vlak van lettergrootte en vensterposities worden deze venster-
voorkeur-presets per gebruiker bijgehouden en opgeslagen. Als u ook de optie 

Integratie digitale mengtafel heeft, dan kunnen deze venster-voorkeur-presets bij een 
aantal mengtafels ook via de bediening op de mengtafel met de knoppen worden 
ingeladen. 
 
Desktop schermresolutie 
AerOn studio kan tegelijkertijd gestart en gebruikt worden op verschillende computers in 
een netwerk. Omdat een PC een afwijkende desktop schermresolutie kan hebben ten 
opzicht van een andere PC waar een gebruiker ook op inlogt, bijvoorbeeld als de ene 
PC meerdere monitoren heeft aangesloten. Juist daarom worden de venstervoorkeuren 
ook per schermresolutie bijgehouden en in een andere preset opgeslagen voor precies 
die schermresolutie. De vensterindeling voor bijvoorbeeld het voicetracken op een PC 
met 1 beeldscherm of op een PC met twee beeldschermen zal er uiteraard anders 
uitzien.  
 
Samengevat: de venster voorkeuren (presets) worden door AerOn studio per gebruiker 
per desktop schermresolutie bijgehouden en opgeslagen. Daarbij wordt ook bijgehouden 
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welke vensters geopend zijn, waar ze staan op het scherm en ook de lettergrootte van 
ieder venster. Met deze optie kan iedere gebruiker op elke werkplek specifiek zijn eigen 
venster presets maken en deze per werkplek opnieuw inladen. 

29.2 Lettergrootte 

Via het menu Venster en Letter grootte kunt u in de belangrijkste AerOn studio-
vensters, die de instelbare grootte van het gebruikte lettertype ondersteunen, de letter 
grootte wijzigen.  
De letter grootte wordt toegepast in het geactiveerde venster, het venster dat de focus 
heeft, en wordt ook per gebruiker bijgehouden en opgeslagen. Daarmee kan iedere 
gebruiker voor zichzelf een eigen compromis instellen tussen grote letters en de 
hoeveelheid scherminformatie. 
 

Tip! U kunt de letter grootte ook wijzigen met het muis-draaiwiel terwijl u de CTRL-toets 
ingedrukt houdt. 
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30 Installatie AerOn studio 

Het installeren en configureren van een AerOn studio-systeem vergt enige planning. In 
dit hoofdstuk beschrijven we waar u op moet letten en wat u moet doen voor een 
succesvolle installatie. 

30.1 AerOn NexusDB gebruikers 

AerOn NexusDB gebruikers hebben NexusDB 4 geïnstalleerd als database server. Na 
de installatie van AerOn studio voor het eerste gebruik, voert u een conversie van de 
databank uit. Dit staat later in dit hoofdstuk beschreven. 

30.2 Configuratie netwerk 

Voor het configureren van een AerOn studio-systeem onderscheiden we drie 
verschillende basis configuraties die we hierna aan de hand van een aantal tekeningen 
beschrijven. Naast deze basis configuraties zijn er diverse op maat gemaakte 
configuraties mogelijk o.a. in een master/slave multi-studiosysteem.  
 
Bij een bestaand systeem zult u uw eigen configuratie aan de hand van één van de 
beschrijvingen herkennen. Gaat u voor het eerst met AerOn studio aan de slag, dan zult 
u aan de hand van deze beschrijvingen een keuze maken over hoe u AerOn studio bij 
uw omroep moet configureren. 
 
Hoewel het eenvoudig is om van de ene naar de andere configuratie te gaan, is het aan 
te raden om de gewenste configuratie nauwkeurig te plannen. Dit voorkomt overbodige 
werkzaamheden achteraf. 
 
AerOn studio maakt gebruik van een zogeheten Client/Server database-architectuur. Dit 
houdt in dat op één PC een server applicatie van de PostgreSQL service voor de 
databanken draait waar alle AerOn studio OnAir- en Productiemachines een verbinding 
mee maken als client. 
 
De configuratie van de PostgreSQL database-server vergt minimale PC- en 
netwerkkennis en wordt later in dit hoofdstuk beschreven. 
 

30.2.1 Configuratie 1, stand-alone 
In deze configuratie heeft u één enkele PC (of laptop) waarmee u alles doet. Deze OnAir 
playout PC gebruikt u voor de uitzending, het plannen van playlist en commercials, het 
toevoegen van muziek, het opnemen van voicetracks, enzovoort. 
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In het installatieprogramma kiest u 
AerOn studio software, PostgreSQL database-server en InOutBox. 
 
PostgreSQL database-server 
Het installatieprogramma voor de PostgreSQL database-server kunt u downloaden via 
de downloadknop in het AerOn studio installatieprogramma. Voor het installeren van de 
PostgreSQL database server hebben we op aanvraag een PowerShell script 
beschikbaar. 

30.2.2 Configuratie 2, netwerk zonder stand-alone server 
 

 

 
De meeste omroepen opteren voor een configuratie waarin gebruik gemaakt wordt van 
twee of meer PC’s die in een netwerk met elkaar verbonden zijn. De centrale PC (OnAir) 
heeft een grote harddisk waarop de audiobestanden staan en tevens draait op deze 
machine de PostgreSQL database-server. De drie PC’s die als voorbeeld gegeven zijn 
in de afbeelding hierboven zijn als client met de databaseserver verbonden. 
 
Deze configuratie kiest u als u ‘slechts’ één (OnAir) PC hebt, maar van plan bent om in 
de nabije toekomst het systeem uit te breiden met één of meer productiestations of een 
of meer studio’s. Deze configuratie kiest u ook als u bijvoorbeeld thuis AerOn installeert 
en standalone wil gaan produceren en de playlists en audio gaat exporteren naar 
externe-schijf, usb-stick of cloud (bvb. Dropbox) om deze te kunnen importeren in de 
database van de studio. In dat geval heeft u ook lokaal een eigen database nodig. 
 
Bij het configureren van de OnAir PC raden wij aan om minimaal twee SSD harde 
schijven te gebruiken. Op de eerste schijf met een grootte van pakweg 256 GB installeert 
u het besturingssysteem en de database-server. Op de tweede grote schijf die gedeeld 
wordt in het netwerk (bijvoorbeeld schijfletter P:) installeert u de AerOn studio data en 
daarop zet u ook de audiobestanden. Eventueel kunt u nog een extra schijf installeren 
voor systeembeheer. 
 
In het installatieprogramma kiest u bij de installatie van 

OnAir playout: AerOn studio software, PostgreSQL database-server en  InOutBox 

Productie:   AerOn studio software 

Thuis:    AerOn studio software 
 
PostgreSQL database-server 
Het installatieprogramma voor de PostgreSQL database-server kunt u downloaden via 
de downloadknop in het AerOn studio installatieprogramma. Voor het installeren van de 
PostgreSQL database server hebben we op aanvraag een PowerShell script 
beschikbaar. 
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30.2.3 Configuratie 3, netwerk met stand-alone server 
 

 
 
Deze configuratie lijkt sterk op de voorgaande, maar wordt vooral gekozen door 
omroepen die de hoogst mogelijke betrouwbaarheid wensen. In deze configuratie is een 
extra PC aan het netwerk toegevoegd die enkel als server fungeert om op die manier de 
audiobestanden veiliger te kunnen opslaan. Meestal zal op deze PC een Windows 
Server OS  geïnstalleerd zijn. Een Windows 10 als “server” kan een beperkt aantal van 
20 verbindingen leggen. In de regel geldt: gebruikt u vijf of meer Windows clients 
tegelijkertijd, neem dan een Windows Server 2022 OS. 
 
Voor het configureren van de server in dit voorbeeld geldt dezelfde aanbeveling als bij 
de OnAir PC in de voorgaande configuratie. Op de eerste schijf installeert u de externe 
databaseserver. De tweede schijf gebruikt u voor de audiobestanden. 
 
In het installatieprogramma kiest u bij de installatie van 

Server:  PostgreSQL database-server en InOutBox 

OnAir playout: AerOn studio software 

Productie:  AerOn studio software 

Thuis:  AerOn studio software 
 
PostgreSQL database-server 
Het installatieprogramma voor de PostgreSQL database-server kunt u downloaden via 
de downloadknop in het AerOn studio installatieprogramma. Voor het installeren van de 
PostgreSQL database server hebben we op aanvraag een PowerShell script 
beschikbaar. 

30.3 Installatie AerOn studio 

Broadcast Partners stelt de AerOn studio software over het algemeen beschikbaar op 
de website of via ftp. Het programma Setup.exe installeert de software en alle benodigde 
extra componenten (behalve de drivers voor de audiokaart). Welke versie van het Setup 
programma u heeft, kunt u controleren door de versie-informatie op te vragen (in de 

Windows Explorer rechter muisknop op Setup.exe, optie Eigenschappen, tabblad 

Versie).  
 
Sluit de AerOn studio applicaties op alle PC’s af. Het installatieprogramma controleert of 
AerOn studio nog actief is in het geheugen. Verder moet de resolutie van het 
beeldscherm minimaal op 1280 bij 1024 punten ingesteld zijn en heeft u ‘administrator’ 
rechten nodig voor de installatie van de AerOn studio-software. 
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Als u dubbelklikt op Setup.exe kunt u 
kiezen voor installatie in het Nederlands 
of Engels. Met deze keuze bepaalt u 
tevens de taal van de software die 
geïnstalleerd wordt. Dat betekent: als u 
hier ‘English’ kiest, dan wordt de 
Engelstalige AerOn studio software 
geïnstalleerd! Mocht u echter later 
beslissen om de taal te wijzigen, dan is 
dat ‘on the fly’ mogelijk via het menu 

Tools → Taal instellen. Om de taalwijziging te activeren dient u alle vensters in AerOn 
studio vooraf te sluiten. 
 
Vervolgens wordt u via een aantal duidelijke schermen door de installatie geleid. 
 

 
 

Met de knop Volgende gaat u steeds naar het volgende venster, soms kunt u naar een 

vorig venster terug met de knop Vorige. 

30.3.1 Licentieovereenkomst 
De licentieovereenkomst moet u lezen en accepteren voordat u verder kunt gaan met de 
installatie. 
 

 
 

30.3.2 Informatie 
Dit venster toont belangrijke informatie, zoals ook release notes, die mogelijk (nog) niet 
in de handleiding is opgenomen en hier onder de aandacht gebracht moet worden. 
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30.3.3 Kies configuratie 
 

 
 
Eerder in dit hoofdstuk zijn de verschillende configuraties beschreven. Als u niet weet 
welke keuze u hier moet maken, kunt u het beste terugbladeren en de voorbeelden 
bekijken. 
 
AerOn studio software 
Het installatieprogramma kopieert en installeert alle programma’s en bestanden die 
nodig zijn voor AerOn studio. 
 
InOutBox 
Dit hulpprogramma gebruikt u voor het kopiëren van nieuws en andere items die u 
regelmatig ververst. 
 
Afhankelijk van de hier gekozen optie en andere omstandigheden zal een aantal van de 
volgende schermen verschijnen. 
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30.3.4 Kies de doelmap 
 

 
 

De standaardmap is C:\Program Files (x86)\Broadcast Partners\AerOnPostgres 
zoals te zien is in het schermvoorbeeld. 
 

30.3.5 Kies de datamap 
De datamap is een map waarin zich een aantal gemeenschappelijke bestanden bevindt, 
dat wil zeggen: export bestanden die bereikbaar moeten zijn voor alle OnAir PC’s in het 
netwerk. Op de OnAir PC of de server PC adviseren wij u een netwerkshare P: te maken 
en de map ‘P:\AerOn studio Data’ te gebruiken voor de data. Voor Productie PC’s kan 
een gemeenschappelijke datamap ook handig zijn omdat u dan niet per PC de 
audiomappen hoeft in te stellen. 
 
Als u de software op een standalone PC of laptop installeert, kunt u de map in het 
getoonde voorbeeld behouden. 
 
Mocht een netwerklocatie niet toegangkelijk zijn voor de installer dan is de oplossing 
mogelijk te vinden op onderstaande webpagina. 
 
Some Programs Cannot Access Network Locations When UAC Is Enabled. 
https://technet.microsoft.com/en-us/library/ee844140(v=ws.10).aspx 
 
 

https://technet.microsoft.com/en-us/library/ee844140(v=ws.10).aspx
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In het venster hierboven is C:\Aeron Data als data map gebruikt. Deze is naar wens te 
kiezen door op Bladeren te klikken.  

30.3.6 Download de PostgreSQL instalatie  
 

 
 
PostgreSQL moet geinstalleerd worden op de server of op de OnAir playout machine. 
Ook wanneer u een database backup wilt maken is een geinstalleerde versie van 
PostgreSQL vereist omdat de PostgreSQL tools daarvoor nodig zijn. 
 
Gebruikers die thuis AerOn studio gebruiken om bijv. remote te voicetracken hoeven 
PostgreSQL niet te installeren, deze gebruikers verbinden AerOn studio via VPN met de 
PostgreSQL server in het studio-netwerk. 
 
Wanneer u klikt op de button Open PostgreSQL downloadpagina dan opent zich de 
website waar u de recentste versies van PostgreSQL kunt downloaden.  
AerOn ondersteunt momenteel PostgreSQL versie 13 tot 16. 
 
PostgreSQL versie 13 is supported vanaf AerOn studio 1.14.9.13 
PostgreSQL versie 14 is supported vanaf AerOn studio 1.15.10.28 
PostgreSQL versie 15 is supported vanaf AerOn studio 1.16.3.17 
PostgreSQL versie 16 is supported vanaf AerOn studio 1.16.11.14 
 



2025-05 Handleiding AerOn 

268 Broadcast Partners 

Momenteel is PostgeSQL 17 de hoogste major release versie. Wij adviseren om de 
laatste minor build te installeren van de PostgreSQL versie die op uw systeem draait. 
Op moment van schrijven zijn PostgreSQL 13.20, 14.17, 15.12 en 16.8 de jongste minor 
builds. 
 
PostgreSQL community versies kunt u downloaden van de website 
https://www.enterprisedb.com/downloads/postgres-postgresql-downloads. 
 
De PostgreSQL release notes van alle versies kunt u vinden via onderstaande link. 
https://www.postgresql.org/docs/release 
 
Om de installatie en configuratie van PostgreSQL eenvoudiger te maken hebben wij een 
PowerShell script beschikbaar. Neemt u daarvoor contact op met onze support afdeling, 
u kunt dit ook doen door een mail te sturen naar support@broadcastpartners.nl. 
 

30.3.7 Het voorbereiden van de installatie is gereed 

Het setup programma heeft alle benodigde informatie verzameld. Druk op Volgende om 
naar het laatste venster voor de installatie te gaan. U kunt hier nog terug gaan om de 
ingevoerde gegevens te controleren. 
 

 
 

Als alles goed is ingevoerd, drukt u op Volgende en begint de installatie van de software. 
Deze installatie neemt enige tijd in beslag. Wacht tot het volgende venster verschijnt. 
 

 

https://www.enterprisedb.com/downloads/postgres-postgresql-downloads
https://www.postgresql.org/docs/release
mailto:support@broadcastpartners.nl
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Druk op Voltooien om het programma af te sluiten.  

30.3.8 PostgreSQL installeren  
Wanneer u in de vorige stap PostgreSQL hebt gedownload moet deze geinstalleerd 
worden op de server machine. Open het PostgreSQL installatiebestand wat u bij de 
vorige stap hebt gedownload.  
 
Standaard gebruikte waarden voor installatie AerOn studio  
 
Installatie map: C:\Program Files\PostgreSQL\16 
Data map:   C:\Aeron Database\PostgreSQL\16\Database 
Back-up map:  C:\Aeron Database\PostgreSQL\16\Backup 
Hostname:   127.0.0.1 
Poort:   5416 (zie note) 
Database naam:  aeron_prod_db 
Gebruiker:   aeron_dba 
Wachtwoord:  aeron_dba 
 
Note!: De default Postgres port is 5432. Pas de laaste twee cijfers van de default poort 
aan naar de postgres versie. Bij PostgreSQL 16 hanteren wij poort 5416. Zo kunnen 
meerdere postgres versies herkenbaar naast elkaar draaien en kunt u eenvoudig de 
database migreren. 
 

Installatie postgres database server  
 
PostgreSQL werkt enkel op een 64-bit OS.  
 
De setup van PostgreSQL kunt u downloaden via  
https://www.enterprisedb.com/downloads/postgres-postgresql-downloads. 
 
 
De diverse PostgreSQL documentatie kunt u voor iedere versie vinden via deze links. 
https://www.postgresql.org/docs/ 
 
https://www.postgresql.org/docs/14/index.html 
https://www.postgresql.org/docs/15/index.html 
 
 

Tip! Het updaten naar een hogere minor PostgreSQL versie, bijvoorbeeld 16.6 updaten 
naar 16.8 is eenvoudig te doen door enkel de installer uit te voeren. U moet wel vooraf 
overal AerOn studio afsluiten. Maak voorafgaand altijd een backup van uw database. 
 
Start de PostgreSQL installer. 
 

https://www.enterprisedb.com/downloads/postgres-postgresql-downloads
https://www.postgresql.org/docs/
https://www.postgresql.org/docs/14/index.html
https://www.postgresql.org/docs/15/index.html
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Klik op Next om naar het volgende venster te gaan. 
 

 
 
Indien PostgreSQL wordt geupdate en eerder is geinstalleerd wordt het bovenstaande 
venster getoond. De instellingen van de eerdere installatie worden automatisch 
overgenomen. Een aantal van de vensters verderop in dit hoofdstuk worden bij een 
minor versie update niet getoond. 
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Geef de locatie op waar postgres geïnstalleerd mag worden. De standaard locatie is 
C:\Program Files\PostgreSQL\16. Iedere major versie heeft een eigen map zodat 
meerdere versies naast elkaar kunnen draaien. 
 
 

 
 
Kies de componenten die u wilt installeren.  
Belangrijk: PostgreSQL Server en Command Line Tools zijn essentieel om AerOn te 
laten werken. Met pgAdmin 4 kunt u de PostgreSQL database beheren. Deze is ook los 
te downloaden via de site van PostgreSQL. Stack Builder is een component waarmee je 
optionele plugins en modules kunt intergreren in PostgreSQL.  
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Standaard locatie voor het PostgreSQL database cluster is C:\Program 
Files\PostgreSQL\16\data.  Het is belangrijk om het database cluster op een 
afgeschermde locatie te plaatsen zodat gebruikers er vanaf netwerk niet bij kunnen. 
Voor AerOn studio plaatsen wij het PostgreSQL database cluster in C:\Aeron 
Database\PostgreSQL\16\Database. 
 
 

 
 
Vul een wachtwoord in voor de super user postgres (administrator). Standaard gebruiken 
we het password “postgres”. 
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Vul een wachtwoord in voor het postgres service account. Standaard gebruiken we 
“postgres”. 
 

 
 
Vul een poort in. De standaard poort voor postgres is 5432. Voor de laatste twee cijfers 
gebruiken wij het versie nummer. Bij PostgreSQL 14 hanteren wij poort 5414.  
 
Tip! Om Postgres vanaf netwerk te kunnen benaderen kan het nodig zijn om in Windows 
een inbound firewall rule in te stellen. Check ook de configuratie van pg_hba.conf. 
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De Locale kunt u op [Default locale] laten. De installer neemt dan de locale over van 
Windows. 
 
 

 
 
Het overzicht van instellingen die gebruikt gaan worden voor de installatie. 
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Druk op Next om de installatie te starten 
 

 
 
Postgres wordt nu geïnstalleerd.. Nadat de installatie is geslaagd wordt de Stack builder 
optie getoond. Standaard installeren we geen extra plugins. 
 



2025-05 Handleiding AerOn 

276 Broadcast Partners 

30.3.9 PostgreSQL configuratie  pg_hba.conf 
Het pg_hba.conf bestand wordt door PostgreSQL gebruikt om beveiliging toe te passen 
en IP-adressen/werkmachines toe te staan gebruik te maken van de PostgreSQL 
database/server.  
 

Host all   postgres  127.0.0.1/32  md5 
 
Wil je gebruikers vanaf het netwerk toegang verlenen tot het PostgreSQL cluster dan 
voeg je regels toe volgens het onderstaande formaat. 

 
Host all   aeron_dba  0.0.0.0/0  md5 
Host aeron_prod_db aeron_vt_user  0.0.0.0/0  md5 
 
Host = Staat voor een client verbinding over TCP/IP. 
All = De gebruiker mag verbinden met alle databases aanwezig op de server. 
aeron_prod_db = De gebruiker mag enkel met deze database verbinden. 
aeron_dba,  aeron_vt_user  = Gebruikersnaam die mag verbinden. 

IP-Adres 127.0.0.1/32 staat voor dat de gebruiker enkel via localhost mag verbinden. 
IP-Adres 0.0.0.0/0  = de gebruiker mag via ieder ip-adres verbinden. 
IP-Adres 192.168.10.120/24  = de gebruiker mag via subnet 192.168.10.0 verbinden. 
 
MD5 = Verbinden met een md5 versleuteld wachtwoord. 
 
Gedetailleerde informatie is te vinden op de PostgreSQL website 
https://www.postgresql.org/docs/14/static/auth-pg-hba-conf.html 
 

Tip!  Voor het installeren van AerOn en PostgreSQL hebben we een PowerShell script 
beschikbaar. Mocht u een maatwerk oplossing zoeken m.b.t. deze configuratie, 
benaderd dan onze support afdeling. 

30.3.10 PostgreSQL configuratie postgresql.conf 
Het postgresql.conf bestand wordt door PostgreSQL gebruikt om de waarden van de 
diverse instellingen te laden. Een aantal instellingen benoemen we hieronder. 
 
Verbindingen 
max_connections = 100 
Deze instelling bepaalt het totaal aantal verbindingen die de PostgreSQL server toestaat. 
Iedere AerOn studio client legt ± 30 verbindingen met de database zodat meerdere data 
parallel verwerkt kan. Verhoog indien nodig max_connections als u merkt dat clients niet 
kunnen verbinden. PostgreSQL geeft een exception melding om u daarop te attenderen. 
 

Geheugen parameters 
shared_buffers = 512MB.  Voor Windows systemen is 512MB in de meeste gevallen de 
beste waarde.  Zet deze waarde max op 25% van het beschikbare geheugen. 
 

work_mem = 8MB 
Zet deze waarde max op (20% van het beschikbare geheugen / max_connections). 
 
maintenance_work_mem = 128MB 
Zet deze waarde max op 5% van het beschikbare geheugen en niet hoger dan 1GB. 
 
temp_buffers = 80MB 
 
effective_cache_size = 2GB 
Zet deze waarde max op 50% van het beschikbare geheugen. 

https://www.postgresql.org/docs/14/static/auth-pg-hba-conf.html
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Worker parameters 
max_worker_processes = 8     
Zet deze waarde max op 2x het aantal beschikbare CPU cores.  
Op een VM is de max het aantal beschikbare CPU cores. 
 

max_parallel_workers_per_gather = 0 
Deze parameter is specifiek voor zeer grote databases met miljoenen records. Voor 
AerOn studio zet u deze waarde het beste op 0.  
 

max_parallel_workers = 4 
Zet deze waarde max op het aantal beschikbare CPU cores. 
 

random_page_cost = 1.1  (bij SSD)  4 (bij HDD) 
Zet deze waarde op 1.1 indien het PostgreSQL database cluster op een SSD draait. 
Zet op 4 als het database cluster op een HDD draait. 
 
Vacuum & Analyze 
autovacuum_vacuum_threshold = 40 
autovacuum_vacuum_scale_factor = 0.01 
autovacuum_analyze_threshold = 40 
autovacuum_analyze_scale_factor = 0.01 
autovacuum_vacuum_insert_threshold = 500 
autovacuum_vacuum_insert_scale_factor = 0.01 
Het autovacuum analyze mechanisme doet automatisch database onderhoud en 
analytics t.b.v. de query planner voor het behoud van performance. 
 
Gedetailleerde informatie is te vinden op de PostgreSQL website. 
https://www.postgresql.org/docs/16/runtime-config.html 
 

Tip!  Voor het installeren van AerOn en PostgreSQL hebben we een PowerShell script 
beschikbaar. Mocht u een maatwerk oplossing zoeken m.b.t. deze configuratie, 
benaderd dan onze support afdeling. 

30.3.11 PostgreSQL configuratie database 
 
Een database aanmaken en configureren kan in PostgreSQL via de tool pgAdmin. In dit 
voorbeeld gebruiken we pgAdmin4. PgAdmin wordt standaard mee geinstalleerd met 
PostgreSQL. Met de Query tool in pgAdmin kunt u SQL commands uitvoeren. 
 
Wanneer je pgAdmin opent start er een webrowser. De pgAdmin tool is een webbased 
tool.  
 
Via de browser aan de linkerkant kun je bladeren naar je de database. Wanneer je voor 
het eerst met de server wil connecten wordt het root wachtwoord van de PostgreSQL 
server gevraagd. Standaard is dit wachtwoord postgres.  
 

Wanneer je verbonden bent kun je al je databases en 
statistieken van de database server inzien.  
 
Via rechtermuisknop bij databases kun je een nieuwe 
database aanmaken in PostgreSQL.  

https://www.postgresql.org/docs/16/runtime-config.html
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Eerst moeten we een 
gebruiker aanmaken 
die de owner van de 
database wordt. 
 
Klik op Create → 
Login/Group role om een nieuwe gebruiker aan te maken. 
 

  
 
Vul gebruiker in “aeron_dba”. 

 
 
Vul wachtwoord in “aeron_dba” 
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Gebruiker aanmaken via SQL 
 
CREATE USER aeron_dba WITH 
  LOGIN 
  NOSUPERUSER 
  INHERIT 
  NOCREATEDB 
  NOCREATEROLE 
  NOREPLICATION 
  PASSWORD 'xxxxxx'; 
 
Een database aanmaken in PostgreSQL gaat als volgt. Je klikt op Create → Database.  
 

 
 
Database 
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De naam gewenste naam van de database. 
 
Owner  
De eigenaar van de database, wanneer je de AerOn studio database installatie 
procedure gebruikt kies je bij owner aeron_dba 
 
Comment 
Hier heb je de mogelijkheid om commentaar toe te voegen.  
 
Databasse aanmaken via SQL 
 
CREATE DATABASE aeron_live_db 
    WITH  
    OWNER = aeron_dba 
    ENCODING = 'UTF8' 
    CONNECTION LIMIT = -1; 
 
Wanneer deze informatie is ingevuld kun je op Save klikken. De database wordt nu 
aangemaakt en zal verschijnen in de database lijst.  Vervolgens kunt u nog een schema 
‘aeron’ aanmaken, maar dat is niet perse nodig. Als u de installatie uitvoert middels het 
PowerShell script, dan wordt het schema ‘aeron’ aangemaakt. 
 
SQL om een schema ‘aeron’ aan te maken. 
CREATE SCHEMA aeron AUTHORIZATION aeron_dba; 
ALTER DATABASE aeron_prod_db SET search_path = "$user", aeron, public; 
REVOKE CONNECT ON DATABASE aeron_prod_db FROM public; 
 
Wanneer de database is aangemaakt hebben we ook een gebruiker nodig waarmee 
externe voicetrackes op de database mogen inloggen. Deze gaan we nu aanmaken. De 
gebruikers vindt je onder Login Role.  
 
Klik op Create → 
Login/Group role om 
een nieuwe gebruiken 
aan te maken voor de 
PostgreSQL database.  
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We kunnen nu overige gebruikers aanmaken.  
 

 
 
Name 
Gewenste gebruikersnaam 
 
 
Comments 
Commentaar wat eventueel toegevoegd kan worden.  
 
Wanneer deze infromatie is ingevuld gaan we naar het tablad Definition.  
 
 

 
 
Password 
Het gewenste wachtwoord 
voor de gebruiker “aeron_vt” 
 
Account expires 
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Daarmee kun je het account 
Laten vervallen automatisch 
 
Wanneer deze informatie is ingevuld gaan we naar het tabblad Privileges  
 

 
In dit tablad is het belangrijk dat Can Login op Yes staat. Anders kan de gebruiker 
namelijk niet inloggen.  
 
 Wanneer deze stap is gelukt kunnen 
We de gebruiker aanmaken door op Save te klikken.  
 
Gebruiker aanmaken via SQL 
 
CREATE USER aeron_vt_user WITH 
 LOGIN 
 NOSUPERUSER 
 NOCREATEDB 
 NOCREATEROLE 
 INHERIT 
 NOREPLICATION 
 CONNECTION LIMIT -1 
 PASSWORD 'xxxxxx'; 
 
 
De gebruiker moet vervolgens de nodige rechten krijgen om de database te mogen 
bewerken. Dat doen we middels onderstaand SQL. Het SQL moet worden uitgevoerd na 
de eerste start van Aeron zodat de database tabellen aanwezig zijn.   
 
GRANT USAGE ON SCHEMA aeron TO aeron_vt_user; 
GRANT ALL ON ALL TABLES IN SCHEMA aeron TO aeron_vt_user; 
 
Is er geen schema ‘aeron’ aangemaakt, dan deze SQL uitvoeren voor het standaard 
schema public: 
GRANT USAGE ON SCHEMA public TO aeron_vt_user; 
GRANT ALL ON ALL TABLES IN SCHEMA public TO aeron_vt_user; 
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30.4 AerOn NexusDB gebruikers 

 
Gebruikers die migreren van AerOn NexusDB naar AerOn Postgres moeten hun 
database converteren.  
 

Het benodigde conversieprogramma kunt u openen via de menu’s van Windows: Start  
→ Programma’s (bij Windows 10: Alle apps) → Broadcast Partners → AerOn studio 

→ Aeron database conversie. Start het programma. 
 

Druk op de linker knop ‘Change’ om de NexusDB database of een map met .nx1 

bestanden te selecteren. Druk op de rechter knop ‘Change’ om de gegevens van de 
PostgreSQL database server in te vullen. 
 

Als alle gegevens juist zijn ingevuld, druk dan op ‘Start’. 
 

 
 

 

30.5 PC-Radio, Carmen, Mouse Music, Airwave en Dalet 
gebruikers 

Er is een databankconversie nodig als u de overstap maakt van PC-Radio 6, Carmen, 
Mouse Music, Airwave of Dalet naar AerOn studio. Deze gebruikers kunnen hun 
databank omzetten naar NexusDB. Deze conversie is een eenmalige actie. 
 

Op de AerOn studio OnAir PC vindt u via de menu’s van Windows: Start  → 

Programma’s (bij Windows 10: Alle apps) → Broadcast Partners → AerOn studio → 

Overige databases conversie. Start het programma. 
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PostgreSQL 
Zodra deze conversie van uw datababase naar NexusDB is voltooid kunt u de NexusDB 
database converteren naar een PostgreSQL database met het conversieprogramma in 
hoofdstuk 30.4. 
 
NexusDB 
Hier vullen we in, waar de databanken van uw oude systeem naar toe geconverteerd 

gaan worden. Met de knop Wijzigen kunt u een lege map (Interne server) of een IP-
server en database (Externe server) opgeven. PC-Radio 5/6 gebruikers stellen hier de 
te converteren databank in. 
  
PC-Radio 5 / 6 
Gebruikers van PC-Radio 5 en PC-Radio 6 moeten onder NexusDB een map met de 
.nx1 bestanden of hun NexusDB database instellen. 
 
Carmen 1.2 

Bij Bronlocatie vult u de map in waarin zich de Carmen databases digital.mdb en  
jingles.mdb bevinden. Het conversieprogramma gaat zelf actief op zoek naar deze 
bestanden en probeert de map alvast voor u in te vullen. In de situatie van Carmen op 
SQL Server dient u zelf de connectiegevevens in te vullen om verbindig te kunnen maken 
met de Carmen database.  
 
Bij de conversie van Carmen 1.2 naar AerOn studio is het handig om eerst AerOn studio 
te starten, voordat u de conversie uitvoert. Bij de criteria in de instellingen kunt u namelijk 
de genres uit Carmen invullen. Het programma zal genres  vervolgens converteren naar 
de juiste criteria in AerOn studio. 
 
Carmen 1.3 SQL server 

Bij SQL Server vult u in de naam van de SQL server. Daarnaast moeten ook Port, 
Database, Username en Password worden ingevuld. 
 
De criteria van Carmen 1.3 worden automatisch in de 5 criteria kolommen in AerOn 
studio gezet. En daarnaast worden alle criteria ook als categorie in Item browser gezet. 
 
Mouse Music 

Bij Bronlocatie vult u de map in waarin zich de Mouse Music database Mmusic.mdb 
bevindt. 
 

Bij de conversie van Mouse Music naar AerOn studio worden de instellingen voor Taal 
overgenomen, Doelgroep overgezet naar Extra3 en Geografische oorsprong naar 
Extra5. 
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Airwave 

Bij Bronlocatie vult u de map in waarin zich de mdb-database van Airwave bevindt. 
 
Dalet 
Plaats het conversieprogramma op de PC waar de dalet database wordt geserved. 
Configureer onder NexusDB een map. Daarna volstaat een druk op de ‘Start’-knop om 
de databank te converteren. 
 

Als alle gegevens juist zijn ingevuld, druk dan op ‘Start’.  Indien u afwijkende criteria 
heeft die nog niet in het conversieprogramma zijn verwerkt of een andere database, 
neem dan contact op met support@broadcastpartners.nl. 

30.6 Eerste start AerOn 

 

30.6.1 PostgreSQL Database verbinding 
 
Zodra AerOn studio de eerste keer gestart wordt en er dus nog niet is opgegeven met 
welke database u een verbinding wilt maken, verschijnt het volgende venster: 
 

 
 
Om AerOn studio te kunnen starten is een verbinding met een PostgreSQL database 
nodig. Via dit venster kunnen we AerOn studio verbinden met een PostgresSQL 
database.  

 

Server Het IP-adres van de machine waar de PostgreSQL server op 
draait. Gebruik hier bij voorkeur niet de computernaam of localhost.  

Poort De poort waarop de server draait, meestal is dit 54XX waarbij XX 
het versienummer van PostgreSQL is.  

Database Hier vult u de naam van de database in waarmee u wilt verbinden. 

Gebruikersnaam De gebruikersnaam waarmee je wilt inloggen op de database. 
Deze gebruikseraccount moet rechten op deze database.  

Wachtwoord Het wachtwoord wat bij deze gebruikersnaam hoort om in te loggen 
op de database server. Via het vinkje aan de rechterkant van het 
wachtwoord vak kun je het wachtwoord zichtbaar maken.  
 

Testknop Via de testknop kun je de verbinding met de PostgreSQL server 
testen.  

 
  Wanneer u het PowerShell script gebruikt  

Als u gebruikt maakt van het PowerShell script om AerOn studio met de PostgreSQL 
server te installeren zijn dit de standaard inloggegevens voor de database. 

mailto:support@broadcastpartners.nl
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Database naam aeron_prod_db 

Gebruikersnaam aeron_dba  

Wachtwoord aeron_dba 

 

30.6.2 Wizard 
Nadat u de database verbinding geselecteerd heeft, verschijnt de onderstaande Wizard 
die op zoek gaat naar audiobestanden die op de PC of het netwerk aanwezig zijn. 
 
Deze wizard verschijnt alleen als u een nieuwe installatie van AerOn studio gedaan hebt. 
 

 
 
De lokale vaste schijven zijn aangevinkt. De netwerkstations kun u zelf aanvinken als u 
weet dat gewenste audiobestanden zich hierop bevinden. Hoe meer stations u aanvinkt, 
hoe langer de wizard bezig is. Verwisselbare media moet u, om problemen te vermijden, 
niet aanvinken. Het ligt immers voor de hand dat de audiobestanden die daar op staan 
niet altijd beschikbaar zullen zijn. 
 

Druk op de knop Volgende om de wizard te laten zoeken naar audiobestanden op de 
gewenste stations. Het zoeken naar audiobestanden kan enkele minuten duren. U kunt 

deze actie steeds annuleren door op de knop Stop te drukken. 
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In dit venster toont de wizard de mappen waarin audiobestanden gevonden zijn en het 
aantal. AerOn studio staat u toe om maximaal 99 audiomappen op te geven. Indien er 
meer dan 99 mappen zijn met audiobestanden, zal de wizard de mappen met de minste 
audiobestanden uitvinken. Deze worden dan niet in de standaard zoekpaden van AerOn 
studio opgenomen. Zelf kunt u natuurlijk wijzigingen aanbrengen in de selectie van 
gewenste zoekpaden. Onderliggende mappen worden automatisch ingelezen.  
 

Als u op Volgende drukt worden de gevonden audiobestanden in de databank 
opgenomen. Van audiobestanden met tags (bijvoorbeeld mp3 ID3v2) worden titel en 
artiest overgenomen in de databank. 
 

 
 
Nadat de wizard de databank gevuld heeft, worden 7 willekeurige playlists gemaakt (voor 
elke dag van de week één) en start de automatisering. Enkele minuten na installatie van 
AerOn studio bent u on air! 
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30.6.3 Controle configuratie 
Zodra de automatisering is gestart kunt u de configuratie van het systeem controleren. 
 

Kies via de menu’s Help → Systeem info voor een compleet overzicht van de 
configuratie. De informatie in dit venster is op een logische wijze verdeeld in een aantal 
blokken. 
 

 
 

Licentie informatie 
De knop ‘Verlengen’ naast ‘Licentie geldig t/m’ start het programma voor verlengen van 
de licentie. Bij ‘Software-onderhoud t/m’ start een invoervenster voor het verlengen van 
het software-onderhoud. Tien dagen voordat de licentie verloopt verschijnt er een wekker 
naast de hoofdklok van AerOn. Er is een apart hoofdstuk gewijd aan het verlengen van 
licenties en software-onderhoud. 
 

PostgreSQL 
Hier ziet u de versie van de database server en met welke server u verbonden bent. 
 

Actieve software modules 
Hier kunt u terugvinden welke AerOn studio-softwarecomponenten actief zijn. 
 

Harddisk audio 
Hier ziet u welke harddisk audio ondersteuning u heeft. U ziet ondermeer de versie van 
de geïnstalleerde driver en de beschikbare afspeel- en opnamekanalen. 
 

30.6.4 Virusscanners 

Soms gebeurt het wel eens dat een virusscanner alarm slaat wegens de software 
beveiling in Aeron Studio en InOutBox. Als u dit overkomt is het aanbevolen om 
een uitsluiting in te stellen in uw virusscan software. Afhankelijk van de opties in 
uw virusscan software kunt u uitsluitingen instellen op basis van mappen of 
processen. Dit heeft vaak ook een positieve invloed op de algehele performance. 
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Mappen uitsluiten 
“C:\Program Files (x86)\Broadcast Partners\Aeron”   (Softwaremap) 
“C:\Users\Public\Documents\Broadcast Partners\Aeron”   (Datamap) 
“C:\Program Files\PostgreSQL”  (PostgreSQL map) 

 

Processen uitsluiten 
Aeron.exe 
InOutBox.exe 
Postgres.exe 
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31 Audiokaarten 

 
Gebruikers hebben wat betreft de keuze van audiokaart onbegrensde mogelijkheden. 
Het on-board audio van de PC of laptop is voldoende om te starten. Na korte tijd zal 
echter blijken dat de audiokwaliteit niet volstaat en gaat men op zoek naar betaalbare 
alternatieven. In dit hoofdstuk presenteren wij een aantal audiokaarten waarmee 
Broadcast Partners goede ervaringen heeft. 
 

Model Uitvoering Analoog 
In 

Analoog 
Uit 

Digitaal 
in 

Digitaal 
uit 

RME Fireface 802  USB & 
Firewire 
19 inch 

4 6 1 AES / 
EBU 

8 ADAT 

1 AES / 
EBU 

8 ADAT 

RME Fireface UC USB 
19 inch 

4 4 1 S/PDIF 1 S/PDIF 

RME HDSPe AES PCIe - - 8 AES / 
EBU 

8 AES / 
EBU 

PreSonus Studio 1824 USB 4 4 1 S/PDIF 
8 ADAT 

1 S/PDIF 
8 ADAT 

Roland UA-1010 USB 4 4 1 S/PDIF 1 S/PDIF 

Behringer UMC1820 USB 
19 inch 

4 5 1 S/PDIF 
ADAT 

1 S/PDIF 
ADAT 

Behringer FCA1616 USB & 
Firewire 
19 inch 

4 4 1 S/PDIF 
ADAT 

1 S/PDIF 
ADAT 

Behringer FCA610 USB & 
Firewire 

2 4 1 S/PDIF 1 S/PDIF 

ESI Maya44 XTe PCIe 2 2 - - 

ESI Maya44 USB+ USB 2 2 - - 

ESI Gigaport HD+ USB - 4 - - 

Lynx Studio Technology 
AES16e 

PCIe - - 8 AES / 
EBU 

8 AES / 
EBU 

Axia IP-Audio (Livewire) WDM   16 16 

Dante Virtual Soundcard WDM   16 16 

LAWO R3LAY VSC WDM   8 8 

 
Tip! Het aantal in- & uitgangen is hier aangegeven is in stereo. 
 
Onderstaande modellen zijn niet meer leverbaar, maar wel geschikt om te gebruiken met 
AerOn studio. Een aantal modellen beschikt niet over drivers voor Windows 10. 
 

RME Hammerfall DSP 
Multiface II  
(Windows 10) 

PCIe & box 4 Jack 4 Jack 1 S/PDIF 1 S/PDIF 

M-Audio Delta 1010 
(Windows 7) 

PCI & 19” 4 Jack 4 Jack 1 S/PDIF 1 S/PDIF 

      

M-Audio Delta 1010LT 
(Windows 7) 

PCI & 
Cable 

4 RCA 4 RCA 1 S/PDIF 1 S/PDIF 

M-Audio FireWire 410 
(Windows 7) 

FireWire 1 XLR / 
Jack 

4 Jack 1 S/PDIF 1 S/PDIF 
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Marian Trace D4 SRC 
(Windows 7) 

PCI & 
Cable 

- - 4 AES / 
EBU 

4 AES / 
EBU 

Terratec Phase 88 Rack 
(Windows 7) 

PCI / 
FireWire & 
19” 

4 Jack 4 Jack 1 S/PDIF 1 S/PDIF 

Terratec Phase 88 
(Windows 7) 

PCI & 
5.25” box 

4 RCA 4 RCA 1 S/PDIF 1 S/PDIF 

Echo AudioFire 12 
(Windows 8) 

FireWire 6 Jack 6 Jack - - 

ESI ESP1010e 
(Windows 10) 

PCIe & 
Cable 

8 Jack 8 Jack 1 S/PDIF 1 S/PDIF 

 
 

RME Hammerfall DSP Multiface II 

    
 
 
RME HDSPe AES + BOB-32 

 

 
 
 
RME Fireface 802 

 
 
RME Fireface UC + RM19 
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Roland UA-1010 Octa Capture 

 
 
PreSonus Studio 1824 

 

 
 
Behringer UMC-1820 

 
 
Behringer FCA1616 

 
Behringer FCA610 

 
 
 
 
 
ESI Maya44 XTe 
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ESI Maya44 USB 

 
ESI Gigaport HD+ 

 
Lynx StudioTechnology AES16e 

 
 
SoundCraft Ui24R  (Te gebruiken als mixer) 

 
 
 
Axia IP-Audio (Livewire) 
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RME Hammerfall DSP Multiface II en AES-32 
Gebruikers van een RME Multiface wordt geadviseerd om driver 3.38 of hoger te 
installeren. 
 
M-Audio Delta 
Gebruikers van een M-Audio Delta audiokaart wordt geadviseerd om driver 6.0.8 te 
installeren, deze is audiokaart geschikt t/m Windows 7. 
 
Lynx StudioTechnology AES16e 

Zet in de mixer via de menu’s Settings → Advanced → SyncStart uit. 
 
RME Fireface 400 
Zet in de Fireface Settings de volgende 4 opties rechts boven in het venster uit: 

Check Input,  
SyncAlign,  
TMS,  
Interleaved. 

 
Echo AudioFire 12 

Zet in de AudioFire Console de optie Locked aan en kies een sampling frequentie. 
Schakel daarna de AudioFire uit en weer aan. 
 

 
 
Wij adviseren driver 5.8 te installeren. Deze is audiokaart is geschikt t/m Windows 8. 
 
ESI ESP1010e 
In het Configuratiescherm moet bij Geluid de audiokaart geconfigureerd worden op 7.1 
kanalen om 4 stereo outputs te kunnen gebruiken, anders is slechts één stereopaar 
beschikbaar. 
 

31.1 Configuratie 

Als standaardapparaat voor het afspelen van geluid, stelt u het beste het voorafluister 
kanaal in. Dit voorkomt dat de audio die u afspeelt in bijvoorbeeld Windows Media Player 
of WinAmp direct OnAir hoorbaar is. 
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De volgorde waarin in Windows de audioapparaten geïnitialiseerd worden bepaalt de 
apparaatvolgorde van de weergave en opnamekanalen in AerOn studio. Zie AerOn 
studio systeeminfovenster. 
 
De output routering moet zodanig ingesteld worden dat dat de gewenste functie op de 

juiste audio-output terechtkomt. Zie menu Tools → Instellingen → Lokaal → Audio. 
 
Als standaardapparaat voor het opnemen van geluid stelt u input 1 in. Deze is dan 
gereserveerd voor het maken van opnames (voicetrack / Databank editor). De overige 
inputs kunt u bijvoorbeeld gebruiken voor het doorgeven van extern audio. 
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32 Compact Interface Module 

Voor radiostations die hun fader/knop-starts willen aansluiten op de radio-automatisering 
heeft Broadcast Partners de Compact Interface Module (CIM) in het leverings-
programma. Deze module is ontworpen om met alle typen mengtafels compatibel te zijn, 
in tegenstelling tot in de handel verkrijgbare amateur-elektronica kitjes. Iedere ingang is 
voorzien van meerdere aanpassingsmogelijkheden. Dit betreft pull-up en pull-down 
weerstanden en een hoog/laag impedantie selectie. Hiermee worden problemen met 
aansluiten van de mengtafel voorkomen en zal het faderstartsignaal in een oogwenk 
worden verwerkt door de automatisering. 
 

 
De CIM is een kant-en-klare interface. Hij is leverbaar als een insteekkaart voor de 
computer of in een externe 1HE 19” behuizing. Het resultaat is een professioneel ogende 
en werkende combinatie van uw hardware met AerOn studio. 
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 Ingangen Uitgangen Interface 

CIM 6/2 (*) 6 2 Serieel 

CIM 8/4 Serieel 8 4 Serieel 

CIM 8/4 USB 8 4 USB 

CIM 8/4 LAN(**) 8 4 Netwerk 

CIM 16/8 Serieel 16 8 Serieel 

CIM 16/8 USB 16 8 USB 

CIM 16/8 LAN(**) 16 8 Netwerk 

(*) Niet meer leverbaar sinds 2009 
(*) GPS module t.b.v. tijdsklok optioneel 
(**) Leverbaar in 19” behuizing 
 
Zowel de USB en de LAN-interface werken softwarematig naar AerOn studio toe over 
een virtuele COM-poort. 
 
In Windows wordt de virtuele COM-poort voor USB automatisch via windows update 
herkend en geïnstalleerd. 
 
Voor de CIM met LAN-interface moeten er altijd drivers geïnstalleerd worden die ook 
terug te vinden zijn op de website www.broadcastpartners.nl . 
 
De nieuwste drivers zijn terug te vinden op de website van de USB-chip fabrikant:  
http://www.ftdichip.com/Drivers/D2XX.htm 
 

32.1.1 Remote inputs 
Alle ingangen zijn voorzien van een selecteerbaar hoog- of laagimpedant pull up of pull 
down circuit. Dit wordt geselecteerd met de jumpers op het board. Met de rij jumpers aan 
de linker kant kan het pull up of pull down circuit worden geactiveerd. Met de rij switches 
aan de rechterkant kan de impedantie worden bepaald (47k of 4k7). 
 

32.1.2 Remote outputs 
De remote outputs schakelen tussen 0 en 5 V. 
 

32.1.3 GPS time reference 
De tijdbasis voor de automatisering wordt bepaald met het Global Positioning System 
(GPS). Dit systeem werkt met 24 satellieten in de ruimte die op iedere plaats op de aarde 
te ontvangen zijn. Dit systeem wordt primair gebruikt voor plaatsbepaling, maar beschikt 
tegelijkertijd over een zeer nauwkeurige UTC-tijd. De effectieve nauwkeurigheid voor de 
automatisering is 50 ms. Omdat er gebruik wordt gemaakt van satellieten is het van 
belang dat de antenne een redelijk vrij zicht op de lucht heeft. In de meeste gevallen is 
een positie voor een raam voldoende voor de GPS om goede ontvangst te hebben (3 
satellieten of meer). 
Broadcast Partners levert bij de GPS klok een actieve antenne mee. Het gebruik van 
passieve antennes kan beschadiging van de GPS klok in de Compact Interface Module 
tot gevolg hebben. 
 

http://www.broadcastpartners.nl/
http://www.ftdichip.com/Drivers/D2XX.htm
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32.2 Technische details 

Algemeen 
Vmains: 12 V 
Dimensions: PCI formaat insteekkaart 
Pmax: 40 W max 
 
Remote ingangen 
Vmax: 5 V 
Vmin: 0 V 
Vhigh: >4.2 V 
Vlow: <1.0 V 
Rpull: pull up or pull down, 47k or 4k7, jumper selectable 
 
Remote uitgangen 
Vhigh: 5 V 
Vlow: 0 V 
Imax,out: 25 mA 
Power output Imax: 5 mA 

32.3 Installatie hardware 

Voor het aansluiten van de mengtafel (faderstart) op AerOn studio kunt u, zoals op de 
vorige pagina’s beschreven staat, gebruik maken van de Compact Interface Module, 
kortweg CIM genoemd. De CIM kan eenvoudig in een vrij PCI slot worden geplaatst.  
 

32.3.1 CIM Serieel 
Achterop de CIM bevinden zich twee connectoren. De kleine connector (COM) moet 
verbonden worden met een COM-poort op de computer. De CIM Serieel dient extern 
gevoed te worden. 
 

32.3.2 CIM USB 

 
Aansluiting USB kabel op de CIM 
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Het bijgeleverde kabeltje wordt aangesloten tussen een USB connector op het 
moederbord in de computer en op de 5-pinnenconnector rechtsboven op de CIM. Op 
bovenstaande foto is het kabeltje aangesloten op een (blauwe) USB connector op het 
moederbord. Meestal kunnen 2 USB apparaten worden aangesloten op 1 connector van 
het moederbord. Bijgevolg heeft men de keuze tussen de bovenste pinnen (op de foto 4 
pinnen) of de onderste (op de foto 5) pinnen van de USB connector op het moederbord. 
 
LET OP: als de connector verkeerd wordt aangesloten, kan het moederbord of de CIM 
onherstelbaar beschadigd worden! Kijk goed naar de tekstopdruk op de CIM en het 
moederbord of in het instructieboekje. In het instructieboekje van het moederbord is 
terug te vinden welke connectoren op het moederbord gebruikt kunnen worden voor 
USB-aansluitingen en waar de 5V voor de rode draad zit. 
 

32.3.3 CIM LAN 
De CIM Lan dient extern gevoed te worden en wordt met een standaard RJ-45 
netwerkkabeltje aangesloten op een hub, router of switch van het netwerk. 
 

32.3.4 IO-Interface 
De grote connector(en) (IO interface) dient om de faderstarts (mengtafel) en externe 
bronnen aan te sluiten. Voor de pin-out zie onderstaande tabel. De CIM routeert geen 
audio. 
 
Een CIM 6/2 en CIM 8/4 hebben elk 1 grote Sub D25-connector. De CIM 16/8 heeft 2 
grote Sub D25-connectoren. In onderstaande tabel een overzicht van de aansluiting op 
de Sub-D connectoren. 
 
De CIM heeft, afhankelijk van het type 6 tot 16 remote inputs (D1-D6; D1-D8 of D1-D16) 
en 2 tot 8 remote outputs. Per remote input kan er één faderstart aangesloten worden. 
Het ene contact van de faderstart schakeling wordt aangesloten op een remote input. 
Het andere contact meestal op de GND. De functies van de remote inputs zijn naar eigen 
inzicht definieerbaar binnen AerOn studio. Per remote output kan er maximaal 1 externe 
bron aangesloten worden.  
 
Een CD- of Solid state audio player die is omgebouwd voor faderstart kan als externe 
bron worden gebruikt. De play/pause of pause knop moet worden aangesloten op de 
remote interface van de -speler.  De audio-output wordt meestal rechtstreeks 
aangesloten op de mengtafel. 
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Op de CIM bevindt zich een rij jumpers en een dipswitch. Met de jumpers wordt de 
reactie van de remote inputs bepaald. Instelmogelijkheden zijn up (pull up) en down (pull 
down). Voor de meeste mengtafels volstaat de jumperinstelling up.  
 
Met de dipswitch wordt de impedantie bepaald. Instelmogelijkheden zijn high (47kΩ) en 
low (4k7Ω). In de meeste gevallen volstaat een impedantie van 47kΩ. Voor signaallijnen 
langer dan 15 meter kan een impedantie van 4k7Ω nodig zijn. Gebruik goed 
afgeschermde kabels om storingen te voorkomen. 
 
Overzicht van aansluiten 
 
Het aantal in- en uitgangen is afhankelijk van het type CIM. 
 

Pin CIM 8/4  
CIM 8/16 

CIM 8/16 
tweede D 25 

Type AerOn 
studio 

AerOn 
studio 

18 Ingang 1 Ingang 9 Ingang D1 A1 

19 Ingang 2 Ingang 10 Ingang D2 A2 

20 Ingang 3 Ingang 11 Ingang D3 A3 

21 Ingang 4 Ingang 12 Ingang D4 A4 

5 Ingang 5 Ingang 13 Ingang D5 A5 

6 Ingang 6 Ingang 14 Ingang D6 A6 

7 Ingang 7 Ingang 15 Ingang D7 A7 

8 Ingang 8 Ingang 16 Ingang D8 A8 

 Uitgangen 1 t/m 4 Uitgangen 5 t/m 8  Uit  1 - 4 Uit 5 - 8 

12 Uitgang 1 Uitgang 5 Uitgang D1 D5 

13 Uitgang 2 Uitgang 6 Uitgang D2 D6 

22 Uitgang 3 Uitgang 7 Uitgang D3 D7 

23 Uitgang 4 Uitgang 8 Uitgang D4 D8 

9 +5V +5V Voeding - - 

24 GND GND GND - - 

25 GND GND GND - - 

 
 
Live assist en Jingle players faderstart via CIM-ingang 
 
Bij de meeste mengtafels kunt u instellen of de remote faderstart of de remote knopstart 
een gepulst contact of een continu contact uitstuurt. Voor AerOn studio is een continu 
contact nodig indien u met één en dezelfde ingang de start en stop wilt ontvangen. Bij 
één van de twee ingangen moet dan “Inv” (Inverteren) worden aangevinkt 
 
Bij een gepulst contact kan per CIM-ingang enkel worden gestart of gestopt. Bij een 
gepulste faderstart zijn er twee CIM-ingangen nodig: één ingang voor start en één ingang 
voor stop. 
 
Aansluiten MD speler of CD speler op CIM-uitgang: 
 

MD/CD speler Functie Type 

Meestal Jack Tip Play/Pause Remote input 

Meestal Jack Huis GND GND 
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Van een aantal mengtafels staan hieronder de aansluitingen vermeld. 
 

Merk Mengtafel Connector op 
mengtafel 

Pin-out op 
mengtafel 

Aansluiting 
op CIM 

Jumper op 
CIM 

     

D&R Airmate Stereojack 
chassis 

tip GPI input 
D1 t/m 8 

Pull up 

Airmix / Airlab  ring GND  

Aircom     

     

D&R Sirius Sub-D 9 female 1 GPI input 
D1 t/m 8 

Pull up 

  6 GND  

     

D&R Scorpius Stereojack 
chassis 

tip GPI input 
D1 t/m 8 

Pull up 

  ring GND  

     

Dateq BCS-50 / 
100 / 200 

Stereojack 
chassis 

tip GPI input 
D1 t/m 8 

Pull up 

  huis GND  

     

Dateq BCS-25 Sub-D 25 female 3 (via 
schakeling) 

GPI input 
D1 t/m 8 

Pull up 

  7 (via 
schakeling) 

GND  

     

DHD 52/XS 1330 
Multi I/O 

Sub-D 15 female 1, 2, 3, 4 of 5 GPI input 
D1 t/m 8 

Pull up 

  8 GND  

     

Dateq BCS-70 Sub-D 25 female 17 (collector) GPI input 
D1 t/m 8 

Pull up 

  5 (emitter) GND  

     

Eela SBM-90 Sub-D 25 female 22 (knopstart) GPI input 
D1 t/m 8 

Pull up 

  23 (knopstart) GND  

     

Eela SBM-90 Sub-D 25 female 24 (faderstart) GPI input 
D1 t/m 8 

Pull up 

  25 (faderstart) GND  

     

Eela SRM Cinch female kern GPI input 
D1 t/m 8 

Pull up 

  massa GND  

     

Soundcraft 
SCA200 

Sub-D 9 female 1 GND  

  2 cue kanaal B GPI input 
D1 t/m 8 

Pull up 

  4 cue kanaal A GPI input 
D1 t/m 8 

Pull up 
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Alice Sub-D25 female 22 GPI input 
D1 t/m 8 

Pull up 

  10 GND  

     

Klotz Xenon Sub-D37 female 20 (Kathode) GPI input 
D1 t/m 8 

Pull up 

 16x GPI 1 (Anode) GND  

 
 
De Dateq BCS-25 schakelt met 15 Volt daarom moet er een spanningsdelerschakeling 
worden opgenomen in het kabeltraject. 
 

  
 

32.4 Installatie software drivers 

De software van AerOn studio maakt een verbinding via een COM-poort met de CIM. 
Voor de CIM Serieel is dit een fysieke aansluiting op de SUB-D9 connector. Voor de CIM 
LAN en USB gebeurt dit met een virtuele COM-poort. 
 

32.4.1 CIM USB 
Bij het aansluiten van de CIM USB verschijnt het dialoogvenster dat er nieuwe hardware 
is gevonden. Als de computer is aangesloten op internet, dan worden de drivers 
automatisch gevonden en geinstalleerd. Als dit niet het geval is, dan kunnen de drivers 
handmatig worden geïnstalleerd. Deze drivers staan op de website van de USB-chip 
fabrikant: http://www.ftdichip.com/Drivers/D2XX.htm 
 
Als alles succesvol is verlopen staat in het apparaatbeheer bij “Poorten (COM & LPT)” 
een apparaat met de naam “USB Serial Port (COMx)”. Waarbij x het nummer van de 
COM-poort is. 
 

32.4.2 CIM LAN 
De CIM LAN maakt gebruikt van de XPORT-03 component van de firma Lantronix. 
 
De softwareconfiguratie bestaat uit 2 delen. Enerzijds de netwerkconfiguratie van het 
CIM-apparaat zelf m.b.v. Lantronix DeviceInstaller en anderzijds het aanmaken van een 
virtuele COM-poort die via het LAN-netwerk een verbinding maakt tussen de PC en de 
CIM m.b.v. de Lantronix Com-Port-Redirector Manager. 
 

32.4.3 CIM LAN Netwerk en seriële instellingen 
Voor het instellen van het CIM Lan netwerk en de seriële instellingen is enige kennis van 
netwerken vereist. Als de begrippen DHCP server, mac address, vast-IP, default 

http://www.ftdichip.com/Drivers/D2XX.htm
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gateway, subnetmask u niet vertrouwd zijn, kunt u beter contact opnemen met uw 
netwerkbeheerder vooraleer verder te gaan. Helaas is een pasklare configuratie niet 
mogelijk omdat dit op iedere netwerk kan verschillen. 
 
Met de Deviceinstaller kunt u de XPORT-03 configureren wat betreft LAN en seriële 
instellingen in de CIM. Ons advies is om gebruik te maken van een vast IP-adres in uw 
netwerkbereik, maar buiten het IP-bereik dat wordt toegekend door een eventueel 
aanwezige DHCP server. 
 
De Serial Settings moeten als volgt ingesteld zijn: 

Protocol: RS232 
Flow Control: CTS/RTS (Hardware) 
Baud rate: 38400 
Data Bits 8 
Parity: None 
Stop Bits: 1 

 
Indien in uw netwerk nog componenten van de firma Lantronix aanwezig zijn, dan kunt 
u de CIM herkennen aan het unieke Mac-address die terug te vinden is op de CIM. 
 
Op het moment van dit schrijven (maart 2016) is de meest actuele versie van de 
Lantronix DeviceInstaller 4.4.0.2RC3. De Lantronix Xport werkt intern op eigen firmware 
(=software). We raden af om daarvan een upgrade uit te voeren omdat de huidige versie 
voldoet. Het upgraden van de firmware is specialistenwerk en houdt risico’s in. Als de 
upgrade wat tegenzit of mislukt, kan de CIM onbruikbaar worden! 
 

32.4.4 CIM LAN Lantronix Com-Port-Redirector Manager 
Met de Lantronix Com-Port-Redirector (=CPR) Manager configureert u een virtuele 
COM-poort op de computer waarop AerOn studio gebruikmaakt van de CIM ergens in 
uw netwerk. In de CPR Manager kunnen met de knop “Add/Remove” seriële poorten 
worden toegevoegd of verwijderd. Nadat een poort is toegevoegd, kunt u aan de settings 
van die poort in de CPR Manager het IP-adres gaan toekennen van de CIM LAN die 
reeds in het netwerk aanwezig is en aan staat. 
 
Op het moment van dit schrijven (maart 2016) is de meest actuele versie van de 
Lantronix CPR Manager 4.3.0.3. 
 
Als alles succesvol is verlopen staat in het apparaatbeheer bij “Poorten (COM & LPT)” 
een apparaat met de naam “Lantronix CPR Port (COMx)”. Waarbij x het nummer van de 
COM-poort is. 
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33 Compact Interface Module instellingen 

Na het aansluiten van de Compact Interface Module op de hardware (meestal de 

mengtafel in de studio) kan de CIM in AerOn studio ingesteld worden. Via Tools → 

Compact Interface Module bereikt u het onderstaande venster. 

33.1 Modules 

Aan de linkerzijde van het venster kunt u navigeren tussen een aantal vensters. 
 

 
 

Het venster Modules gebruikt u voor het aangeven op welke COM-poort van de PC u 
de CIM heeft aangesloten. Aangezien de CIM aangesloten op USB of LAN (netwerk) 
over een virtuele COM-poort wordt aangestuurd, kiest u hier ook de betreffende virtuele 

COM-poort. Vink de optie Actief aan om aan te geven dat er een CIM is aangesloten en 

druk vervolgens op Toepassen om de verbinding tot stand te brengen. Nadat de CIM is 
herkend worden in het middelste deel van het venster enkele gegevens over de 
aangesloten CIM getoond. 

33.2 GPS klok 

Deze optie is enkel beschikbaar op een CIM 6/2 (6x IO in en 2x IO out).  Als de CIM 6/2 
is uitgebreid met een GPS klok, kunt u in dit venster de status van de GPS ontvanger 
bekijken. 
Voor een goede ontvangst is het noodzakelijk dat u de antenne bij een raam met vrij 
zicht naar de hemel legt. 
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33.3 Ingangen 

 
 
In deze vensters geeft u aan welke functies in AerOn studio u wilt bedienen en welke 
ingang van de CIM u daarvoor gebruikt. De algemene ingangen zijn actief in zowel 
nonstop-mode als in Live mode. De studio 1 ingangen zijn actief als Live assist wordt 
geactiveerd vanuit de software of met een knop in studio 1. De studio 2 ingangen zijn 
actief als Live assist wordt geactiveerd met een knop in studio 2. 
 
Bij een mengtafel die gebruik maakt van continue fader- of knopstart wordt per faderstart 
functie achter de play en stop/cue dezelfde ingang ingevuld. Achter één van de twee 
functies (start of stop/cue) moet een vinkje geplaatst worden bij Inv. (=Inverted). Dit is 
nodig omdat er anders op één en dezelfde input niet geschakeld kan worden tussen play 
en stop/cue. Er is bijvoorbeeld tweemaal ingang D2 ingevuld bij Live assist HD-B cue en 
play. Achter welke ingang D2 (cue of play) dit vinkje moet staan hangt af van de 
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faderstart schakeling op de mengtafel en de jumperinstelling op de CIM.  In de praktijk 
staan de jumpers meestal op UP en moet er een vinkje geplaatst worden achter de 
onderste ingang D2 (play functie).  Hetzelfde geldt dan ook voor de overige 
faderstartfuncties en ingangen. 
 

Testmode U gebruikt deze optie voor het testen van de instellingen. Als deze 
optie is aangevinkt, hebben de wijzigingen die u doorvoert geen 
invloed op AerOn studio. Zo kunt u bijvoorbeeld makkelijk de 
fader- of knopstart testen en nagaan of het groene lampje uit- of 
aangaat zonder dat de functie wordt uitgevoerd in AerOn studio. 

Programmeren Met deze knop schakelt u de CIM naar een soort leerstand. Eerst 
selecteert u een functie, dan drukt u de betreffende knop in die 
deze functie moet activeren. AerOn studio registreert de ingang 
van waarop de betreffende knop is aangesloten en vult die voor u 
in. 

 
De eerder getoonde configuratie is voor een mengtafel met continue fader- of knopstart. 
Bij een mengtafel die gebruik maakt van gepulste fader- of knopstart is de volgende 
instelling van toepassing. 
 

 

33.4 Uitgangen 

In dit venster kunt u de beschikbare outputs configureren. In het menu ‘Acties’ (Tools → 
Acties) kunt u de uitgaande acties voor de CIM koppelen aan audiobestanden. 
 
U kunt bijvoorbeeld een CD speler aansturen die omgebouwd is voor faderstart. Of er 
een vinkje moet staan bij Inv. (=Inverted) hangt van de CD speler af.  Het lampje mag 
niet constant groen branden, maar mag enkel eventjes oplichten bij een uitgaande 
actiepuls. 
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33.5 Interface modules 

 
 
Dit venster geeft de status van alle beschikbare inputs weer. 

De Testmode kunt u gebruiken om te controleren of de hardware goed is aangesloten. 
Hiervoor vinkt u deze optie aan en bedient u de faders op de mengtafel (als u die zo 
heeft geconfigureerd in de tafel). De leds zullen vervolgens uitgaan of oplichten. Een 
toegekende actie aan deze ingang zal in Testmode niet worden uitgevoerd. 
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34 Studio switch 

Een studio switch is bedoeld voor het automatisch schakelen van studio’s en studio’s 
offline kunnen schakelen zodat de mengtafel kan worden gebruikt voor productiewerk. 

34.1 Master / Slave studio switch 

Voor omroepen met meerdere studios biedt AerOn studio de mogelijkheid om een multi-
studio systeem te bouwen. Een multi-studio systeem bestaat uit één AerOn studio 
nonstop-server PC en (op moment van schrijven) maximaal drie AerOn Slave studios. 
De nonstop-server PC schakelt de studios en de externe bronnen. De nonstop-server 
noemen we Studio 0.  
 
In studio 1, 2 en 3 wordt een AerOn Slave studio geinstalleerd. En afhankelijk van de 
behoefte kan in plaats daarvan in één of meerdere studio’s een AerOn Event 
geinstalleerd.  

 
Werking van de studio switch 
De automatisering op de nonstop-server moet zijn gestart voordat de automatisering op 
een AerOn Slave studio of op een AerOn Event als slave kan worden gestart.  
 
Zodra de automatisering op een AerOn Slave studio is gestart verschijnen er in de 
werkbalk extra knoppen waarmee een studio kan worden aangevraagd en vrijgegeven.  
 
Bediening van de studio switch 
 

Studio 0 is actief. Klik in studio 1, 2 of 3 op de knop Studio aanvragen. (CTRL+ALT+A) 

 
 
Na het aanvragen wordt de track die in de studio zal gaan spelen in de playlist oranje 
gekleurd. De gele klok telt vanaf dat moment af tot de volgende-tijd (start next) van de 
track die op de nonstopserver aan het spelen is. Daarna, als u geen actie neemt, gaat 
de oranje gekleurde track automatisch in de studio spelen, in non-stop mode. 
 

 
 
De meest rechtse knop kan gebruikt worden om direct in te breken op de nonstop server. 
Als u daarna met Ja bevestigd wordt de studio meteen geactiveerd en onair geschakeld. 
Voorwaarde is dat er in hetzelfde playlistblok nog opvolgende glijdende items staan met 
starttijden ofwel streepjes. Anders wacht het systeem tot het volgend uitvullend of vast. 
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Vanuit iedere studio kan de studio worden aangevraagd als het systeem nonstop speelt  
 
Na een gehonoreerde aanvraag wordt een studio meteen naar de zendlijn geschakeld. 
Tenzij in de automatiseringsinstellingen een vinkje staat bij “Activeer de studio pas als 
nonstop-server bijna is uitgespeeld”. In dat geval is de studio nog OffAir en wordt de 
studio pas naar de zendlijn geschakeld als de nonstop-server nog 15 seconden te spelen 
heeft tot aan de volgende-tijd (start next) van de spelende track. 
 

 
 
Een gele tijdklok geeft de resterende tijd weer tot de volgende-tijd van het op de nonstop-
server nog spelende item. Dit onair spelende item blijft op de nonstop-server doorspelen 
tot aan de eindtijd van dit item. Zodra de gele klok is afgeteld tot 0:00 dan is de volgende 
tijd van het onair spelende item bereikt. Daarna start het eerstvolgende item in de studio 
in nonstop-mode, tenzij u ondertussen Live assist activeert.  
 

 
 
Als het item op de nonstop-server is afgelopen, gaat de nonstop-server over in de wacht 
stand. 
 
Studio 2 is actief. De studio kan op elk moment weer vrijgegeven worden. Sneltoets 

CTRL+ALT+V. 

 
 
Als de studio is vrijgegeven neemt de nonstop server de uitzending weer over zodra de 
volgende-tijd van de in de studio spelende track is bereikt.  De volgende-tijd is bereikt 
als de klok 00:00 aangeeft. Als de track in de studio helemaal is uitgespeeld dan schakelt 
de nonstop server de studio OffAir. 
 
Live assist 
Nadat een studio is aangevraagd kan een DJ meteen beginnen met presenteren. Tenzij 
in de automatiseringsinstellingen een vinkje staat bij “Activeer de studio pas als nonstop-
server bijna is uitgespeeld” en de studio nog OffAir is.  
 
Als u tijdens het aftellen van de gele klok Live-assist activeert, dan blijft de gele klok 
aftellen tot 00:00 totdat u het item in de Cart-player start. Terwijl de gele klok nog aan 
het aftellen is en er nog niets in de studio speelt kunt u de studio zonder onderbreking 
weer vrijgeven en zal de nonstop server gewoon verder spelen.  
 
Als u Live-assist uitschakelt dan gaat de automatisering in de studio meteen in nonstop-
mode afspelen. Ook als de nonstop-server nog aan het spelen is en de gele klok nog 
aftelt. Houdt u daar rekening mee bij de bediening van het systeem. De studio zal in 
nonstop blijven afspelen totdat u de studio weer vrijgeeft of totdat de studio afhankelijk 
van de instellingen automatisch wordt vrijgegeven. De dan spelende track speelt nog 
volledig uit deze studio. Daarna neemt de nonstop-server de uitzending weer over tenzij 
er ondertussen in een andere studio een aanvraag is gedaan.  
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Zolang Live assist is geactiveerd kan in één van de andere studios niet de studio worden 
aangevraagd. Zodra Live assist is uitgeschakeld kan de studio worden vrijgegeven en 
kan in een andere studio de studio worden aangevraagd. 
 
Als een studio offline is geschakeld kan deze als productie studio worden gebruikt. 
 

Tip! Zodra een studio is aangevraagd ontvangt de automatisering in de studio het ID 
van de track waarmee deze mag starten en ook het tijdstip waarop is dan bepaald. 
Verplaats of verwijder deze track niet uit de playlist. 
 
Studio automatisch vrijgeven 
Met behulp van automatiseringsinstellingen kan een studio automatisch worden 
vrijgegeven bij het starten van een commercialblok zodat commercials op de nonstop-
server uitspelen. 

 
 
Failover 
De nonstop-server kan in een aantal situaties een studio terug overnemen. Als de PC in 
de actieve studio mocht vastlopen zal de nonstop-server binnen 30 seconden de 
uitzending overnemen. Ook als er op de PC in de studio afspeelfouten optreden, 
bijvoorbeeld wegens storing met de geluidskaart, zal de nonstop-server uit voorzorg de 
studio meteen offair schakelen en de uitzending direct overnemen. 
 
Aeron Event 
Voor gebruikers die in één van de studios een programma willen opnemen met behulp 
van de Live assist-cart players of als u DJ’s wil opleiden in een testomgeving, terwijl de 
nonstop-server of een andere studio de uitzending verzorgt, is er de mogelijkheid om 

een AerOn Event te installeren i.p.v. een AerOn Slave studio.  Een AerOn Event kan  
naast stand-alone playout ook als AerOn Slave studio fungeren en is daarom prima 
inzetbaar zowel in een mobiele studio als in een multi-studio systeem. Een AerOn Event 
kan 24/7 draaien als Slave studio. Voor het inregelen van een dergelijke setup kunnen 
op maat gemaakte oplossingen worden geboden. Neem contact met ons op als daar 
behoefte aan is. 
 
Export HTML / XML / Tekst 
Bij een Master-slave systeem moet u er voor zorgen dat alle automatiseringen de export 
sjablonen via hetzelfde pad benaderen. Bijvoorbeeld overal C:\Export\Source\.... En dat 
ze allemaal naar hetzelfde pad exporteren, bijvoorbeeld overal C:\Export\Target\...  
Op alle systemen zet u dan in C:\Export\Source de benodigde sjablonen en scripts. 
 
U kunt de sjablonen en scripts ook in een gedeelde map op het netwerk zetten die alle 
systemen via hetzefde pad kunnen benaderen.  Iedere automatisering in iedere studio 
kan dan de export van HTML / XML / Tekst uitvoeren. 
 
Tijdsynchronisatie 
Bij een multi-studio systeem is het belangrijk dat de tijdklok op alle PC’s exact gelijk 
loopt. Dit is belangrijk om naadloos op eenzelfde tijdbasis te kunnen overschakelen. Er 
zijn diverse mogelijkheden om eenvoudig te synchroniseren met een interne of externe 
ntp server. Bijvoorbeeld NetTime http://www.timesynctool.com 
 

http://www.timesynctool.com/


Handleiding AerOn Studio switch 

 we make radio happen 311 

Studio switch routering instellen 
Voor het schakelen en routeren van de studio’s kan gebruik worden gemaakt van een 
RME geluidskaart of een AXIA xNode. Ook met een D&R AXUM of een D&R AXITE kan 
een studio switch geschakeld. De nonstop server schakelt de studios. 
 
Voor het instellen van de studio switch bediening zie: 
- Hoofdstuk Instellingen / Automatisering / Extern audio / Extern audio via RME mixer 
- Hoofdstuk Instellingen / Lokaal / Axia xNode 
- Hoofdstuk Instellingen / Lokaal / D&R MambaNet 
 
 
Voorbeeldopstelling RME Studio Switch 
 

 
 

RME HDSPe AES geluidskaart in serie geschakeld met een Sonifex RD-DSS10 
waarmee een studio rechtstreeks naar de zendlijn kan worden geschakeld indien de 
nonstop-server onderhoud nodig heeft. 
 
Zie hoofdstuk 27.2.3 betreffende het instellen van de RME Matrix mixer. 
 

34.2 ehringer MX882 als studio switch 

 
Voor radiostations met een kleiner budget die AerOn studio in non stop mode ook buiten 
de mengtafel/studio om willen kunnen routen, is de Behringer MX882 een zeer 
betaalbare oplossing.  
 

 
 

Non-Stop/Schakelcomputer

met

RME HDSPe AES + BOB-32

Zendstraat

PGM 

Studio 1

PGM 

Studio 2

PGM 

Studio 3

PGM 

Studio 1

PGM 

Studio 2

PGM 

Studio 3

Non-

Stop

Sonifex RD-DSS10

Bron 1 Bron 2 Bron 3
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Blokschema Behringer MX882 

 
 

34.2.1 Audio routing MX882 
Input Main Left = Geluidskaart kanaal 1 of ander kanaalnummer dat voor de 
linkeruitgang van het AerOn studio nonstop signaal gebruikt wordt. (instelling in AerOn 
studio) 
 
Input Main Right = Geluidskaart kanaal 2 of ander kanaalnummer dat voor de 
linkeruitgang van het AerOn studio nonstop signaal gebruikt wordt. (instelling in AerOn 
studio) 
 
Left main output = naar linkeringang van een stereozender, STL of kabelmodulator. 
Right Main output = naar rechteringang van een stereozender, STL of kabelmodulator. 
 
Input 1 =  van de masteruitgang van de mengtafel links. 
Output 1 =  niet aangesloten. 
Input 2 =  van de masteruitgang van de mengtafel rechts. 
Output 2 =  niet aangesloten. 
 
Input 3 =  niet aangesloten. 
Output 3 = split van input main left = Geluidskaart  > naar mengtafel eerste  
 kanaal van AerOn studio links. 
Input 4 =  niet aangesloten. 
Output 4 =  split van input main right = Geluidskaart > naar mengtafel eerste  
 kanaal van AerOn studio rechts. 
 
Input 5 = Output soundblaster links. (met door AerOn studio gefade externe bron via 

extra geluidskaart) 
Output 5 = eventueel naar mengtafel om door AerOn studio gefade externe bron 
tijdens   open fader te kunnen beluisteren. 
Input 6 = Output soundblaster rechts. (met door AerOn studio gefade externe bron 
via   extra geluidskaart) 
Output 6 = eventueel naar mengtafel om door AerOn studio gefade externe bron 
tijdens   open fader te kunnen beluisteren. 
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Stand van de bedieningsknoppen 
Main Link = aan bij nonstop, uit bij live. 
Input 1 & 2 = “split” bij nonstop, “mix” bij live. 
Input 3 & 4 = altijd in “split” stand. 
Input 5 & 6 = altijd in “mix” stand. 
 
Dus enkel de knoppen met oranje tekst moeten worden omgezet bij omschakelen tussen 
nonstop en live (drie knopjes in het totaal). 
 
De balance van inputs 1, 3 & 5 staan volledig links.  
De balance van inputs 2, 4 & 6 staan volledig rechts.  
 

Schema audio routing 
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35 InOutBox 

Veel omroepen maken gebruik van nieuws- en andere info-items die via internet de 
studio binnenkomen. Het programma InOutBox maakt het mogelijk deze items direct en 
automatisch beschikbaar te stellen aan AerOn studio. Het InOutBox-programma vindt u 
via het Windows-startmenu in de AerOn studio softwaremap in Windows Verkenner. 
 

 
 
Met de standaardversie van InOutBox is het mogelijk om een verbinding met de 
database van Aeron te maken om nieuwe items in de Item Browser te plaatsen. 
Voorheen was hiervoor een licentie nodig. 
 
InOutBox Xtra heeft twee nieuwe opties: 
 
Multiple configurations  
Binnen InOutBox is het mogelijk om meerdere configuraties te maken, bijvoorbeeld voor 
nieuwsberichten die in de Item browser naar een nieuwsmap gaan, en voor 
regioberichten die naar een andere map in de Item browser gaan.  
In de algemene instellingen geeft u audioniveaus en de Aeron database aan. 
 

  
 
Elke configuratie heeft een eigen naam wat het makkelijk maakt om ze van elkaar te 
onderscheiden. 
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Active Hiermee kunt u een configuratie tijdelijk actief of juist niet 
actief zetten 

Picture Ken een afbeelding toe aan de configuratie 

Convert Converteer de bestanden naar een lage kwaliteit audio 

 
Per configuratie is er een instelling voor: 

• In folders 

• Out folders 

• Extensions 

• Files 

• Item browser 
 
Een goede, actieve configuratie wordt met een groen bolletje aangegeven, een niet-
actieve met een grijd bolletje. Een rood bolletje geeft aan dat er een fout in de 
configuratie zet, niet alles is ingevuld of er zijn In folders en Out folders die naar dezelfde 
map wijzen. 
 
In het hoofdscherm zijn alle configuraties zichtbaar. Klik een configuratie aan om de 
ingestelde mappen te bekijken. 
 
Convert file to low quality 
Soms is het gewenst om bestanden in een lage kwaliteit beschikbaar te hebben voor 
DJ’s die thuis voice tracks opnemen. Deze bestanden nemen minder ruimte in op de 
harddisk en klinken goed genoeg voor het beoogde doel. 
 
InOutBox migreert dan de bestanden in de In folders naar lage kwaliteit Opus in de Out 
folders. Daarbij wordt gebruik gemaakt van opusenc.exe dat aanwezig moet zijn in de 
map waarin InOutBox.exe staat. 

 
Als deze optie actief is, worden de bestanden niet in de database en Item browser gezet. 
Het hoofdscherm geeft aan dat deze conversie plaats vindt. 
 
Door twee configuraties aan te maken is het mogelijk om bestanden in hoge en lage 
kwaliteit beschikbaar te stellen, bijvoorbeeld: 
 

Configuratie General In folders Out folders Extensions Item 
browser 

Config 1  Active E:\InBox E:\Audio 
F:\Audio\High 

.wav 

.flac 

.mp3 

[Algemeen 
– Nieuwe 
audio] 

Config 2  
Convert 

F:\Audio\High  .wav 
.flac 
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to low 
quality 
 Active 

.mp3 

 

35.1 Instellingen in detail 

In folders / Out folders 

U geeft één of meerdere inbox-mappen op waarin bestanden inkomen en daarnaast één 

of meerdere outbox-mappen waarnaar de bestanden verplaatst worden. U moet ook 
extensies of bestandsnamen opgeven. InOutBox verplaatst enkel bestanden die voldoen 
aan de ingestelde extensies en/of bestandsnamen. Golfvormbestanden met extensie 
.bpk worden altijd verplaatst. De extensie .bpk hoeft u niet in te stellen. 
 

Zodra er in één van de inbox-mappen een nieuw audiobestand beschikbaar komt, 

probeert InOutBox het audiobestand te verplaatsen en verplaatst deze naar alle outbox-
mappen en logt het tijdstip waarop dit gebeurt. Bestanden die nog in gebruik zijn door 
Windows Verkenner of FTP-software, omdat ze nog aan het downloaden zijn, worden 
door InOutBox continu in de gaten gehouden. De bestanden worden meteen verplaatst 
zodra de bestanden zijn vrijgegeven door Windows Verkenner of de download software.  
 
Om AerOn studio in staat te stellen om de bestanden te kunnen afspelen, moeten de 
audiobestanden verplaatst worden naar een map die onderdeel uitmaakt van de audio 

lokaal mappen of naar een submap daarvan. Zie Instellingen → Globaal → Audio 
lokaal 
 
Extensions 
Hier kunt u extensies invullen, bijvoorbeeld .flac, .wav en .mp3 , niet .bpk omdat 
InOutBox deze zelf en automatisch afhandelt.   
 
Enkel inkomende bestanden die voldoen aan één van deze extensies worden verplaatst 

naar de outbox-map. InOutBox laat inkomende-bestanden met andere extensies in de 
inbox-map staan. 
 
Files 
Hier kunt u bestandsnamen invullen, bijvoorbeeld Nieuws.wav, Verkeer.mp3.   
Inkomende bestanden die exact overeenkomen met één van de ingevulde 

bestandsnamen  worden verplaatst naar de outbox-map. 
 
Tracks in de playlist plaatsen 

Met behulp van een marker <DateTime> kan InOutBox bestanden in de playlist 
plaatsen. Voor deze functionaliteit is een InOutBox-licentie nodig. 
 
Stel u wil het bestand OchtendProgramma.wav als track in de playlist plaatsen.  In de 

kolom File typt u dan als bestandsnaam OchtendProgramma<DateTime>.wav. Als u wil 
dat de track in de playlist van 21 juli 2022 om 11u04 terecht komt, dan plaatst u in de 
InBox-map een bestand OchtendProgramma20220721_1104.wav. De track zal in de 
playlist van 21 juli geplaatst worden achter de groep of track die eerder start en later 
eindigd dan 11u04.   
 
Thema kanalen 
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Standaard wordt altijd Radio ID 1 toegepast. Met een optionele marker <RadioID> kan  
InOutBox de track in een playlist van een ander themakanaal zetten. In dat geval typt u 

bij File als bestandsnaam OchtendProgramma<DateTime><RadioID>.wav.   
In de InBox-map plaatst u dan een bestand OchtendProgramma20220721_1104_2.wav 
(RadioID 2) 
 
Alternatieve notatie 
In de bestandsnaam kunt u i.p.v. 20220721_1104_2 ook zetten 20220721@1104#2. Of 
20220721@1104. De relatieve positie van de cijfers is belangrijk voor de decodering. 
 

Tip! Een track zal niet aan de playlist worden toegevoegd als het playlistblock door 
bewerken in gebruik is. Zorg ervoor dat het blok door de gebruker is vrijgegeven.  
Als een playlistblock toch in gebruik is dan verplaatst InOutBox wel het bestand en dan 
zorgt InOutBox er ook voor dat er in AerOn studio een pop-up melding komt en dat in de 
historie playout log wordt gelogd dat het playlistblock in gebruik is.  
 
Database verbinden 
Wanneer een verbinding met de AerOn studio database tot stand is gebracht ziet u in de 
instellingen op het tabblad Database alle beschikbare Item browser-categorieën. Na het 
selecteren van een Item browser-categorie en opslaan zal InOutBox inkomende items in 
deze categorie plaatsen. Dit zorgt ervoor dat nieuwe of updatet inhoud meteen in Item 
browser zichtbaar wordt als de door InOutBox bijgewerkte categorie in Item browser is 
geopend. 
 
Wanneer er in Item browser een andere categorie is geopend dan de door InOutBox 
bijgewerkte categorie, wordt de bijgewerkte categorie rood gemarkeerd zodat in Item 
browser meteen duidelijk zichtbaar wordt dat er in die categorie nieuwe items geplaatst 
zijn of items ververst zijn. Als een nieuwsredactie nieuwe bestanden in een inbox-map 
plaatst, kan de DJ / presentator deze items meteen gebruiken en vanuit Item browser in 
zijn Playlist of Jingle players slepen.  
 
Wanneer er een verbinding met de AerOn database is ingesteld, werkt InOutBox meteen 
de ook tijden in de track database bij. Nieuwe audiobestanden worden automatisch 
geimporteerd. 
 

Tip! Als u een upgrade van PostgreSQL installeert moet u in InOutBox de database 
verbinding instellingen nazien. 
 
General 
Op het tablad ‘General’ kunt u onderstaande instellingen aanpassen. 
 

Auto start Met deze optie zal InOutBox direct starten als de gebruiker in 
Windows is aangemeld. Hiervoor wordt er een snelkoppeling in 
‘Opstarten’ geplaatst. Het aan- of uitzetten van deze functie werkt 
enkel als u InOutBox met een administrator account start. 
(Uitvoeren als Administrator) 

Minimize to tray Met deze optie minimaliseert het programma naar het systeemvak 
en blijft het daar als icoon zichtbaar. Deze optie voorkomt ook dat 
u InOutBox per ongeluk afsluit. Indien nodig kunt u InOutBox alsnog 
afsluiten middels een rechtsklik op het icon in de tray en kies Exit 
in het menu. 
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Start level AerOn studio bepaalt bij nieuwe tracks automatisch het ‘fade-in 
start’ punt aan de hand van het niveau in het bestand. Geef hier het 
gewenste level in. (Enkel van toepassing bij InOutBox licentie) 
 

End level AerOn studio bepaalt bij nieuwe tracks automatisch het ‘volgende’ 
punt aan de hand van het niveau in het bestand. Geef hier het 
gewenste level in. (Enkel van toepassing bij InOutBox licentie) 
 

Auto gain Omdat niet alle tracks even luid zijn, is het raadzaam om de gain te 
corrigeren zodat het standaard afspeelniveau op -18 dB komt. U 
kunt deze optie ook uitzetten, bijvoorbeeld als u klassieke muziek 
speelt en de tracks van te voren al het juiste niveau hebben 
gekregen. (Enkel van toepassing bij InOutBox licentie) 
 

Publish Nieuwe tracks in de databank worden gepubliceerd zoals u dat hier 
instelt. (Enkel van toepassing bij InOutBox licentie) 
 

Available 
planner 

Normaliter zijn alle tracks beschikbaar voor Formatplanner en de 
gebruiker. Bij tracks die niet automatisch gepland mogen worden 
door Formatplanner kunt u ‘Available planner’ uitvinken. Als 
‘Available user’ is aangevinkt, kan de track wel nog manueel door 
de gebruiker ingepland worden via Databank browser. (Enkel van 
toepassing bij InOutBox licentie) 
 

Available user Deze optie kunt u afvinken om tracks in een bepaalde Item brower 
categorie te plaatsen terwijl u de geïmporteerde tracks niet aan alle 
gebruikers beschikbaar wil stellen. Als deze optie is afgevinkt 
worden de geïmporteerde tracks niet zichtbaar in Databank 
browser (Enkel van toepassing bij InOutBox licentie) 

  

35.2 Backup en Restore instellingen 

Na het volledig configureren is het raadzaam om de instellingen te bewaren met een 
backup zodat die in geval van nood terug geplaatst kunnen worden. De backup is ook 
handig als u InOutBox op een andere PC gaat gebruiken met dezelfde instellingen. 
 
Backup instellingen 
Ga naar de algemene instellingen en kies ‘Backup’. Nu krijgt u de mogelijkheid een map 
te kiezen waarin het bestand InOutBox.backup wordt opgeslagen.  
Dit bestand bevat alle instellingen van InOutBox. 
 
Restore instellingen 
Het terugzetten van de instellingen is niet mogelijk als InOutBox actief is. Sluit de 
applicatie eerst af. 
Kopieer  

InOutBox.backup  
naar  

C:\ProgramData\Broadcast Partners\InOutBox\InOutBox.db 
 
Let op: De extensie moet nu .db zijn! 
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36 Externe koppelingen / applicaties / Visual Radio 

Multicam Systems Visual Radio  
AerOn studio heeft speciale koppelingen met 
verschillende appilicaties. Zo werken wij voor Visual 
Radio samen met het Visual Radio systeem van 
Multicam Systems.   
 
 

Pluxbox RadioManager 
AerOn studio werkt samen met RadioManager van 
Pluxbox. Met dit systeem kun je draaiboeken voor je 
radioprogramma maken. Ook is het mogelijk om social 
media intergraties te maken.  
 
 

E-power Radio & online 
Gebruikt u E-power voor uw reclame campanges? De 
Commercialplanner Xtra in AerOn leest met gemak de 
campanges in die E-power aanlevert.   
 
 

vMix  Live Production & streaming software 
AerOn studio werkt samen met vMix Live Production & 
streaming software. Meer informatie is te vinden in onze 
Visual Radio handleiding. 
 
 
SmartGPIO 
De SmartGPIO applicatie koppelt meerdere protocollen van hardware apparatuur met 
Aeron Studio op basis van triggers. Hardware apparatuur kan een mengtafel of een 
controller zijn. Bvb een Pioneer DJ set of Elegato Stream Deck. De ondersteunde 
protocollen zijn: Ember+, Axia (LWRP), D&R Airlite, Tipro keyboards en Midi-in. Daarbij 
wordt ook de Shuttle Pro ondersteund. De SmartGPIO is een client server applicatie. 
Vanop meerdere computers kan de configuratie worden aangemaakt en gewijzigd. 
SmartGPIO wordt geleverd middels een installatieprogramma en met handleiding. 
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37 AerOn studio softwarelicentie 

Bij elk AerOn studio-systeem wordt door Broadcast Partners één of meerdere software 
licenties gerealiseerd. Deze software licenties zijn machine gebonden aan de hand van 
een Hardware ID. Dit Hardware ID is per machine uniek. Het Hardware ID kunt u in 
AerOn studio vinden onder Help → Systeeminfo → Verlengen 
 

 
 
Dit hardware ID is nodig per machine om een licentie aan te maken. Als u deze aan ons 
doorgeeft kunnen wij voor u een licentie aanmaken met de modules aan de hand van 
uw contract/overeenkomst.  
 
Licentie codes die u per mail ontvangt plakt u in het invoerveld. 

37.1 Licenties 

Het gebruik van AerOn OnAir en productiestations is gebonden aan licenties die in de 
softwarekey opgeslagen zijn. 
 
Aeron haalt wekelijks een update van de licentie van een server van Broadcast Partners 
op. Daar heeft u dus eigenlijk geen omkijken naar. 
 
Het blijft altijd mogelijk dat Broadcast Partners een e-mail met codes stuurt. 
Aan de hand van een voorbeeld leggen we uit waar u op moet letten bij het handmatig 
verlengen van licenties. 
Hier ziet u een voorbeeld van de codes die verstrekt worden voor een AerOn 
studiosysteem: 
 

HardwareID 
======================================================================= 
Kopieer onderstaande tekst in zijn geheel, plak deze in het veld ‘Registratiecode - tekst’. Registreer de 
licentie.  
 
Aeron  >>  HardwareID: 1055-4E4A-F44D-E5C9-7AD4-0E8B-1081-3C64  (License: 2019-04-02 - Software 
support: 2019-09-30) 
072A28401179E9AA4591B3129F0C5D8B97F24B6BE654FE6C0EC989D30D933670448D852547DA58F
653B4E7A840B467CDD8C8977A6685AE16BB0C01686B9DDCD3ECEDC7878D0284E792183B2DB620
AB42C9CF76BAFBD2FE199D8DB09964FD7B944D2B1FD346A35… 
 
======================================================================= 

 

Kies in AerOn studio via de menu’s Help en Systeem info en druk dan op de knop voor 
verlengen van de licentie. 
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38 Probleemoplossing en Zomertijd/Wintertijd 

Hoewel de grootste zorg is besteed aan het optimaal functioneren van AerOn studio kan 
het toch gebeuren dat zich problemen voordoen. In dit hoofdstuk proberen we aan te 
geven hoe u daar het beste mee om kunt gaan. 
 
Als u een recente gebruiker bent van AerOn studio kan het zo zijn, dat u nog niet alle 
functies kent. Wij raden u aan om de handleiding helemaal door te lezen nadat u een 
eerste kennismaking met het systeem heeft gehad. Door de handleiding vervolgens als 
naslagwerk bij uw systeem te houden, kunt u de meeste zaken zelf oplossen. Deze 
handleiding is geschreven door technici die het systeem van binnen en van buiten 
kennen. Daardoor kunnen bepaalde zaken als bekend worden beschouwd, terwijl 
gebruikers graag een uitgebreidere toelichting zouden willen.  
 
Wij verzoeken u eventuele onduidelijkheden die u in deze handleiding tegenkomt 
schriftelijk per email aan ons door te geven via support@broadcastpartners.nl, dan 
zullen wij dat in een volgende uitgave toevoegen of de tekst aanpassen. 
 
Het kan gebeuren dat er bij bepaalde handelingen onverwacht een foutmelding 
verschijnt. Nadat u op OK klikt, verdwijnt de melding en is er verder niets aan de hand. 
Deze categorie meldingen heeft geen gevolgen voor de verdere werking van het 
systeem. Uiteraard willen wij dit graag in een volgende software release oplossen. Krijgt 
u dezelfde melding opnieuw als u de handeling herhaalt? In dat geval hebben wij graag 
dat u ons schriftelijk per email op de hoogte stelt. Vermeld exact het probleem en probeer 
daarbij daarbij zo goed als mogelijk uw workflow te omschrijven. Naast een 
gedetailleerde omschrijving is het voor ons handig ook het foutenlogbestand Aeron.el te 
ontvangen. Voeg Aeron.el en ook de logbestanden als bijlage in uw email. Dit bestand 
vindt u het makkelijkst vinden via de instellingen: Open de instellingen, scroll naar 
beneden en klik op de knop “Verkenner” achter Logsmap. 
 
De volgende categorie heeft tot gevolg dat AerOn studio of een onderdeel daarvan niet 
meer goed functioneert na het opgetreden probleem. In dat geval sluit u AerOn studio af 
. U kunt AerOn studio vervolgens weer starten waarna alles weer naar verwachting 
functioneert. Heeft het stoppen en starten van AerOn studio niet het gewenste effect, 
herstart dan het Windows systeem. Raadpleeg dan de Windows logboeken. 
 
In de historie playout log worden ook bepaalde fouten gelogd. Bijvoorbeeld als de 
automatisering een item overslaat omdat het audiobestand niet aanwezig is. Of als er 
niet kan worden afgespeeld wegens een storing met een audiokaart. Probeer dan met 
de meldingen in de historie playout log de oorzaak te achterhalen. Ook de controle 
functie in het playlist-menu kan hulp bieden, hiermee kunt u de aanwezigheid van 
bestanden controleren. 
 
Door de eerder aangegeven handelwijze te hanteren, lost u de problemen vaak zelf en 
op de snelst mogelijke manier op. Het heeft weinig zin om de support van Broadcast 
Partners te bellen voordat u deze stappen heeft doorlopen. Heeft u dit nog niet gedaan, 
dan zal hier alsnog om worden gevraagd. 
 
In alle gevallen geldt: Meldt ieder probleem bij ons. Is het probleem reproduceerbaar? 
Vermeld het exacte versienummer. Vermeldt exact de gedane workflow, evenals de 
melding die op het scherm verschijnt. Hoe nauwkeuriger u bent in uw omschrijving, hoe 
eerder wij in staat zijn om het probleem te reproduceren en op te lossen. 

mailto:support@broadcastpartners.nl
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38.1 Backup 

Waarschijnlijk heeft u het al eerder gehoord: zorg voor een degelijke backup van 
databanken en audiobestanden. Vaak genoeg worden argumenten gegeven om geen 
backup te maken: een backup systeem is weer een extra kostenpost, het maken van 
een backup is ingewikkeld, de apparatuur is net nieuw dus raakt er niets defect. Het zijn 
allemaal bekende argumenten. Helaas is het wel zo dat er over de levensduur van een 
harddisk alleen maar een schatting gemaakt kan worden. Gaan we uit van een 
gemiddelde levensduur van drie jaar dan blijkt dat vele harddisks na jaren nog lopen en 
helaas komt het af en toe voor dat een drie maanden oude harddisk de geest geeft. 
Vergis u zich echter niet: de PC op een gemiddeld kantoor gaat elke ochtend aan en 
elke middag uit, de harddisk draait daarom niet meer dan 43 uur per week. De harddisk 
in automatisering is continu in bedrijf en draait elke week 168 uur. Dat is ca. vier keer zo 
veel! Voorkom dus problemen en maak geregeld een backup! 

38.2 Wintertijd en zomertijd 

De overgang van wintertijd naar zomertijd en omgekeerd heeft gevolgen voor de 
automatisering van AerOn studio. Hieronder wordt beschreven wat er in die gevallen 
moet gebeuren. 
 

Overgang van wintertijd naar zomertijd 
Hiervoor adviseren wij om 1 glijdend blok te maken van 01:00 uur wintertijd naar 04:00 
uur zomertijd ‘s nachts. Het is belangrijk dat er tussen deze tijdstippen geen vaste of 
semi-vaste items aanwezig zijn!  Een aantal seconden na de werkelijke winter/zomertijd 
overgang wijzigt de automatisering de starttijd van alle nummers in dat blok zodat alle 
nog te spelen nummers de juiste, nieuwe starttijd volgens de zomertijd krijgen.  
Indien er toch meerdere vaste of semi-vaste blokken zijn tussen 01:00 en 04:00 dan kan 
het zijn dat een aantal minuten 2 of meer nummers ongewenst tegelijk gespeeld worden 
en de automatisering stilvalt. 
 

Overgang van zomertijd naar wintertijd 
Hiervoor adviseren wij om 1 lang glijdend blok te maken van 02:00 uur zomertijd tot 
04:00 uur wintertijd. Het is belangrijk dat er tussen deze tijdstippen geen vaste of semi-
vaste items aanwezig zijn! Anders zal de automatisering stlvallen. Zorg er ook voor dat 
dit blok minstens een uur extra nummers bevat om voldoende muziek of audio te hebben 
in het extra uur voor deze uitzonderlijke dag van 25 uur. Er moet tussen 02:00 en 04:00 
minimaal drie uur muziek geprogrammeerd zijn. De muziek in het blok zal in die volgorde 
gespeeld worden. Een aantal seconden na de werkelijke zomer/wintertijd overgang 
wijzigt de automatisering de starttijd van alle nummers in dat blok zodat alle nog te spelen 
nummers de juiste nieuwe starttijd (in wintertijd) krijgen. Indien het glijdend blok waarin 
de zomer/wintertijd zit, te weinig nummers bevat dan zal het tot het einde van het blok 
stil zijn. 

38.3 Systeem relevante problemen 

Ondervindt u problemen met het Windows systeem of heeft u problemen met de audio 
performance of andere systeem issues, raadpleeg in dat geval eerst de Windows event 
logboeken. Kijk in de logboeken voor berichten m.b.t. hardware of systeem issues. Indien 
er relevante berichten zijn, google dan met behulp van de inhoudelijke info om deze op 
te lossen. 
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Een aantal tips die u naar relevantie kunt toepassen 
 

Windows update uitvoeren. 
 

Update HP Support Assistant, indien van toepassing. 
 

Update de systeem BIOS. 
Update chipset en systeem drivers. 
Update audio device drivers. 
Update network device drivers. 
 

Alle power management in de systeem BIOS uitschakelen. 
 

In apparaatbeheer grafics audio en energiebeheer uitschakelen: 
- Grafics audio en HDMI/Displayport audio devices uitschakelen. 
- Netwerkadapters energiebeheer uitschakelen. 
- Netwerkadapter, geavanceerd, Energy Efficient Ethernet: Off 
- USB controllers en hubs energiebeheer uitschakelen. 
 

Het energiebeheerschema “Hoge prestaties” inschakelen. 
     Schema-instellingen wijzigen: 
        - Harde schijf uitzetten na: Nooit 
        - USB Selectieve USB-onderbreking: Uitgeschakeld 
 

Snel opstarten uitzetten. 
 

SSD / HDD optimaliseren: SSD trim / HDD defrag. 
 
 

Indien er na het nemen van bovenstaande stappen nog issues zijn, dan hebben we nog 
onderstaande tips die u naar relevantie kunt toepassen. 
 
 

Open de Command prompt, uitvoeren als Administrator. 
 

# Schijfcontrole uitvoeren. 
chkdsk /f /r 
 
### Schijfopruiming 
# Cleanup manager uitvoeren met /sageset:1 en check alle opties in het venster dat zich 
opent. 
cleanmgr /sageset:1 
 

# Cleanup manager uitvoeren met /sagerun:1  De opties gezet in de vorige stap worden 
toegepast. 
cleanmgr /sagerun:1 
 
### Image controle en herstel 
# De Deployment Image Servicing and Management tool uitvoeren. 
dism /Online /Cleanup-image /Scanhealth 
dism /Online /Cleanup-Image /CheckHealth 
dism /Online /Cleanup-image /RestoreHealth 
 
### Bestandscontrole en herstel 
# De System File Control tool uitvoeren. 
sfc /scannow 
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39 AerOn studio thuis en remote voicetrack 

AerOn studio kunt u uitstekend thuis (of waar ook ter wereld) gebruiken. Zo is het 
mogelijk om vanaf thuis de databank van de studio te raadplegen of voicetracks op te 
nemen. Vanuit thuis kunt u met behulp van een VPN-verbinding (Virtual Private Network) 
toegang krijgen tot de audiomappen en databank in de studio. U kan in dit geval 
rechtstreeks in de studio databanktracks toevoegen en playlists bewerken (en o.a. 
voicetracks opnemen). Met de synchronisatiemodule kunt u eenvoudig de nieuwe 
audiobestanden en eventueel voicetracks naar de studio transporteren. De 
synchronisatiemodule kunt u ook aanroepen vanuit de playlist. U kunt zo via een selectie 
uit uw playlist audiobestanden en voicetracks eenvoudig synchroniseren met de studio. 
 

 
 
Voor de installatie van de software kunt u de beschrijving in hoofdstuk 30 volgen. In de 
meeste gevallen heeft u thuis één PC die u gebruikt om verbinding te maken met de 

studio. In het installatieprogramma kiest u de onderdelen AerOn software. 

39.1 Configuratie 

Voordat u aan de slag kunt, moeten er een aantal zaken geconfigureerd worden, zowel 
in de studio als thuis. Een uitgebreide beschrijving hiervan valt buiten het bestek van 
deze handleiding, omdat het enkel Windows of uw specifieke hardware betreft.  
 
Op internet vindt u diverse beschrijvingen die behulpzaam kunnen zijn bij het opzetten 
van een VPN-verbinding. 
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In het studio-netwerk 
 
Configureer een VPN server 
Als er in het studionetwerk geen dedicated VPN-server of VPN-router aanwezig is, kunt 
u op de AerOn playout PC een binnenkomende verbinding in Windows configureren die 
dan als VPN-server functioneert en VPN-aanvragen accepteert. 
 
De WAN-router die verbonden is met het internet configureert u voor VPN-toegang. Stel 
‘port forwarding’ in van poort 1723 naar het IP-adres van de VPN-server in het 
studionetwerk. Afhankelijk van het type router moet ook VPN-passthrough geactiveerd 
worden.  
 
Vaak is er ook een firewall actief, waarin de toegang naar de PostgreSQL database 
server doorgelaten moet worden. In iedere firewall moet een uitzondering ingesteld 
worden voor postgres.exe en/of poort 5432. 
 
 

Bij u thuis (of waar ook ter wereld) 
 
Configureer en maak een VPN-verbinding 
Eerst configureert u in Windows een VPN-verbinding. In het netwerkcentrum van 
Windows moet u een nieuwe VPN-verbinding instellen met behulp van “een verbinding 
met een bedrijfsnetwerk maken”. Hiervoor heeft u het externe IP-adres of DNS-naam 
van de studiorouter nodig, inclusief een gebruikersnaam en wachtwoord.  
 
De snelheid van dataoverdracht wordt bepaald door de traagste factor, namelijk de 
beschikbare upload bandbreedte. 
 
Netwerk mapping maken 
Nadat de VPN-verbinding tot stand is gebracht maakt u een netwerk mapping via een 
schijfletter, bijvoorbeeld schijf V:. De schijfletter laat u over VPN verwijzen naar een 
gedeelde schijf of map op de AerOn studio playout PC, bijvoorbeeld  Aeron_audio.  De 
schijfletter V:\ verwijst dan bijvoorbeeld naar \\AERON_PLAYOUT\Aeron_audio. of naar 
\\192.168.1.200\Aeron_audio. 
 
Databaseverbinding instellen 
Bij de eerste start van AerOn studio moet u de databaseverbinding met de database-
server in het studio-netwerk instellen.  Het onderstaande venster zal automatisch 
verschijnen bij de eerste start. Als u al eerder een databaseverbinding had ingesteld, 

kunt u tijdens het starten van AerOn studio de Shift-toets indrukken om dit venster te 

laten verschijnen. U kunt het venster ook openen via Instellingen → Globaal → 
Algemeen → Database verbinding. 
 

 
 

file://///192.168.1.200/Aeron
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In het venster PostgreSQL database verbinding moet u de gegevens invullen die u van 
de systeembeheerer heeft ontvangen. Als u de naam of het IP-adres van de database-
server in de studio niet weet, moet u alsnog contact opnemen met de netwerkbeheerder. 
Mocht u na invullen van de juiste gegevens geen toegang krijgen tot de PostgreSQL 
database server dan wordt de toegang mogelijk geblokkeerd door een firewall. 
 
Wanneer u vanaf huis of een andere externe locatie via internet werkt, is de 
databaseverbinding vaak een stuk trager dan wanneer u lokaal binnen het LAN-netwerk 
van het radiostation zelf werkt. Het laden van tracks kan over VPN langer duren dan u 
in de studio gewend bent. 
 
U kunt in AerOn studio met behulp van het database-icoon informatie zien over de 
databaseverbinding. (de blauwe olifant linksonder op de statusbalk) Ook in het Systeem 
info-venster is die informatie te vinden. Menu help → Systeem info. 
 

 
 
 
 
 
 
 
Audiobestanden 
Om het werken op afstand snel te laten verlopen, is het prettig als de audiobestanden 
van het radiostation ook thuis lokaal aanwezig zijn. De beste werkwijze hiervoor is het 
eenmalig meenemen van de bestanden (eventueel in lo-res lage kwaliteit) op 
bijvoorbeeld een externe USB harddisk.  
 
AerOn studio biedt de mogelijkheid om bestanden die naderhand toegevoegd worden in 
de studio eenvoudig te synchroniseren naar de lokale mappen thuis. Voordat u start met 
het synchroniseren en kopiëren van de bestanden is de eerste stap om aan te geven 
welke mappen gebruikt gaan worden voor de lokale bestanden thuis. 
 
Daarnaast biedt AerOn studio de mogelijkheid om audiobestanden stapsgewijs te 
synchroniseren met behulp van playlistblok-selectie, zodat een gebruiker enkel de 
audiobestanden uit het geselecteerde playlistblok of uur hoeft te synchroniseren. 
 
En ook welke mappen en bestanden er gebruikt gaan worden als remote-bestanden. (in 
de studio). Indien gewenst kan er een kopie gemaakt in lage kwaliteit en gebruik gemaakt 
worden van zogenaamde lo-res lage-kwaliteit-bestanden. De configuratie hiervan is 
afwijkend en kan aanvullend worden aangeschaft. Dergelijke bestanden zijn vaak kleiner 
en hebben minder tijd nodig om deze te synchroniseren. 
 
Audiomappen instellen 

Open het instellingenscherm via menu Tools → Instellingen → Globaal en vul de lokale 
en remote audiomappen in. 
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Op het tabblad Audio lokaal vult u de audio-hoofdmappen in die bij U thuis op de lokale 
harddisk staan. 

Op het tabblad Audio remote vult u de audio-hoofdmappen in die op de server in de 
studio staan.  Deze remote-mappen kunt u enkel benaderen na het maken van VPN-
verbinding. 
 
Remote audio mappen over VPN als lokale audio mappen gebruiken 
 
Een aantal gebruikers synchroniseert wel voicetracks naar de studio nadat ze thuis hun 
voicetracks hebben opgenomen, maar ze synchroniseren geen audiobestanden.  
 
In dat geval gebruikt men de remote audiomappen over VPN als lokale audio door deze 
bij audio lokaal in te stellen als lokale audiomappen.   
 
Dit werkt uiteraard trager dan bestanden inladen die op de lokale SSD-schijf staan, 
omdat audiobestanden dan altijd over Internet/VPN worden ingeladen. Het argument 
van deze gebruikers is dat er geen audiobestanden gesynchroniseerd hoeven. Met een 
snelle internet verbinding kan dit prima werken. 
 
Om met deze werkwijze het opstartproces van AerOn studio te versnellen, moeten de 
audio lokaal mappen en de audio remote mappen identiek en in exact dezelfde volgorde 
worden ingesteld.  
 
Als audio lokaal en audio remote indentiek zijn ingesteld zal AerOn studio tijdens het 
opstarten de in-memory bestandscache vullen met de opgeslagen filepath in het lokale 
database bestand AudioName.nx1 zodat een scan over VPN niet noodzakelijk is om de 
filepath van ieder audiobestand te weten.  
 
Dit principe remote audio als lokaal audio werkt i.c.m. met een Remote voicetrack licentie 
en i.c.m. een Productie licentie. 
 
Als AerOn studio eenmaal is opgestart wordt er ook automatisch een remote audio scan 
gestart zodat het AudioName.nx1 database bestand steeds wordt bijgewerkt met de 
actuele filepath van alle aanwezige remote audiobestanden. 
 
Dit bestand AudioName.nx1 wordt opgeslagen in een map “Remote” in de AerOn 
datamap. Bij de eerstvolgende start van AerOn studio zal die daardoor snel alle locaties 
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van bestanden vinden en inladen en sneller opstarten dan met een remote audio scan 
over VPN. 
 

Tip! Als u in het menu toegang de remotemappen opnieuw activeert dan wordt het 
zoeken naar alle remote bestanden in gang gezet. Zo kunt u thuis de in-memory 
bestandscache tussentijds vernieuwen als er in de studio nieuwe tracks zijn toegevoegd.  
Als de bestandscache is bijgewerkt zal AerOn studio de remote bestanden sneller 
lokaliseren. 

39.2 Voicetracks opnemen 

De eerste stap om van thuis uit te voicetracken is VPN-verbinding maken tussen het 
studio-netwerk en het thuisnetwerk. Eenmaal als de VPN-verbinding is opgezet, kunt u 
gaan beginnen met het opnemen van voicetracks. 
 

Tip! Na het activeren en leggen van een VPN-verbinding worden in Windows soms niet 
automatisch de netwerkverbindingen geactiveerd. Daarom kunt u het beste ‘Deze 
computer’ openen en controleren of de audiomappen bereikbaar zijn. Als de remote-
mappen in de studio via bijvoorbeeld V:\ zijn gekoppeld, dan moet u de V: schijf 
aanklikken en openen. Zodat u er zeker van bent dat de audiomappen geactiveerd zijn 
en benaderd kunnen worden door AerOn studio. 
 
Als u soms of geregeld AerOn studio ook opstart met een lokale database en de remote 
audiomappen eens (tijdelijk) niet toegankelijk zijn kan dat voor problemen en vertraging 
zorgen. Dit kan bijvoorbeeld gebeuren als de VPN-verbinding niet is gelegd en de optie 

Remote audio mappen actief toch is aangevinkt,. Zo kan het zijn dat daardoor AerOn 
studio minder snel reageert als de software op dat moment de remote V:\ schijf probeert 
te benaderen. Controleer in zo’n geval de remote-audiomap-instellingen. 
 
Als de VPN verbinding bij storing kortstondig wegvalt terwijl AerOn studio verbonden is 
met de database in de studio, moet u mogelijk AerOn studio afsluiten en herstarten om 
de databaseverbinding opnieuw tot stand te brengen. 
 
Remote audio scannen 
Bij de allereerste scan van alle remote audiobestanden in de synchronisatie module kan 
het zoeken naar remote bestanden lang duren. Dat is ook mede afhankelijk van de 
hoeveelheid audiobestanden. Zodra het scannen van alle remote bestanden is voltooid 
en de te verwerken lijst is ingeladen in het synchronisatie venster wordt de 
remotebestandslijst lokaal opgeslagen in een bestand.  Vanaf de tweede synchronisatie 
zal het inladen van remote bestanden dan minder lang duren.   
 
Het is aanbevolen, zoals hierboven beschreven, een volledige scan van alle remote 
bestanden uit te voeren voordat u voor de allereerste keer begint met het opnemen van 
voicetracks. De te verwerken bestandslijst toepassen (volgende stap) mag u hierbij 
overslaan als het enkel de bedoeling is om de remotebestandslijst te maken en lokaal 
op te slaan. Als u de bestandslijst toch toepast dan wordt effectief het kopieren gestart 
en worden alle remote bestanden, die nog niet bij u lokaal op de harddisk staan, naar u 
toe gekopieerd.  
 
Of u mag synchroniseren is afhankelijk van de aan u toegewezen gebruikersrechten 
binnen AerOn studio. Indien van toepassing vraag dan om toestemming bij de persoon 
die de gebruikersrechten in beheer heeft. De beheerder heeft de mogelijkheid om per 
gebruiker in te stellen in welke richting u mag synchroniseren.  
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Werkwijze stapsgewijs bij remote voicetracks opnemen 
 
1. Activeer de VPN verbinding. 

 
2. Start AerOn studio. 

 

3. Activeer de remote audiomappen via menu Gebruikers. 

 
Na het activeren van de remotemappen begint AerOn studio met het samenstellen van 
de remotebestandenlijst. Deze lijst wordt in cache geladen. De doorlooptijd van alle 
remotemappen is mede afhankelijk van het aantal bestanden en de internetsnelheid. 
 
4. Sluit Mix editor indien deze is geopend. 
Mix editor gaat altijd op zoek naar bestanden. Als één of meerdere bestanden lokaal nog 
niet aanwezig zijn duurt het langer eer een playlist en Mix-editor geladen is omdat alle 
audiomappen dan doorzocht worden om bestanden te vinden. Mix editor kunt u best 
openen nadat audiobestanden in een van de volgende stappen gesynchroniseerd zijn. 
 

Tip! Wanneer audiobestanden lokaal niet aanwezig zijn, dan duurt het navigeren door 
de playlist en Mix-editor langer omdat een audiobestand bij aanklikken in de playlist 
wordt geladen en Mix-editor altijd ook de opvolgende bestanden zoekt.  
Om audiobestanden te laden doorzoekt AerOn studio alle audiomappen om deze te 
kunnen vinden en er dan uiteindelijk achter komt dat een bestand niet aanwezig is. U 
kunt daarom het beste eerst de audiobestanden synchroniseren voordat u door uw uur 
in de playlist gaat navigeren. 
 

Tip! Als de tijden in de playlist niet overeenstemmen met de lengte van een track dan 

kunt u de mixtijden corrigeren met de functie “Update tijden van muziek databank” in 

het playlistmenu.  Sneltoets CTRL+T.  U moet in de playlist minimaal twee tracks 

selecteren om de mix-tijden uit de databank toe te passen. 
 

5. Open de playlist waarin u voicetracks gaat opnemen. 
Verzeker u er nogmaals van dat u bent ingelogd in de databank van de studio. Als u 
opstart met een lokale databank komen de voicetracks daarin terecht en niet in de 
playlist databank van de studio.  
 
6. Playlist-blok selecteren. 
Selecteer in de bloknavigator het playlist uur waarin u voicetracks gaat opnemen. 

 
7. Synchroniseer de audiobestanden tussen de studio (remote) en uw PC (lokaal). 
Om voicetracks te kunnen opnemen zijn lokaal de audiobestanden nodig van de tracks 
in het Playlist-blok waarin u gaat opnemen. Daarom moet u eerst de audiobestanden 
naar u toehalen met de Synchronisatie-module. Om de audiobestanden te kunnen 
synchroniseren selecteert u eerst de items in het playlistblkok. 
Selecteer het bovenste item van het blok in de playlist waarin u de voicetracks wil gaan 

opnemen, houdt de SHIFT-toets ingedrukt en klik op het onderste item van het 
playlistblok. Alle items in het playlist-blok worden dan geselecteerd.  

Open dan het Playlist-popupmenu (met de rechter muisknop) en kies Synchronisatie 

→ Audiobestanden. 
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Het Synchronisatie-venster opent zich, de bestandslijst van de geselecteerde items in 

de playlist wordt geladen. Klik op Toepassen om de (lo-res) audiobestanden naar u 
thuis te kopiëren.  
 

Tip! Als u straks nogmaals gaat synchroniseren, verwijder dan alle regels uit het 
synchronisatie-venster nadat het synchroniseren is voltooid. Dan houdt u een beter 
overzicht. In het popup-menu is daarvoor een verwijder-functie aanwezig. 

 
8. Open Mix editor en neem uw voicetracks op. 
Vergeet niet uw wijzigingen op te slaan. Raadpleeg ook hoofdstuk Mix editor. 
 
Uw persoonlijke voicetrack-instellingen zoals ducking, faden en levels kunt u aanpassen 

via Instellingen → Gebruiker → Persoonlijk → Voice track 
 

Tip! U kunt in Mix Editor ‘Automatisch opslaan’ activeren. 
 
9. Synchroniseer de voicetracks tussen uw PC (lokaal) en de studio (remote). 
Na het opnemen van uw voicetracks selecteert u opnieuw het uur in de playlist waarin 
de voicetracks zijn opgenomen. Selecteer het bovenste item van het blok in de playlist 
waarin u de voicetracks heeft opgenomen, houdt de SHIFT-toets ingedrukt en klik op het 
onderste item van het playlistblok. Alle items in het uur zijn dan geselecteerd. 

Open het Playlist-popupmenu met de rechter muisknop en kies Synchronisatie → 

Voice tracks. 
 

 
 

De synchronisatiemodule opent zich. Klik op Toepassen om de voicetracks te 
synchroniseren en te kopiëren naar remote voicetrackmap in de studio. 
 
10. Controleer of de voicetracks zijn overgezet naar de Remote map voice tracks. 

 
11. Sluit Mix-editor af. De volgende keer dat u zich aanmeldt in AerOn studio wordt Mix-

editor niet automatisch geopend. U kunt dan sneller aan de slag met het 
synchroniseren. AerOn studio opent per gebruiker bij het aanmelden altijd de 
vensters zoals die eerder bij het afmelden zijn achtergelaten. 

 
MIC processing met voicetracks 
Om er voor te zorgen dat voicetracks hard genoeg kunnen worden afgespeeld is het 
nodig om altijd in te spreken in een microfoon met voiceprocessing erachter zodat de 
Loudness (RMS-waarde) van de audio wordt verhoogd. Zonder voice-processing 
(compressor/limiter) zijn er meer peaks van 0 dB en is gemiddelde loudness lager. 
Harder dan 0 dB is niet toegestaan binnen AerOn studio. Dus ook al verhoogt u de gain, 
een voicetrack zal niet harder afspelen zodra er een peak 0dB is. Hoe hoger de RMS 
van een voicetrack is, hoe beter die uitkomt over de muziek, met als gevolg dat er minder 
ducking van de muziek nodig is waardoor muziek-spraak-muziek-overgangen beter 
zullen klinken. Een RMS-waarde van ongeveer -12dB is goed. Een alternatief i.p.v. een 
voice-processor is gebruik maken van VST2 plugin. 
 
VST plugin  (VST2 voice track plugin host) 
Mix editor biedt ondersteuning voor VST2 plugins.  
 
Bij AerOn worden standaard enkele free en trial VST2 plugins meegeleverd. 
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Om uw VST plugin dll in te vullen, zie Instellingen → Algemeen → Voicetrack → 
VST. 
 
Zodra een VST plugin is ingevuld kunt u na het opnemen van een eerste voicetrack de 
plugin naar wens instellen. Tijdens het afspelen van een voicetrack kunt u het VST plugin 
effect en voice-processing beluisteren. De VST plugin moet u eenmalig naar uw eigen 
smaak instellen. Daarna als volgende voicetracks worden opgenomen zal de ingestelde 
VST plugin voice-processing automatisch worden toegepast en opgeslagen in iedere 
voicetrack. 
 

39.3 Synchroniseren audiobestanden 

Synchronisatie audiobestanden kunt u openen via menu Tools of via het playlist-menu 
of via de sneltoets CTRL+ALT+S. 

 
Nadat u de audiobestanden van de studio mee naar huis hebt genomen, is het veelal 
gewenst om de bestanden thuis up-to-date te houden. AerOn studio biedt hiervoor de 
mogelijkheid om te synchroniseren.  
 
In dit geval zult u meestal alle audiobestanden synchroniseren en niet alleen de 
audiobestanden die in uw playlist-uur met voicetracks staan. Het spreekt voor zich dat 
dit synchoniseren wel meer tijd in beslag neemt omdat het dan om veel meer bestanden 
gaat. 
 
Of u mag synchroniseren is afhankelijk van de aan u toegewezen gebruikersrechten 
binnen AerOn studio.  
 
De optie synchroniseren wordt pas actief als u mag synchroniseren en als ook de remote 
audio mappen actief zijn. Activeer daarom in AerOn studio eerst de remote audiomappen 

via het menu Gebruikers. 

 
 
Nadat u de Synchronisatie module heeft geopend klik dan op Lokaal & remote scannen. 
Het zoeken naar alle lokale en remote bestanden wordt gestart. Wanneer het zoeken is 
voltooid, wordt in een tweede stap een lijst opgebouwd met te verwerken bestanden. Als 
dat is voltooid wordt die lijst ingeladen. Aan de hand van de ingestelde paden geeft 
AerOn studio een overzicht van alle bestanden in de studio die nog niet thuis aanwezig 

zijn en omgekeerd. Deze kunt u dan eenvoudig synchroniseren door op Toepassen te 
klikken. De doorlooptijd is afhankelijk van de snelheid van uw internetverbinding en het 
aantal te synchroniseren audiobestanden. Bij het naar u toehalen van deze gegevens 
wordt de hoogsthaalbare snelheid bepaald door de uploadbandbreedte in de studio. En 
bij het versturen van gegevens naar de studio is de uploadbandbreedte bij u thuis de 
meest bepalende factor. 
 

Tip! Audiobestanden en voicetracks kunt u enkel synchroniseren indien AerOn studio is 
verbonden met de databank in de studio. U kunt ook tracks slepen vanuit bijvoorbeeld 
Databank browser of Item browser om daarvan de audiobestanden te synchroniseren. 
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Aan de hand van de datum waarop een audiobestand is gewijzigd, wordt lokaal bij u 
thuis op hdd en remote in de studio op hdd met elkaar vergeleken en wordt er 
gesuggereerd in welke richting een audiobestand wordt gekopieerd: van lokaal naar 
remote (Uploaden naar de studio) of remote naar lokaal (Downloaden van de studio).  
 
U als gebruiker kunt, voordat u de acties toepast, de acties nog wijzigen. U kunt 
bijvoorbeeld manueel ook kiezen om een audiobestand lokaal of remote te verwijderen. 
Het verwijderen gebeurt enkel op aangeven van u als gebruiker en wordt nooit 
gesuggereerd. 
 
Tracks die u thuis aan de database heeft toegevoegd, krijgen tijdens het synchroniseren 
naar remote (Uploaden naar de studio) de status ‘Aanwezig’ in de database. Als u, nadat 
het synchroniseren is voltooid, de Databank browser vernieuwt, dan worden de uploaded 
tracks meteen zichtbaar in Databank browser. 
 

 
 
De synchronisatie-module onthoudt alle bestanden die u heeft gesynchroniseerd totdat 
u AerOn studio afsluit. De audiobestanden worden onthouden zodat u telkens kunt 
nazien welke bestanden u eerder gesynchroniseerd heeft.  
 

Via een popupmenu of via de sneltoets CTRL+DEL kunt u de historische items uit de 

synchronisatie-module verwijderen als u meermaals na elkaar synchroniseert om zo het 
overzicht van actuele tracks te behouden. 
 
 



Handleiding AerOn AerOn studio vertalen 

 we make radio happen 333 

40 AerOn studio vertalen 

AerOn studio is standaard te gebruiken in het Nederlands of Engels, maar laat zich op 
eenvoudige wijze vertalen naar andere gewenste talen. U installeert hiervoor het 
programma Language Manager. 
 
De installatie van Language Manager is vrij eenvoudig, u hoeft immers geen instellingen 
in het installatieprogramma te wijzigen. Na de installatie kunt u het programma starten 

via de menu’s Start → Programma’s (of Alle apps in Windows 10) → Language 
Manager → Language Manager. 
 
In de menu’s vindt u bij Help → Contents uitgebreide Engelstalige informatie over de 
werking van het programma. Dit hoofdstuk geeft een korte beschrijving van de 
werkzaamheden voor het vertalen van AerOn studio naar de door u gewenste taal. 
 
De Language Manager vertaalt de software vanuit de ‘native’ taal (Nederlands) naar een 
willekeurige andere taal. De taalbestanden hebben de extensie .lng en staan in de map 
van AerOn studio. 
 
De Language Manager zelf is in zeven talen beschikbaar. Om deze in het Nederlands in 

te stellen gaat u in de menu’s naar Edit → Options. In het onderstaande venster gaat u 

naar tabblad Language om een andere taal te kiezen. 
 

 
 
In de verdere beschrijving van het programma gaan we er van uit dat de taal op Engels 
ingesteld blijft staan. 
 

Kies File → Open om de ‘native language’ van AerOn studio te openen. Dit bestand 
heeft de naam Aeron.ntv.lng. 
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Language Manager heeft de ‘native language’ geopend en toont in een venster de 
beschikbare vertalingen. Voor de meeste gebruikers zal het handig zijn om de Engelse 
vertaling te openen. Dat doet u door deze aan te vinken. 
 
U kunt nu de teksten in de Engelse vertaling aanpassen of een nieuwe taal toevoegen 

via de menu’s met File → Create New Language. 
 

 
 

Based On 
Language 

Voor de nieuwe vertaling kopieert de Language Manager de 
teksten van een aanwezige taal. Voor de meeste gebruikers zal 
Engels de meest voor de hand liggende keuze zijn. 
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Language 
Identifier 

Hier kiest u de nieuwe taal. Sommige talen worden in meerdere 
landen gesproken waarbij men soms afwijkend woordgebruik heeft. 
Voor Italiaans kan men zo een onderscheid maken tussen Italië en 
Zwitserland. 

 
De overige opties kunt u hier ongewijzigd laten. Nadat u op OK hebt gedrukt wordt een 
nieuw taalbestand aangemaakt en kunt u beginnen met het vertalen van de applicatie. 
 
De teksten in de software zijn verdeeld over verschillende modules. De handigste 
methode is om de vertaling per module af te werken, zodat u overzicht over het werk 
houdt. Language Manager kent een groot aantal functies die behulpzaam kunnen zijn bij 
het vertalen. Deze vindt u ondermeer onder het menu van de rechter muisknop. 
 
Nadat u (een deel van) de teksten vertaald hebt, slaat u het bestand op en maakt u een 

resource DLL met File → Create DLL. Language Manager maakt dan een bestand met 
de vertaalde teksten dat door AerOn studio gebruikt kan worden. Dit moet u steeds doen 
als u teksten vertaald hebt. 
 
In het voorbeeld van een Italiaanse vertaling, bevat het bestand Aeron.ITA.lng de teksten 
die u vertaald hebt in Language Manager. Met de opdracht Create DLL maakt deze het 
bestand Aeron.ITA dat vervolgens door AerOn studio gebruikt wordt. 
 
Met het verschijnen van updates van AerOn studio worden er teksten aan de software 
toegevoegd of gewijzigd. De AerOn studio software (Aeron.exe) en de vertalingen (*.lng) 
horen per versie bij elkaar en kunnen niet door elkaar gebruikt worden. Gebruikt u deze 
toch door elkaar, dan is het goed mogelijk dat er overal verkeerde teksten in de software 
verschijnen. 
 
Voor het verwerken van de door u vertaalde teksten in een update van de software moet 
u de taalbestanden (Aeron.XXX.lng en de standaardtaal Aeron.ntv.lng) naar Broadcast 
Partners sturen. Daar wordt er voor gezorgd dat de nieuwe teksten integraal onderdeel 
van AerOn studio worden. Mocht u aansluitend daarna meer teksten vertalen of 
verbeteren, dan kunt u altijd weer de taalbestanden opsturen. 
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AerOn studio sneltoetsen 
 

Vensters 
Alt+F11 Databank editor 
F11  Databank browser 
Ctrl+F11 Item browser 
Ctrl+B  File browser 
F8  Jingle players 
F5  Mix edtior  
F12  Live assist players 
Ctrl+M Multi criteria editor 
 

Live assist 
F1  Cue Cart A 
F2  Play/Pauze Cart A 
F3  Cue Cart B 
F4  Play/Pauze Cart B 
F7  Live assist in/uit schakelen 
F12  Venster openen 
 

Programma 
Ctrl+F4 Sluiten 
Alt+F4  Afsluiten 
Ctrl+Z  Ongedaan maken 
Ctrl+X  Knippen 
Ctrl+C  Kopieren 
Ctrl+V  Plakken 
Ctrl+W Wijzigen 
Ctrl+Ins Toevoegen 
Ctrl+Del Verwijderen 
Ctrl+F  Zoeken 
Ctrl+P  Start afspelen (PFL) 
Spatiebalk Start/Stop afspelen 
Ctrl+S  Stop afspelen/opnemen 
Ctrl+R           Start opnemen 
Ctrl+Alt+E Externe audio editor 
Ctrl+Alt+A Studio aanvragen 
Ctrl+Alt+V Studio vrijgeven 
 

Playlist 
F9  Playlist vandaag 
Sift+F9 Playlist van morgen 
Ctrl+F9 Playlist van overmorgen 
Ctrl+V  Plak met tijden uit playlist 
Ctrl+E  Plak met tijden uit databank 
Ctrl+T  Update tijden vanuit databank 
Ctrl+K  Blokken vrijgeven 
Ctrl+N  Vernieuwen 
Ctrl+W Item wijzigen 
Ctrl+U  Items uitvullend maken 
Ctrl+L  Items glijdend maken 
Ctrl+D  Doorstart met volgend item 
Ctrl+O  Automix jingle onder intro 

 
 
Als je gebruikt wilt maken van de sneltoetsen 
voor Live assist dan dien je deze aan te zetten 
in de AerOn instellingen. Dit doet u via deze 
instellingen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



2025-05 Handleiding AerOn 

338 Broadcast Partners 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 


	1 Welkom bij AerOn
	1.1 OnAir en Productiestation
	1.2 Systeemeisen
	1.3 Opbouw van het systeem
	1.4 Overzicht van beschikbare modules
	1.5 Overzicht van sneltoetsen
	1.6 Audio systeem
	1.7 Hardware ondersteuning
	1.8 Extra mogelijkheden
	1.8.1 TeamViewer
	1.8.2 Backupvoorziening
	1.8.3 RAID 1

	1.9 Aan de slag met AerOn
	1.10 Playout output reference level

	2 Audioformaten en mappen
	3 Databank editor
	3.1 Track
	3.2 Artiest
	3.3 Criteria 1
	3.4 Criteria 2
	3.5 Songtekst
	3.6 Statistieken
	3.7 Editor
	3.8 Speciale functies

	4 Multi criteria editor
	5 Databank browser
	5.1 Zoeken
	5.2 Exporteren
	5.3 Databank browser Xtra

	6 Item browser
	6.1 File browser

	7 Playlist
	7.1 Speciale functies
	7.2 Playlist import .pll bestand
	7.3 Playlist import .txt bestand

	8 Formatplanner
	8.1 Achtergronden bij formatplanning
	8.2 Aan de slag met Formatplanner
	8.3 Formatplanner modules
	8.4 Formatplanner basis
	8.5 Formatplanner Xtra
	8.6 Formatplanner Xpert
	8.7 Formatplanning overzicht
	8.8 Instellingen
	8.9 Uurformat
	8.10 Dagformat
	8.11 Info (Formatplanner Xpert)
	8.12 Planning
	8.13 Plan checker

	9 Commercialplanner
	9.1 Instellingen
	9.1.1 Algemeen
	9.1.2 Branche / Stem
	9.1.3 Jingle
	9.1.4 Blok

	9.2 Klant
	9.2.1 Algemeen
	9.2.2 Browser
	9.2.3 Import (Commercialplanner Xtra)

	9.3 Campagne
	9.3.1 Algemeen
	9.3.2 Spots
	9.3.3 Browser
	9.3.4 Import (Commercialplanner Xtra)

	9.4 Planning
	9.4.1 Campagnes plannen
	9.4.2 Jingles plannen
	9.4.3 Spots plannen
	9.4.4 Automatisch exporteren

	9.5 Dagoverzicht
	9.6 Edities
	9.6.1 Configuratie master editie
	9.6.2 Configuratie slave editie
	9.6.3 Centraal commercials plannen (Commercialplanner Xtra)
	9.6.4 Multiple playout


	10 Nieuws
	11 Automatisering
	12 Live assist
	12.1 Doorstarten/groeperen

	13 Jingle players
	13.1 Jingle players Xtra
	13.2 Jingle keypad

	14 Mix editor
	14.1 Voicetracks opnemen
	14.2 Bedieningsconsoles

	15 Audio logger
	16 Time shifter
	16.1 Time Shift opnames zonder commercials
	16.2 Time Shifter met een master/slave studio systeem

	17 Gebruikers  (Rechten in AerOn studio)
	17.1 Overzicht gebruikersrechten

	18 Databank import
	19 Databank export
	20 Databank backup
	20.1 Databank backup maken in AerOn studio
	20.2 Databank backup maken via een script
	20.3 PostgreSQL database backup terugzetten
	20.3.1 Restore database via pgAdmin 4
	20.3.2 Restore database via een script


	21 Aanwezig scannen
	22 Historie playout log
	22.1 Afdrukken

	23 Buma/Sabam rapportage
	24 Export (HTML, XML en tekst)
	24.1 Playlist
	24.2 Playlist OnAir
	24.3 Publicatie op internet
	24.4 Voorbeelden
	24.4.1 Playlist op website
	24.4.2 Playlist op website – meer afbeeldingen
	24.4.3 Actieve track in bestand
	24.4.4 Vorige, actieve en volgende track in bestand
	24.4.5 Playlist zonder opmaak
	24.4.6 Actieve track als billboard
	24.4.7 XML
	24.4.8 Klokken
	24.4.9 Shoutcast en Icecast
	24.4.10 Orban Opticodec


	25 Acties
	25.1 Uitgaande acties
	25.1.1 Actietijd
	25.1.2 Voor stop
	25.1.3 Actie
	25.1.4 Live, Nonstop en Jingle

	25.2 Inkomende acties

	26 Beheer
	27 Instellingen
	27.1 Globaal
	27.1.1 Algemeen
	27.1.2 Criteria
	27.1.3 Audio lokaal
	27.1.4 Scan rechten
	27.1.5 Radio
	27.1.6 FTP upload

	27.2 Automatisering
	27.2.1 Export HTML / XML / Tekst
	27.2.2 Radix RDS
	27.2.3 Extern audio

	27.3 Lokaal
	27.3.1 Algemeen
	27.3.2 Audio
	27.3.3 Audio logger
	27.3.4 D&R Airence
	27.3.5 D&R Airlite / Webstation
	27.3.6 Studer
	27.3.7 DHD 52SX
	27.3.8 GatesAir
	27.3.9 Ember plus
	27.3.10 Axia xNode
	27.3.11 AXIA Livewire
	27.3.12 D&R MambaNet  (AXUM / AXITE)

	27.4 Gebruiker / Persoonlijk

	28 Afdruksjablonen
	29 Venster
	29.1 Venster voorkeuren (Databank browser Xtra)
	29.2 Lettergrootte

	30 Installatie AerOn studio
	30.1 AerOn NexusDB gebruikers
	30.2 Configuratie netwerk
	30.2.1 Configuratie 1, stand-alone
	30.2.2 Configuratie 2, netwerk zonder stand-alone server
	30.2.3 Configuratie 3, netwerk met stand-alone server

	30.3 Installatie AerOn studio
	30.3.1 Licentieovereenkomst
	30.3.2 Informatie
	30.3.3 Kies configuratie
	30.3.4 Kies de doelmap
	30.3.5 Kies de datamap
	30.3.6 Download de PostgreSQL instalatie
	30.3.7 Het voorbereiden van de installatie is gereed
	30.3.8 PostgreSQL installeren
	30.3.9 PostgreSQL configuratie  pg_hba.conf
	30.3.10 PostgreSQL configuratie postgresql.conf
	30.3.11 PostgreSQL configuratie database

	30.4 AerOn NexusDB gebruikers
	30.5 PC-Radio, Carmen, Mouse Music, Airwave en Dalet gebruikers
	30.6 Eerste start AerOn
	30.6.1 PostgreSQL Database verbinding
	30.6.2 Wizard
	30.6.3 Controle configuratie
	30.6.4 Virusscanners


	31 Audiokaarten
	31.1 Configuratie

	32 Compact Interface Module
	32.1.1 Remote inputs
	32.1.2 Remote outputs
	32.1.3 GPS time reference
	32.2 Technische details
	32.3 Installatie hardware
	32.3.1 CIM Serieel
	32.3.2 CIM USB
	32.3.3 CIM LAN
	32.3.4 IO-Interface

	32.4 Installatie software drivers
	32.4.1 CIM USB
	32.4.2 CIM LAN
	32.4.3 CIM LAN Netwerk en seriële instellingen
	32.4.4 CIM LAN Lantronix Com-Port-Redirector Manager


	33 Compact Interface Module instellingen
	33.1 Modules
	33.2 GPS klok
	33.3 Ingangen
	33.4 Uitgangen
	33.5 Interface modules

	34 Studio switch
	34.1 Master / Slave studio switch
	34.2 ehringer MX882 als studio switch
	34.2.1 Audio routing MX882


	35 InOutBox
	35.1 Instellingen in detail
	35.2 Backup en Restore instellingen

	36 Externe koppelingen / applicaties / Visual Radio
	37 AerOn studio softwarelicentie
	37.1 Licenties

	38 Probleemoplossing en Zomertijd/Wintertijd
	38.1 Backup
	38.2 Wintertijd en zomertijd
	38.3 Systeem relevante problemen

	39 AerOn studio thuis en remote voicetrack
	39.1 Configuratie
	39.2 Voicetracks opnemen
	39.3 Synchroniseren audiobestanden

	40 AerOn studio vertalen

